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Intel® Fortran Compiler Classic and
Intel® Fortran Compiler Developer
Guide and Reference

This document is for versions 2021.5 of the Intel® Fortran Compiler Classic (ifort) and 2022.0 Intel® Fortran
Compiler (1£x).

This guide provides information about Intel® Fortran Compiler Classic (ifort) and its runtime environment,
and about Intel® Fortran Compiler (i£x), which is a new compiler based on the Intel Fortran Compiler Classic
(ifort) frontend and runtime libraries, using LLVM backend technology.

Refer to the Intel® Fortran Compiler main page for more information about features, specifications, and
downloads.

Use this guide to learn about:

e Compiler Setup: How to invoke the compiler on the command line or from within an IDE.

e Compiler Options: Information about options you can use to affect optimization, code generation, and
more.

e Language Reference: Information on language syntax and semantics, on adherence to various Fortran
standards, and on extensions to those standards.

e OpenMP* Support: Details about compiler support for OpenMP 5.0 Version TR4 features and some
OpenMP Version 5.1 features.

e Fortran Language Extensions: Information on using additional implementation features, including
creating a Component Object Model server, generating listing and map files, and more.

e Mixed Language Programming: Information about Fortran and C interoperable procedures and data
types, as well as various specifics of mixed-language programming.

e Run-Time Error Messages: Information about the errors processed by the Intel® Fortran runtime library
(RTL).

For more information, refer to Introducing the Intel® Fortran Compiler Classic and Intel® Fortran Compiler.

Notices and Important Information

e Support for 32-bit targets is deprecated in ifort and may be removed in a future release. i fx does not
support 32-bit targets.

e macOS* is supported for the i fort compiler. However, support for Interprocedural Optimization (IPO) is
disabled for macOS SDK 11 or higher.

e Xcode* integration capabilities within our Intel® Fortran Compiler bundle have been removed. The
command-line interface remains fully functional for macOS.

Keep in mind that installation of Xcode is still recommended because command-line tools from Xcode are
required by the command-line compiler. However, you can install just the Xcode Command Line Tools with
this command from a terminal window:

xcode-select --install

Using the Compiler Documentation

e Context Sensitive/F1 Help: To use the Context Sensitive/F1 Help feature, visit the Download
Documentation: Intel® Compiler (Current and Previous) page and follow the provided instructions.
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e Download Previous Versions of the Developer Guide and Reference :Visit the Download
Documentation: Intel® Compiler (Current and Previous) page to download PDF or FAR HTML versions of
previous compiler documentation.

NOTE
For the best search experience, use a Google Chrome* or Internet Explorer* browser to view your
downloaded copy of the Intel Fortran Compiler Developer Guide and Reference.

If you use Mozilla Firefox*, you may encounter an issue where the Search tab does not work. As a
workaround, you can use the Contents and Index tabs or a third-party search tool to find your
content.
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Introducing the Intel® Fortran Part
Compiler Classic and Intel® Fortran
Compiler

Using the Intel® Fortran Compiler Classic and Intel® Fortran Compiler, you can compile and generate
applications that can run on Intel® 64 architecture. You can also create programs for the IA-32 architecture
on Windows* and Linux*.

Intel® 64 architecture applications can run on the following:

e Windows operating systems for Intel® 64 architecture-based systems.
e Linux operating systems for Intel® 64 architecture-based systems.
e macOS* operating systems for Intel® 64 architecture-based systems.

NOTE macOS is only available for the ifort compiler.

IA-32 architecture applications can run on the following:

NOTE Support for 32-bit targets is deprecated in ifort and may be removed in a future release. ifx
does not support 32-bit targets.

e Supported Windows operating systems
e Supported Linux operating systems

Unless specified otherwise, assume the information in this document applies to all supported architectures
and all operating systems.

You can use the compiler in the command-line or in a supported Integrated Development Environment (IDE):

e Microsoft Visual Studio* (Windows only)
e Eclipse*/CDT (Linux only)

The Intel Fortran Compiler (ifx) is a new compiler based on the Intel Fortran Compiler Classic (ifort) front-
end and runtime libraries, using LLVM back-end technology. At this time, i fx supports features of the Fortran
95 language, OpenMP* 5.0 Version TR4 and some OpenMP Version 5.1 directives and offloading features.

ifx is binary (.o/.0ob7j) and module (.mod) file compatible; binaries and libraries generated with ifort can
be linked with binaries and libraries built with i fx, and .mod files generated with one compiler can be used
by the other. Both compilers use the ifort runtime libraries. ifx supports GPU offloading, which ifort does
not support. Fortran users that are uninterested in GPU offloading should continue to use ifort.

See the Release Notes for complete information on supported architectures, operating systems, and IDEs for
this release.

Product and Performance Information

Performance varies by use, configuration and other factors. Learn more at www.Intel.com/
Performancelndex.

Notice revision #20201201
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Feature Requirements

To use these tools and features, you need licensed versions of the tools and you must have an appropriately
supported version of the product edition. For more information, check the product release notes.

NOTE Some features may require additional product installation.

The following table shows components (tools) and where to find additional information on them.

Component More Information
Intel® Fortran Compiler Classic and Intel® Fortran More information on tools and features can be
Compiler found on the Intel® Developer Zone and the

Software Development Tools pages.
Intel® Advisor

Intel® Inspector
Intel® Trace Analyzer and Collector

Intel® VTune™ Profiler

The following table lists dependent features and their corresponding required products. For certain compiler
options, the compilation may fail if the option is specified but the required product is not installed. In this
case, remove the option from the command line and recompile.

Feature Requirements

Feature Requirement
Thread Checking Intel® Inspector
Trace Analyzing and Collecting Intel® Trace Analyzer and Collector

Compiler options related to this feature may require
a set-up script. For further information, see the
product documentation.

Coarray programs built to run using distributed Intel® oneAPI HPC Toolkit
memory

Refer to the Release Notes for detailed information about system requirements, late changes to the products,
supported architectures, operating systems, and Integrated Development Environments (IDEs).

Getting Help and Support

Windows*

Documentation is available from within the version of Microsoft Visual Studio*. You must install the
documentation on your local system. To use the feature, visit the Download Documentation: Intel® Compiler
(Current and Previous) page and follow the instructions provided there. From the Help menu, choose Intel
Compilers and Libraries to view the installed user and reference documentation.
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Intel® Software Documentation

You can find product documentation for many released products at: https://software.intel.com/
content/www/us/en/develop/documentation.html

Product Website and Support

To find product information, register your product, or contact Intel, visit: https://software.intel.com/
content/www/us/en/develop/support.html

At this site, you will find comprehensive product information, including:

e Links to Get Started, Documentation, Individual Support, and Registration
e Links to information such as white papers, articles, and user forums

e Links to product information

e Links to news and events

Online Service Center

Each purchase of an Intel® Software Development Product includes a year of support services, which includes
priority customer support at our Online Service Center. For more information about the Online Service Center
visit: https://supporttickets.intel.com/servicecenter

NOTE To access support, you must register your product at the Intel® Registration Center: https://
registrationcenter.intel.com/en/products/

Release Notes

For detailed information on system requirements, late changes to the products, supported architectures,
operating systems, and Integrated Development Environments (IDE) see the Release Notes for the product.

Forums

You can find helpful information in the Intel Software user forums. You can also submit questions to the
forums. To see the list of the available forums, go to https://community.intel.com/t5/Software-Development-
Tools/ct-p/software-dev-tools

Related Information

Reference and Tutorial Information
The following commercially published documents provide reference or tutorial information about Fortran:

e Introduction to Programming with Fortran with coverage of Fortran 90, 95, 2003, 2008 and 77, by 1.D.
Chivers and J. Sleightholme; published by Springer, ISBN 9780857292322

e The Fortran 2003 Handbook: The Complete Syntax, Features and Procedures, by Adams, J.C., Brainerd,
W.S., Hendrickson, R.A., Maine, R.E., Martin, J.T., Smith, B.T., published by Springer Verlag, ISBN
9781846283789

e Fortran 95/2003 For Scientists and Engineers, by Chapman S.J., published by McGraw- Hill, ISBN
0073191574

e Modern Fortran Explained: Incorporating Fortran 2018, by Metcalf M., Reid J. and Cohen M., 2018,
published by Oxford University Press, ISBN-13: 978-0198811886

Intel does not endorse these books or recommend them over other books on the same subjects.

52


https://software.intel.com/content/www/us/en/develop/documentation.html
https://software.intel.com/content/www/us/en/develop/documentation.html
https://software.intel.com/content/www/us/en/develop/support.html
https://software.intel.com/content/www/us/en/develop/support.html
https://supporttickets.intel.com/servicecenter
https://registrationcenter.intel.com/en/products/
https://registrationcenter.intel.com/en/products/
https://community.intel.com/t5/Software-Development-Tools/ct-p/software-dev-tools
https://community.intel.com/t5/Software-Development-Tools/ct-p/software-dev-tools

Notational Conventions

Additional Product Information

For additional technical product information including white papers, forums, and documentation, visit https://
software.intel.com/content/www/us/en/develop/tools.html

Additional Language Information

e For information about the OpenMP* standards, visit the OpenMP website: http://www.openmp.org/
e For information about the Fortran standards, visit the Fortran standards technical committee website:
http://j3-fortran.org/

Notational Conventions

Information in this documentation applies to all supported operating systems and architectures unless
otherwise specified. This documentation uses the following conventions:

Notational Conventions

THIS TYPE Indicates statements, data types, directives, and
other language keywords. Examples of statement
keywords are WRITE, INTEGER, DO, and OPEN.

this type Indicates command-line or option arguments, new
terms, or emphasized text. Most new terms are
defined in the Glossary.

This type Indicates a code example.

This type Indicates what you type as input.

This type Indicates menu names, menu items, button names,
dialog window names, and other user-interface
items.

File > Open Menu names and menu items joined by a greater

than (>) sign to indicate a sequence of actions. For
example, Click File > Open indicates that in the
File menu, you would click Open to perform this
action.

{value | value} Indicates a choice of items or values. You can
usually only choose one of the values in the braces.

[item] Indicates items that are optional. Brackets are also
used in code examples to show arrays.

item [, item ]... Indicates that the item preceding the ellipsis (...)
can be repeated. In some code examples, a
horizontal ellipsis means that not all of the
statements are shown.

Intel® Fortran This term refers to the name of the common
compiler language supported by the Intel® Fortran
Compiler.
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compiler or the compiler

Windows* or Windows operating system

Linux or Linux operating system

macOS* or macOS* operating system

Microsoft Visual Studio*

compiler option

These terms are used when information is not
limited to only one specific compiler, or when it is
not necessary to indicate a specific compiler.

These terms refer to all supported Microsoft
Windows operating systems.

These terms refer to all supported Linux operating
systems.

These terms refer to all supported macOS*
operating systems.

An asterisk at the end of a word or name indicates
it is a third-party product trademark.

This term refers to Linux, macOS*, or Windows
options, which are used by the compiler to compile
applications.

The following conventions are used as shortcuts
when referencing compiler option names in text:

¢ Many options have names that are the same on
Linux, macOS*, and Windows, except that the
Windows form starts with an initial / and the
Linux and macOS*form starts with an initial -.
Within text, such option names are shown
without the initial character. For example,
check.

¢ Many options have names that are the same on
Linux, macOS*, and Windows, except that the
Windows form starts with an initial Q. Within
text, such option names are shown as
[Qloption—-name.

For example, if you see a reference to [Q] ipo,
the Linux and macOS* form of the option is
-ipo and the Windows form of the option

is /Qipo.

e Several compiler options have similar names
except that the Linux and macOS* forms start
with an initial g and the Windows form starts
with an initial Q. Within text, such option names
are shown as [g or Q]option-name.

For example, if you see a reference to

[g or Q]lopt-report, the Linux and macOS*
form of the option is ~qopt-report and the
Windows form of the option is /Qopt-report.

Other dissimilar compiler option names are shown
in full.
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Conventions Used in Compiler Options

/option or

-option

/option:argument or

-option=argument

/option:keyword or
-option=keyword
/option[:keyword ] or
-option[=keyword ]
option[n] or
option[:n] or
option[=n]

option[-]

[no]option or

[no-]option

A slash before an option name indicates the option
is available on Windows. A dash before an option
name indicates the option is available on Linux and
macOS* systems. For example:

e Windows option: /help
e Linux and macOS*option: -help

NOTE If an option is available on all supported
operating systems, no slash or dash appears in
the general description of the option. The slash
and dash only appear where the option syntax is
described.

Indicates that an option requires an argument
(parameter). For example, you must specify an
argument for the following options:

¢ Windows option: /tune:processor
¢ Linux and macOS* option: -mtune=processor

Indicates that an option requires one of the
keyword values.

Indicates that the option can be used alone or with
an optional keyword.

Indicates that the option can be used alone or with
an optional value. For example, in —unroll[=n],
the n can be omitted or a valid value can be
specified for n.

Indicates that a trailing hyphen disables the option.
For example, /Qglobal hoist- disables the
Windows option /Qglobal hoist.

Indicates that no or no- preceding an option
disables the option. For example, in the Windows
option / [no]traceback, /traceback enables the
option, while /notraceback disables it.

In the Linux and macOS* option
-[no-]global hoist, -global hoist enables
the option, while -no-global hoist disables it.

In some options, the no appears later in the option
name. For example, -fno-common disables the
—-fcommon option.
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Conventions Used in Language Reference

This color

Fortran

Standard Fortran

Fortran 95

Fortran 2003

Fortran 2008

Fortran 2018

integer

INTEGER

real

REAL

complex

COMPLEX

logical

56

Indicates Intel extensions (non-standard features)
that may or may not be implemented by other
compilers. Features defined by the Fortran
Standards or the OpenMP* Standards are shown in
black.

This term refers to language information that is
common to previously supported Fortran standards,
Fortran 2018, and the Intel® Fortran Compiler.

This term refers to language information that is
common to ANSI/ISO Fortran 95, ANSI/ISO Fortran
90, and Intel® Fortran.

This term refers to language features specific to
ANSI/ISO Fortran 95.

This term refers to language features specific to
ANSI/ISO Fortran 2003.

This term refers to language features specific to
ISO/IEC 1539-1:2010 (Fortran 2008).

This term refers to language features specific to
ISO/IEC 1539-1:2018 (Fortran 2018).

This term refers to the INTEGER(KIND=1),
INTEGER(KIND=2), INTEGER (INTEGER(KIND=4)),
and INTEGER(KIND=8) data types as a group.

This term refers to the default data type of objects
declared to be INTEGER. INTEGER is equivalent to
INTEGER(KIND=4), unless a compiler option
specifies otherwise.

This term refers to the REAL (REAL(KIND=4)),
DOUBLE PRECISION (REAL(KIND=8)), and
REAL(KIND=16) data types as a group.

This term refers to the default data type of objects
declared to be REAL. REAL is equivalent to
REAL(KIND=4), unless a compiler option specifies
otherwise.

This term refers to the COMPLEX
(COMPLEX(KIND=4)), DOUBLE COMPLEX
(COMPLEX(KIND=8)), and COMPLEX(KIND=16)
data types as a group.

This term refers to the default data type of objects
declared to be COMPLEX. COMPLEX is equivalent to
COMPLEX(KIND=4), unless a compiler option
specifies otherwise.

This term refers to the LOGICAL(KIND=1),
LOGICAL(KIND=2), LOGICAL (LOGICAL(KIND=4)),
and LOGICAL(KIND=8) data types as a group.
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LOGICAL This term refers to the default data type of objects
declared to be LOGICAL. LOGICAL is equivalent to
LOGICAL(KIND=4), unless a compiler option
specifies otherwise.

< Tab> This symbol indicates a nonprinting tab character.

A This symbol indicates a nonprinting blank character.

Platform Labels

A platform is a combination of an operating system (OS) and a central processing unit (CPU), which provides
a distinct environment for product use (in this case, a computer language). An example of a platform is
Microsoft Windows on processors using Intel® 64 architecture.

In this documentation, the information applies to all supported platforms unless it is otherwise labeled for a
specific platform (or platforms).

These labels may be used to identify specific platforms:

L*X Applies to a Linux operating system.
M*X Applies to a macOS* operating system.
W*S Applies to a Microsoft Windows operating system.
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Part

Compiler Setup

You can use the Intel® Fortran from the command line, or from the IDEs listed below.

These IDEs are described in further detail in their corresponding sections.

Using the Command Line

This section provides information about the Command Line Interface (CLI).

Specifying the Location of Compiler Components

Before you invoke the compiler, you may need to set certain environment variables that define the location of
compiler-related components. The Intel® Fortran Compiler Classic and Intel® Fortran Compiler includes
environment configuration scripts to configure your build and development environment variables:

e On Linux*, and macOS#*, the file is a shell script called setvars.sh. Note that macOS* is only available
for ifort.
e On Windows*, the file is a batch file called setvars.bat.

The following information is operating system dependent.

Linux and macOS*:

Set the environment variables before using the compiler by sourcing the shell script setvars.sh. Depending
on the shell, you can use the source command or a . (dot) to source the shell script, according to the
following rule for a . sh script:

source /<install-dir>/setvars.sh <argl> <arg2> .. <argn>
/<install-dir>/setvars.sh <argl> <arg2> .. <argn>

# examples: (assuming <install-dir> is /opt/intel/oneapi)
prompt> source /opt/intel/oneapi/setvars.sh intel64
prompt> . /opt/intel/oneapi/setvars.sh intel64

NOTE Type: source /<install-dir>/setvars.sh --help for more setvars usage information.

The compiler environment script file accepts an optional target architecture argument <arg>:

e intel64: Generate code and use libraries for Intel® 64 architecture-based targets.
e 1a32: Generate code and use libraries for IA-32 architecture-based targets.

If you want the setvars.sh script to run automatically in all of your terminal sessions, add the source
setvars.sh command to your startup file. For example, inside your .bash profile entry for Intel® 64
architecture targets:

# set environment vars for Intel® Fortran Compiler
source <install-dir>/setvars.sh intel64
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If the proper environment variables are not set, errors similar to the following may appear when attempting
to execute a compiled program:

./a.out: error while loading shared libraries:
libimf.so: cannot open shared object file: No such file or directory

Windows:

Under normal circumstances, you do not need to run the setvars.bat batch file. The terminal shortcuts in the
Windows Start menu, Intel oneAPI command prompt for <target architecture> for Visual Studio
<year>, set these variables automatically.

For additional information, see Using the Command Line on Windows.

NOTE You need to run the setvars batch file if a command line is opened without using one of the
provided Command Prompt menu items in the Start menu, or if you want to use the compiler from a
script of your own.

The setvars batch file inserts DLL directories used by the compiler and libraries at the beginning of the
existing Path. Because these directories appear first, they are searched before any directories that were part
of the original path provided by Windows (and other applications). This is especially important if the original
Path includes directories with files that have the same names as those added by the compiler and libraries.

The setvars batch file takes multiple optional arguments; the following two arguments are recognized for
compiler and library initialization:

<install-dir>\setvars.bat [<argl>] [<arg2>]
Where <argl> is optional and can be one of the following:

e intel64: Generate code and use libraries for Intel® 64 architecture (host and target).
e ia32: Generate code and use libraries for IA-32 architecture (host and target).

The <arg2> is optional. If specified, it is one of the following:

e vs2019: Microsoft Visual Studio* 2019
e vs2017: Microsoft Visual Studio 2017

NOTE If <argl> is not specified, the script uses the intel 64 argument by default. If <arg2> is not
specified, the script uses the highest installed version of Microsoft Visual Studio detected during the
installation procedure.

NOTE Support for Microsoft Visual Studio 2017 is deprecated as of the Intel® oneAPI 2022.1 release,
and will be removed in a future release.

See Also
oneAPI Development Environment Setup

Configure Your CPU or GPU System
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Invoking the Compiler

Requirements Before Using the Command Line

You may need to set certain environment variables before using the command line. For more information,
see Specifying the Location of Compiler Components.

Different Compilers and Drivers

The table below provides the different compiler front-end and driver information.

Compiler Notes Linux* Driver Windows* Driver
Intel® Fortran A Fortran compiler ~ 1fort ifort
Compiler Classic with full Fortran
2018 support.
Intel® Fortran A Fortran compiler ifx ifx
Compiler based on the Intel

Fortran Compiler
Classic (ifort)
front-end and
runtime libraries,
using LLVM back-
end technology.

Using the Intel® Fortran Compiler from the Command Line

You can invoke the Intel® Fortran Compiler on the command line using the ifort command.

NOTE For Windows and macOS* systems, you can use the compiler within the IDE.
For more information on using the Microsoft Visual Studio IDE, see Using Microsoft Visual Studio.

The syntax of the i fort command is:
ifort [options]input file(s)

The ifort command can compile and link projects in one step, or can compile them and then link them as a
separate step.

In most cases, a single i fort command invokes the compiler and linker. You can also use 14 (Linux and
macOS*) or 1ink (Windows) to build libraries of object modules. These commands provide syntax
instructions at the command line if you request it with the -help (Linux and macOS*), or the /help or /?
(Windows) options.

The ifort command automatically references the appropriate Intel® Fortran runtime Libraries when it
invokes the linker. To link one or more object files created by the Intel® Fortran Compiler, you should use the
ifort command instead of the 1ink command.

The ifort command invokes a driver program that is the user interface to the compiler and linker. It
accepts a list of command options and file names and directs processing for each file. The driver program
does the following:

e Calls the Intel® Fortran Compiler to process Fortran files.
e Passes the linker options to the linker.

e Passes object files created by the compiler to the linker.
e Passes libraries to the linker.
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e Calls the linker or librarian to create the executable or library file.

Because the compiler driver calls other software components, they may return error messages. For instance,
the linker may return a message if it cannot resolve a global reference. The watch option can help clarify
which component is generating an error.

For a complete listing of compiler options, see the Compiler Options reference.

NOTE

The compiler recognizes language extensions for offloading in the source program by default and
builds a heterogeneous binary that runs on the target and host when any are present. If your program
includes these language extensions and you do not want to build a heterogeneous binary, specify the
-gno-offload compiler option. For more information, see the -gno-offload compiler option.

Offload is not supported on Windows systems.

NOTE
Windows systems support characters in Unicode* (multibyte) format. The compiler processes the file
names containing Unicode characters.

Syntax Rules
The following rules apply when specifying ifort on the command line:

Argument Description

options An option is specified by one or more letters preceded by a hyphen (-) for Linux and
macOS* or a slash (/) for Windows. (You can use a hyphen (-) instead of a slash
(/) for Windows, but it is not the preferred method.)

Options cannot be combined with a single slash or hyphen, you must specify the
slash or hyphen for each option specified. For example: /1 /c is correct, but /1c is
not.

Options can take arguments in the form of file names, strings, letters, and numbers.
If a string includes spaces, they must be enclosed in quotation marks.

Some options take arguments in the form of file names, strings, letters, or numbers.
Except where otherwise noted, a space between the option and its argument(s) can
be entered or combined. For a complete listing of compiler options, see the Compiler
Options reference.

Some compiler options are case-sensitive. For example, c and C are two different
options.

Option names can be abbreviated, enter as many characters as are needed to
uniquely identify the option.

Compiler options remain in effect for the whole compilation unless overridden by a
compiler directive.

Certain options accept one or more keyword arguments following the option name
on Windows. To specify multiple keywords, you typically specify the option multiple
times. However, some options allow comma-separated keywords. For example:

e Options that use a colon can use an equal sign (=) instead.
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Argument Description

e Standard output and standard error can be redirected to a file, avoiding
displaying excess text, which slows down execution. Scrolling text in a terminal
window on a workstation can cause an I/O bottleneck (increased elapsed time)
and use more CPU time. See the examples in the next section.

NOTE Options on the command line apply to all files. In the following example,
the -c and -nowarn options apply to both files x.f and y. f:

ifort -c x.f -nowarn y.f

input file(s) Multiple input_files can be specified, using a space as a delimiter. When a file is not
in PATH or working directory, specify the directory path before the file name. The file
name extension specifies the type of file. See Understanding File Extensions.

Xlinker (Linux Unless specified with certain options, the command line compiles and links the files
and macOS*) you specify. To compile without linking, specify the ¢ option.
or /link

All compiler options must precede the -Xlinker (Linux and macOS*) or /1link
(Windows) options. Options that appear following -X1inker or /1ink are passed
directly to the linker.

(Windows)

Examples of the ifort Command

The following command compiles x. for, links, and creates an executable file. This command generates a
temporary object file, which is deleted after linking:

ifort x.for

The following command compiles x. for and generates the object file x.o (Linux and macOS*) or x.ob]
(Windows). The c option prevents linking (it does not link the object file into an executable file):

// (Linux and macOS*)
ifort -c x.for

//  (Windows)

ifort x.for /c

The following command links x.o or x.ob7j into an executable file. This command automatically links with
the default Intel® Fortran libraries:

// (Linux and macOS*)
ifort x.o

// (Windows)

ifort x.obj

The following command compiles a. for, b. for, and c. for, creating three temporary object files, then
linking the object files into an executable file named a.out (Linux and macOS*) or a.exe (Windows).

ifort a.for b.for c.for

Compile the source files that define modules before the files that reference the modules (in USE statements)
when using modules and compile multiple files.
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When you use a single ifort command, the order in which files are placed on the command line is
significant. For example, if the free-form source file moddef . £90 defines the modules referenced by the file
projmain.f£90, use the following syntax:

ifort moddef.f90 projmain.f90

To specify a particular name for the executable file, specify the option -o (Linux and macOS*) or /exe
(Windows):

// (Linux and macOS*)
ifort x.for -o myprog.out
//  (Windows)

ifort x.for /exe:myprog.exe

To redirect output to a file and then display the program output (Linux and macOS*):

// (Linux and macOS*)
myprog > results.lis
more results.lis

To place standard output into file one.out and standard error into file two.out:

//  (Windows)

ifort filenames /options 1>one.out 2>two.out
// OR

ifort filenames /options >one.out 2>two.out

To place standard output and standard error into a single file both.out (Windows):

// (Windows)

ifort filenames /options 1>both.out 2>&l
// OR

ifort filenames /options >both.out 2>&1

Other Methods for Using the Command Line to Invoke the Compiler

¢ Using makefiles from the Command Line: Use makefiles to specify a number of files with various
paths and to save this information for multiple compilations. For more information on using makefiles, see
Using Makefiles to Compile Your Application.

e Using the devenv Command from the Command Line (Windows Only): Use devenv to set various
options for the IDE, and to build, clean, and debug projects from the command line. For more information
on the devenv command, see the devenv description in the Microsoft Visual Studio documentation.

e Using a Batch File from the Command Line: Create and use a .bat file to consistently execute the
compiler with a desired set of options instead of retyping the command each time you need to recompile.

See Also

Understanding File Extensions

Using Microsoft Visual Studio

Using Makefiles to Compile Your Application
watch compiler option

goffload compiler option

Using the Command Line on Windows*

The compiler provides a shortcut to access the command line with the appropriate environment variables
already set.
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NOTE Instructions and menu options may vary by Windows* version.

To invoke the compiler from the command line:

1. Open the Windows Start menu.
2. Scroll down the list of apps (programs) in the Start menu and find the Intel oneAPI 2021 folder.
3. Left click on the folder name and select your component.

NOTE The command prompts shown are dependent on the versions of Microsoft Visual Studio* you
have installed on your machine.

4. Right click on the command prompt icon to pin it to your taskbar.

NOTE This step is optional.

The command line opens.
You can use any command recognized by the Windows command prompt, plus some additional commands.

Because the command line runs within the context of Windows, you can easily switch between the command
line and other applications for Windows or have multiple instances of the command line open simultaneously.

When you are finished working in a command line, use the exit command to close and end the session.

Running Fortran Applications from the Command Line

For programs run from the command line, the operating system searches directories listed in the PATH
environment variable to find the requested executable file.

The program can also be run by specifying the complete path of the executable file. On Windows* operating
systems, any DLLs you are using must be in the same directory as the executable or in one specified in the
path.

Multithreaded Programs

If the program is multithreaded, each thread starts on whichever processor is available at the time. On a
computer with one processor, the threads all run in parallel, but not simultaneously; the single processor
switches among them. On a computer with multiple processors, the threads can run simultaneously.

Using the -fpscomp filesfromemd Option

If you specify the -fpscomp option with keyword filesfromcmd, the command line that executes the
program can include additional filenames to satisfy OPEN statements in the program for which the filename
field (FILE specifier) has been left blank. The first filename on the command line is used for the first OPEN
statement executed, the second filename for the second OPEN statement, and so on.

NOTE
In the Visual Studio* IDE, you can provide these filenames using Project > Properties. Choose the
Debugging category and enter the filenames in the Command Arguments text box.

Each filename on the command line (or in an IDE dialog box) must be separated from the names around it
by one or more spaces or tab characters. You can enclose each name in quotation marks ("<filename>"), but
this is not required unless the argument contains spaces or tabs. A null argument consists of an empty set of
quotation marks with no filename enclosed ("").
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The following example runs the program MYPROG.EXE from the command line:
MYPROG "" OUTPUT.DAT

Because the first filename argument is null, the first OPEN statement with a blank filename field produces the
following message:

File name missing or blank - please enter file name
UNIT number °?

The number is the unit number specified in the OPEN statement. The filename OUTPUT.DAT is used for the
second OPEN statement executed. If additional OPEN statements with blank filename fields are executed, you
will be prompted for more filenames.

Instead of using the -fpscomp option with keyword filesfromcmd, you can:

e Call the GETARG library routine to return the specified command-line argument. To execute the program
in the Visual Studio* IDE, provide the command-line arguments to be passed to the program using
Project > Properties. Choose the Debugging category and enter the arguments in the Command
Arguments text box.

e On Windows* OS, call the GetOpenFileName Windows* API routine to request the file name using a
dialog box.

See Also
-fpscomp option

Understanding File Extensions

Input File Extensions
The Intel® Fortran Compiler interprets the type of each input file by the file name extension.

The file extension determines if a file gets passed to the compiler or to the linker. The following types of files
are used with the compiler:

e Files passed to the compiler: .£90, .for, .f, .fpp, .1, .190, .ftn

Typical Fortran source files have a file extension of .£90, . for, and . f. When editing your source files,
you need to choose the source form, either free-source form or fixed-source form (or a variant of fixed
form called tab form). You can use a compiler option to specify the source form used by the source files
(see the description for the free or fixed compiler option) or you can use specific file extensions when
creating or renaming your files. For example, the compiler assumes that files with an extension of:

e .f90 or .i90 are free-form source files.
e .f, .for, .ftn, or .1i are fixed-form (or tab-form) files.
e Files passed to the linker: .a, .1ib, .obj, .o, .exe, .res, .rbj, .def, .dll

The most common file extensions and their interpretations are:

Filename Interpretation Action

file.a (Linux and macOS*) Object library Passed to the linker.

file.lib (Windows)

file.f Fortran fixed-form Compiled by the Intel® Fortran Compiler.
, source

file.for

file.ftn

65



Intel® Fortran Compiler Classic and Intel® Fortran Compiler Developer Guide and Reference

Filename Interpretation Action

file.i

file.fpp Fortran fixed-form Automatically preprocessed by the Intel®
source Fortran preprocessor fpp; then compiled

On Linux, filenames with the following

© .
uppercase extensions: by the Intel® Fortran Compiler.

file.FPP

file.F

file.FOR

file.FTN

file.f90 Fortran free-form Compiled by the Intel® Fortran Compiler.

file.1i90 source

file.F90 (Linux and macOS*) Fortran free-form Automatically preprocessed by the Intel®
source Fortran preprocessor fpp; then compiled

by the Intel® Fortran Compiler.

file.s (Linux and macOS*) Assembly file Passed to the assembler.

file.asm (Windows)

file.o (Linux and macOS*) Compiled object Passed to the linker.
file

file.obj (Windows)

When you compile from the command line, you can use the compiler configuration file to specify default
directories for input libraries. To specify additional directories for input files, temporary files, libraries, and for
the files used by the assembler and the linker, use compiler options that specify output file and directory
names.

Output File Extensions (Windows)

On Windows operating systems, many compiler options allow you to specify the name of the output file being
created. These compiler options are summarized in the table below.

If you specify only a filename without an extension, a default extension is added for the file.

Compiler option Default file extension
/Fafile .ASM
/dll:file .DLL
/exe:file .EXE
/map:file .MAP
See Also

Invoking the Compiler
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Using Makefiles to Compile Your Application

This topic describes the use of makefiles to compile your application. You can use makefiles to specify a
number of files with various paths, and to save this information for multiple compilations.

Using Makefiles to Store Information for Compilation on Linux* or macOS*

To run make from the command line using the Intel® Fortran Compiler, make sure that /usr/bin and /usr/
local/bin are in your PATH environment variable.

If you use the C shell, you can edit your .cshrc file and add the following:
setenv PATH /usr/bin:/usr/local/bin:S$SPATH

Then you can compile using the following syntax:
make -f yourmakefile

Where -f is the make command option to specify a particular makefile name.

Using Makefiles to Store Information for Compilation on Windows*

To use a makefile to compile your source files, use the nmake command. For example, if your project is
your_ project.mak, you can use the following syntax:

nmake /f [makefile name.mak] FPP=[compiler name] LINK32=[linker name]
For example:

prompt> nmake /f your project.mak FPP=ifort LINK32=xilink

Argument Description

/£ The nmake option to specify a makefile.

your_ project.mak The makefile used to generate object and executable files.

FPP The preprocessor/compiler that generates object and executable files.
(The name of this macro may be different for your makefile.)

LINK32 The linker that is used.

The nmake command creates object files (.ob7j) and executable files () from the information specified in the
your_ project.mak makefile.

Generating Build Dependencies for Use in a Makefile
Use the gen-dep compiler option to generate build dependencies for a compilation.

Build dependencies include a list of all files included with INCLUDE statements and .mod files accessed with
USE statements. The resulting output can be used to create a makefile to with the appropriate dependencies
resolved.

Consider a source file that contains the following:

module b
include 'gendepOOlb.inc'
end module b

program gendep001
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use b
a global = b global
end

When you compile the source using the gen-dep option, the following output is produced:

b.mod : \

gendep001.£90

gendep001.0bj : \
gendep001.£90 gendep00lb.inc

This output indicates that the generated file, b.mod, depends on the source file, gendep001. £90. Similarly,
the generated file, gendep001.0b7j, depends on the files, gendpe001.£90 and gendep001b.inc.

Using Microsoft Visual Studio*

You can use the Intel® Fortran Compiler within the Microsoft Visual Studio* integrated development
environment (IDE) to develop Fortran applications, including static library (.LIB), dynamic link library
(.pLL), and main executable (.EXE) applications. This environment makes it easy to create, debug, and
execute programs. You can build your source code into several types of programs and libraries, using the IDE
or from the command line.

The IDE offers these major advantages:

e Makes application development quicker and easier by providing a visual development environment.
e Provides integration with the native Microsoft Visual Studio debugger.
e Makes other IDE tools available.

See Also

Performing Common Tasks with Microsoft Visual Studio*
Using Microsoft Visual Studio* Solution Explorer

Using Breakpoints in the Debugger

Using Microsoft Visual Studio* Solution Explorer

Creating a Fortran project in Microsoft Visual Studio* causes a screen to appear. This screen shows an open
Solution named Consolel and a Project named Consolel. You will see that the source file
Consolel.£90 is open. The left pane shows the file, Consolel.£90, which is opened in the default
language-sensitive integrated development environment text editor. The text editor uses different colors to
identify the following:

Source comments (green)

Fortran standard language elements (blue)
Other language text (black)

Sample name (red)

Solution Explorer View

The right pane shows the Solution Explorer view, which lets you view different aspects of your solution,
such as the source files. The tabs displayed in Solution Explorer vary depending upon the products
installed, and the files associated with the current solution. To display the Solution Explorer view, select
View > Solution Explorer. To display the Properties view, select View > Properties.

To edit a file listed in the Solution Explorer, either double-click its file name or select File > Open and
specify the file.
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The Output window displays compilation and linker messages. To display the Output window, select View >
Output. The Output window also links to the build log, if the Generate Build logs option is enabled in
Tools > Options > Intel Compilers and Libraries > Visual Fortran.

Creating a New Project

Creating a New Project

When you create a project, Microsoft Visual Studio* automatically creates a corresponding solution to contain
it. To create a new Intel® Fortran project using Microsoft Visual Studio:

NOTE Exact steps may vary depending on the version of Microsoft Visual Studio in use.

1. Select File > New > Project.

2. In the left pane, click Intel® Visual Fortran to display the Fortran project types. For each project type,
available templates are listed in the right pane.

3 Click the appropriate project type (see Understanding Project Types).

4. Accept or specify a project name.

5 Accept or specify the Location for the project directory. Project files will be stored here. If the directory
specified does not exist, it will be created.

6. Click OK to complete the new project.

The hello32 project assumes focus in the Solution Explorer view. The default Microsoft Visual Studio*
solution is also named hello32.

The project and its files appear in the Solution Explorer view. For a COM Server project, you will see a
second page with additional user options.

Add an Existing File to the Project

1. If not already open, open the project (use the File menu).
2. Select Project > Add Existing Item.
3. In the Add Existing Item dialog box that appears, select the Fortran files to be added to the project.

Add a New File to the Project

If not already open, open the project (use the File menu).

Select Project > Add New Item.

In the Add New Item dialog box that appears, choose the type of file.

Specify the file name. Click Open. The file name appears in the Solution Explorer view.

Use the Microsoft Visual Studio* editor to type in source code. Be sure to save your work when you are
finished.

L o ol

Organizing Existing Source Code

If you have existing source code, you should organize it into directories before creating a project, although it
is easy to move files and edit your project definitions if you should later decide to reorganize your files.

Working with Fortran Modules

If your program uses Fortran modules, you do not need to explicitly add them to your project; they appear
as dependencies (.MOD files).

A module file is a precompiled, binary version of a module definition, stored as a .mod file. When you change
the source definition of a module, you can update the .mod file before you rebuild your project. To do this,
compile the corresponding source file separately by selecting the file in the Solution Explorer window and
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selecting Build > Compile. If the module source file is part of your project, you do not need to compile the
file separately. When you build your project, the Intel® Fortran Compiler determines what files need to be
compiled.

To control the placement of module files in directories, use Project > Properties > Fortran > Output
Files > Module Path in the IDE or the compiler option [no]module on the command line. The location you
specify is automatically searched for .mod files.

To control the search for module files in directories, select one of the following:
e In the IDE:

¢ Project > Properties > Fortran > Preprocessor > Default Include and Use Path
¢ Project > Properties > Fortran > Preprocessor > Ignore Standard Include Path
¢ On the Command Line:

e XorIandassume:source include compiler options.

For a newly created project (or any other project), the IDE scans the file list for sources that define modules
and compiles them before compiling the program units that use them. The IDE automatically scans the
added project files for modules specified in USE statements, as well as any INCLUDE statements. It scans the
source files for all tools used in building the project.

See Also

Understanding Project Types
I

X

assume

Performing Common Tasks with Microsoft Visual Studio*

This topic outlines the basic steps for using the Intel® Fortran Compiler with Microsoft Visual Studio*.

Building and Running a Fortran Project

e To build the application, select Build > Build Solution. Any errors will be displayed in the Output
Window. Double-click a message to go to the line in error.

e To run without debugging, select Debug > Start Without Debugging. The console window will remain
open after the program exits until you press Enter.

e To run under the debugger, first set a breakpoint at the first executable line of the program by clicking in
the gray column to the left of the source line. Then select Debug > Start. If the program exits normally,
the console window will be closed automatically.

Converting Compaq* Visual Fortran Projects

For information on converting projects from Compaqg* Visual Fortran to Intel® Fortran, see Converting
Projects.

See Also
Creating a New Project
Converting Projects
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Selecting a Version of the Intel® Fortran Compiler

If you have more than one version of the Intel® Fortran Compiler installed, you can choose which version to
be used when building applications. You can also select different versions for different target platforms and
the version of the compiler you are using. The target platform you select determines the compiler versions
that appear in the Selected drop-down box.

To select the compiler version:

1. Select Tools > Options > Intel Compilers and Libraries > Visual Fortran > Compilers.
2. Select a compiler from Selected compiler. Click OK.

Specifying Fortran File Extensions

You can specify additional Fortran free format and fixed format file extensions to be recognized as valid file
extensions within the IDE. The IDE treats these additional extensions as compilable Fortran source files. You
can also remove or modify existing extensions.

When you add a new extension, the IDE checks the registry to determine whether the extension is already
associated with a language, tool, or file format. If there is such an association, a message informs you of this
and you will not be allowed to add the extension.

To specify Fortran file extensions:

1. Open Tools > Options.

2. In the left pane, go to Intel Compilers and Libraries > Visual Fortran > General.

3. Specify one or more Fortran File Extensions, each beginning with a period and separated by semi-
colons. You can specify extensions for both Free Format Extensions and Fixed Format Extensions.
Click OK.

These new settings take effect the next time you start Visual Studio*.

Understanding Solutions, Projects, and Configurations

The Microsoft Visual Studio* IDE consists of one or more projects contained within a solution. A solution can
contain multiple projects. If you have several Fortran applications that do different calculations but are
related, you can store all the individual projects in a single solution. Along with a solution file (.s1n), the IDE
creates a solution user options (. suo) file for storing IDE customization.

The following table summarizes the files created by Microsoft Visual Studio when a new project is created:

File Extension Description
Project .sln Stores solution information, including the projects and items in the
Solution file solution and their locations on disk.
Project file .vEproj Contains information used to build a single project or sub-project.
.VCXproj

Solution .suo Contains IDE customization for the solution, based on the selected
options file options.

Caution

¢ Directly modifying these files with a text editor is not supported.
e Before opening Compaqg* Visual Fortran 6.0 projects or Intel® Visual Fortran 7.x projects in
Microsoft Visual Studio, review the guidelines listed in Converting Projects.
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Each project can specify one or more configurations to build from its source files. A configuration specifies
such information as the type of application to build, the platform it runs on, and the tool settings to use when
building. Having multiple configurations extends the scope of a project, but maintains a consistent source
code base to work with.

Microsoft Visual Studio automatically creates Debug and Release (also known as Retail) configurations
when a new project is started. The default configuration is the Debug configuration. To specify the current
configuration, select Configuration Manager from the Build menu.

Specify build options in the Project > Properties dialog box, for one of the following:

e For all configurations (project-wide).
e For certain configurations (per configuration).
e For certain files (per file).

For example, specify compiler optimizations for all general configurations, but turn them off for certain
configurations or certain files.

Once the files in the project are specified and the configurations for your project build are set, including the
tool settings, build the project with the commands on the Build menu.

NOTE For a multiple-project solution, make sure that the executable project is designated as the
startup project (shown in bold in the Solution Explorer view). To modify the startup project, right-
click on the project and select Set as StartUp Project.

See Also
Converting Projects

Navigating Programmatic Components in a Fortran File

You can quickly navigate the code of the file currently open in the source editor using the Tree Navigation
Window. The Tree Navigation Window displays the following components of the file as nested, selectable
nodes in a tree:

e Programs

¢ Modules

e Subroutines with signature
e Functions with signature

o Types

e Interfaces

Nodes at each nested level are sorted alphabetically.

Any changes you make to a file, such as adding or deleting a component or changing a signature, are
immediately reflected in the tree.

To navigate a file:

1. Select View > Other Windows > Tree Navigation Window.
The Tree Navigation Window tab appears near the Solution Explorer tab. When no Fortran project
is opened, the Tree Navigation Window is empty. When you open a Fortran file in the source editor,
all components of the file appear in the window.

2. Select a node in the tree to view the corresponding component in the source editor.
The cursor appears at the correct location in the file.

Selecting a Configuration

A configuration contains settings that define the final binary output file that you create within a project. It
specifies the type of application to build, the platform on which it is to run, and the tool settings to use when
building.
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Debug and Release Configurations
When you create a new project, Visual Studio* automatically creates the following configurations:

Configuration Description

Debug configuration By default, the debug configuration sets project options to
include the debugging information in the debug configuration. It
also turns off optimizations. Before you can debug an
application, you must build a debug configuration for the project.

Release (Retail) configuration The release configuration does not include the debugging
information, and it uses any optimizations that you have chosen.

Use the Visual Studio* Configuration Manager to select:

¢ Release or Debug configuration for the active solution.
e Release or Debug configuration for any project within the active solution.
e Target platform for each project.

Multiple configurations allow extending the scope of a project while maintaining a consistent source code
base from which to work. The default configuration is the Debug configuration. To add, change, or delete a
configuration, select Build > Configuration Manager from the main menu or use the drop-down box on
the main menu bar. Only one configuration can be active at one time. Configurations can be used for the
whole solution or for specific projects in the solution.

When you build your project, the currently selected configuration is built, as follows:

e If you selected the debug configuration, a directory called Debug contains the output files created by the

build for the debug version of your project.
e If you selected the release configuration, a directory called Release contains the output files created by

the build for the release version of your project.
(You can change the output directory using the General category in Project > Properties.)
A configuration has the following characteristics:

e Configuration type: specifies the type of Fortran application to build.
¢ Build options: specifies the build options, which include the compiler and linker options.

By default, the Debug configuration sets project options to include debug symbol information and turns off
optimizations. Before you can debug an application, you must build a debug configuration for the project.
Although debug and release configurations usually use the same set of source files, the project setting
information usually differs. For example, the default debug configuration supplies full debug information and
no optimizations, whereas the default release configuration supplies minimal debug information and full
optimizations.

To make configuration changes for your project:

1. Choose an active solution in the Solution Explorer.
2. Go to Build > Configuration Manager.
3. Select a configuration.

Platform Types

The platform type sets options required specifically for the selected platform, such as options that the
compiler uses for the source files, the libraries that the linker uses for the platform, defined constants, and so
on.
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New Configurations

In addition to the default Debug and Release configurations, you can also define new configurations within
your project. These configurations may use the existing source files in your project, the existing project
settings, or other characteristics of existing configurations.

See Also
Setting Compiler Options in the Visual Studio* IDE Property Pages
Understanding Errors During the Build Process

Specifying Path, Library, and Include Directories

You can specify directories that the Microsoft Visual Studio* project system should search for certain types of
files.

To set path, library, and include directories for your Intel® Fortran project environment on a particular
machine:

1. Select Tools > Options.

2. In the left pane, select Intel Compilers and Tools > Visual Fortran > Compilers.

3. In the right pane, specify directories where the Microsoft Visual Studio* project system should look for
files:

o Executables: The directories to be searched for executable files. (Works like the PATH environment
variable.)
Libraries: The directories to be searched for libraries. (Works like the LIB environment variable.)
Includes: The directories to be searched for include files. (Works like the INCLUDE environment
variable.) You can use macros like $ (VvSInstallDir) in directory names. For list of supported
macros, see Supported Build Macros.
4. Click OK.

Use the Reset buttons to restore original installation settings for Executables, Libraries, and Includes fields.
Reset restores initial settings for the currently selected compiler.

NOTE If you specify devenv or useenv on the command line to start the IDE, the IDE uses the PATH,
INCLUDE, and LIB environment variables as defined for that command line when performing a build. It
uses these values instead of the values defined in Tools > Options.

For more information on the devenv command, see the devenv description in the Microsoft Visual
Studio* documentation.

For more information on environment variables, see Supported Environment Variables.

See Also
Supported Environment Variables

Supported Build Macros

Setting Compiler Options in the Microsoft Visual Studio*
IDE Property Pages

To set compilation and related options for the current project:

1. Select the project name in the Solution Explorer view.
2. In the Project menu, select Properties.

The Intel® Fortran Compiler lets you specify compiler options for individual source files by selecting the file
name and clicking View > Property Pages.
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NOTE For convenience, context-sensitive pop-up menus containing commonly used menu options are
available by right-clicking on an item (for example, a file name or solution) in the IDE.

Displaying the Options

To display the Fortran Compiler option categories, click the Fortran folder in the left pane to display the
compiler option categories. The following sample screen shows the compiler options in the General category
in the right pane. The selected option within the General category is Suppress Startup Banner, with a
default value of Yes. The corresponding command line compiler option is nologo, as shown in the Help text
at the bottom of the right pane.

NOTE Option values that are different from the compiler defaults are displayed in bold.

Changing Option Settings
To change the setting for a compiler option:

1. Select a category and then click the desired option. Click the button at the right of an option line to
display the available settings or display a dialog box. Available settings may include <inherit from
project defaults>, which resets the option value to the compiler default.

2. Select the desired setting and click OK.

To change the configuration (such as from Debug to Release), do one of the following:

e Select a different configuration in the Configuration: drop-down box in the upper-left of the window.
¢ Click the Configuration Manager button in the upper-right of the window and reset the configuration in
the dialog box that appears.

Fortran Option Categories

The Intel® Fortran Compiler options available from the IDE are grouped in categories. Some options appear in
multiple categories. Available options in each category may vary, depending on the platform you have
selected in the Platform box at the top of the dialog box. Options not listed in one of the categories can be
typed into the Command Line category window.

Command Line Category

The Command Line category contains the Additional Options field where you can type in an option as you
would from the command line. The IDE will process them as part of the Property Pages options for the
particular project. For instance, you can use the Command Line category to type in miscellaneous Intel®
Fortran Compiler options that are not represented in any of the listed categories. The option you specify in
the Command Line category takes precedence and overrides the equivalent setting in another category.

Supported Build Macros

The Intel® Fortran Compiler supports certain build macros for use in the Property Pages dialog boxes
associated with a project. Use these macros where character strings are accepted. The macro names are not
case-sensitive.

The following table lists macros supported by Visual Studio* that are also supported by the Intel® Fortran
Compiler.

Macro Name Format

Configuration name $ (ConfigurationName)
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Macro Name

Format

Platform name
Intermediate directory
Output directory
Input directory

Input path

Input name

Input filename

Input file extension
Inherit properties

Do not inherit properties
Project directory
Project path

Project name

Project filename
Project file extension
Solution directory
Solution path
Solution name
Solution filename
Solution file extension
Target directory
Target path

Target name

Target filename
Target file extension

Visual Studio* installation
directory

Visual C++* installation
directory

.NET Framework directory
.NET Framework version

.NET Framework SDK
Directory

S (PlatformName)
$(IntDir)

$ (OutDir)

$ (InputDir)

$ (InputPath)

$ (InputName)

$ (InputFileName)
S (InputExt)

S (Inherit)

$ (NoInherit)

$ (ProjectDir)

$ (ProjectPath)

$ (ProjectName)

S (ProjectFileName)
$ (ProjectExt)

S (SolutionDir)

$ (SolutionPath)

$ (SolutionName)

S (SolutionFileName)
$ (SolutionExt)

$ (TargetDir)

$ (TargetPath)

$ (TargetName)

S (TargetFileName)
$ (TargetExt)

$(VSInstallDir)

$ (VCInstallDir)

S (FrameworkDir)
S (FrameworkVersion)

$ (FrameworkSDKDir)
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The Intel® Fortran Compiler also supports the following macros (not supported by Visual Studio*).

Macro Name Format

Intel® Fortran IDE installation directory S(IFIDEInstallDir)

For additional information on using build macros, see the Microsoft MSDN* online documentation.

Using Manifests

The Intel® Fortran Compiler supports manifests, a Visual Studio* feature. Manifests describe run-time
dependencies of a built application. A manifest file can be embedded in the assembly, which is the default
behavior, or can be a separate standalone file. You can use the Manifest Tool property pages, which are
accessed through Project > Properties, to change project settings that affect the manifest.

NOTE

In earlier releases, manifest files were embedded in the assembly, and were not able to be accessed or
changed.

Using Intel Libraries with Microsoft Visual Studio*

You can use the compiler with the following Intel Libraries, which may be included as a part of the product:

e Intel® Integrated Performance Primitives (Intel® IPP)
e Intel® oneAPI Threading Building Blocks (oneTBB)
e Intel® oneAPI Math Kernel Library (oneMKL)

Use the property pages to specify Intel Libraries to use with the selected project configuration.

To specify Intel Libraries, select Project > Properties. In Configuration Properties, select Intel
Libraries for oneAPI, then do the following:

1. To use Intel® Integrated Performance Primitives, change the Use Intel® IPP settings as follows:

No: Disable use of Intel® IPP libraries.

Default Linking Method: Use dynamic Intel® IPP libraries.

Static Library: Use static Intel® IPP libraries.

Dynamic Library: Use dynamic Intel® IPP libraries.

2. To use oneTBB in your project, change the Use oneTBB settings as follows:

¢ No: Disable use of oneTBB libraries.
e Use oneTBB: Set to Yes to use oneTBB in the application.
¢ Instrument for use with Analysis Tools: Set to Yes to analyze your release mode application
(not required for debug mode).
3. To use oneMKL in your project, change the Use oneMKL property settings as follows:

No: Disable use of oneMKL libraries.
Parallel: Use parallel oneMKL libraries.
Sequential: Use sequential oneMKL libraries.
Cluster: Use cluster libraries.

For more information, see the Intel® Integrated Performance Primitives, Intel® oneAPI Threading Building
Blocks, and Intel® oneAPI Math Kernel Library documentation.

Product and Performance Information

Performance varies by use, configuration and other factors. Learn more at www.Intel.com/
Performancelndex.
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Product and Performance Information
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Using Guided Auto Parallelism in Microsoft Visual Studio*

The Guided Auto Parallelism (GAP) feature helps you locate portions of your serial code that can be
parallelized. When you enable analysis using GAP, the compiler guides you to places in your code where you
can increase efficiency through automatic parallelization and vectorization.

Running Analysis on a Project
You can start analysis from the Microsoft Visual Studio* IDE in several ways:
e From the Tools menu: Select Intel Compiler > Guided Auto Parallelism > Run Analysis...

Starting analysis in this way results in a one-time run for the current project. The default values are taken
from Tools > Options unless you have chosen to override them in the dialog box.
e From the Diagnostics property page: Use the Guided Auto Parallelism Analysis property.

Specifically, choose Project > Properties > Fortran > Diagnostics and enable analysis using the
Guided Auto Parallelism Analysis property. Enabling analysis in the property page allows you to run an
analysis as part of a normal project Build request in Microsoft Visual Studio*. In this mode, GAP-related
settings in Tools > Options are ignored, in favor of other GAP-related settings available in the property
page.

e From the context menu: Right-click and select Intel Compiler > Guided Auto Parallelism > Run
Analysis....

This is equivalent to using the Guided Auto Parallelism > Run Analysis option on the Tools menu.

To receive advice for auto parallelization, be sure that certain property page settings are correct. Select
Project > Properties > Fortran > Optimization and set Parallelization to Yes to enable auto-
parallelization optimization. You may also need to set the Optimization level at option 02 or higher.

GAP Scenarios

To illustrate how the various GAP settings work together, consider the following scenarios:

Scenario Result
The GAP analysis setting in the Analysis always occurs for the project, whenever a regular project
property pages is set to Enabled. build occurs. Other analysis settings specified in the property pages

are used. Analysis setting in Tools > Options are ignored.

The Gap analysis setting in the Analysis occurs for this one run. The default values for this analysis
property pages is set to Disabled, are taken from Tools > Options and can be overridden in the

and GAP is run from the Tools dialog box. Options specified in the property pages are also used,
menu. but will be overridden by any specified analysis option.

The GAP analysis setting in the No analysis occurs, unless analysis is explicitly run from the Tools
property pages is set to Disabled, menu.

and GAP options are set in Tools >

Options.

Running Analysis on a File or within a File
Right-click on Guided Auto Parallelism context menu item to run analysis on the following:

¢ Single file: Select a file and right-click.
¢ Function (routine):Right-click within the function scope.
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¢ Range of lines: Select one or more lines for analysis and right-click.

See Also
Options: Guided Auto Parallelism dialog box

Guided Auto Parallelism

Using Guided Auto Parallelism

Using Code Coverage in Microsoft Visual Studio*

The code coverage tool provides the ability to determine how much application code is executed when a
specific workload is applied to the application. The tool analyzes static profile information generated by the
compiler, as well as dynamic profile information generated by running an instrumented form of the
application binaries on the workload. The tool can generate a report in HTML-format and export data in both
text- and XML-formatted files. The reports can be further customized to show color-coded, annotated source-
code listings that distinguish between used and unused code.

To start code coverage:

1. Select Tools > Intel Compiler > Code Coverage...
2. Specify settings for the various phases.
3. Click Run.

The Output window shows the results of the coverage and a general summary of information from the code
coverage.

See Also
Code Coverage dialog box

Code Coverage Settings dialog box

Code Coverage Tool

Using Profile Guided Optimization in Microsoft Visual
Studio*

Profile Guided Optimization (PGO) improves application performance by reorganizing code layouts to reduce
instruction-cache problems, shrinking code size, and reducing branch misprediction. PGO provides
information to the compiler about areas of an application that are most frequently executed. By knowing
these areas, the compiler is able to be more selective and specific in optimizing the application.

To start PGO:

1. Choose Tools > Intel Compiler > Profile Guided Optimization...
2. Specify settings for the various phases.
3. Click Run.

The Output windows show the results of the optimization with a link to the composite log.

See Also
Profile Guided Optimization dialog box

Options: Profile Guided Optimization dialog box

Profile Guided Optimization
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Using Source Editor Enhancements in Microsoft Visual
Studio*

A number of Fortran source editor enhancements are available in Microsoft Visual Studio*.

Modules and Procedures Navigation Bar

A two-part navigation bar, located above the source editor pane, lets you navigate to a specific module (left
part) and procedure (right part). To enable the navigation bar, choose Navigation Bar in Tools >
Options > Text Editor > Fortran > General.

Source Editor Pane

Smart indenting: Smart indenting automatically indents block constructs (such as IF and DO) and left
justifies the corresponding end statement. To enable smart indenting, select it in Tools > Options > Text
Editor > Fortran > Tabs.

Code snippet insertion: Code snippet insertion lets you insert a prototype construct (such as DO, WHILE,
or MODULE) from a list. Use the right-click context menu Snippet > Insert Snippet... option to display the
list and insert a snippet.

Delimiter matching: Delimiter (brace) matching lets you jump to a matching statement in a block construct
(IF...THEN...END IF, DO...END DO). Use Ctrl] to jump. To enable delimiter matching, use Automatic
delimiter highlighting in Tools > Options > Text Editor > General.

Call/Callers graph: Call/Caller information can be collected and shown visually in a graph that indicates the
call stacks that lead to a unit of code. To enable Call/Callers graph information, change Collect Call/Callers
graph information to True in Tools > Options > Text Editor > Fortran > Advanced > Browsing/
Navigation.

Fortran Editor Options Page
Use Tools > Options > Text Editor > Fortran > Advanced to view the Fortran Advanced Options page.

Browsing/Navigation Section

Collect Object Browser information: Choose this option to enable the display of procedures in your
project in a hierarchical tree. Once enabled, you can use View > Object Browser to display your
procedures.

NOTE If the procedures in your project do not show when browsing in My Solution, you can right-
click the message (No information. Try browsing a different component set.) and select View
Containers as a possible solution.

Disable Database: Choose this option to disable creation of the code browsing database. This may help
increase performance on slow machines. If you disable the database, all features that rely on code browsing
information will not work.

Enable Find all References: Choose this option to enable display of the location(s) in your code where a
symbol is referenced. When this option is enabled, you can use the right-click context menu Find All
References option to display a list of references to the selected symbol. Double-click a reference to find that
reference.
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Enable Go To Definition: Choose this option to enable quick navigation to an object definition. When this
option is enabled, you can use the right-click context menu Go to Definition option to locate where the
selected object was declared, opening the associated source file if required. (If you have also enabled Scan
system includes, any objects declared in system modules such as IFWINTY cause the associated source for
that module to be opened.)

Scan system includes: Choose this option to scan system include files. This option is used with one or
more of the following options: Collect Object Browser Information, Enable Find All References,
Enable Go To Definition.

Intrinsics Section

Enable Intrinsic Parameter Info: Choose this option to enable the display of intrinsic function and
subroutine parameter information. When this option is enabled, you can type a name of an intrinsic
procedure, followed by an open parenthesis, and information about the procedure and its arguments
appears.

Enable Intrinsic Quick Info: Choose this option to enable the display of additional information when the
cursor is moved over an intrinsic function or subroutine name.

Miscellaneous Section

Enumerate Comment Tasks: Choose this option to enable the display of a list of tasks consisting of source
files containing comments. Comments take the form of the ! character, followed by a token such as TO DO.
Valid tokens are listed in Tools > Options > Environment > Task List. When this option is enabled, you
can select Comments from the task list using View > Other Windows Task List. Double-click a comment
in the list to jump to its location.

Highlight Matching Tokens: Choose this option to allow identifier highlighting and block delimiter
matching. When enabled, this option highlights all references to the identifier under the cursor.

Outlining Section

Enable Outlining: Choose this option to allow the collapsing of whole program units. When this option is
enabled, you can click the minus (-) or plus (+) symbols for PROGRAM, SUBROUTINE, FUNCTION, MODULE,
and BLOCK DATA statements.

Outline Statement Blocks: Choose this option to allow collapsing of block constructs such as IF and DO.
You must also choose Enable Outlining.

Creating the Executable Program

When you are ready to create an executable image of your application, use the options on the Build menu.
You can:

Compile a file without linking.

Build a project or solution.

Rebuild a project or solution.

Batch build several configurations of a project.

Clean a project or solution (which deletes all files created during the Build).
Select the active solution and configuration.

Edit the project configuration.

When you have completed your project definition, you can build the executable program.

When you select Build <projectname> from the Build menu (or Build toolbar), the integrated
development environment (IDE) automatically updates dependencies, compiles and links all files in your
project. When you build a project, the IDE processes only the files in the project that have changed since the
last build and those files dependent on the changed files. The following example illustrates this.

NOTE To define the build order of projects, right-click on the solution and choose Properties >
Project Dependencies.
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Example: Assume you have multiple projects (A, B, and C) in a solution with the following defined
dependencies:

e A dependsonB
e B dependsonC

If you build A, the build process verifies that B is up-to-date. During verification of B, C is also verified that it
is likewise up-to-date. When either, or both, are determined to be out of date, the appropriate build
operations will occur to update them. When C and B produce .1ib or .d11 output, the output of C is linked
into B and the output of B is linked into A.

The Rebuild <project name> option forces a new compilation of all source files listed for the project.

You either can choose to build a single project, the current project, or multiple project configurations (using
the Batch Build... option) in one operation. You can also choose to build the entire solution.

You can execute your program from the IDE using Debug > Start Without Debugging (Ctrl and F5) or
Debug > Start (F5). You can also execute your program from the command line prompt.

Compiling Files in a Project

You can select and compile individual files in any project in your solution. To do this, select the file in the
Solution Explorer view. Then, do one of the following:

e Select Compile from the Build menu (or Build toolbar).
e Right-click to display the pop-up menu and select Compile.

You can also use Compile from the Build menu (or Build toolbar) options when the source window is active
and has input focus.

Encountering Errors during Compilation

When the compiler encounters an error in a file, compilation stops and the error is reported. You can change
this default behavior and allow compilation to continue despite an error in the current file. When you do this,
an error in the current file will cause the compiler to begin compiling the next file.

To enable Continue on errors behavior:

1. In Tools > Options > Intel Compilers and Libraries > Visual Fortran, select the General
category.
2. Check Continue on errors and click OK.

To set the maximum number of errors to encounter before compilation stops, choose Configuration
Properties > Fortran > Diagnostics > Error Limit.

Converting and Copying Projects

This section provides information about converting and copying projects.

Converting Projects

In general, you can open projects created by older versions of Intel® Visual Fortran and use them directly. If
the projects were created in older versions of Microsoft Visual Studio*, the solution file is converted first and
then any non-Fortran projects it contains. Projects created in newer versions of Intel® Visual Fortran might
not be usable in older versions.

Projects created in Compag* Visual Fortran 6.0 or later can usually be converted to Intel® Visual Fortran as
follows:

1. Open the Microsoft Visual Studio 6 workspace file (.dsw) in @ newer version of Microsoft Visual Studio.
The project is converted to the new format.

2. Right click on the solution and select Extract Compaqg Visual Fortran Project Items. This option
is available only if your installation of Microsoft Visual Studio includes Microsoft Visual C++ (MSVC).
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Some general conversion principles apply:

e Itis good practice to make a backup copy of the project before starting conversions.

e Intel® Fortran projects are created and built in a particular version of Microsoft Visual Studio. If you open
the project in a later version, you will be prompted to convert the solution. Once converted, a solution
cannot be used in its previous environment.

e Compaq Visual Fortran 6.x projects can be converted to Intel® Fortran projects in Microsoft Visual Studio
2017, 2019, or 2022 environments. Fortran-only projects are simpler to convert.

NOTE Support for Microsoft Visual Studio 2017 is deprecated as of the Intel® oneAPI 2022.1 release,
and will be removed in a future release.

e Project conversion support is provided for Compaq Visual Fortran Version 6.x only. Compaq Visual Fortran
projects created with earlier versions may not convert correctly.

e Fortran source files, resource files, and MIDL files lose any custom build step information when converted
from Compagq Visual Fortran to Intel® Fortran. For other file types, custom build steps are propagated
during the project's conversion.

e Conversion of Fortran and C/C++ mixed language projects results in the creation of two separate projects
(a Fortran project and a C/C++ project) in a single solution.

e Intel® Fortran projects that are created with a point release (for instance, 2022.x) are typically backward
compatible to the first release of that number (in this case, 2022.0). Projects are not backward-
compatible between major release numbers.

See Also
Copying Projects

Copying Projects
You need to follow certain procedures to move a project's location if you copy a project to:

e Another disk or directory location on the same system.
¢ Another system where the Intel® Fortran Compiler is installed.

If you upgrade your operating system version on your current system, you should delete the *.suo and
* NCB files in each main project directory before you open solutions with the new operating system.

It is good practice to clean a solution before moving and copying project files. To do this, select Clean in the
Build menu.

Copy an Existing Intel® Fortran Project to Another Disk or System

1. Copy all project files to the new location. You do not need to copy the subdirectories created for each
configuration. Keep the directory hierarchy intact by copying the entire project tree to the new
computer. For example, if a project resides in the folder \MyProjects\Projapp on one computer, you
can copy the contents of that directory, and all subdirectories, to the \MyProjects\Projapp directory
on another computer.

2. Delete the following files from the main directory at the new location. These files are disk- and
computer-specific and should not be retained:

e *_sUO files
e * NCB files (if present)

3. If you copied the subdirectories associated with each configuration (for example, Debug and Release),
delete the contents of subdirectories at the new location. The files contained in these subdirectories are
disk- and computer-specific files and should not be retained. For example, Intel® Fortran module (.MOD)
files contained in these subdirectories should be recreated by the compiler, especially if a newer version
of Intel® Fortran has been installed.
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NOTE The internal structure of module files can change between Intel® Fortran releases.

If you copied the project files to the same system or a system running the same platform and major
Intel® Fortran version, do the following steps to remove most or all of the files in the configuration
subdirectory:

Mpen the appropriate solution. In the File menu, either select Open Solution or select Recent
Solutions. If you use Open Solution, select the appropriate . SLN file.

Relect Set Active Configuration in the Build menu and select a configuration.

Select Clean in the Build menu.

RAepeat the previous two steps for other configurations whose subdirectories have been copied.

4. If possible, after copying a project, verify that you can open the project at its new location using the
same Fortran version that it was created in. This ensures that the project has been moved successfully
and minimizes the chance of conversion problems. If you open the project with a later version of
Fortran, the project will be converted and you will not be able to convert the project back. For this
reason, making an archive copy of the project files before you start is recommended.

5. View the existing configurations. To view the existing configurations associated with the project, open
the solution and view available configurations using the drop-down box at the top of the screen.

6. Check and reset project options.

Because not all settings are transportable across different disks and systems, you should verify your
project settings on the new platform. To verify your project settings:

a. From the Project menu, choose Properties. The Project Property Pages dialog box appears.
b. Configure settings as desired. Pay special attention to the following items:

¢ General: Review the directories for intermediate and output files. If you moved the project to
a different system, be aware that any absolute directory paths (such as C:\TEMP or \Myproj
\TEMP) will most likely need to be changed. Instead, use relative path directory names
(without a leading back slash), such as Debug
e Custom Build Step: Review for any custom commands that might change between platforms.
¢ Pre-build, Pre-link, and Post-build Steps in Build Events: Review for any custom
commands that may have changed.
7. Check your source code for directory paths referenced in INCLUDE or similar statements. Microsoft
Visual Studio* provides a multi-file search capability called Find in Files, available from the Edit
menu.

About Fortran Project Types

This section provides information about Fortran project types.

Understanding Project Types

When you create a project in Visual Studio*, you must choose a project type. You need to create a project
for each binary executable file to be created. For example, the main Fortran program and a Fortran dynamic-
link library (DLL) would each reside in the same solution as separate projects.

The project type specifies what to generate and determines some of the options that the visual development
environment sets by default for the project. It determines, for instance, the options that the compiler uses to
compile the source files, the static libraries that the linker uses to build the project, and the default locations
for output files.

When you select a project type, an Application wizard (AppWizard) is launched, which guides you through
project set-up. The AppWizard supplies default settings for both the Release and Debug Configurations of
the project. For more information about configurations, see Understanding Solutions Projects and
Configurations and Selecting a Configuration.
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The following table lists the available Intel® Fortran Compiler project types. The first four projects listed are
main project types, requiring main programs. The last two are library projects, without main programs.

Project Type

Key Features

Using Fortran
Console
Application
Projects (.EXE)

Using Fortran
Standard Graphics

Single window main projects without graphics (resembles character-cell
applications). Requires no special programming expertise.

Single window main projects with graphics. The programming complexity is simple
to moderate, depending on the graphics and user interaction used.

Application
Projects (.EXE)

Multiple window main projects with graphics. The programming complexity is simple
to moderate, depending on the graphics and user interaction used.

Using Fortran
QuickWin
Application
Projects (.EXE)

Using Fortran
Windowing
Application
Projects (.EXE)

Multiple window main projects with full graphical interface and access to all
Windows* API routines. Requires advanced programming expertise and knowledge
of the Calling Windows API Routines.

Using Fortran
Static Library
Projects (.LIB)

Library routines to link into .EXE files.

Using Fortran
Dynamic-Link
Library Projects
(.pLL)

Library routines to associate during execution.

Using the Fortran

COM Server (.DLL) Fortran in-process COM server

If you need to use the command line to build your project, you can:

e Use the command line compiler options to specify the project type (see Specifying Project Types with ifort
Command Options).
e Create the application from the command line (see Invoking the Intel® Fortran Compiler).

See Also
Understanding Solutions Projects and Configurations

Selecting a Configuration

Additional Documentation: Creating Fortran Applications that Use Windows* OS Features

Specifying Project Types with ifort Command Options

This section provides the ifort command-line options that correspond to Microsoft Visual Studio* project
types.

Creating Main Project Types

The first four projects described below are main project types, requiring main programs. You can create any
of the following project types with the i fort command:

e To create console application projects, you do not need to specify any options. (If you link separately,
specify the 1ink option /subsystem:console.) A console application is the default project type created.
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e To create standard graphics application projects, specify the 1ibs option with keyword qwins (also sets
certain linker options).

e To create QuickWin application projects, specify the 1ibs option with keyword qwin (also sets certain
linker options).

e To create windowing application projects, specify the winapp option (also sets certain linker options).

Creating Library Project Types

The following project types are library projects, without main programs. You can create them with the ifort
command:

e To create dynamic-link library (DLL) projects, specify the d11 option (which sets the 1ibs option with
keyword d11).
e To create static library projects:

e If your application does not call any QuickWin or standard graphics routines, specify the 1ibs option
with keyword static and c options to create the object files.

e If your application calls QuickWin routines, specify the 1ibs option with keyword qwin and c options
to create the object files.

e If your application calls standard graphics routines, specify the 1ibs option with keyword qwins and
c options to create the object files.

e Use the LIB command to create the library.

See Also

Understanding Project Types

Using Fortran Console Application Projects

Using Fortran Standard Graphics Application Projects
Using Fortran QuickWin Application Projects

Using Fortran Windowing Application Projects

Using Fortran Dynamic-Link Library Projects

Using Fortran Static Library Projects

Using Fortran Console Application Projects

A Fortran Console application (.EXE) is a character-based Intel® Fortran program that does not require
screen graphics output.

Fortran Console projects operate in a single window and let you interact with your program through normal
read and write commands. Console applications are better suited to problems that require pure numerical
processing rather than graphical output or a graphical user interface. This type of application is also more
transportable to other platforms than the other types of application.

Fortran Console applications can be faster than Fortran Standard Graphics or Fortran QuickWin graphics
applications, because of the resources required to display graphical output (see Using the Console).

Any graphics routine that your program calls will produce no output, but will return error codes. A program
will not automatically exit if such an error occurs, so your code should be written to handle this condition.

With a Fortran Console project, you cannot use the QuickWin functions. However, you can use single- or
multi-threaded static libraries, DLLs, and dialog boxes.

As with all Windows* command consoles, you can toggle between console viewing modes by pressing ALT
and ENTER.
To create a console application from the IDE:

1. Select the Console Application project type.
2. Select from two templates: Empty project or Main program code, which includes sample code.
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See Also
Using the Console

Using Fortran Standard Graphics Application Projects

A Fortran standard graphics application (.EXE) is an Intel® Fortran QuickWin program with graphics that runs
in a single QuickWin window. A standard graphics (QuickWin single window, sometimes called single
document) application looks similar to an MS-DOS* program when manipulating the graphics hardware
directly, without Windows*.

A Fortran standard graphics application allows graphics output (such as drawing lines and basic shapes) and
other screen functions, such as clearing the screen. Standard Graphics is a subset of QuickWin. You can use
all of the QuickWin graphics functions in these projects. You can use dialog boxes with all other project types.

You can select displayed text either as a bitmap or as text. Windows provides APIs for loading and unloading
bitmap files. Standard graphics applications should be written as multithreaded applications.

Fortran standard graphics (QuickWin single window) applications are normally presented in full-screen mode.
The single window can be either full-screen or have window borders and controls available. You can change
between these two modes by using ALT and ENTER.

If the resolution selected matches the screen size, the application covers the entire screen; otherwise, scroll
bars are present to resize the window. You cannot open additional windows in a standard graphics
application. Standard graphics applications have neither a menu bar at the top of the window, nor a status
bar at the bottom.

Fortran standard graphics applications are appropriate for problems that:

e Require numerical processing and some graphics.
e Do not require a sophisticated user interface.

Create a Standard Graphics Application with the Microsoft Visual Studio* IDE

1. Select the QuickWin Application project type.
2. Select the Standard Graphics Application template.

When you select the Fortran standard graphics project type, the IDE includes the QuickWin library
automatically, which lets you use the graphics functions. When building from the command line, you must
specify the 1ibs option with keyword gwins. You cannot use the runtime functions meant for multiple-
window projects if you are building a standard graphics project. You cannot make a standard graphics
application a DLL.

See Also
Additional Documentation: Creating Fortran Applications that Use Windows* Features

Using Fortran QuickWin Application Projects

Fortran QuickWin graphics applications (.EXE) are multi-threaded and are more versatile than standard
graphics (QuickWin single window ) applications because you can open multiple windows while your project is
executing. This multiple window capability is also referred to as multiple-document interface or MDI. Multiple
windows can be used in a variety of ways. For example, you might want to generate several graphic plots
and be able to switch between them while also having a window for controlling the execution of your
program. These windows can be full screen or reduced in size and can be placed in various parts of the
screen.

QuickWin library routines let you build applications with a simplified version of the Windows* interface using
Intel® Fortran. The QuickWin library provides a rich set of Windows* features, but it does not include the
complete Windows* Applications Programming Interface (API). If you need additional capabilities, you must
set up a Windows* application to call the Windows* API directly rather than using QuickWin to build your
program.
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Applications that use a multiple-document interface (MDI) have a menu bar at the top of the window and a
status bar at the bottom. The QuickWin library provides a default set of menus and menu items that you can
customize with the QuickWin APIs. An application that uses MDI creates many "child" windows within an
outer application window. The user area in an MDI application is a child window that appears in the space
between the menu bar and status bar of the application window. Your application can have more than one
child window open at a time.

Fortran QuickWin applications can use the TFL.OGM module to access functions to control dialog boxes. These
functions allow you to display, initialize, and communicate with special dialog boxes in your application. They
are a subset of Windows* API functions, which Windows* applications can call directly.

To create a QuickWin application in Visual Studio*:

1. Select the QuickWin Application project type.
2. Select the QuickWin Application template in the right pane.

When you select the Fortran QuickWin project type, the IDE includes the QuickWin library automatically,
which lets you use the graphics functions.

When building from the command line, you must specify the 1ibs compiler option with keyword qwin to
indicate a QuickWin application.

A QuickWin application covers the entire screen if the resolution selected matches the screen size; otherwise,
the window will contain scroll bars.

You cannot make a Fortran QuickWin application a DLL.

See Also
Additional Documentation: Creating Fortran Applications that Use Windows* Features

Using Fortran Windowing Application Projects

Fortran Windowing applications (.EXE) are main programs that you create when you choose the Fortran
Windowing Application project type. This type of project lets you call the Windows* APIs directly from Intel®
Fortran. This provides full access to the Windows* APIs, giving you a larger (and different) set of functions to
work with than QuickWin.

Although you can call some of the Windows* APIs from the other project types, Fortran Windowing
applications allow you to use the full set of API routines and use certain system features not available for the
other project types.

The IFWIN module contains interfaces to the most common Windows APIs. If you include the USE IFWIN
statement in your program, the most common Windows* API Routines are available to you. The IFWIN
module gives you access to a full range of routines including window management, graphic device interface,
system services, multimedia, and remote procedure calls.

Window management routines give your application the means to create and manage a user interface. You
can create windows to display output or prompt for input. Graphics Device Interface (GDI) functions provide
ways for you to generate graphical output for displays, printers, and other devices. Windows* system
functions allow you to manage and monitor resources such as memory, access to files, directories, and I/0O
devices. System service functions provide features that your application can use to handle special conditions
such as errors, event logging, and exception handling.

Using multimedia functions, your application can create documents and presentations that incorporate music,
sound effects, and video clips as well as text and graphics. Multimedia functions provide services for audio,
video, file I/O, media control, joystick, and timers.

Remote Procedure Calls (RPC) gives you the means to carry out distributed computing, letting applications
tap the resources of computers on a network. A distributed application runs as a process in one address
space and makes procedure calls that execute in an address space on another computer. You can create
distributed applications using RPC, each consisting of a client that presents information to the user and a
server that stores, retrieves, and manipulates data as well as handling computing tasks. Shared databases
and remote file servers are examples of distributed applications.

See Also
Calling Windows* API Routines
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Additional Documentation: Creating Fortran Applications that Use Windows* OS Features

Using Fortran Static Library Projects

Fortran static libraries (.LIB) are blocks of code compiled and kept separate from the main part of your
program. The Fortran static library is one of the Fortran project types.

To create a static library from the integrated development environment (IDE), select the Static Library
project type. To create a static library from the command line, use the ¢ option to suppress linking and use
the LIB command.

NOTE

When compiling a static library from the command line, include the ¢ option to suppress linking.
Without this option, the compiler generates an error because the library does not contain a main
program.

When you create a static library, you are asked to specify whether you want to prevent the insertion of link
directives for default libraries. By default, this checkbox is selected, which means insertion of link directives
is prevented. Select this option if you plan to use this static library with other Fortran projects. The option
prevents the static library from specifying a version of the Fortran run-time library. When the static library is
linked with another Fortran project, the Fortran run-time library choice in the other Fortran project is used for
the static library as well.

You may decide against selecting this option if you plan to use this static library with C/C++ projects. If you
do select it, you need to explicitly name the Fortran run-time library to use in the Linker Additional
Dependencies property. You can change your selection after creating the project using the Fortran Disable
Default Library Search Rules property.

A static library is a collection of source and object code defined in the Solution Explorer window. The
source code is compiled when you build the project. The object code is assembled into a .L.IB file without
going through a linking process. The name of the project is used as the name of the library file by default.
Static libraries offer important advantages in organizing large programs and in sharing routines between
several programs. These libraries contain only subprograms, not main programs. A static library file has

a .LIB extension and contains object code.

When you associate a static library with a program, any necessary routines are linked from the library into
your executable program when it is built. Static libraries are usually kept in their own directories. If you use a
static library, only those routines actually needed by the program are incorporated into the executable image
(.EXE). This means that your executable image will be smaller than if you included all the routines in the
library in your executable image. The Linker determines which routines to include.

Because applications built with a static library all contain the same version of the routines in the library, you
can use static libraries to help keep applications current. When you revise the routines in a static library, you
can easily update all the applications that use it by relinking the applications.

If you have a library of substantial size, you should maintain it in a dedicated directory. Projects using the
library access it during linking.

When you link a project that uses the library, selected object code from the library is linked into that project's
executable code to satisfy calls to external procedures. Unnecessary object files are not included.

To debug a static library, you must use a main program that calls the library routines. Both the main program
and the static library should have been compiled using the debug option. After compiling and linking is
completed, open the Debug menu and choose Go to reach breakpoints, or use the step controls on the
Debug toolbar.
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Using Static Libraries

To add static libraries to a main project in the IDE, use the Add Existing Item... option in the Project
menu. You can enter the path and library name with a .LIB extension in the dialog box that appears. If you
are using a makefile, you must add the library by editing the makefile for the main project. If you are
building your project from the command line, add the library name with a .1.IB extension and include the
path specification if necessary.

Using Fortran Dynamic-Link Library Projects

A dynamic-link library (.DLL) is a source-code library that is compiled and linked to a unit independently of
the applications that use it. A DLL shares its code and data address space with a calling application. A DLL
contains only subprograms, not main programs.

A DLL offers the organizational advantages of a static library, but with the advantage of a smaller executable
file at the expense of a slightly more complex interface. Object code from a DLL is not included in your
program's executable file, but is associated as needed in a dynamic manner while the program is executing.
More than one program can access a DLL at a time.

When routines in a DLL are called, the routines are loaded into memory at run-time, as they are needed. This
is most useful when several applications use a common group of routines. By storing these common routines
in a DLL, you reduce the size of each application that calls the DLL. In addition, you can update the routines
in the DLL without having to rebuild any of the applications that call the DLL.

With Intel® Fortran, you can use DLLs in two ways:

1. You can build a DLL with your own routines. In Visual Studio*, select Dynamic-link Library as your
project type. From the command line, use the DLL option with the ifort command.

2. You can build applications with the run-time library stored in a separate DLL instead of in the main
application file. In the integrated development environment, open a solution and do the following:

e From the Project menu, select Properties to display the project properties dialog box.
e Click the Fortran folder.

e Select the Libraries category.

¢ In the Runtime Library option, select an option ending with "DLL."

From the command line, use the 1ibs compiler option with keyword d11 to build applications with the
run-time library stored in a separate DLL.

See Also
Additional Documentation: Creating Fortran Applications that Use Windows* OS Features

Using the Console
On Windows* OS, a console window allows input and output of characters (not graphics).

For example, data written (explicitly or implicitly) by Fortran WRITE (or other) statements to Fortran logical
unit 6 display characters on a console window. Similarly, data read by Fortran READ (or other) statements to
unit 5 accept keyboard character input.

The console consists of two components:

e The actual console window that shows the characters on the screen.
e The console buffer that contains the characters to be displayed.

If the console screen buffer is larger than the console window, scroll bars are automatically provided. The
size of the console screen buffer must be larger (or equal to) the size of the console window. If the buffer is
smaller than the size of the console window, an error occurs. For applications that need to display more than
a few hundred lines of text, the ability to scroll quickly through the text is important.

Fortran Console applications automatically provide a console. Fortran QuickWin (and Fortran Standard
Graphics) applications do not provide a console, but display output and accept input from Fortran statements
by using the program window.

The following Fortran Project Types provide an application console window:
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Project Type Description of Console Provided

Fortran Provides a console window intended to be used for character-cell applications that use
Console text only.

When running a Fortran Console application from the command prompt, the existing
console environment is used. When you run the application from Windows* or Developer
Studio* (by selecting Start Without Debugging in the Debug menu), a new console
environment is created.

Basic console use is described in Code Samples of Console Use.

Fortran Does not provide a console, but output to unit 6 and input to unit 5 are directed to the
QuickWin or application program window, which can handle both text and graphics. Because the
Fortran program window must handle both text and graphics, it is not as efficient as the console
Standard for just text-only use. A Fortran QuickWin or Fortran Standard Graphics program window
Graphics (or child window) provides a console-like window.

See Console Use for Fortran QuickWin and Fortran Standard Graphics Applications.

Fortran Does not provide a console window, but the user can create a console by using Windows*

Windows API routines. See Console Use for Fortran Windows* Applications and Fortran DLL
Applications.

Fortran DLL Does not provide a console window, but the user can create a console by using Win32
routines. See Console Use for Fortran Windows* Applications and Fortran DLL
Applications.

Fortran Static Depends upon the project type of the main application that references the object code in
Library the library (see above project types).

In addition to the Windows* API routines mentioned below, there are other routines related to console use
described in the Microsoft Platform SDK* documentation.

Console Use for Fortran QuickWin and Fortran Standard Graphics Applications

For a Fortran QuickWin or Fortran Standard Graphics application, because the default program window
handles both graphics and text, the use of a QuickWin window may not be very efficient:

e QuickWin windows use lots of memory and therefore have size limitations.
e They can be slow to scroll.

Although you can access the console window using WRITE and READ (or other) statements, applications that
require display of substantial lines of text, consider creating a DLL that creates a separate console window for
efficiency. The DLL application needs to call Windows* API routines to allocate the console, display text,
accept keyed input, and free the console resources.

Basic use of a console is described in Code Samples of Console Use.

Console Use for Fortran Windows Applications and Fortran DLL Applications

With a Fortran Windows* or Fortran DLL application, attempting to write to the console using WRITE and
READ (or other) statements before a console is created results in a run-time error (such as error performing
WRITE).

A console created by a Fortran DLL is distinct from any application console window associated with the main
application. A Fortran DLL application has neither a console nor an application window created for it, so it
must create (allocate) its own console using Windows* API routines. When used with a Fortran QuickWin or
Fortran Standard Graphics application main program, the Fortran DLL can provide its main application with a
very efficient console window for text-only use.
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Like a Fortran DLL application, a Fortran Windows application has neither a console nor an application
window created for it, so it must create its own console using Windows* API routines. After allocating a
console in a Fortran DLL, the handle identifier returned by the GetStdHandle Windows* API routine refers
to the actual console the DLL creates.

When the Fortran Windows application does create a console window, it is very efficient for text-only use.
The handle identifier returned by the GetStdHandle Calling Windows* API Routines refers to the actual
console the Fortran Windows application creates.

For information about creating a console, see Allocating and Deallocating a Console below.

Code Samples for Console Use
The following sections shows sample code for using a console:

e Allocating and Deallocating a Console for Fortran Windows* and DLL Applications.
e Extending Size of the Console Window and Console Buffer for console use in any project type.
e Writing and Reading Characters at a Cursor Position for console use in any project type.

Allocating and Deallocating a Console

To create a console, you use the AllocConsole routine. When you are done with the console, free its
resources with a FreeConsole routine. For example, the following code allocates the console, enlarges the
buffer size, writes to the screen, waits for any key to be pressed, and deallocates the console:

! The following USE statement provides Fortran interfaces to Windows routines
USE IFWIN

! Begin data declarations
integer lines, length
logical status
integer fhandle
Type (T_COORD) wpos

! Set buffer size variables
length = 80

lines = 90
! Begin executable code
! Allocate a console

status = AllocConsole() ! get a console window of the currently set size
handle = GetStdHandle (STD OUTPUT HANDLE)

wpos.x = length ! must be >= currently set console window line length
wpos.y = lines ! must be >= currently set console window number of lines

! Set a console buffer bigger than the console window. This provides

! scroll bars on the console window to scroll through the console buffer
status = SetConsoleScreenBufferSize (fhandle, wpos)

! Write to the screen as needed. Add a READ to pause before deallocation

write (*,*) "This is the console output! It might display instructions or data "
write (*,*) " "

write (*,*) "Press any key when done viewing "

read (*,*)

! Deallocate the console to free its resources.

status = FreeConsole ()

Calling Windows* API routines is described in Calling Windows* API Routines.

If you are using a DLL, your DLL code will need to create subprograms and export their symbols to the main
program.

Basic use of a console is described in Extending Size of the Console Window and Console Buffer and Writing
and Reading Characters at a Cursor Position.

92



Compiler Setup

Extending the Size of the Console Window and Console Buffer

When you execute a Fortran Console application, the console is already allocated. You can specify the size of
the console window, size of the console buffer, and the location of the cursor. If needed, you can extend the
size of the console buffer and console window by using the following Windows* API routines:

1. You first need to obtain the handle of the console window using the GetStdHandle routine. For
example:

! USE statements to include routine interfaces
use ifqwin
use ifport
use ifcore
use ifwin
! Data declarations
integer fhandle
logical lstat
! Executable code
fhandle = GetSthandle(STD_OUTPUT_HANDLE)
|
2. If needed, you can obtain the size of the:

e Console window by using the GetConsoleWindowInfo routine.
e Console buffer by using the GetConsoleScreenBufferInfo routine.

For example:

! USE statements to include routine interfaces
use ifqwin

use ifport

use ifcore

use ifwin

! Data declarations

integer fhandle

logical lstat

Type (T_CONSOLE_SCREEN BUFFER INFO) conbuf
type (T _COORD) dwSize

type (T _SMALL RECT) sriWindow

fhandle = GetStdHandle (STD_OUTPUT HANDLE)

! Executable code to get console buffer size

lstat = GetConsoleScreenBufferInfo(fhandle, conbuf)
write (*,*) " "

write (*,*) "Window coordinates= ", conbuf.srWindow
write (*,*) "Buffer size= ", conbuf.dwSize

|
3. To set the size of the console window and buffer, use the SetConsoleWindowInfo and
SetConsoleScreenBufferSize routines with the fhandle value returned previously:

! USE statements to include routine interfaces
use ifqwin

use ifport

use ifcore

use ifwin

! Data declarations

integer nlines, ncols

logical lstat

Type (T_COORD) wpos

Type (T_SMALL RECT) sr

Type (T_CONSOLE_SCREEN BUFFER INFO) cinfo

! Executable code to set console window size
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sr.top = 0

sr.left = 0

sr.bottom = 40 ! <= console buffer height
=1

sr.right = 60 ! <=

console buffer width -1

lstat = SetConsoleWindowInfo (fhandle, .TRUE., sr)
! Executable code to set console buffer size
nlines = 100

ncols = 80
wpos.x = ncols ! columns >= console window width
wpos.y = nlines ! lines >= console window height

lstat = SetConsoleScreenBufferSize (fhandle, wpos)
|

Writing and Reading Characters at a Cursor Position

You can position the cursor as needed using the SetConsoleCursorPosition routine before you write
characters to the screen:

! Use previous data declarations
! Position and write two lines
wpos.x = 5 ! 6 characters from left
wpos.y = 5 ! 6 lines down
lstat = SetConsoleCursorPosition (fhandle, wpos)
write(*,*) 'Six across Six down'

|
You read from the screen at an appropriate place, but usually you should set the cursor relative to the
starting screen location:

! Use previous and the following data declaration
CHARACTER (Len=50) charin
! Go back to beginning position of screen
wpos.x = 0 ! 0 characters from left
wpos.y = 0 ! 0 lines down
lstat = SetConsoleCursorPosition (fhandle, wpos)
! Position character input at start of line 11
wpos.x = 0 ! first character from left
wpos.y = 10 ! 11 lines down
lstat = SetConsoleCursorPosition(fhandle, wpos)
read (*,*) charin
|
For console I/0O, you can use Windows* OS routines WriteConsoleLine and ReadConsoleLine instead of
Fortran WRITE and READ statements.

See Also

Understanding Project Types

Calling Windows* API Routines

Using the Console

Code Samples of Console Use

Console Use for Fortran QuickWin and Fortran Standard Graphics Applications
Console Use for Fortran Windows* Applications and Fortran DLL Applications
Allocating and Deallocating a Console

Extending Size of the Console Window and Console Buffer

Writing and Reading Characters at a Cursor Position
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Creating Fortran Applications that Use Windows* Features

A separate document is available that details the process of creating features: Using Intel® Visual Fortran to
Create and Build Windows*-Based Applications.

The document covers:

e Creating Fortran Windowing Applications: Windows-based applications use the familiar Windows
interface, complete with tool bars, pull-down menus, dialog boxes, and other features. You can include
data entry and mouse control in your application and allow for interaction with programs written in other
languages or commercial programs such as Microsoft Excel*.

e Creating and Using Fortran DLLs: A dynamic-link library (DLL) contains one or more subprogram
procedures (functions or subroutines) that are compiled, linked, and stored separately from the
applications using them. Because the functions or subroutines are separate from the applications using
them, they can be shared or replaced easily.

¢ Using QuickWin: The Intel® Fortran QuickWin runtime library helps you turn graphics programs into
simple Windows applications. Though the full capability of Windows is not available through QuickWin,
QuickWin is simpler to learn and to use. QuickWin applications support pixel-based graphics, real-
coordinate graphics, text windows, character fonts, user-defined menus, mouse events, and editing
(select/copy/paste) of text, graphics, or both.

¢ Using Dialog Boxes for Application Controls: Dialog boxes are a user-friendly way to solicit
application control. As your application executes, you can make a dialog box appear on the screen. You
can click a dialog box control to enter data or choose what happens next. Using the dialog routines
provided with Intel® Fortran, you can add dialog boxes to your application. These routines define dialog
boxes and their controls (scroll bars, buttons, and so on), and call your subroutines to respond to user
selections.

See Also
Intel® Software Documentation Library

Optimization Reports: Enabling in Microsoft Visual Studio*

Optimization reports can help you address vectorization and optimization issues.

When you build a solution or project, the compiler generates optimization diagnostics. You can view the
optimization reports in the following windows:

e The Compiler Optimization Report window, either grouped by loops or in a flat format.
e The Compiler Inline Report window.
e The optimization annotations, which are integrated within the source editor.

To enable viewing for the optimization reports:

1. In your project's property pages, select Configuration Properties > Fortran > Diagnostics.
2. Set a non-default value for any of the following options:

e Optimization Diagnostics Level
e Optimization Diagnostics Phase
e Optimization Diagnostics Routine
3. The Interprocedural Optimization (IPO) is turned off by default. To view the IPO diagnostics, set the
property Fortran > Optimization > Interprocedural Optimization to Single-file or Multi-file.
4, Build your project to generate an optimization report.

When the compiler generates optimization diagnostics, the Compiler Optimization Report and the
Compiler Inline Report windows open. The optimization report annotations appear in the source editor.

NOTE You can specify how you want the optimization reporting to appear with the Optimization
Reports dialog box. Access this dialog box by selecting Tools > Options > Intel Compilers and
Libraries > Optimization Reports.
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See Also
Options: Optimization Reports dialog box

Optimization Reports: Viewing

When the compiler generates optimization diagnostics, the Compiler Optimization Report and the
Compiler Inline Report windows open, and optimization report annotations appear in the editor.

Compiler Optimization Report window

The Compiler Optimization Report window displays diagnostics for the following phases of the
optimization report:

e PGO

e LOOP

e PAR

e VEC

e Offload (Linux* only)
e OpenMP

e CG

Information appears in this window grouped by loops, or in a flat format. To switch the presentation format,
click the gear button on the toolbar of the window, and uncheck Group by loops.

In addition to sorting information by clicking column headers and resizing columns, you can use the windows
described in the following table:

Do This To Do This

Double-click a diagnostic. Jump to the corresponding position in the editor.

Click a link in the Inlined into column. Jump to the call site of the function where the loop
is inlined.

Expand or collapse a diagnostic in Group by loops View detailed information for the diagnostic.
view.

Click on a column header. Sort the information according to that column.

Click the filter button. Select a scope by which to filter the diagnostics
that appear in the window.

The title bar of the Compiler Optimization
Report window shows the applied filter. Labels on
optimization phase filter buttons show how many
diagnostics of each phase are in the current scope.

Click a Compiler Optimization Report window Turn filtering diagnostics on or off for an
toolbar button corresponding to an optimization optimization phase.

report phase. Labels on optimization phase filter buttons show

the total number of diagnostics for each phase.

By default all phases turned on.

Enter text in the search box in the Compiler Filter diagnostics using the text pattern.

Optimization Report window toolbar. Diagnostics are filtered when you stop typing.

Pressing Enter saves this pattern in the search
history.
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Do This

To Do This

To disable filtering, clear the search box.

To use a pattern from the search history, click on
the down arrow next to the search box.

Compiler Inline Report window

The Compiler Inline Report window displays diagnostics for the IPO phase of the optimization report.

Information appears in this window in a tree. Each entry in the tree has corresponding information in the
right-hand pane under the Properties tab and the Inlining options tab.

You can use the window as described in the following table:

Do This

To Do This

Double-click a diagnostic in the tree, or click on the
source position link under the Properties tab.

Click Just My Code.

Right-click on a function body in the editor and
select Intel Compiler > Show Inline report for
function name.

Right-click on a function body in the editor and
select Intel Compiler > Show where function
name in inlined.

Enter text in the search box in the Compiler Inline
Report window toolbar.

Jump to the corresponding position in the editor.

Only display functions from your code, filter all
records from files that don't belong to the current
solution file tree.

View detailed information for the specified function.

Show where the specified function is inlined.

Filter diagnostics using the text pattern.

Diagnostics are filtered when you stop typing.
Pressing Enter saves this pattern in the search
history.

To disable filtering, clear the search box.

To use a pattern from the search history, click on
the down arrow next to the search box.

Viewing Optimization Notes in the Editor

Viewing optimization notes in the editor provides context for the diagnostics that the compiler generates.

1. In Caller Site
2. In Callee Site
3. In Caller and Callee Site

You can use optimization notes as described in the following table:

Do This

To Do This

Right-click an optimization note

e Expand or collapse the current optimization
note, or all of them.
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Do This To Do This

¢ Open the Optimization Reports dialog box to
adjust settings for optimization report viewing.
You can view optimization notes in one of the
following locations:

o Caller Site
o Callee Site
o Caller Site and Callee Site

Double-click an optimization note heading. Expand or collapse the current optimization note.
Double-click a diagnostic detail. Jump to the corresponding position in the editor.
Click a hyperlink in the optimization note. Show where the specified function is inlined.

Click the help (?) icon. Get detailed help for the selected diagnostic. The

default browser opens and, if you are connected to
the internet, displays the help topic for this

diagnostic.
Hover the mouse over a collapsed optimization View a detailed tooltip about that optimization note.
note.
See Also

Optimization Reports: Enabling in Visual Studio*
gopt-report-phase, Qopt-report-phase

Dialog Box Help

This section provides information about access to dialog boxes and information about compilers, libraries,
and converter dialog boxes.

Options: General dialog box

To access the General page, click Tools > Options and then select Intel Compilers and Libraries >
Visual Fortran > General. Use this page to specify Fortran File Extensions and Build Options.

Build Options

Continue on Errors: Check this box to allow compilation to continue regardless of an error in the current
file. The compiler will begin compiling the next file. (To set the maximum number of errors to encounter
before compilation stops, choose Configuration Properties > Fortran > Diagnostics > Error Limit).

Generate Build Logs: Check this box to generate build logs.

Show Environment in Log: Check this box to show environment variable settings in the log file.

Fortran File Extensions

You can specify additional Fortran free format and fixed format file extensions to be recognized as valid file
extensions within the IDE. The IDE treats these additional extensions as compilable Fortran source files. You
can also remove or modify existing extensions that appear in the list.

When you add a new extension, the IDE checks the registry to determine whether the extension is already
associated with a language, tool, or file format. If there is such an association, a message informs you of this
and you will not be allowed to add the extension.
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Headers: Specify one or more file extensions for header files, each beginning with a period and separated by
semi-colons.

Sources: Specify one or more file extensions for source files, each beginning with a period and separated by
semi-colons.

Click OK to save your changes.

Options: Compilers dialog box
To access the Compilers page:

1. Open Tools > Options.
2. In the left pane, select Intel Compilers and Libraries > IFORT Intel Fortran Classic > Compilers
for i fort or Intel Compilers and Libraries > IFX Intel Fortran > Compilers for ifx.

Compiler Selection for IFORT Intel Fortran Classic
Tabs Win32 and x64: Select Win32 or x64 target platforms.

Selected compiler: Selects the compiler version. The default value is <Latest>.

NOTE The compiler details are shown in the two boxes directly below.

Executables: Specifies the directory location for executable files. You may specify this setting for each
selected compiler.

Includes: Specifies the directory location for included files. You may specify this setting for each selected
compiler.

Libraries: Specifies the directory location for libraries. You may specify this setting for each selected
compiler.

Default options: Sets the default options for a selected compiler You may specify this setting for each
selected compiler.

Reset...: Resets the settings for the compiler.

Compiler Selection for IFX Intel Fortran

Selected compiler: Selects the compiler version. The default value is <Latest>.

NOTE The compiler details are shown in the two boxes directly below.

Executables: Specifies the directory location for executable files. You may specify this setting for each
selected compiler.

Includes: Specifies the directory location for included files. You may specify this setting for each selected
compiler.

Libraries: Specifies the directory location for libraries. You may specify this setting for each selected
compiler.

Default options: Sets the default options for a selected compiler You may specify this setting for each
selected compiler.

Reset...: Resets the settings for the compiler.
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See Also
Selecting the Compiler Version
Specifying Path, Library, and Include Directories

Options: Advanced dialog box

To access the Advanced page, expand the Tools > Options > Text Editor > Fortran nodes and select
Advanced. Here you can specify advanced options for text editing.

Browsing/Navigation section

Collect Object Browser information: Choose this option to enable the display of procedures in your
project in a hierarchical tree. Once enabled, you can use View > Object Browser to display your
procedures.

Disable Database: Choose this option to disable creation of the code browsing database. This may help
increase performance on slow machines. When you disable the database, all features that rely on code
browsing information do not work.

Enable Database Saving/Loading: Choose this option to save collected data to a file on disk so that all
source browsing features are available immediately when you open the project. When this option is disabled,
the code browsing database is generated via background source parsing, so many features that rely on code
browsing information do not work until this process completes. Saving and loading the database requires
some additional time when saving and loading the project.

Enable Find all References: Choose this option to enable display of the location(s) in your code where a
symbol is referenced. When this option is enabled, you can use the right-click context menu Find All
References option to display a list of references to the selected symbol. Double-click on a reference to find
that reference.

Enable Go To Definition: Choose this option to enable quick navigation to an object definition. When this
option is enabled, you can use the right-click context menu Go to Definition option to locate where the
selected object was declared, opening the associated source file if required. (If you have also enabled Scan
system includes, any objects declared in system modules such as IFWINTY cause the associated source for
that module to be opened.)

Scan system includes: Choose this option to scan system include files. This option is used with one or
more of the following options: Collect Object Browser Information, Enable Find All References,
Enable Go To Definition.

Intrinsics section

Enable Intrinsic Parameter Info: Choose this option to enable the display of intrinsic function and
subroutine parameter information. When this option is enabled, you can type a name of an intrinsic
procedure, followed by an open parenthesis, and information about the procedure and its arguments
appears.

Enable Intrinsic Quick Info: Choose this option to enable the display of additional information when the
mouse pointer is moved over an intrinsic function or subroutine name.

Miscellaneous section

Enumerate Comment Tasks: Choose this option to enable the display of a list of tasks consisting of source
files containing comments. Comments take the form of the ! character, followed by a token such as TO DO.
Valid tokens are those listed in Tools > Options > Environment > Task List. When this option is enabled,
you can select Comments from the task list using View > Other Windows Task List. Double-click on a
comment in the list to jump to its location.
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Highlight Matching Tokens: Choose this option to allow identifier highlighting and block delimiter
matching. When enabled, this option highlights all references to the identifier under the cursor.

Outlining Section

Enable Outlining: Choose this option to allow the collapsing of whole program units. When this option is
enabled, you can click the minus (-) or plus (+) symbols for PROGRAM, SUBROUTINE, FUNCTION, MODULE,
and BLOCK DATA statements.

Outline Statement Blocks: Choose this option to allow collapsing of block constructs such as IF and DO.
You must also choose Enable Outlining.

Configure Analysis dialog box

Use the Configure Analysis dialog box to specify settings for Guided Auto Parallelism (GAP) analysis and
run the analysis.

To access this dialog box, click Tools > Intel Compiler > Guided Auto Parallelism > Run Analysis...

Configure Analysis Options
Scope: Specify the desired scope.

Level of Analysis: Specify the desired level of analysis. Choose Simple, Moderate, Maximum, or
Extreme.

Suppress Compiler Warnings: Check this box to suppress compiler warnings. This adds the option W0 to
the compiler command line.

Suppress remark IDs: Specify one or more remark IDs to suppress. Use a comma to separate IDs.
Send remarks to a file: Check this box to send GAP remarks to a specified text file.
Remarks file: Specify the filename where GAP remarks will be sent.

Save these settings as the default (in Tools -> Options for Guided Auto Parallelism): Check this box
to save the specified settings as the default settings.

Show all GAP configuration and informational dialogs: Check this box to display this dialog box next
time.

When you are done specifying settings, click Run Analysis.

See Also
Options: Guided Auto Parallelism dialog box

Options: Guided Auto Parallelism dialog box
Use the Guided Auto Parallelism page to specify settings for Guided Auto Parallelization (GAP) analysis.

To access the Guided Auto Parallelism page click Tools > Options and then select: Intel Compilers and
Libraries > Visual Fortran > Guided Auto Parallelism.

NOTE These settings are used when running analysis using Tools > Intel Compiler > Guided Auto
Parallelism > Run Analysis on project...

Guided Auto Parallelism Options

Level of Analysis:Specify the desired level of analysis. Choose Simple, Moderate, Maximum, or
Extreme.

101



Intel® Fortran Compiler Classic and Intel® Fortran Compiler Developer Guide and Reference

Suppress compiler warnings: Check this box to suppress compiler warnings. Selection adds option W0 to
the compiler command line.

Suppress Remark IDs: Specify one or more remark IDs to suppress. Use a comma to separate IDs.
Send remarks to a file: Check this box to send GAP remarks to a specified text file.
Remarks file: Specify the filename to send GAP remarks to.

Show all GAP configuration and informational dialogs: Check this box to display additional dialog boxes
when you run an analysis.

Reset: Click this button to restore the previously selected settings.

See Also
Using Guided Auto Parallelism in Microsoft Visual Studio*

Guided Auto Parallelism

Using Guided Auto Parallelism

Profile Guided Optimization dialog box
This topic has information on the following dialog boxes:

Profile Guided Optimization (PGO) dialog box
Application Invocations dialog box

Edit Command dialog box

Command dialog box

Profile Guided Optimization dialog box

To access the Profile Guided Optimization dialog box, choose Tools > Intel Compiler > Profile Guided
Optimization.

Use the Profile Guided Optimization dialog box to set the options for profile guided optimization.

Phase 1 - Instrument: This phase produces an instrumented object file for the profile guided optimization.
The command line compiler option for each optimization instrument you choose appears in Compiler
Options.

e Enable Function Ordering in the optimized application: Select this checkbox to enable ordering of
static and extern routines using profile information. This optimization specifies the order in which the
linker should link the functions of your application. This optimization can improve your application
performance by improving code locality and by reducing paging.

 Enable Static Data Layout in the optimized application: Select this checkbox to enable ordering of
static global data items based on profiling information. This optimization specifies the order in which the
linker should link global data of your program. This optimization can improve application performance by
improving the locality of static global data, reduce paging of large data sets, and improve data cache use.

¢ Instrument with guards for threaded application: Select this checkbox to produce an instrumented
object file that includes the collection of PGO data on applications that use a high level of parallelism.

Selecting an option produces a static profile information file (.spi), but also increases the time needed to do
a parallel build.

Deselect the checkbox to skip this phase to save time running profile guided optimization. When you skip this
phase, you use the existing profile information when running profile guided optimization. For example, you
may want to skip this phase when you change the code to fix a bug and the fix doesn't affect the architecture
of the project.
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Phase 2 - Run Instrumented Application(s): This phase runs the instrumented application produced in
the previous phase as well as other applications in the Applications Invocations dialog box. To add a new
application or edit an existing application in the list, click Applications Invocations.

Deselect the checkbox to skip this phase to save time running profile guided optimization. When you skip this
phase, you do not run the applications in the list when running profile guided optimization. For example, you
might want to skip this phase when you change the code to fix a bug and the fix doesn't affect the
architecture of the project.

Phase 3 - Optimize with Profile Data: This phase performs the profile guided optimization.
Deselect the checkbox to skip this phase.

Profile Directory: The directory that contains the profile. Click Edit to edit the profile directory or the
Browse button to browse for the profile directory.

Show this dialog next time: Deselect this checkbox to run profile guided optimization without displaying
this dialog box. The profile guided optimization will use these settings.

Save Settings: Click to save your settings.
Run: Click to start the profile guided optimization.

Cancel: Click to close this dialog box without starting the profile guided optimization.

Application Invocations dialog box

To access the Application Invocations dialog box, click Application Invocations... in the Profile Guided
Optimization dialog box. Use the Profile Guided Optimization dialog box to configure the application
options for your application as well add additional applications when you run profile guided optimization.

The list of applications comes from the debug settings of the Startup Project.

Merge Environment: Select this checkbox to merge the application environment with the environment
defined by the operating system.

To add, edit, or remove an application, click one of the buttons.

Add: Click to add a new application in the Edit Command dialog box.

Duplicate: Click after selecting an application to copy its settings so that you can use a different setting.
Edit: Click after selecting an application to change its settings in the Edit Command dialog box.
Delete: Click to remove the selected application from the list.

OK: Click to save the settings and close this dialog box.

Cancel: Click to discard the settings and close this dialog box.

Edit Command dialog box

To access the Edit Command dialog box, click Add or Edit in the Application Invocations dialog box. Use
the Edit Command dialog box to add a new or edit an existing application in the Application Invocations
dialog box.

Command: Add a new or edit an existing application. Click Edit to open the Command dialog box with a list
of macros. Click Browse to navigate to another directory that contains the application.

Command Arguments: Enter the arguments required by the application.

Working Directory: Enter a new or edit the working directory for the application. Click Edit to open the
Command dialog box with a list of macros. Click Browse to navigate to working directory of the application.

Environment: Enter the environment variable required by this application.
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Merge Environment: Select this checkbox to merge the application environment with the environment
defined by the operating system.

Load from Debugging Settings: Click to load the debug settings for this application.
OK: Click to save the settings and close this dialog box.

Cancel: Click to discard the settings and close this dialog box.

Command dialog box

To access the Command dialog box, click Edit in the Edit Command dialog box. Use the Command dialog
box to specify or change the macro used in the application to run as part of the profile guided optimization.

Select a macro from the list and then click one of the buttons.
Macro: Click to show or close the list of available macros.
Insert: Click to use the selected macro.

OK: Click to save the settings and close this dialog box.

Cancel: Click to discard the settings and close this dialog box.

See Also
Profile-Guided Optimization

Using Profile Guided Optimization in Microsoft Visual Studio*
Options: Profile Guided Optimization

Using Function Order Lists, Function Grouping, Function Ordering, and Data Ordering
Optimizations

Options: Profile Guided Optimization (PGO) dialog box

Use the Profile Guided Optimization page to specify settings for PGO. To access the Profile Guided
Optimization page, click Tools > Options and then select Intel Compilers and Libraries > Profile
Guided Optimization.

Profile Guided Optimization (PGO) Options

Show PGO Dialog: Specify whether to display the Profile Guided Optimization dialog box when you begin
PGO.

See Also
Using Profile Guided Optimization in Microsoft* Visual Studio*

Profile Guided Optimization dialog box

Profile-Guided Optimizations

Configure Analysis dialog box

Use the Configure Analysis dialog box to specify settings for Guided Auto Parallelism (GAP) analysis and
run the analysis.

To access this dialog box, click Tools > Intel Compiler > Guided Auto Parallelism > Run Analysis...
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Configure Analysis Options
Scope: Specify the desired scope.

Level of Analysis: Specify the desired level of analysis. Choose Simple, Moderate, Maximum, or
Extreme.

Suppress Compiler Warnings: Check this box to suppress compiler warnings. This adds the option W0 to
the compiler command line.

Suppress remark IDs: Specify one or more remark IDs to suppress. Use a comma to separate IDs.
Send remarks to a file: Check this box to send GAP remarks to a specified text file.
Remarks file: Specify the filename where GAP remarks will be sent.

Save these settings as the default (in Tools -> Options for Guided Auto Parallelism): Check this box
to save the specified settings as the default settings.

Show all GAP configuration and informational dialogs: Check this box to display this dialog box next
time.

When you are done specifying settings, click Run Analysis.

See Also
Options: Guided Auto Parallelism dialog box

Code Coverage dialog box

To access the Code Coverage dialog box, select Tools > Intel Compiler > Code Coverage....
Use the Code Coverage dialog box to set the code coverage feature.

Phase 1 - Instrument: Select this checkbox to compile your code into an instrumented application.

Select the Instrument with guards for threaded application checkbox to produce an instrumented
object file that includes the collection of PGO data on applications that use a high level of parallelism.

The compiler option used is shown in Compiler Options.
Deselect the Phase 1 - Instrument checkbox to skip this phase.

Phase 2 - Run Instrumented Application(s): Select this checkbox to run your instrumented application
as well as other applications.

You can specify the options to run with the applications by choosing the Application Invocations... button
to access the Applications Invocations dialog box.

Deselect the Phase 2 - Run Instrumented Application(s) checkbox to skip this phase.

Phase 3 - Generate Report: Select this checkbox to generate a report with the results of running the
instrumented application.

Choose the Settings... button to access the Code Coverage Settings dialog box to configure the settings.
Profile Directory: Where the profile is stored.
Browse: Button to browse for the profile directory.

Show this dialog next time: Choose this button to access the dialog box when you run profile guided
optimization.

Save Settings: Choose this button to save your settings.
Run: Choose this button to start the profile guided optimization.
Cancel: Choose this button to close this dialog box without starting the profile guided optimization.

See Also
Using Code Coverage in Microsoft Visual Studio*
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Code Coverage Settings dialog box
code coverage Tool

Options: Code Coverage dialog box

To access the Code Coverage page, click Tools > Options and then select Intel Compilers and
Libraries > Code Coverage.

Use this page to specify settings for code coverage. These settings are used when you run an analysis.

Code Coverage Options
Use the available options to:

e Select colors to be used to show covered and uncovered code.
e Enable or disable the progress meter.
e Set the email address and name of the web page owner.

General

Show Code Coverage Dialog: Specify whether to display the Code Coverage dialog box when you begin
code coverage.

Profmerge Options
Suppress Startup Banner: Specify whether version information is displayed.

Verbose: Specify whether additional informational and warning messages should be displayed.

See Also
Using Code Coverage in Microsoft Visual Studio*

Code Coverage dialog box

Code Coverage Tool

Code Coverage Settings dialog box

To access the Code Coverage Settings dialog box, choose the Settings button in the Code Coverage
dialog box. Use the Code Coverage Settings dialog box to specify settings for the generated report.

Code Coverage options
Ignore Object Unwind Handlers: Set to True to ignore the object unwind handlers.
Show Execution Counts: Set to True to show the dynamic execution counts in the report.

Treat Partially-covered Code As Fully Covered Code: Set to True to treat partially covered code as fully
covered code.

Profmerge options
Dump Profile Information: Set to True to include profile information in the report.

Exclude Functions: Enter the functions that will be excluded from the profile. The functions must be

separated by a comma (","). A period (".") can be used as a wildcard character in function names.
OK: Click to save your settings and close this dialog box.

Cancel: Click to discard the settings and close this dialog box.
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See Also

Code Coverage dialog box

Using Code Coverage in the Microsoft Visual Studio* IDE
code coverage Tool

Options: Optimization Reports dialog box

To access the Optimization Reports page, click Tools > Options and then select Intel Compilers and
Libraries > Optimization Reports. Use this page to specify how you want optimization reporting to appear.

This page, in conjunction with the Diagnostics property page for your project or solution, defines settings
for optimization report viewing in Visual Studio*.

General

Always Show Compiler Inline Report: Specify if the Compiler Inline Report appears after building or
rebuilding your solution or project when inline diagnostics are present.

Always Show Compiler Optimization Report: Specify if Compiler Optimization Report appears after
building or rebuilding your solution or project when optimization diagnostics are present. This option has
higher priority than Always Show Compiler Inline Report. If both options are set to True, then this
window has focus by default.

Show Optimization Notes in Text Editor Margin: Specify if optimization notes appear in the editor as
source code annotations.

Optimization Notes in Text Editor

Collapse by Default: Specify if optimization notes appear expanded or collapsed by default.

Show Optimization Notes: Specify if source code annotations appear in the editor.

Site: Specify where optimization notes appear in the editor. Select from one of the following options:

e Caller Site
e Callee Site
e Caller Site and Callee Site

See Also
Optimization Reports: Enabling in Visual Studio*
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Part

Compiler Reference

This section contains compiler reference information. For example, it contains information about compiler
options, compiler limits, and libraries.

Compiler Limits

The amount of data storage, the size of arrays, and the total size of executable programs are limited only by
the amount of process virtual address space available, as determined by system parameters.

The table below shows the limits to the size and complexity of a single Intel® Fortran program unit and to
individual statements contained within it:

Language Element Limit

Actual number of arguments per CALL or Limited only by memory constraints
function reference

Arguments in a function reference in a 255
specification expression

Array dimensions 31

(The Fortran 2018 standard supports a maximum array
dimension of 15.)

Array elements per dimension 2**31-1 on systems using IA-32 architecture
2**63-1 on systems using Intel® 64 architecture

Limited by current memory configuration.

Character lengths 2**31-1 on systems using IA-32 architecture

2**63-1 on systems using Intel® 64 architecture
Constants: character and Hollerith 7198

Constants: characters read in list- 2048 characters
directed I/0

Continuation lines No fixed limit; at least 255 lines of 132 or fewer characters.
Longer lines may reduce the number of allowed continuations,
subject to the limit on lexical tokens per statement.

Data and I/0O implied DO nesting 31
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Language Element

Limit

DO, CASE, FORALL, WHERE, and block
IF statement nesting (combined)

DO loop index variable
Format group nesting

Fortran source line length

INCLUDE file nesting

Labels in computed or assigned GOTO
list

Lexical tokens per statement

Named common blocks

Nesting of array constructor implied DOs
Nesting of input/output implied DOs
Nesting of interface blocks

Nesting of DO, IF, or CASE constructs
Nesting of parenthesized formats
Number of arguments to MIN and MAX
Number of digits in a numeric constant
Parentheses nesting in expressions
Structure nesting

Symbolic name length

Width field for a numeric edit descriptor

512

9,223,372,036,854,775,807= 2**63-1
8

fixed form: 72 (or 132 if /extend source is in effect)
characters

free form: 7200 characters
20 levels

Limited only by memory constraints

40000

Limited only by memory constraints
31

31

Limited only by memory constraints
Limited only by memory constraints
Limited only by memory constraints
Limited only by memory constraints
Limited by statement length
Limited only by memory constraints
30

63 characters

2**15-1 on systems using IA-32 architecture
2**31-1 on systems using Intel® 64 architecture

For limits of other edit descriptor fields, see Forms for Data
Edit Descriptors.

For more information on memory limits for large data objects, see:

The AUTOMATIC statement
The /F compiler option

The heap-array compiler option
The product Release Notes

See Also
Forms for Data Edit Descriptors
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Using Visual Studio* IDE Automation
Objects (Windows*)

This topic briefly describes the Automation interfaces provided by Intel® Visual Fortran. Automation interfaces
are programmable objects used to access underlying IDE components and projects to provide experienced
developers with a means of automating common tasks and allow a finer degree of control over the IDE and
the Fortran projects being used within it.

You can use the Visual Studio* Object Browser (View > Object Browser) to view an object and its
associated properties. Open the following in the browser: Browse > Edit Custom Component Set > .NET
> Microsoft.VisualStudio.VFProject.

NOTE

The objects listed here are provided as an advanced feature for developers who are already familiar
with using Automation objects and the Visual Studio* object model.

Object
IVFCollection

VFConfiguration

VFCustomBuildTool

VFDebugSettings

VFFile

VFFileConfiguration

VFFilter

VFFortranCompiler
Tool

VFFortranCompiler
Version

VFLibrarianTool
VFLinkerTool
VFManifestTool

VFMidITool

VFPlatform

VFPreBuildEventTo
ol
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Description
Contains the functionality that can be exercised on a collections object.

Programmatically accesses the properties in the General property page of a
project's Property Pages dialog box. This object also allows access to the tools used
to build this configuration.

Programmatically accesses the properties in the Custom Build Step property page
in a project's Property Pages dialog box.

Contains properties that allow the user to programmatically manipulate the settings
in the Debug property page.

Describes the operations that can take place on a file in the active project.

Contains build information about a file (VFFile object), including such things as what
tool is attached to the file for that configuration.

Exposes the functionality on a folder in Solution Explorer for an Intel® Visual Fortran
project.

Exposes the functionality of the IFORT tool.

Provides access to properties relating to the Intel® Visual Fortran Compiler version.

Exposes the functionality of the LIB tool.
Exposes the functionality of the LINK tool.

Programmatically accesses the properties in the Manifest Tool folder of a project's
Property Pages dialog box.

Programmatically accesses the properties in the MIDL folder of a project's Property
Pages dialog box.

Provides access to properties relating to supported platforms.

Programmatically accesses the properties on the Pre-Build Event property page, in
the Build Events folder in a project's Property Pages dialog box.



Compiler Reference

VFPreLinkEventToo

Programmatically accesses the properties on the PreLink Event property page, in

I the Build Events folder in a project's Property Pages dialog box.

VFPostBuildEventT

Programmatically accesses the properties on the Post-Build Event property page,

ool in the Build Events folder in a project's Property Pages dialog box.

VFProject Exposes the properties on an Intel® Visual Fortran project

VFResourceCompil Programmatically accesses the properties in the Resources folder in a project's
erTool Property Pages dialog box.

The following example, written in Visual Basic*, demonstrates how to use automation objects to modify the
list of available platforms and versions in the Visual Studio* IDE Configuration Manager:

Imports System

Imports EnvDTE

Imports EnvDTES80

Imports System.Diagnostics

Imports Microsoft.VisualStudio.VFProject
Imports System.Collections

Public Module MultiPV

' Create a Console application before executing this module
' Module demonstrates Multi Platform & Multi Version Automation Support

' Variable definition

Dim Prj As Project ' VS project
Dim VFPrj As VFProject ' Intel VF project
Dim o As Object ' Object
Sub run()
' Get the Project
Prj = DTE.Solution.Projects.Item(1l)

' Get Intel VF project
VEPrj = Prj.Object
1
' Get list of Supported platforms
Dim pList As ArraylList = New ArrayList ()
Dim cList As ArrayList = New ArrayList()
Dim i As Integer
plist = getSupportedPlatforms ()
For i = 0 To pList.Count - 1
clist = getCompilers(pList.Item(i))
printCompilers (pList.Item (i), cList)
Next
1
' Add configurations - x64
For i = 0 To pList.Count - 1
If pList.Item(i) <> "Win32" Then
addConfiguration(pList.Item(i))
End If
Next

Dim cfgsList As ArraylList = New ArrayList()

cfgslList = getAllConfigurations/()
1
' Set compiler
For i = 0 To pList.Count - 1
Dim pNm As String

' list of platforms
' lost of compilers

' list of configurations

Dim cvList As ArrayList = New ArrayList()

pNm = pList.Item(i)
cList = getCompilers (pNm)
cvlist = getCompilerVersions (pNm)
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Dim j As Integer
For j = 0 To cvlList.Count - 1

Dim cv As String = cvList.Item(j)

If SetCmplrForPlatform(pNm, cv) Then
setActiveCfg (pNm)
SolutionRebuild ()

Dim sOut As String = GetOutput ()
Dim scv As String = CheckCompiler (sOut)
MsgBox (pNm + " " + cv + " " + scv)
End If
Next
Next
End Sub
' get context from Output window
Function GetOutput () As String
Dim win As Window
Dim w As OutputWindow
Dim wp As OutputWindowPane
Dim td As TextDocument
win = DTE.Windows.Item(Constants.vsWindowKindOutput)
w = win.Object
Dim i As Integer
For i = 1 To w.OutputWindowPanes.Count
wp = w.OutputWindowPanes.Item (i)
If wp.Name = "Build" Then

td = wp.TextDocument

td.Selection.SelectAll ()

Dim ts As TextSelection = td.Selection

GetOutput = ts.Text

Exit Function

End If
Next
End Function
Function CheckCompiler (ByVal log As String) As String
Dim s As String
Dim beg As Integer
Dim end As Integer
beg = log.IndexOf ("Compiling with")
beg = log.IndexOf ("Intel", beg )
end = log.IndexOf("]", beg )
s = log.Substring(beg , end - beg + 1)
CheckCompiler = s
End Function
Function SetCmplrForPlatform(ByVal plNm As String, ByVal vers As String) As Boolean
Dim pl As VFPlatform
Dim cll As IVFCollection
Dim cvs As IVFCollection
Dim cv As VFFortranCompilerVersion
Dim maj As String
Dim min As String
Dim ind As Integer
Try
ind = vers.IndexOf (".")
maj = vers.Substring (0, ind)
min = vers.Substring(ind + 1)
cll = VFPrj.Platforms
pl = cll.Item(plNm)
If pl Is Nothing Then
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Catc

End
End Func

Function getSupportedPlatforms() As ArrayList
list As ArrayList = New ArrayList()

Dim
Dim
Dim
pls
Dim
For

Next
getsS
End Func

Function getCompilers (ByVal plNm As String) As ArrayList
im list As ArraylList = New ArrayList()

Dim
Dim
Dim
Dim
Dim
Dim
pls
pl =
cvs
For

Next
getC
End Func

Function getCompilerVersions (ByVal plNm As String) As ArraylList
list As ArrayList = New ArrayList()

Dim
Dim
Dim
Dim
Dim
pls
pl =
cvs
Dim
For

MsgBox ("Platform " + plNm + " not exist")

Exit Function
End If
cvs = pl.FortranCompilerVersions
Dim j As Integer
For j = 1 To cvs.Count
cv = cvs.Item(J)

If cv.MajorVersion.ToString() maj And cv.MinorVersion.ToString() = min Then
pl.SelectedFortranCompilerVersion cv
SetCmplrForPlatform = True
Exit Function
End If
Next
MsgBox ("Compiler version " + maj + "." + min + " not exist for platform " + plNm)

SetCmplrForPlatform = False
h ex As Exception
SetCmplrForPlatform = False
Try

tion

pl As VFPlatform
pls As IVFCollection
= VFPrj.Platforms

i As Integer

i =1 To pls.Count
pl = pls.Item (i)
list.Add (pl.Name)

upportedPlatforms = list
tion

pl As VFPlatform

pls As IVFCollection

cvs As IVFCollection

cv As VFFortranCompilerVersion
j As Integer

= VFPrj.Platforms
pls.Item(plNm)

= pl.FortranCompilerVersions
j =1 To cvs.Count

cv = cvs.Item(])
list.Add(cv.DisplayName)

ompilers = list
tion

pl As VFPlatform

pls As IVFCollection

cvs As IVFCollection

cv As VFFortranCompilerVersion
= VFPrj.Platforms
pls.Item(plNm)

= pl.FortranCompilerVersions

j As Integer

j = 1 To cvs.Count
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cv = cvs.Item(])
Dim vers As String
vers = cv.MajorVersion.ToString() + "." + cv.MinorVersion.ToString()
list.Add(vers)
Next
getCompilerVersions = list
End Function
Sub printCompilers (ByVal plNm As String, ByVal list As ArrayList)
Dim s As String
s = "Platform " + plNm + Chr(13)
Dim i As Integer
For i = 0 To list.Count - 1
s +=" " 4+ list.Item(i) + Chr(13)
Next
MsgBox (s)
End Sub
Sub addConfiguration (ByVal cfgNm As String)
Dim cM As ConfigurationManager
cM = Prj.ConfigurationManager
cM.AddPlatform(cfgNm, "Win32", True)
End Sub
Function getAllConfigurations() As ArrayList
Dim list As ArrayList = New ArrayList()
Dim cM As ConfigurationManager
Dim i As Integer
Dim ¢ As Configuration
cM = Prj.ConfigurationManager
For 1 = 1 To cM.Count
c = cM.Item(1i)
list.Add(c.ConfigurationName + "|" + c.PlatformName)
Next
getAllConfigurations = list
End Function
Sub setActiveCfg(ByVal pNm As String)
Dim scs As SolutionConfigurations = DTE.Solution.SolutionBuild.SolutionConfigurations
Dim i As Integer
Dim j As Integer
For i = 1 To scs.Count
Dim sc As SolutionConfiguration
Dim sctxs As SolutionContexts
sc = scs.Item (i)
sctxs = sc.SolutionContexts
For j = 1 To sctxs.Count
Dim sctx As SolutionContext = sctxs.Item(j)

If sctx.ConfigurationName = "Debug" And sctx.PlatformName = pNm Then
sc.Activate ()
Exit Sub
End If
Next
Next
End Sub

Sub SolutionRebuild()
DTE.Solution.SolutionBuild.Clean (True)
DTE.Solution.SolutionBuild.Build (True)

End Sub

End Module

114



Compiler Options

Compiler Options

This compiler supports many compiler options you can use in your applications.

The LLVM-based Intel® Fortran Compiler supports many Intel® Fortran Compiler Classic compiler options, but
full implementation is not yet available for ifx.1. Implementation will be improved in future releases.

In this section, we provide the following:

An alphabetical list of compiler options that includes their short descriptions

Lists of new options and lists of deprecated and removed options

General rules for compiler options and the conventions we use when referring to options

Details about what appears in the compiler option descriptions

A description of each compiler option. The descriptions appear under the option's functional category.
Within each category, the options are listed in alphabetical order.

New Options

This topic lists the options or option settings that provide new functionality in this release.

If no label appears, the option is available on all supported systems.

If "only" appears in the label, the option is only available on the identified system.
For more details on the options, refer to the individual option descriptions.

For information on conventions used in this table, see Notational Conventions.
New compiler options or option settings are listed in tables below:

e The first table lists new options or option settings that are available on Windows* systems.
e The second table lists new options or option settings that are available on Linux* and macOS* systems. If
an option is only available on one of these operating systems, it is labeled.

Windows* Options Description

/Qno-intel-1ib[:library] Disables linking to specified Intel® libraries,
or to all Intel® libraries.
Default:
OFF

/Qopt-for-throughput[:value] Determines how the compiler optimizes for

throughput depending on whether the
program is to run in single-job or multi-job
mode. This feature is only available for ifx.

Default:
OFF

Linux* and macOS* Options Description

-no-intel-1lib[=library] Disables linking to specified Intel® libraries,
or to all Intel® libraries.

Default:
OFF
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Linux* and macOS* Options

Description

-gqopt-for-throughput[=value]

Determines how the compiler optimizes for
throughput depending on whether the

program is to run in single-job or multi-job
mode. This feature is only available for ifx.

Default:
OFF

Product and Performance Information

Performancelndex.

Notice revision #20201201

Performance varies by use, configuration and other factors. Learn more at www.Intel.com/

Alphabetical List of Compiler Options

The following table lists all the current compiler options in alphabetical order.

4Nportlib, 4Yportlib

align
allow

altparam

ansi-alias, Qansi-alias

arch

assume

auto

auto-scalar, Qauto-scalar

ax, Qax

Bdynamic

bigobj

bintext

Bstatic
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Determines whether the compiler links to the library of portability
routines.

Tells the compiler how to align certain data items.
Determines whether the compiler allows certain behaviors.

Allows alternate syntax (without parentheses) for PARAMETER
statements.

Tells the compiler to assume certain rules of the Fortran standard
regarding aliasing and array bounds.

Tells the compiler which features it may target, including which
instruction sets it may generate.

Tells the compiler to make certain assumptions.

Causes all local, non-SAVEd variables to be allocated to the run-time
stack.

Causes scalar variables of intrinsic types INTEGER, REAL, COMPLEX, and
LOGICAL that do not have the SAVE attribute to be allocated to the run-
time stack.

Tells the compiler to generate multiple, feature-specific auto-dispatch
code paths for Intel® processors if there is a performance benefit. This
feature is only available for ifort.

Specifies a directory that can be used to find include files, libraries, and
executables.

Enables dynamic linking of libraries at run time.

Increases the number of sections that an object file can contain. This
feature is only available for ifort.

Places a text string into the object file (.obj) being generated by the
compiler. This feature is only available for ifort.

Enables static linking of a user's library.
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Bsymbolic

Bsymbolic-functions

C

ccdefault

check
coarray, Qcoarray

coarray-config-file, Qcoarray-
config-file

coarray-num-images,
Qcoarray-num-images

complex-limited-range,
Qcomplex-limited-range
convert

cxxlib

D
dbglibs

debug (Linux* and macOS* )
debug (Windows*)

debug-parameters

device-math-lib

diag, Qdiag
diag-dump, Qdiag-dump

diag-error-limit, Qdiag-error-
limit

diag-file, Qdiag-file

diag-file-append, Qdiag-file-
append

diag-id-numbers, Qdiag-id-
numbers

diag-once, Qdiag-once
d-lines, Qd-lines

dll

Binds references to all global symbols in a program to the definitions
within a user's shared library.

Binds references to all global function symbols in a program to the
definitions within a user's shared library.

Prevents linking.

Specifies the type of carriage control used when a file is displayed at a
terminal screen.

Checks for certain conditions at run time.
Enables the coarray feature.

Specifies the name of a Message Passing Interface (MPI) configuration
file.

Specifies the default number of images that can be used to run a coarray
executable.

Determines whether the use of basic algebraic expansions of some
arithmetic operations involving data of type COMPLEX is enabled. This
feature is only available for ifort.

Specifies the format of unformatted files containing numeric data.

Determines whether the compiler links using the C++ run-time libraries
provided by gcc.

Defines a symbol name that can be associated with an optional value.

Tells the linker to search for unresolved references in a debug run-time
library.

Enables or disables generation of debugging information.
Enables or disables generation of debugging information.

Tells the compiler to generate debug information for PARAMETERS used in
a program.

Enables or disables certain device libraries. This is a deprecated option
that may be removed in a future release.

Controls the display of diagnostic information during compilation.
Tells the compiler to print all enabled diagnostic messages.

Specifies the maximum number of errors allowed before compilation
stops.

Causes the results of diagnostic analysis to be output to a file.

Causes the results of diagnostic analysis to be appended to a file.

Determines whether the compiler displays diagnostic messages by using
their ID number values.

Tells the compiler to issue one or more diagnostic messages only once.
Compiles debug statements.

Specifies that a program should be linked as a dynamic-link (DLL) library.
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double-size

dryrun
dumpmachine

dynamiclib

dynamic-linker
dyncom, Qdyncom
E

EP

exe
extend-source
extfor

extfpp

extlnk

F ( macOS* )

F (Windows*)
f66

f77rtl

Fa

FA

falias, Oa

falign-functions, Qfnalign

falign-loops, Qalign-loops
falign-stack

fast

fast-transcendentals, Qfast-

transcendentals

fasynchronous-unwind-tables
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Specifies the default KIND for DOUBLE PRECISION and DOUBLE COMPLEX
declarations, constants, functions, and intrinsics.

Specifies that driver tool commands should be shown but not executed.
Displays the target machine and operating system configuration.

Invokes the libtool command to generate dynamic libraries. This feature
is only available for ifort.

Specifies a dynamic linker other than the default.
Enables dynamic allocation of common blocks at run time.
Causes the preprocessor to send output to stdout.

Causes the preprocessor to send output to stdout, omitting #line
directives.

Specifies the name for a built program or dynamic-link library.
Specifies the length of the statement field in a fixed-form source file.
Specifies file extensions to be processed by the compiler as Fortran files.

Specifies file extensions to be recognized as a file to be preprocessed by
the Fortran preprocessor.

Specifies file extensions to be passed directly to the linker.

Adds a framework directory to the head of an include file search path.
This feature is only available for ifort.

Specifies the stack reserve amount for the program.

Tells the compiler to apply FORTRAN 66 semantics.

Tells the compiler to use the run-time behavior of FORTRAN 77.
Specifies that an assembly listing file should be generated.
Specifies the contents of an assembly listing file.

Specifies whether or not a procedure call may have hidden aliases of local
variables not supplied as actual arguments.

Tells the compiler to align procedures on an optimal byte boundary.

Aligns loops to a power-of-two byte boundary. This feature is only
available for ifort.

Tells the compiler the stack alignment to use on entry to routines. This
option is deprecated and will be removed in a future release. This feature
is only available for ifort.

Maximizes speed across the entire program.

Enables the compiler to replace calls to transcendental functions with
faster but less precise implementations. This feature is only available for
ifort.

Determines whether unwind information is precise at an instruction
boundary or at a call boundary.
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fcf-protection, Qcf-protection

fcode-asm

fcommon

Fd

feliminate-unused-debug-
types, Qeliminate-unused-
debug-types

fexceptions

ffat-lto-objects

ffnalias, Ow

fimf-absolute-error, Qimf-
absolute-error

fimf-accuracy-bits, Qimf-
accuracy-bits

fimf-arch-consistency, Qimf-
arch-consistency

fimf-domain-exclusion, Qimf-
domain-exclusion

fimf-force-dynamic-target,
Qimf-force-dynamic-target

fimf-max-error, Qimf-max-
error

fimf-precision, Qimf-precision

fimf-use-svml, Qimf-use-svml

finline

finline-functions
finline-limit

finstrument-functions,
Qinstrument-functions

Enables Control-flow Enforcement Technology (CET) protection, which
defends your program from certain attacks that exploit vulnerabilities.
This option offers preliminary support for CET.

Produces an assembly listing with machine code annotations. This feature
is only available for ifort.

Determines whether the compiler treats common symbols as global
definitions. This feature is only available for ifort.

Lets you specify a nhame for a program database (PDB) file created by the
compiler. This feature is only available for ifort.

Controls the debug information emitted for types declared in a
compilation unit. This feature is only available for ifort.

Enables exception handling table generation. This feature is only available
for ifort.

Determines whether a fat link-time optimization (LTO) object, containing
both intermediate language and object code, is generated during an
interprocedural optimization compilation (-c -ipo). This feature is only
available for ifort.

Determines whether aliasing is assumed within functions. This feature is
only available for ifort.

Defines the maximum allowable absolute error for math library function
results. This feature is only available for ifort.

Defines the relative error for math library function results, including
division and square root. This feature is only available for ifort.

Ensures that the math library functions produce consistent results across
different microarchitectural implementations of the same architecture.
This feature is only available for ifort.

Indicates the input arguments domain on which math functions must
provide correct results. This feature is only available for ifort.

Instructs the compiler to use run-time dispatch in calls to math functions.

Defines the maximum allowable relative error for math library function
results, including division and square root. This feature is only available
for ifort.

Lets you specify a level of accuracy (precision) that the compiler should
use when determining which math library functions to use. This feature is
only available for ifort.

Instructs the compiler to use the Short Vector Math Library (SVML) rather
than the Intel® Math Library (LIBM) to implement math library functions.

Tells the compiler to inline functions declared with !'DIR$ ATTRIBUTES
FORCEINLINE .

Enables function inlining for single file compilation.
Lets you specify the maximum size of a function to be inlined.

Determines whether routine entry and exit points are instrumented.
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fixed

fkeep-static-consts , Qkeep-

static-consts
fltconsistency

fma, Qfma

fmath-errno

fmerge-constants

fmerge-debug-strings

fminshared

fmpc-privatize

fnsplit, Qfnsplit

fomit-frame-pointer , Oy

fopenmp

fopenmp-device-lib

fopenmp-target-buffers,
Qopenmp-target-buffers

fopenmp-targets, Qopenmp-

targets

foptimize-sibling-calls

fpconstant

fpe

fpe-all

fpic
fpie

fp-model, fp
fpp
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Specifies source files are in fixed format.

Tells the compiler to preserve allocation of variables that are not
referenced in the source. This feature is only available for ifort.

Enables improved floating-point consistency.

Determines whether the compiler generates fused multiply-add (FMA)
instructions if such instructions exist on the target processor.

Tells the compiler that errno can be reliably tested after calls to standard
math library functions. This feature is only available for ifort.

Determines whether the compiler and linker attempt to merge identical
constants (string constants and floating-point constants) across
compilation units. This feature is only available for ifort.

Causes the compiler to pool strings used in debugging information.

Specifies that a compilation unit is a component of a main program and
should not be linked as part of a shareable object. This feature is only
available for ifort.

Enables or disables privatization of all static data for the MultiProcessor
Computing environment (MPC) unified parallel runtime. This feature is
only available for ifort.

Enables function splitting. This feature is only available for ifort.

Determines whether EBP is used as a general-purpose register in
optimizations. Option /Oy is deprecated and will be removed in a future
release. This feature is only available for ifort.

Option -fopenmp is a deprecated option that will be removed in a future
release.

Enables or disables certain device libraries for an OpenMP* target.

Enables a way to overcome the problem where some OpenMP* offload
SPIR-V* devices produce incorrect code when a target object is larger
than 4GB. This feature is only available for ifx.

Enables offloading to a specified GPU target if OpenMP* features have
been enabled. This feature is only available for ifx.

Determines whether the compiler optimizes tail recursive calls. This
feature is only available for ifort.

Tells the compiler that single-precision constants assigned to double-
precision variables should be evaluated in double precision.

Allows some control over floating-point exception handling for the main
program at run-time.

Allows some control over floating-point exception handling for each
routine in a program at run-time.

Determines whether the compiler generates position-independent code.

Tells the compiler to generate position-independent code. The generated
code can only be linked into executables.

Controls the semantics of floating-point calculations.

Runs the Fortran preprocessor on source files before compilation.
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fpp-name

fp-port, Qfp-port
fprotect-parens, Qprotect-
parens

fpscomp

fp-speculation, Qfp-
speculation

fp-stack-check, Qfp-stack-
check

free

fsource-asm

fstack-protector

fstack-security-check

ftrapuv , Qtrapuv

ftz, Qftz

fuse-Id

fverbose-asm

fvisibility

fzero-initialized-in-bss, Qzero-

initialized-in-bss

gcc-name

gdwarf

Ge

gen-dep

gen-depformat

Lets you specify an alternate preprocessor to use with Fortran.

Rounds floating-point results after floating-point operations. This feature
is only available for ifort.

Determines whether the optimizer honors parentheses when floating-
point expressions are evaluated.

Controls whether certain aspects of the run-time system and semantic
language features within the compiler are compatible with Intel® Fortran
or Microsoft* Fortran PowerStation.

Tells the compiler the mode in which to speculate on floating-point
operations.

Tells the compiler to generate extra code after every function call to
ensure that the floating-point stack is in the expected state. This feature
is only available for ifort.

Specifies source files are in free format.

Produces an assembly listing with source code annotations. This feature is
only available for ifort.

Enables or disables stack overflow security checks for certain (or all)
routines.

Determines whether the compiler generates code that detects some
buffer overruns.

Initializes stack local variables to an unusual value to aid error detection.
This feature is only available for ifort.

Flushes subnormal results to zero.

Tells the compiler to use a different linker instead of the default linker
(Id). This feature is only available for ifort.

Produces an assembly listing with compiler comments, including options
and version information. This feature is only available for ifort.

Specifies the default visibility for global symbols or the visibility for
symbols in a file. This feature is only available for ifort.

Determines whether the compiler places in the DATA section any
variables explicitly initialized with zeros. This feature is only available for
ifort.

Tells the compiler to generate a level of debugging information in the
object file.

Lets you specify the name of the GCC compiler that should be used to set
up the link-time environment, including the location of standard libraries.

Lets you specify a DWARF Version format when generating debug
information.

Enables stack-checking for all functions. This is a deprecated option. The
replacement option is /GsO0.

Tells the compiler to generate build dependencies for the current
compilation.

Specifies the form for the output generated when option gen-dep is
specified.
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gen-depshow

gen-interfaces

GF

global-hoist, Qglobal-hoist

grecord-gcc-switches

GS

Gs

gsplit-dwarf
guard
guide, Qguide

guide-data-trans, Qguide-
data-trans

guide-file, Qguide-file
guide-file-append, Qguide-
file-append

guide-opts, Qguide-opts
guide-par, Qguide-par
guide-vec, Qguide-vec
gxx-name

heap-arrays

help

homeparams

hotpatch

I

idirafter
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Determines whether certain features are excluded from dependency
analysis. Currently, it only applies to intrinsic modules.

Tells the compiler to generate an interface block for each routine in a
source file.

Enables read-only string-pooling optimization.

Enables certain optimizations that can move memory loads to a point
earlier in the program execution than where they appear in the source.
This feature is only available for ifort.

Causes the command line options that were used to invoke the compiler
to be appended to the DW_AT_producer attribute in DWARF debugging
information.

Determines whether the compiler generates code that detects some
buffer overruns.

Lets you control the threshold at which the stack checking routine is
called or not called. This feature is only available for ifort.

Creates a separate object file containing DWARF debug information.
Enables the control flow protection mechanism.

Lets you set a level of guidance for auto-vectorization, auto parallelism,
and data transformation. This feature is only available for ifort.

Lets you set a level of guidance for data transformation. This feature is
only available for ifort.

Causes the results of guided auto parallelism to be output to a file. This
feature is only available for ifort.

Causes the results of guided auto parallelism to be appended to a file.
This feature is only available for ifort.

Tells the compiler to analyze certain code and generate recommendations
that may improve optimizations. This feature is only available for ifort.

Lets you set a level of guidance for auto parallelism. This feature is only
available for ifort.

Lets you set a level of guidance for auto-vectorization. This feature is only
available for ifort.

Lets you specify the name of the g++ compiler that should be used to set
up the link-time environment, including the location of standard libraries.

Puts automatic arrays and arrays created for temporary computations on
the heap instead of the stack.

Displays all supported compiler options or supported compiler options
within a specified category of options.

Tells the compiler to store parameters passed in registers to the stack.
This feature is only available for ifort.

Tells the compiler to prepare a routine for hotpatching. This feature is
only available for ifort.

Specifies an additional directory for the include path.

Adds a directory to the second include file search path.
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iface

init, Qinit

inline

inline-factor, Qinline-factor
inline-forceinline, Qinline-
forceinline

inline-level, Ob

inline-max-per-compile,
Qinline-max-per-compile

inline-max-per-routine,
Qinline-max-per-routine

inline-max-size, Qinline-max-
size

inline-max-total-size, Qinline-
max-total-size

inline-min-caller-growth,
Qinline-min-caller-growth
inline-min-size, Qinline-min-
size

intconstant

integer-size
intel-freestanding

intel-freestanding-target-os
ip, Qip

ip-no-inlining, Qip-no-inlining
ip-no-pinlining, Qip-no-
pinlining

ipo, Qipo

ipo-c, Qipo-c

ipo-jobs, Qipo-jobs

ipo-S, Qipo-S

Specifies the default calling convention and argument-passing convention
for an application.

Lets you initialize a class of variables to zero or to various numeric
exceptional values.

Specifies the level of inline function expansion.

Specifies the percentage multiplier that should be applied to all inlining
options that define upper limits. This feature is only available for ifort.

Instructs the compiler to force inlining of functions suggested for inlining
whenever the compiler is capable doing so. This feature is only available
for ifort.

Specifies the level of inline function expansion.

Specifies the maximum number of times inlining may be applied to an
entire compilation unit. This feature is only available for ifort.

Specifies the maximum number of times the inliner may inline into a
particular routine. This feature is only available for ifort.

Specifies the lower limit for the size of what the inliner considers to be a
large routine. This feature is only available for ifort.

Specifies how much larger a routine can normally grow when inline
expansion is performed. This feature is only available for ifort.

Lets you specify a procedure size n for which procedures of size <= n do
not contribute to the estimated growth of the caller when inlined. This
feature is only available for ifort.

Specifies the upper limit for the size of what the inliner considers to be a
small routine. This feature is only available for ifort.

Tells the compiler to use FORTRAN 77 semantics to determine the kind
parameter for integer constants.

Specifies the default KIND for integer and logical variables.
Lets you compile in the absence of a gcc environment.
Lets you specify the target operating system for compilation.

Determines whether additional interprocedural optimizations for single-
file compilation are enabled. This feature is only available for ifort.

Disables full and partial inlining enabled by interprocedural optimization
options. This feature is only available for ifort.

Disables partial inlining enabled by interprocedural optimization options.
This feature is only available for ifort.

Enables interprocedural optimization between files.

Tells the compiler to optimize across multiple files and generate a single
object file.

Specifies the number of commands (jobs) to be executed simultaneously
during the link phase of Interprocedural Optimization (IPO). This feature
is only available for ifort.

Tells the compiler to optimize across multiple files and generate a single
assembly file. This feature is only available for ifort.
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ipo-separate, Qipo-separate

isystem
I
L

libdir

libs
link
list

list-line-len

list-page-len

logo

m

m32, m64 , Qm32, Qm64

m80387

map

map-opts, Qmap-opts

march

masm

mauto-arch, Qauto-arch

mbranches-within-32B-
boundaries, Qbranches-
within-32B-boundaries

mcmodel

mconditional-branch,
Qconditional-branch
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Tells the compiler to generate one object file for every source file. This
feature is only available for ifort.

Specifies a directory to add to the start of the system include path.
Tells the linker to search for a specified library when linking.

Tells the linker to search for libraries in a specified directory before
searching the standard directories.

Controls whether linker options for search libraries are included in object
files generated by the compiler.

Tells the compiler which type of run-time library to link to.
Passes user-specified options directly to the linker at compile time.
Tells the compiler to create a listing of the source file.

Specifies the line length for the listing generated when option list is
specified.

Specifies the page length for the listing generated when option list is
specified.

Displays the compiler version information.

Tells the compiler which features it may target, including which
instruction set architecture (ISA) it may generate.

Tells the compiler to generate code for a specific architecture. Option m32
(and /Qm32) is deprecated and will be removed in a future release. 32-
bit options are only available for ifort.

Specifies whether the compiler can use x87 instructions. This feature is
only available for ifort.

Tells the linker to generate a link map file.

Maps one or more compiler options to their equivalent on a different
operating system.

Tells the compiler to generate code for processors that support certain
features.

Tells the compiler to generate the assembler output file using a selected
dialect.

Tells the compiler to generate multiple, feature-specific auto-dispatch
code paths for x86 architecture processors if there is a performance
benefit. This feature is only available for ifort.

Tells the compiler to align branches and fused branches on 32-byte
boundaries for better performance.

Tells the compiler to use a specific memory model to generate code and
store data.

Lets you identify and fix code that may be vulnerable to speculative
execution side-channel attacks, which can leak your secure data as a
result of bad speculation of a conditional branch direction. This feature is
only available for ifort.
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MD

MDs

mdynamic-no-pic

minstruction, Qinstruction

module

momit-leaf-frame-pointer

mp1l, Qprec

mstringop-inline-threshold,

Qstringop-inline-threshold

mstringop-strategy,
Qstringop-strategy

MT

mtune, tune

multiple-processes , MP

names

no-bss-init, Qnobss-init

nodefaultlibs

nofor-main

no-intel-lib, Qno-intel-lib
nolib-inline

nostartfiles

nostdlib

0
o

object

Tells the linker to search for unresolved references in a multithreaded,
dynamic-link run-time library.

Tells the linker to search for unresolved references in a single-threaded,
dynamic-link run-time library. This is a deprecated option. There is no
replacement option.

Generates code that is not position-independent but has position-
independent external references. This feature is only available for ifort.

Determines whether MOVBE instructions are generated for certain Intel®
processors. This feature is only available for ifort.

Specifies the directory where module files should be placed when created
and where they should be searched for.

Determines whether the frame pointer is omitted or kept in leaf functions.
This feature is only available for ifort.

Improves floating-point precision and consistency. This feature is only
available for ifort.

Tells the compiler to not inline calls to buffer manipulation functions such
as memcpy and memset when the number of bytes the functions handle
are known at compile time and greater than the specified value. This
feature is only available for ifort.

Lets you override the internal decision heuristic for the particular
algorithm used when implementing buffer manipulation functions such as
memcpy and memset. This feature is only available for ifort.

Tells the linker to search for unresolved references in a multithreaded,
static run-time library.

Performs optimizations for specific processors but does not cause
extended instruction sets to be used (unlike -march).

Creates multiple processes that can be used to compile large numbers of
source files at the same time.

Specifies how source code identifiers and external names are interpreted.

Tells the compiler to place in the DATA section any uninitialized variables
and explicitly zero-initialized variables. This option is deprecated and will
be removed in a future release. This feature is only available for ifort.

Prevents the compiler from using standard libraries when linking.
Specifies that the main program is not written in Fortran.

Disables linking to specified Intel® libraries, or to all Intel® libraries.
Disables inline expansion of standard library or intrinsic functions.
Prevents the compiler from using standard startup files when linking.

Prevents the compiler from using standard libraries and startup files when
linking.

Specifies the code optimization for applications.
Specifies the name for an output file.

Specifies the name for an object file.
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Od
Ofast
Os

Ot

p
pad, Qpad

pad-source, Qpad-source
par-affinity, Qpar-affinity

parallel, Qparallel

parallel-source-info,
Qparallel-source-info

par-num-threads, Qpar-num-
threads

par-runtime-control, Qpar-
runtime-control

par-schedule, Qpar-schedule

par-threshold, Qpar-threshold

pc, Qpc
pdbfile

pie

prec-div, Qprec-div

prec-sqrt, Qprec-sqrt

preprocess-only
print-multi-lib
prof-data-order, Qprof-data-
order

prof-dir, Qprof-dir

prof-file, Qprof-file

prof-func-groups
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Disables all optimizations.
Sets certain aggressive options to improve the speed of your application.

Enables optimizations that do not increase code size; it produces smaller
code size than 02.

Enables all speed optimizations.

Compiles and links for function profiling with gprof(1).

Enables the changing of the variable and array memory layout.
Specifies padding for fixed-form source records.

Specifies thread affinity. This feature is only available for ifort.

Tells the auto-parallelizer to generate multithreaded code for loops that
can be safely executed in parallel. This feature is only available for ifort.

Enables or disables source location emission when OpenMP* or auto-
parallelism code is generated. This feature is only available for ifort.

Specifies the number of threads to use in a parallel region. This feature is
only available for ifort.

Generates code to perform run-time checks for loops that have symbolic
loop bounds. This feature is only available for ifort.

Lets you specify a scheduling algorithm for loop iterations. This feature is
only available for ifort.

Sets a threshold for the auto-parallelization of loops. This feature is only
available for ifort.

Enables control of floating-point significand precision.

Lets you specify the name for a program database (PDB) file created by
the linker. This feature is only available for ifort.

Determines whether the compiler generates position-independent code
that will be linked into an executable.

Improves precision of floating-point divides. This feature is only available
for ifort.

Improves precision of square root implementations. This feature is only
available for ifort.

Causes the Fortran preprocessor to send output to a file.
Prints information about where system libraries should be found.

Enables or disables data ordering if profiling information is enabled. This
feature is only available for ifort.

Specifies a directory for profiling information output files. This feature is
only available for ifort.

Specifies an alternate file name for the profiling summary files. This
feature is only available for ifort.

Enables or disables function grouping if profiling information is enabled.
This feature is only available for ifort.
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prof-func-order, Qprof-func-

order

prof-gen, Qprof-gen

prof-gen-sampling

prof-hotness-threshold,
Qprof-hotness-threshold

prof-src-dir, Qprof-src-dir

prof-src-root, Qprof-src-root

prof-src-root-cwd, Qprof-src-
root-cwd

prof-use, Qprof-use

prof-use-sampling

prof-value-profiling, Qprof-
value-profiling

pthread

Qcov-dir

Qcov-file

Qcov-gen

Qinline-dllimport

Qinstall

Qlocation

gmkl, Qmkl

qoffload

Enables or disables function ordering if profiling information is enabled.
This feature is only available for ifort.

Produces an instrumented object file that can be used in profile guided
optimization. This feature is only available for ifort.

Tells the compiler to generate debug discriminators in debug output. This
aids in developing more precise sampled profiling output. This option is
deprecated and will be removed in a future release. This feature is only
available for ifort.

Lets you set the hotness threshold for function grouping and function
ordering. This feature is only available for ifort.

Determines whether directory information of the source file under
compilation is considered when looking up profile data records. This
feature is only available for ifort.

Lets you use relative directory paths when looking up profile data and
specifies a directory as the base. This feature is only available for ifort.

Lets you use relative directory paths when looking up profile data and
specifies the current working directory as the base. This feature is only
available for ifort.

Enables the use of profiling information during optimization. This feature
is only available for ifort.

Lets you use data files produced by hardware profiling to produce an
optimized executable. This option is deprecated and will be removed in a
future release. This feature is only available for ifort.

Controls which values are value profiled. This feature is only available for
ifort.

Tells the compiler to use pthreads library for multithreading support.

Specifies a directory for profiling information output files that can be used
with the codecov or tselect tool. This feature is only available for ifort.

Specifies an alternate file name for the profiling summary files that can
be used with the codecov or tselect tool. This feature is only available for
ifort.

Produces an instrumented object file that can be used with the codecov
or tselect tool. This feature is only available for ifort.

Determines whether dllimport functions are inlined. This feature is only
available for ifort.

Specifies the root directory where the compiler installation was
performed.

Specifies the directory for supporting tools.

Tells the compiler to link to certain libraries in the Intel® oneAPI Math
Kernel Library ( oneMKL ) . On Windows systems, you must specify this
option at compile time.

Lets you specify the mode for offloading or tell the compiler to ignore
language constructs for offloading. This is a deprecated option. There is
no replacement option. This feature is only available for ifort.
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gopenmp, Qopenmp
qopenmp-lib, Qopenmp-lib
qopenmp-link
gopenmp-offload
gopenmp-simd, Qopenmp-

simd

gopenmp-stubs, Qopenmp-
stubs

qopenmp-threadprivate,
Qopenmp-threadprivate

gopt-args-in-regs, Qopt-args-
in-regs

gopt-assume-safe-padding,
Qopt-assume-safe-padding

qopt-block-factor, Qopt-block-
factor

qgopt-dynamic-align, Qopt-
dynamic-align

gopt-for-throughput, Qopt-
for-throughput
Qoption

gopt-jump-tables, Qopt-
jump-tables

qopt-malloc-options
gopt-matmul, Qopt-matmul
qgopt-mem-layout-trans,
Qopt-mem-layout-trans
gopt-multiple-gather-scatter-
by-shuffles, Qopt-multiple-
gather-scatter-by-shuffles
qgopt-multi-version-
aggressive, Qopt-multi-
version-aggressive

qopt-prefetch, Qopt-prefetch
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Enables recognition of OpenMP* features and tells the parallelizer to
generate multi-threaded code based on OpenMP* directives.

Lets you specify an OpenMP* run-time library to use for linking. This
feature is only available for ifort.

Controls whether the compiler links to static or dynamic OpenMP* run-
time libraries.

Enables or disables OpenMP* offloading compilation for the TARGET
directives . This feature is only available for ifort.

Enables or disables OpenMP* SIMD compilation.

Enables compilation of OpenMP* programs in sequential mode.

Lets you specify an OpenMP* threadprivate implementation.

Determines whether calls to routines are optimized by passing arguments
in registers instead of on the stack. This option is deprecated and will be
removed in a future release. This feature is only available for ifort.

Determines whether the compiler assumes that variables and dynamically
allocated memory are padded past the end of the object. This feature is
only available for ifort.

Lets you specify a loop blocking factor. This feature is only available for
ifort.

Enables or disables dynamic data alignment optimizations. This feature is
only available for ifort.

Determines how the compiler optimizes for throughput depending on
whether the program is to run in single-job or multi-job mode. This
feature is only available for ifx.

Passes options to a specified tool.

Enables or disables generation of jump tables for switch statements. This
feature is only available for ifort.

Lets you specify an alternate algorithm for malloc(). This feature is only
available for ifort.

Enables or disables a compiler-generated Matrix Multiply (matmul) library
call.

Controls the level of memory layout transformations performed by the
compiler.

Enables or disables the optimization for multiple adjacent gather/scatter
type vector memory references.

Tells the compiler to use aggressive multi-versioning to check for pointer
aliasing and scalar replacement. This feature is only available for ifort.

Enables or disables prefetch insertion optimization. This feature is only
available for ifort.
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qopt-prefetch-distance, Qopt-
prefetch-distance

qopt-prefetch-issue-excl-hint,
Qopt-prefetch-issue-excl-hint

gopt-ra-region-strategy,
Qopt-ra-region-strategy

qgopt-report, Qopt-report
gopt-report-annotate, Qopt-
report-annotate
gopt-report-annotate-
position, Qopt-report-
annotate-position
qopt-report-embed, Qopt-
report-embed
qopt-report-file, Qopt-report-
file

qgopt-report-filter, Qopt-
report-filter
qgopt-report-format, Qopt-
report-format
qgopt-report-help, Qopt-
report-help
gopt-report-names, Qopt-
report-names
qgopt-report-per-object, Qopt-
report-per-object
qgopt-report-phase, Qopt-
report-phase
qgopt-report-routine, Qopt-
report-routine
gopt-streaming-stores, Qopt-
streaming-stores
gopt-subscript-in-range,
Qopt-subscript-in-range
gopt-zmm-usage, Qopt-zmm-
usage

goverride-limits, Qoverride-
limits

Specifies the prefetch distance to be used for compiler-generated
prefetches inside loops. This feature is only available for ifort.

Supports the prefetchW instruction in Intel® microarchitecture code name
Broadwell and later. This feature is only available for ifort.

Selects the method that the register allocator uses to partition each
routine into regions. This feature is only available for ifort.

Tells the compiler to generate an optimization report. This feature is only
available for ifort.

Enables the annotated source listing feature and specifies its format. This
feature is only available for ifort.

Enables the annotated source listing feature and specifies the site where
optimization messages appear in the annotated source in inlined cases of
loop optimizations. This feature is only available for ifort.

Determines whether special loop information annotations will be
embedded in the object file and/or the assembly file when it is generated.
This feature is only available for ifort.

Specifies that the output for the optimization report goes to a file, stderr,
or stdout. This feature is only available for ifort.

Tells the compiler to find the indicated parts of your application, and
generate optimization reports for those parts of your application. This
feature is only available for ifort.

Specifies the format for an optimization report. This feature is only
available for ifort.

Displays the optimizer phases available for report generation and a short
description of what is reported at each level. This feature is only available
for ifort.

Specifies whether mangled or unmangled names should appear in the
optimization report. This feature is only available for ifort.

Tells the compiler that optimization report information should be
generated in a separate file for each object. This feature is only available
for ifort.

Specifies one or more optimizer phases for which optimization reports are
generated. This feature is only available for ifort.

Tells the compiler to generate an optimization report for each of the
routines whose names contain the specified substring. This feature is only
available for ifort.

Enables generation of streaming stores for optimization. This feature is
only available for ifort.

Determines whether the compiler assumes that there are no "large"
integers being used or being computed inside loops. This feature is only
available for ifort.

Defines a level of zmm registers usage.

Lets you override certain internal compiler limits that are intended to
prevent excessive memory usage or compile times for very large,
complex compilation units. This feature is only available for ifort.
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Qpar-adjust-stack
Qpatchable-addresses
Qsfalign
gsimd-honor-fp-model,

Qsimd-honor-fp-model

gsimd-serialize-fp-reduction,
Qsimd-serialize-fp-reduction

Quse-msasm-symbols

Qvc

rcd, Qred

real-size

recursive

reentrancy

S

safe-cray-ptr, Qsafe-cray-ptr
save, Qsave

save-temps , Qsave-temps

scalar-rep, Qscalar-rep

shared

shared-intel
shared-libgcc
show

simd, Qsimd

SOX

standard-realloc-lhs
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Tells the compiler to generate code to adjust the stack size for a fiber-
based main thread. This feature is only available for ifort.

Tells the compiler to generate code such that references to statically
assigned addresses can be patched. This feature is only available for ifort.

Specifies stack alignment for functions. This option is deprecated and will
be removed in a future release. This feature is only available for ifort.

Tells the compiler to obey the selected floating-point model when
vectorizing SIMD loops. This feature is only available for ifort.

Tells the compiler to serialize floating-point reduction when vectorizing
SIMD loops. This feature is only available for ifort.

Tells the compiler to use a dollar sign ("$") when producing symbol
names. This feature is only available for ifort.

Specifies which version of Microsoft*Visual C++* or Microsoft Visual
Studio* that the compiler should link to. This feature is only available for
ifort.

Enables fast float-to-integer conversions. This is a deprecated option.
There is no replacement option. This feature is only available for ifort.

Specifies the default KIND for real and complex declarations, constants,
functions, and intrinsics.

Tells the compiler that all routines should be compiled for possible
recursive execution.

Tells the compiler to generate reentrant code to support a multithreaded
application.

Causes the compiler to compile to an assembly file only and not link.
Tells the compiler that Cray* pointers do not alias other variables.
Causes variables to be placed in static memory.

Tells the compiler to save intermediate files created during compilation.

Enables or disables the scalar replacement optimization done by the
compiler as part of loop transformations. This feature is only available for
ifort.

Tells the compiler to produce a dynamic shared object instead of an
executable.

Causes Intel-provided libraries to be linked in dynamically.
Links the GNU libgcc library dynamically.
Controls the contents of the listing generated when option list is specified.

Enables or disables compiler interpretation of SIMD directives. This
feature is only available for ifort.

Tells the compiler to save the compilation options and version humber in
the executable file. It also lets you choose whether to include lists of
certain routines . This feature is only available for ifort.

Determines whether the compiler uses the current Fortran Standard rules
or the old Fortran 2003 rules when interpreting assignment statements.
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standard-semantics

stand

static
static-intel

staticlib

static-libgcc
static-libstdc++
syntax-only
sysroot

-

tcollect, Qtcollect

tcollect-filter, Qtcollect-filter

Tf

threads

traceback

U

u (Windows*)
undef

unroll , Qunroll

unroll-aggressive, Qunroll-
aggressive

use-asm, Quse-asm

v
vec, Qvec

vecabi, Qvecabi

vec-guard-write, Qvec-guard-

write

vec-threshold, Qvec-threshold

Determines whether the current Fortran Standard behavior of the
compiler is fully implemented.

Tells the compiler to issue compile-time messages for nonstandard
language elements.

Prevents linking with shared libraries.
Causes Intel-provided libraries to be linked in statically.

Invokes the libtool command to generate static libraries. This feature is
only available for ifort.

Links the GNU libgcc library statically.

Links the GNU libstdc++ library statically.

Tells the compiler to check only for correct syntax.

Specifies the root directory where headers and libraries are located.
Tells the linker to read link commands from a file.

Inserts instrumentation probes calling the Intel® Trace Collector API. This
feature is only available for ifort.

Lets you enable or disable the instrumentation of specified functions. You
must also specify option [Q]tcollect. This feature is only available for ifort.

Tells the compiler to compile the file as a Fortran source file.

Tells the linker to search for unresolved references in a multithreaded
run-time library.

Tells the compiler to generate extra information in the object file to
provide source file traceback information when a severe error occurs at
run time.

Undefines any definition currently in effect for the specified symbol .
Undefines all previously defined preprocessor values.

Disables all predefined symbols .

Tells the compiler the maximum number of times to unroll loops.

Determines whether the compiler uses more aggressive unrolling for
certain loops. This feature is only available for ifort.

Tells the compiler to produce objects through the assembler. This is a
deprecated option. There is no replacement option. This feature is only
available for ifort.

Specifies that driver tool commands should be displayed and executed.
Enables or disables vectorization.

Determines which vector function application binary interface (ABI) the
compiler uses to create or call vector functions. This feature is only
available for ifort.

Tells the compiler to perform a conditional check in a vectorized loop. This
feature is only available for ifort.

Sets a threshold for the vectorization of loops.
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vms

warn

watch

wWB
what

winapp

Winline

Wi
Wp

wrap-margin

X
X, Qx

xHost, QxHost

Xlinker

Xopenmp-target

zero, Qzero

Zi, 27

Zo

Causes the run-time system to behave like HP* Fortran on OpenVMS*
Alpha systems and VAX* systems (VAX FORTRAN*).

Passes options to the assembler for processing.
Specifies diagnostic messages to be issued by the compiler.

Tells the compiler to display certain information to the console output
window.

Turns a compile-time bounds check into a warning.
Tells the compiler to display its detailed version string.

Tells the compiler to create a graphics or Fortran Windows application and
link against the most commonly used libraries.

Warns when a function that is declared as inline is not inlined. This
feature is only available for ifort.

Passes options to the linker for processing.
Passes options to the preprocessor.

Provides a way to disable the right margin wrapping that occurs in
Fortran list-directed output.

Removes standard directories from the include file search path.

Tells the compiler which processor features it may target, including which
instruction sets and optimizations it may generate.

Tells the compiler to generate instructions for the highest instruction set
available on the compilation host processor.

Passes a linker option directly to the linker.

Enables options to be passed to the specified tool in the device
compilation tool chain for the target. This compiler option supports
OpenMP* offloading. This feature is only available for ifx.

Initializes to zero variables of intrinsic type INTEGER, REAL, COMPLEX, or
LOGICAL that are not yet initialized. This is a deprecated option. The
replacement option is /Qinit:[no]zero or -init=[no]zero.

Tells the compiler to generate full debugging information in either an
object (.obj) file or a project database (PDB) file.

Enables or disables generation of enhanced debugging information for
optimized code. This feature is only available for ifort.

Deprecated and Removed Compiler Options

This topic lists deprecated and removed compiler options and suggests replacement options, if any are

available.

For more information on compiler options, see the detailed descriptions of the individual option descriptions

in this section.

Deprecated Options

Occasionally, compiler options are marked as "deprecated." Deprecated options are still supported in the
current release, but they may be unsupported in future releases.
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The following two tables list options that are currently deprecated.

Note that deprecated options are not limited to these lists.

Deprecated Linux* and macOS*Options

Suggested Replacement

—arch=IA32
-axS

-axT

—Cpp
-device-math-1ib
-falign-stack
—-fopenmp

-m32
-march=pentiumii
-march=pentiumiii
-mcpu

-mia32

-mkl

-msse

-no-bss-init
-prof-gen-sampling
-prof-use-sampling
-gopt-args-in-regs
-rcd

-stand f15
-use-asm

-xS

-xT

-[no]zero

Deprecated Windows* Options

None
-axSSE4.1

Linux*: —axSSSE3
macOS*: —-axSSSE3

-fpp

None

None

None

None

None
-march=pentium3
-mtune

None

-gmkl

Linux* only: None
None

None

None

None

None

-stand f18
None

-xSSE4.1

Linux: —-xSSSE3
macOS*: —-xSSSE3

-init=[no]zero

Suggested Replacement

/arch:IA32

/arch:SSE

None

None
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Deprecated Windows* Options Suggested Replacement
/device-math-1lib None

/Ge /Gs0

/MDs [d] None

/Oy None

/Qaxs /QaxSSE4.1
/QaxT /QaxSSSE3
/QIfist /Qrcd

/Qm32 None
/Qnobss-init None
/Qopt-args—-in-regs None

/Qrcd None

/0Osfalign None

/Qsox None

/Quse-asm None

/QxS /QxSSE4.1

/OxT /OxSSSE3
/Qzero[-] /Qinit: [no]zero
/stand £f15 /stand £18
/unroll /Qunroll

Removed Options

Some compiler options are no longer supported and have been removed. If you use one of these options, the
compiler issues a warning, ignores the option, and then proceeds with compilation.

The following two tables list options that are no longer supported.

Note that removed options are not limited to these lists.

Removed Linux* and macOS*Options Suggested Replacement
1 -£66

-66 -f66

—automatic -auto

-axB -axSSE2

-axH -axSSE4.2
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Removed Linux* and macOS*Options Suggested Replacement

-axi None

-axK No exact replacement; upgrade to -msse?2
-axM None

-axN Linux*: —axSSE2

macOS*: None

-axP Linux: —axSSE3
macOS*: None

-axW -msse2

-cm -warn nousage

-cxxlib-gcc[=dir] -cxx1lib[=dir]

-cxxlib-icc None

-dps -altparam

-F -preprocess-only or -P

-falign-stack=mode None; this option is only removed on macOS*

-fp -fno-omit-frame-pointer

-fpstkchk -fp-stack-check

-func-groups -prof-func-groups

-fvisibility=internal -fvisibility=hidden

-gcc-version No exact replacement; use -gcc-name

-guide-profile None

—-i-dynamic -shared-intel

-i-static -static-intel

-inline-debug-info -debug inline-debug-info

-ipo-obj (and -ipo obj) None

-Kpic, -KPIC -fpic

-lowercase -names lowercase

-mp -fp-model

-no-cpprt -no-cxx1lib

-nobss-init -no-bss-init

-no-standard-semantics No exact replacement; negate specific options
separately
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Removed Linux* and macOS*Options Suggested Replacement
-nus -assume nounderscore

-0Ob —-inline-level

-onetrip -f66

-openmp —-gopenmp

-openmp-1ib —gopenmp-1lib

-openmp-1ib legacy None

-openmp-1link and -gopenmp-1link None

-openmpP —-gopenmp

-openmp-profile None

—openmp-report -gopt-report-phase=openmp
—openmpsS —gopenmp-stubs
-openmp-simd -gopenmp-simd
—-openmp-stubs —gopenmp-stubs
-openmp-threadprivate -gopenmp-threadprivate
-opt-args-in-regs -gqopt-args-in-regs
-opt-assume-safe-padding -gopt-assume-safe-padding
-opt-block-factor -gopt-block-factor
-opt-dynamic-align -gopt-dynamic-align
-opt—-gather-scatter-unroll None

-opt-jump-tables -gopt-jump-tables
-opt-malloc-options -gopt-malloc-options
-opt-matmul -gopt-matmul
-opt-mem-layout-trans -gopt-mem-layout-trans
-opt-multi-version-aggressive -gopt-multi-version-aggressive
-opt-prefetch -gopt-prefetch
-opt-prefetch-distance -qopt-prefetch-distance
-opt-ra-region-strategy -gopt-ra-region-strategy
-opt-report —-gopt-report
-opt-report-embed -gopt-report-embed
-opt-report-file -qopt-report-file
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Removed Linux* and macOS*Options

Suggested Replacement

-opt-report-filter
-opt-report-format
-opt-report-help
-opt-report-level
-opt-report-per-object
-opt-report-phase
-opt-report-routine
-opt-streaming-cache-evict
-opt-streaming-stores
-opt-subscript-in-range
-par-report

-prefetch
-print-sysroot
-prof-format-32
-prof-genx
-profile-functions
-profile-loops
-profile-loops-report
-gqcf-protection
-goffload-arch
-goffload-attribute-target
-goffload-option
—gopenmp-report
-gopenmp-task

-dap

-rct

-shared-libcxa

-ssp

-static-libcxa

-syntax

-gopt-report-filter
-gopt-report-format
-qopt-report-help
—gopt-report
-qopt-report-per-object
-gopt-report-phase
-gqopt-report-routine
None
-gqopt-streaming-stores
-gopt-subscript-in-range
—-gopt-report-phase=par
-gqopt-prefetch

None

None

-prof-gen=srcpos

None

None

None

-fcf-protection

None

None

None
-gopt-report-phase=openmp
None

P

None

-shared-1libgcc

None

-static-libgcc

-syntax-only or —fsyntax-only
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Removed Linux* and macOS*Options

Suggested Replacement

-tcheck
-tppl
-tpp2
-tppb
-tpp6
-tpp7
-tprofile
—-tune
-uppercase
-us
-vec-report

-xB

-xK
-xM

-xN

-x0

-xP

-xSSE3_ATOM
-xSSSE3_ ATOM

-xXW

Removed Windows* Options

None

None
-mtune=itanium?2
None

None
-mtune=pentium4
None

-x<code>

-names uppercase
-assume underscore
—gopt-report-phase=vec
-xSSE2

None

No exact replacement; upgrade to -msse?2

None

Linux: —-xSSE2
macOS*: None

-msse3

Linux: -xSSE3
macOS*: None

-xATOM_SSSE3
-xATOM SSSE3

-msse?2

Suggested Replacement

/1

/4ccD (and /4ccd)
/ 4Nb

/4YDb
/architecture

/asmattr:none, /noasmattr
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Removed Windows* Options

Suggested Replacement

/asmattr:machine
/asmattr:source
/asmattr:all

/asmfile

/automatic

/cm

/debug:parallel
/debug:partial

/Fm

/Gl

/G5

/G6 (or /GB)

/G7

/GE

/ML [d]

/0g

/Op

/optimize:0, /nooptimize
/optimize:1, /optimize:2
/optimize:3, /optimize:4
/optimize:5

/QaxB

/QaxH

/Qaxi

/QaxK

/QaxM

/QaxN

/QaxP

/QaxwW

/Qcpp

/FAc

/FAs

/FAcs

/Fa

/auto
/warn:nousage
None

None

/map

None

None

None

None

/GF

Upgrade to /MT[d]
/01, /02, or /O3
/fltconsistency
/0d

/01

/02

/03

/QaxSSE2
/QaxSSE4.?2
None

Upgrade to /arch:SSE2
None

/QaxSSE?2
/QaxSSE3
/arch:SSE2

/fpp
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Removed Windows* Options Suggested Replacement
/Qdps /altparam
/Qextend-source /extend-source

/Qfppl[0 | 1 | 2 | 3] /fpp

/Qfpstkchk /Qfp-stack-check
/Qguide-profile None
/Qinline-debug-info /debug:inline-debug-info
/Qipo-obj (and /Qipo_obj) None

/Qlowercase /names:lowercase
/Qonetrip /f66
/Qopenmp-1lib:legacy None

/Qopenmp-1link None

/Qopenmp-profile None

/Qopenmp-report /Qopt-report-phase:openmp
/Qopt-report-level /Qopt-report
/Qpar-report /Qopt-report-phase:par
/Qprefetch /Qopt-prefetch
/Qprof-format-32 None

/Qprof-genx /Qprof-gen=srcpos
/Qprofile-functions None

/Qprofile-loops None
/Qprofile-loops-report None

/Qrct None

/Qssp None

/Qtprofile None

/Qtcheck None

/Quppercase /names:uppercase
/Quse-vcdebug None

/Qucll None

/Qvcl0

/Qvc9 and earlier
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Removed Windows* Options

Suggested Replacement

/Qvec-report
/Qvms

/OxB

/Qx1

/QOxK

/QxM

/QxN

/Qx0

/QOxP
/QxSSE3_ATOM
/QxSSSE3_ATOM
/QxW

/source

/standard-semantics-—

/tune
/unix

/us

/w90, /w95

/Zd

/Qopt-report-phase:vec
/vms

/QxSSE2

None

Upgrade to /arch:SSE2
None

/QxSSE2

/arch:SSE3

/OxSSE3

/QXATOM SSSE3
/QXATOM_SSSE3
/arch:SSE2

/Tf

No exact replacement; negate specific options

separately

/Qx<code>

None

/as sume:underscore

None

/debug:minimal

Product and Performance Information

Performancelndex.

Notice revision #20201201

Performance varies by use, configuration and other factors. Learn more at www.Intel.com/

Ways to Display Certain Option Information

This section describes how you can use a certain compiler option to get general information about compiler

options.

Displaying General Option Information From the Command Line

To display a list of all available compiler options, specify option help on the command line.
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To display functional groupings of compiler options, specify a functional category for option help. For
example, to display a list of options that affect diagnostic messages, enter one of the following commands:

-help diagnostics ! Linux and macOS*systems

/help diagnostics ! Windows systems

For details on other categories you can specify, see help.

Compiler Option Details

This section contains the full details about compiler options, including descriptions of each compiler option.

In this section compiler options are listed within their categories. To see an alphabetical list of compiler
options, see Alphabetical List of Compiler Options .

General Rules for Compiler Options

This section describes general rules for compiler options and it contains information about how we refer to
compiler option names in descriptions.

General Rules for Compiler Options
You cannot combine options with a single dash (Linux* and macOS*) or slash (Windows*). For example:

e On Linux* and macOS* systems: This form is incorrect: -Ec; this form is correct: -E -c
e On Windows* systems: This form is incorrect: /Ec; this form is correct: /E /c

All Linux* and macOS* compiler options are case sensitive. Many Windows* options are case sensitive. Some
options have different meanings depending on their case; for example, option "c" prevents linking, but option
"C" checks for certain conditions at run time.

Options specified on the command line apply to all files named on the command line.

Options can take arguments in the form of file names, strings, letters, or numbers. If a string includes
spaces, the string must be enclosed in quotation marks. For example:

e On Linux* and macOS* systems, —unroll [=n] or —-Uname (string)
e On Windows* systems, /Famyfile.s (file name) or /v"version 5.0" (string)

Compiler options can appear in any order.
On Windows* systems, all compiler options must precede /1ink options, if any, on the command line.
Unless you specify certain options, the command line will both compile and link the files you specify.

You can abbreviate some option names, entering as many characters as are needed to uniquely identify the
option.

Certain options accept one or more keyword arguments following the option name. For example, the x option
accepts several keywords.

To specify multiple keywords, you typically specify the option multiple times.

NOTE
On Windows* systems, you can sometimes use a comma to separate keywords. For example, the
following is valid:

ifort /warn:usage,declarations test.f90
On these systems, you can use an equals sign (=) instead of the colon:

ifort /warn=usage,declarations test.f90
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Compiler options remain in effect for the whole compilation unless overridden by a compiler directive.
To disable an option, specify the negative form of the option.

On Windows* systems, you can also disable one or more optimization options by specifying option /0d last
on the command line.

NOTE

On Windows* systems, the /0d option is part of a mutually-exclusive group of options that

includes /04, /01, /02, /03, and /0x. The last of any of these options specified on the command line
will override the previous options from this group.

If there are enabling and disabling versions of an option on the command line, the last one on the command
line takes precedence.

How We Refer to Compiler Option Names in Descriptions
The following conventions are used as shortcuts when referencing compiler option names in descriptions:

e Many options have names that are the same on Linux*, macOS*, and Windows*. However, the Windows
form starts with an initial / and the Linux and macOS* form starts with an initial -. Within text, such
option names are shown without the initial character; for example, check.

e Many options have names that are the same on Linux*, macOS*, and Windows*, except that the
Windows form starts with an initial Q. Within text, such option names are shown as [Q]option-name.

For example, if you see a reference to [Q] ipo, the Linux* and macOS* form of the option is -ipo and the
Windows form of the option is /Qipo.

e Several compiler options have similar names except that the Linux* and macOS* forms start with an
initial g and the Windows form starts with an initial Q. Within text, such option names are shown as
[g or Qloption-name.

For example, if you see a reference to [g or Q]opt-report, the Linux* and macOS* form of the option
is —qopt-report and the Windows form of the option is /Qopt-report.

Compiler option names that are more dissimilar are shown in full.

What Appears in the Compiler Option Descriptions
This section contains details about what appears in the option descriptions.

Following sections include individual descriptions of all the current compiler options. The option descriptions
are arranged by functional category. Within each category, the option names are listed in alphabetical order.

Each option description contains the following information:

e The primary name for the option and a short description of the option.
e Architecture Restrictions

This section only appears if there is a known architecture restriction for the option.
Restrictions can appear for any of the following architectures:

e IA-32 architecture
o Intel® 64 architecture

Certain operating systems are not available on all the above architectures. For the latest information,
check your Release Notes.
e Syntax

This section shows the syntax on Linux* and macOS* systems and the syntax on Windows* systems. If
the option is not valid on a particular operating system, it will specify "None".
e Arguments
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This section shows any arguments (parameters) that are related to the option. If the option has no
arguments, it will specify "None".
e Default

This section shows the default setting for the option.
e Description

This section shows the full description of the option. It may also include further information on any
applicable arguments.
e IDE Equivalent

This section shows information related to the Intel® Integrated Development Environment (Intel® IDE)
Property Pages on Linux*, macOS*, and Windows* systems. It shows on which Property Page the option
appears, and under what category it's listed. The Windows* IDE is Microsoft* Visual Studio* .NET. If the
option has no IDE equivalent, it will specify "None". Note that in this release, there is no IDE support for
Fortran on Linux*.

e Alternate Options

This section lists any options that are synonyms for the described option. If there are no alternate option
names, it will show "None".

Some alternate option names are deprecated and may be removed in future releases.

Many options have an older spelling where underscores ("_") instead of hyphens ("-") connect the main
option names. The older spelling is a valid alternate option name.

Some option descriptions may also have the following:
e Example (or Examples)

This section shows one or more examples that demonstrate the option.
e See Also

This section shows where you can get further information on the option or it shows related options.

Offload Options (Linux* only)

This section contains descriptions for compiler options that pertain to offloading.

qoffload

Lets you specify the mode for offloading or tell the
compiler to ignore language constructs for offloading.
This is a deprecated option. There is no replacement
option. This feature is only available for ifort.

Syntax
Linux OS:

-goffload[=keyword]
-gno-offload

macOS:

None

Windows OS:

None

Arguments

keyword Specifies the mode for offloading or it disables offloading. Possible values are:
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none Tells the compiler to ignore language constructs for offloading. Warnings are
issued by the compiler. This is equivalent to the negative form of the option.

mandatory Specifies that offloading is mandatory (required). If the target is not
available, one of the following occurs:

e If no STATUS clause is specified for the OFFLOAD directive, the program
fails with an error message.

e If the STATUS clause is specified, the program continues execution on the
CPU.

optional Specifies that offloading is optional (requested). If the target is not available,
the program is executed on the CPU, not the target.

Default

mandatory The compiler recognizes language constructs for offloading if they are
specified. If option —-goffload is specified with no keyword, the
default is mandatory.

Description

This option lets you specify the mode for offloading or tell the compiler to ignore language constructs for
offloading.

Option -g[no-]offload is the replacement option for - [no-]offload, which is deprecated.
If no —-goffload option appears on the command line, then OFFLOAD directives are processed and:

e The MANDATORY or OPTIONAL clauses are obeyed if present
o If no MANDATORY or OPTIONAL clause is present, the offload is mandatory

If —-goffload=none or -gno-offload appears on the command line, then OFFLOAD directives are ignored:

However, OpenMP* directives for processor control (for example, !$OMP TARGET) are recognized if the
[g or Q]openmp option is specified, regardless of whether or not OFFLOAD directives are recognized or
ignored.

If keyword mandatory or optional appears for —-goffload, then OFFLOAD directives are processed and:

e The MANDATORY or OPTIONAL clauses are obeyed, regardless of the -qoffload keyword specified.
o If no MANDATORY or OPTIONAL clause is present, then the -qoffload keyword is obeyed.

If the STATUS clause is specified for an OFFLOAD directive, it affects run-time behavior.

IDE Equivalent

None

Alternate Options

None

See Also
Supported Environment Variables

Optimization Options

This section contains descriptions for compiler options that pertain to optimization.
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falias, Oa

Specifies whether or not a procedure call may have
hidden aliases of local variables not supplied as actual
arguments.

Syntax
Linux OS:
-falias
-fno-alias
macOS:
-falias
-fno-alias
Windows OS:
/Oa

/Oa-

Arguments

None
Default

—fno-alias Procedure calls do not alias local variables.
or /Oa

Description

This option specifies whether or not the compiler can assume that during a procedure call, local variables in
the caller that are not present in the actual argument list and not visible by host association, are not
referenced or redefined due to hidden aliasing. The Fortran standard generally prohibits such aliasing.

If you specify -falias (Linux* and macOS*) or /0a- (Windows*), aliasing during a procedure call is
assumed; this can possibly affect performance.

If you specify -fno-alias or /0a (the default), aliasing during a procedure call is not assumed.

IDE Equivalent

None

Alternate Options
None

See Also
ffnalias compiler option

fast
Maximizes speed across the entire program.

Syntax
Linux OS:

-fast
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macOS:
-fast
Windows OS:

/fast

Arguments

None

Default

OFF The optimizations that maximize speed are not enabled.

Description
This option maximizes speed across the entire program.
It sets the following options:

e On macOS* systems: -ipo, -mdynamic-no-pic,-03, -no-prec-div,-fp-model fast=2, and -xHost
e On Windows* systems: /03, /Qipo, /Qprec-div-, /fp:fast=2, and /QxHost
e On Linux* systems: -ipo, -03, -no-prec-div,-static, ~-fp-model fast=2, and -xHost

When option fast is specified, you can override the [Q] xHost option setting by specifying a different
processor-specific [Q]x option on the command line. However, the last option specified on the command line
takes precedence.

For example:

e On Linux* systems, if you specify option -fast -xSSE3, option -xSSE3 takes effect. However, if you
specify -xSSE3 -fast, option -xHost takes effect.

e On Windows* systems, if you specify option /fast /QxSSE3, option/QxSSE3 takes effect. However, if you
specify /QxSSE3 /fast, option /QxHost takes effect.

For implications on non-Intel processors, refer to the [Q] xHost documentation.

NOTE

Option fast sets some aggressive optimizations that may not be appropriate for all
applications. The resulting executable may not run on processor types different from the one
on which you compile. You should make sure that you understand the individual
optimization options that are enabled by option fast.

Product and Performance Information

Performance varies by use, configuration and other factors. Learn more at www.Intel.com/
Performancelndex.

Notice revision #20201201

IDE Equivalent

None

Alternate Options

None
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See Also
fp-model, fp compiler option
XHost, QxHost

compiler option

X, QX

compiler option

ffnalias, Ow

Determines whether aliasing is assumed within
functions. This feature is only available for ifort.

Syntax

Linux OS:
-ffnalias
-fno-fnalias
macOS:
-ffnalias
-fno-fnalias
Windows OS:
/Ow

/Ow—
Arguments
None

Default
—ffnalias Aliasing is assumed within functions.

or /Oow

Description
This option determines whether aliasing is assumed within functions.

If you specify -fno-fnalias or /Ow-, aliasing is not assumed within functions, but it is assumed across
calls.

If you specify -ffnalias or /Ow, aliasing is assumed within functions.

IDE Equivalent

None

Alternate Options

None

See Also
falias compiler option
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foptimize-sibling-calls
Determines whether the compiler optimizes tail
recursive calls. This feature is only available for ifort.

Syntax

Linux OS:
-foptimize-sibling-calls
-fno-optimize-sibling-calls
macOS:
-foptimize-sibling-calls
-fno-optimize-sibling-calls
Windows OS:

None

Arguments

None

Default

~foptimize-sibling-calls The compiler optimizes tail recursive calls.

Description

This option determines whether the compiler optimizes tail recursive calls. It enables conversion of tail
recursion into loops.

If you do not want to optimize tail recursive calls, specify -fno-optimize-sibling-calls.

Tail recursion is a special form of recursion that doesn't use stack space. In tail recursion, a recursive call is
converted to a GOTO statement that returns to the beginning of the function. In this case, the return value of
the recursive call is only used to be returned. It is not used in another expression. The recursive function is
converted into a loop, which prevents modification of the stack space used.

IDE Equivalent

None

Alternate Options
None

fprotect-parens, Qprotect-parens

Determines whether the optimizer honors parentheses
when floating-point expressions are evaluated.

Syntax
Linux OS:

-fprotect-parens

-fno-protect-parens
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macOS:
-fprotect-parens
-fno-protect-parens
Windows OS:
/Qprotect-parens

/Qprotect-parens-

Arguments

None

Default

-fno-protect-parens Parentheses are ignored when determining the order of expression

or /Qprotect-parens-— evaluation.

Description

This option determines whether the optimizer honors parentheses when determining the order of floating-
point expression evaluation.

When option -fprotect-parens (Linux* and macOS*) or /Qprotect-parens (Windows*) is specified, the
optimizer will maintain the order of evaluation imposed by parentheses in the code.

When option -fno-protect-parens (Linux* and macOS*) or /Qprotect-parens- (Windows*) is specified,
the optimizer may reorder floating-point expressions without regard for parentheses if it produces faster
executing code.

IDE Equivalent

None

Alternate Options
Linux and macOS*: -assume protect parens

Windows: /assume:protect parens

Example

Consider the following expression:
A+ (B+C)

By default, the parentheses are ignored and the compiler is free to re-order the floating-point operations
based on the optimization level, the setting of option -fp-model (Linux* and macOS*) or /fp (Windows*),
etc. to produce faster code. Code that is sensitive to the order of operations may produce different results
(such as with some floating-point computations).

However, if -fprotect-parens (Linux* and macOS*) or /Qprotect-parens (Windows*) is specified,
parentheses around floating-point expressions (including complex floating-point and decimal floating-point)
are honored and the expression will be interpreted following the normal precedence rules, that is, B+C will
be computed first and then added to A.

This may produce slower code than when parentheses are ignored. If floating-point sensitivity is a specific
concern, you should use option -fp-model precise (Linux* and macOS*) or /fp:precise (Windows*) to
ensure precision because it controls all optimizations that may affect precision.
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See Also
fp-model, fp compiler option

GF
Enables read-only string-pooling optimization.

Syntax
Linux OS:
None

macOS:

None

Windows OS:
/GF

Arguments

None

Default

OFF Read/write string-pooling optimization is enabled.

Description

This option enables read only string-pooling optimization.

IDE Equivalent

None

Alternate Options
None
nolib-inline

Disables inline expansion of standard library or
intrinsic functions.

Syntax

Linux OS:
-nolib-inline
macOS:
-nolib-inline
Windows OS:

None

Arguments

None
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Default
OFF The compiler inlines many standard library and intrinsic functions.
Description

This option disables inline expansion of standard library or intrinsic functions. It prevents the unexpected
results that can arise from inline expansion of these functions.

IDE Equivalent

None

Alternate Options

None

(0]

Specifies the code optimization for applications.

Syntax

Linux OS:

-0 [n]

macOS:

-0[n]

Windows OS:

/0[n]

Arguments

n Is the optimization level. Possible values are 1, 2, or 3. On Linux* and

macOS* systems, you can also specify 0.

Default

02 Optimizes for code speed. This default may change depending on which other compiler options
are specified. For details, see below.

Description

This option specifies the code optimization for applications.

Option Description
O (Linux* and macOS*) This is the same as specifying 02.
00 (Linux and macOS*) Disables all optimizations.

This option may set other options. This is determined by the compiler,
depending on which operating system and architecture you are using. The
options that are set may change from release to release.

This option causes certain warn options to be ignored. This is the default
if you specify option -debug (with no keyword).
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Option Description

01 Enables optimizations for speed and disables some optimizations that
increase code size and affect speed.
To limit code size, this option:

 Enables global optimization; this includes data-flow analysis, code
motion, strength reduction and test replacement, split-lifetime
analysis, and instruction scheduling.

This option may set other options. This is determined by the compiler,
depending on which operating system and architecture you are using. The
options that are set may change from release to release.

The 01 option may improve performance for applications with very large
code size, many branches, and execution time not dominated by code
within loops.

02 Enables optimizations for speed. This is the generally recommended
optimization level.
Vectorization is enabled at 02 and higher levels.

On systems using IA-32 architecture: Some basic loop optimizations such
as Distribution, Predicate Opt, Interchange, multi-versioning, and scalar
replacements are performed.

This option also enables:

e Inlining of intrinsics
e Intra-file interprocedural optimization, which includes:
¢ inlining
e constant propagation
e forward substitution
e routine attribute propagation
e variable address-taken analysis
e dead static function elimination
e removal of unreferenced variables
e The following capabilities for performance gain:

e constant propagation

e copy propagation

e dead-code elimination

¢ (global register allocation

e global instruction scheduling and control speculation
e loop unrolling

e optimized code selection

e partial redundancy elimination

e strength reduction/induction variable simplification
e variable renaming

e exception handling optimizations

e tail recursions

e peephole optimizations

e structure assignment lowering and optimizations

e dead store elimination
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Option

Description

03

This option may set other options, especially options that optimize for
code speed. This is determined by the compiler, depending on which
operating system and architecture you are using. The options that are set
may change from release to release.

On Windows* systems, this option is the same as the Ox option.

On Linux* and macOS* systems, if —-g is specified, 02 is turned off and 00
is the default unless 02 (or 01 or 03) is explicitly specified in the
command line together with -g.

On Linux systems, the -debug inline-debug-info option will be
enabled by default if you compile with optimizations (option -02 or
higher) and debugging is enabled (option -g).

Many routines in the shared libraries are more highly optimized for Intel®
microprocessors than for non-Intel microprocessors.

Performs 02 optimizations and enables more aggressive loop
transformations such as Fusion, Block-Unroll-and-Jam, and collapsing IF
statements.

This option may set other options. This is determined by the compiler,
depending on which operating system and architecture you are using. The
options that are set may change from release to release.

When 03 is used with options -ax or -x (Linux) or with options /Qax

or /0x (Windows), the compiler performs more aggressive data
dependency analysis than for 02, which may result in longer compilation
times.

The 03 optimizations may not cause higher performance unless loop and
memory access transformations take place. The optimizations may slow
down code in some cases compared to 02 optimizations.

The 03 option is recommended for applications that have loops that
heavily use floating-point calculations and process large data sets.

Many routines in the shared libraries are more highly optimized for Intel®
microprocessors than for non-Intel microprocessors.

The last 0 option specified on the command line takes precedence over any others.

IDE Equivalent

Windows

Visual Studio: General > Optimization (/0d, /01, /02, /03, /fast)

Optimization > Optimization (/0d, /01, /02, /03, /fast)

Alternate Options

02

See Also
od compiler option
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fltconsistency compiler option
fast compiler option

Od
Disables all optimizations.

Syntax
Linux OS:
None
macOS:
None

Windows OS:
/0d

Arguments

None

Default

OFF The compiler performs default optimizations.

Description

This option disables all optimizations. It can be used for selective optimizations, such as a combination of /0d
and /0b1 (disables all optimizations, but enables inlining).

This option also causes certain /warn options to be ignored.

On IA-32 architecture, this option sets the /0y- option.
IDE Equivalent

Windows

Visual Studio: Optimization > Optimization

Alternate Options
Linux and macOS*: -00

Windows: /optimize:0

See Also
0 compiler option (see 00)

Ofast

Sets certain aggressive options to improve the speed
of your application.

Syntax

Linux OS:
-Ofast
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macOS:
-Ofast
Windows OS:

None

Arguments

None

Default

OFF The aggressive optimizations that improve speed are not enabled.

Description
This option improves the speed of your application.
It sets compiler options -03, -no-prec-div, and -fp-model fast=2.

On Linux* systems, this option is provided for compatibility with gcc.

IDE Equivalent

None

Alternate Options

None

See Also

o0 compiler option

prec-div, Qprec-div compiler option
fast compiler option

fp-model, fp compiler option

Os

Enables optimizations that do not increase code size;
it produces smaller code size than O2.

Syntax
Linux OS:
-Os

macOS:

-Os
Windows OS:

/0Os

Arguments

None
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Default
OFF Optimizations are made for code speed. However, if 01 is specified, Os is the default.
Description

This option enables optimizations that do not increase code size; it produces smaller code size than 02. It
disables some optimizations that increase code size for a small speed benefit.

This option tells the compiler to favor transformations that reduce code size over transformations that
produce maximum performance.

IDE Equivalent

Visual Studio

Visual Studio: Optimization > Favor Size or Speed

Alternate Options

None

See Also
0 compiler option
ot compiler option

Ot
Enables all speed optimizations.

Syntax
Linux OS:

None

macOS:

None

Windows OS:
/0t

Arguments

None
Default

/ot Optimizations are made for code speed.

If od is specified, all optimizations are disabled. If 01 is specified, Os is the default.

Description

This option enables all speed optimizations.
IDE Equivalent

Windows

Visual Studio: Optimization > Favor Size or Speed (/0t, /0Os)
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Alternate Options

None

See Also

o0 compiler option
0s compiler option

Code Generation Options

This section contains descriptions for compiler options that pertain to code generation.

arch

Tells the compiler which features it may target,
including which instruction sets it may generate.

Syntax
Linux OS:
—-arch code

macOS:

-arch code

Windows OS:

/arch: code
Arguments

code
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Indicates to the compiler a feature set that it may target, including which instruction sets it
may generate. Many of the following descriptions refer to Intel® Streaming SIMD Extensions
(Intel® SSE) and Supplemental Streaming SIMD Extensions (SSSE). Possible values are:

ALDERLAKE May generate instructions for processors that support the
AMBERLAKE specified Intel® processor or microarchitecture code name.

BROADWELL Keyword ICELAKE is deprecated and may be removed in a
CANNONLAKE future release.

CASCADELAKE
COFFEELAKE
COOPERLAKE
GOLDMONT
GOLDMONT-PLUS
HASWELL
ICELAKE-CLIENT (or ICELAKE)
ICELAKE-SERVER
IVYBRIDGE
KABYLAKE

KNL

KNM

ROCKETLAKE
SANDYBRIDGE
SAPPHIRERAPIDS
SILVERMONT
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Windows and Linux systems:

Description

SKYLAKE
SKYLAKE-AVX512
TIGERLAKE
TREMONT
WHISKEYLAKE

CORE-AVX2

CORE-AVX-I

AVX

SSE4.2

SSE4.1

SSSE3

SSE3

SSE2

SSE

IA32

macOS* systems: SSSE3

May generate Intel® Advanced Vector Extensions 2 (Intel®
AVX2), Intel® AVX, SSE4.2, SSE4.1, SSE3, SSE2, SSE, and
SSSE3 instructions.

May generate the RDRND instruction, Intel® Advanced
Vector Extensions (Intel® AVX), Intel® SSE4.2, SSE4.1,
SSE3, SSE2, SSE, and SSSE3 instructions.

May generate Intel® Advanced Vector Extensions (Intel®
AVX), Intel® SSE4.2, SSE4.1, SSE3, SSE2, SSE, and SSSE3
instructions.

May generate Intel® SSE4.2, SSE4.1, SSE3, SSE2, SSE,
and SSSE3 instructions.

May generate Intel® SSE4.1, SSE3, SSE2, SSE, and SSSE3
instructions.

May generate SSSE3 instructions and Intel® SSE3, SSE2,
and SSE instructions.

May generate Intel® SSE3, SSE2, and SSE instructions.

May generate Intel® SSE2 and SSE instructions. This value
is only available on Linux* and Windows* systems.

This option has been deprecated; it is now the same as
specifying IA32.

Generates x86/x87 generic code that is compatible with
IA-32 architecture. Disables any default extended
instruction settings, and any previously set extended
instruction settings. It also disables all feature-specific
optimizations and instructions.

This value is only available on Linux* and Windows*
systems using IA-32 architecture. IA-32 support is
deprecated, and will be removed in a future release.

For more information on the default values, see Arguments above.

This option tells the compiler which features it may target, including which instruction sets it may generate.

Code generated with these options should execute on any compatible, non-Intel processor with support for
the corresponding instruction set.
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Options /arch and /Qx are mutually exclusive. If both are specified, the compiler uses the last one specified
and generates a warning.

If you specify both the /Qax and /arch options, the compiler will not generate Intel-specific instructions.

For compatibility with Compag* Visual Fortran, the compiler allows the following keyword values. However,
you should use the suggested replacements.

Compatibility Value Suggested Replacement on Linux* and Windows*

pnl -mia32 or /arch:IA32
pn2 -mia32 or /arch:IA32
pn3 -mia32 or /arch:IA32
pné -msse2 Or /arch:SSE2

IDE Equivalent

Visual Studio

Visual Studio: Code Generation > Enable Enhanced Instruction Set

Alternate Options

None

See Also

x, Ox compiler option

xHost, OxHost compiler option
ax, Qax compiler option

arch compiler option

march compiler option

m compiler option

m32, m64 compiler option

ax, Qax

Tells the compiler to generate multiple, feature-
specific auto-dispatch code paths for Intel® processors
if there is a performance benefit. This feature is only
available for ifort.

Syntax
Linux OS:
—-axcode

macOS:

—axcode

Windows OS:

/Qaxcode
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Arguments

code

Indicates to the compiler a feature set that it may target, including which instruction sets it
may generate. The following descriptions refer to Intel® Streaming SIMD Extensions (Intel®
SSE) and Supplemental Streaming SIMD Extensions (SSSE). Possible values are:

ALDERLAKE May generate instructions for processors that support the
AMBERLAKE specified Intel® processor or microarchitecture code name.
BROADWELL Keywords KNL and SILVERMONT are only available on
CANNONLAKE Windows* and Linux* systems.
CASCADELAKE ) ]
Keyword ICELAKE is deprecated and may be removed in a
COFFEELAKE
future release.
COOPERLAKE
GOLDMONT
GOLDMONT-PLUS
HASWELL

ICELAKE-CLIENT (or ICELAKE)
ICELAKE-SERVER

IVYBRIDGE

KABYLAKE

KNL

KNM

ROCKETLAKE

SANDYBRIDGE

SAPPHIRERAPIDS

SILVERMONT

SKYLAKE

SKYLAKE-AVX512

TIGERLAKE

TREMONT

WHISKEYLAKE

COMMON-AVX51 2 May generate Intel® Advanced Vector Extensions 512
(Intel® AVX-512) Foundation instructions, Intel® AVX-512
Conflict Detection Instructions (CDI), as well as the
instructions enabled with CORE-AVX2.

CORE-AVX512 May generate Intel® Advanced Vector Extensions 512
(Intel® AVX-512) Foundation instructions, Intel® AVX-512
Conflict Detection Instructions (CDI), Intel® AVX-512
Doubleword and Quadword Instructions (DQI), Intel®
AVX-512 Byte and Word Instructions (BWI) and Intel®
AVX-512 Vector Length extensions, as well as the
instructions enabled with CORE-AVX2.

CORE-AVX2 May generate Intel® Advanced Vector Extensions 2 (Intel®
AVX2), Intel® AVX, SSE4.2, SSE4.1, SSE3, SSE2, SSE, and
SSSE3 instructions for Intel® processors.

CORE—-AVX-T May generate the RDRND instruction, Intel® Advanced

Vector Extensions (Intel® AVX), Intel® SSE4.2, SSE4.1,
SSE3, SSE2, SSE, and SSSE3 instructions for Intel®
processors.
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AVX May generate Intel® Advanced Vector Extensions (Intel®
AVX), Intel® SSE4.2, SSE4.1, SSE3, SSE2, SSE, and SSSE3
instructions for Intel® processors.

SSE4.2 May generate Intel® SSE4.2, SSE4.1, SSE3, SSE2, SSE,
and SSSE3 instructions for Intel processors.

SSE4.1 May generate Intel® SSE4.1, SSE3, SSE2, SSE, and SSSE3
instructions for Intel® processors.

SSSE3 May generate SSSE3 instructions and Intel® SSE3, SSE2,
and SSE instructions for Intel® processors. For macOS*
systems, this value is only supported on Intel® 64
architecture. This replaces value T, which is deprecated.

SSE3 May generate Intel® SSE3, SSE2, and SSE instructions for
Intel® processors. This value is not available on macOS*
systems.

SSE2 May generate Intel® SSE2 and SSE instructions for Intel®

processors. This value is not available on macOS* systems.

You can specify more than one code value. When specifying more than one code value, each value must be
separated with a comma. See the Examples section below.

Default
OFF No auto-dispatch code is generated. Feature-specific code is generated and is controlled by the
setting of the following compiler options:
e Linux*: -m and -x
e Windows*: /arch and /Qx
e macOS*: -x
Description

This option tells the compiler to generate multiple, feature-specific auto-dispatch code paths for Intel®
processors if there is a performance benefit. It also generates a baseline code path. The Intel feature-specific
auto-dispatch path is usually more optimized than the baseline path. Other options, such as 03, control how
much optimization is performed on the baseline path.

The baseline code path is determined by the architecture specified by options -m or -x (Linux* and macOS*)
or options /arch or /0x (Windows*). While there are defaults for the [Q] x option that depend on the
operating system being used, you can specify an architecture and optimization level for the baseline code
that is higher or lower than the default. The specified architecture becomes the effective minimum
architecture for the baseline code path.

If you specify both the [Q]ax and [Q] x options, the baseline code will only execute on Intel® processors
compatible with the setting specified for the [Q]x.

If you specify both the -ax and -m options (Linux and macOS*) or the /Qax and /arch options (Windows),
the baseline code will execute on non-Intel® processors compatible with the setting specified for the -m
or /arch option.

A Non-Intel® baseline and an Intel® baseline have the same set of optimizations enabled, and the default for
both is SSE4.2 for x86-based architectures.

162



Compiler Reference

If you specify both the -ax and -march options (Linux and macOS*), or the /Qax and /arch options
(Windows), the compiler will not generate Intel-specific instructions. This is because specifying -march
disables -ax and specifying /arch disables /Qax.

The [Q]ax option tells the compiler to find opportunities to generate separate versions of functions that take
advantage of features of the specified instruction features.

If the compiler finds such an opportunity, it first checks whether generating a feature-specific version of a
function is likely to result in a performance gain. If this is the case, the compiler generates both a feature-
specific version of a function and a baseline version of the function. At run time, one of the versions is
chosen to execute, depending on the Intel® processor in use. In this way, the program can benefit from
performance gains on more advanced Intel processors, while still working properly on older processors and
non-Intel processors. A non-Intel processor always executes the baseline code path.

You can use more than one of the feature values by combining them. For example, you can specify
-axSSE4.1,SSSE3 (Linux and macOS*) or /QaxSSE4.1, SSSE3 (Windows). You cannot combine the old

style, deprecated options and the new options. For example, you cannot specify —axSSE4.1, T (Linux and
macOS*) or /QaxSSE4.1, T (Windows).

Product and Performance Information

Performance varies by use, configuration and other factors. Learn more at www.Intel.com/
Performancelndex.

Notice revision #20201201

IDE Equivalent

Visual Studio
Visual Studio: Code Generation > Add Processor-Optimized Code Path

Alternate Options

None

Examples

The following shows an example of how to specify this option:

ifort -axSKYLAKE file.cpp ! Linux* and macOS*systems
ifort /QaxSKYLAKE file.cpp ! Windows* systems

The following shows an example of how to specify more than one code value:

ifort -axSKYLAKE,BROADWELL file.cpp ! Linux* and macOS*systems
ifort /QaxBROADWELL,SKYLAKE file.cpp ! Windows* systems

Note that the comma-separated list must have no spaces between the names.

See Also

x, Ox compiler option

xHost, OxHost compiler option
march compiler option

arch compiler option

m compiler option

fasynchronous-unwind-tables

Determines whether unwind information is precise at
an instruction boundary or at a call boundary.
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Syntax
Linux OS:

-fasynchronous-unwind-tables

-fno-asynchronous-unwind-tables

macOS:
-fasynchronous-unwind-tables

-fno-asynchronous-unwind-tables

Windows OS:

None

Arguments

None
Default

Intel® 64 architecture: The unwind table generated is precise at an instruction boundary,
-fasynchronous-unwind-tables €nabling accurate unwinding at any instruction.

IA-32 architecture (Linux* only): The unwind table generated is precise at call boundaries only.

-fno-asynchronous-unwind-tables

Description

This option determines whether unwind information is precise at an instruction boundary or at a call
boundary. The compiler generates an unwind table in DWARF2 or DWARF3 format, depending on which
format is supported on your system.

If -fno-asynchronous-unwind-tables is specified, the unwind table is precise at call boundaries only. In
this case, the compiler will avoid creating unwind tables for routines such as the following:

e A C++ routine that does not declare objects with destructors and does not contain calls to routines that
might throw an exception.

e A C/C++ or Fortran routine compiled without -fexceptions, and on Intel® 64 architecture, without
-traceback.

e A C/C++ or Fortran routine compiled with -fexceptions that does not contain calls to routines that
might throw an exception.

IDE Equivalent

None

Alternate Options

None

See Also
fexceptions compiler option

fcf-protection, Qcf-protection

Enables Intel® Control-Flow Enforcement Technology
(Intel® CET) protection, which defends your program
from certain attacks that exploit vulnerabilities. This
option offers preliminary support for Intel® CET.
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Syntax
Linux OS:
-fcf-protection[=keyword]

macOS:

None

Windows OS:

/Qcf-protection]:keyword]

Arguments

keyword Specifies the level of protection the compiler should perform. Possible values are:

shadow stack Enables shadow stack protection.
branch tracking Enables endbranch (EB) generation.
full Enables both shadow stack protection and EB generation.

This is the same as specifying this compiler option with no keyword.

none Disables Intel® CET protection.

Default

-fcf-protection=none No Control-flow Enforcement protection is performed.

or /Qcf-protection:none

Description

This option enables Intel® CET protection, which defends your program from certain attacks that exploit
vulnerabilities.

Intel® CET protections are enforced on processors that support Intel® CET. They are ignored on processors
that do not support Intel® CET, so they are safe to use in programs that might run on a variety of processors.

Specifying shadow_stack helps to protect your program from return-oriented programming (ROP). Return-
oriented programming (ROP) is a technique to exploit computer security defenses such as non-executable
memory and code signing by gaining control of the call stack to modify program control flow and then
execute certain machine instruction sequences.

Specifying branch_tracking helps to protect your program from call/jump-oriented programming (COP/
JOP). Jump-oriented programming (JOP) is a variant of ROP that uses indirect jumps and calls to emulate
return instructions. Call-oriented programming (COP) is a variant of ROP that employs indirect calls.

To get both protections, specify this compiler option with no keyword, or specify -fcf-protection=full
(Linux*) or /Qcf-protection: full (Windows*).
IDE Equivalent

None

Alternate Options
Linux and macOS*: -gcf-protection

Windows: None
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fexceptions

Enables exception handling table generation. This
feature is only available for ifort.

Syntax
Linux OS:
-fexceptions

-fno-exceptions

macOS:
-fexceptions

-fno-exceptions

Windows OS:

None

Arguments

None

Default

-fno-exceptions Exception handling table generation is disabled.

Description

This option enables C++ exception handling table generation, preventing Fortran routines in mixed-language
applications from interfering with exception handling between C++ routines. The -fno-exceptions option
disables C++ exception handling table generation, resulting in smaller code. When this option is used, any
use of C++ exception handling constructs (such as try blocks and throw statements) when a Fortran routine
is in the call chain will produce an error.

IDE Equivalent

None

Alternate Options

None

fomit-frame-pointer, Oy

Determines whether EBP is used as a general-purpose
register in optimizations. Option /Oy is deprecated and
will be removed in a future release.This feature is only
available for ifort.

Architecture Restrictions

Option /0y [-] is only available on IA-32 architecture. IA-32 support is deprecated and will be removed in a
future release.

Syntax
Linux OS:

-fomit-frame-pointer
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-fno-omit-frame-pointer
macOS:
-fomit-frame-pointer
-fno-omit-frame-pointer
Windows OS:

/0y

/0y-

Arguments

None
Default

-fomit-frame-pointer EBP is used as a general-purpose register in optimizations. However, on

or /Oy Linux* and macOS* systems, the default is -fno-omit-frame-pointer if
option -00 or —g is specified. On Windows* systems, the default is /0oy- if
option /0d is specified.

Description

These options determine whether EBP is used as a general-purpose register in optimizations. Option
-fomit-frame-pointer and option /Oy allows this use. Option —-fno-omit-frame-pointer and
option /0oy- disallows it.

Some debuggers expect EBP to be used as a stack frame pointer, and cannot produce a stack backtrace
unless this is so. The -fno-omit-frame-pointer and the /0y- option directs the compiler to generate code
that maintains and uses EBP as a stack frame pointer for all functions so that a debugger can still produce a
stack backtrace without doing the following:

e For -fno-omit-frame-pointer: turning off optimizations with -00
e For /oy-: turning off /01, /02, or /03 optimizations

The -fno-omit-frame-pointer option is set when you specify option -00 or the -g option. The
-fomit-frame-pointer option is set when you specify option -01, -02, or -03.

The /0y option is set when you specify the /01, /02, or /03 option. Option /0Oy- is set when you specify
the /0d option.

Using the -fno-omit-frame-pointer or /Oy- option reduces the number of available general-purpose
registers by 1, and can result in slightly less efficient code.

IDE Equivalent

Windows

Visual Studio: Optimization > Omit Frame Pointers

Alternate Options
Linux and macOS*: -fp (this is a deprecated option)

Windows: None

See Also
momit-leaf-frame-pointer compiler option
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guard
Enables the control flow protection mechanism.

Syntax

Linux OS:

None

macOS:

None

Windows OS:
/guard: keyword

Arguments
keyword Specifies the the control flow protection mechanism. Possible values are:

cfl-] Tells the compiler to analyze control flow of valid targets for indirect calls and to insert
code to verify the targets at runtime.

To explicitly disable this option, specify /guard:cf-.

Default

OFF The control flow protection mechanism is disabled.

Description

This option enables the control flow protection mechanism. It tells the compiler to analyze control flow of
valid targets for indirect calls and inserts a call to a checking routine before each indirect call to verify the
target of the given indirect call.

The /guard:cf option must be passed to both the compiler and linker.

Code compiled using /guard:cf can be linked to libraries and object files that are not compiled using the
option.

This option has been added for Microsoft compatibility. It uses the Microsoft implementation.

IDE Equivalent

None

Alternate Options
None

hotpatch

Tells the compiler to prepare a routine for
hotpatching. This feature is only available for ifort.

Syntax

Linux OS:
-hotpatch[=n]
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macOS:

None
Windows OS:
/hotpatch[:n]

Arguments

n An integer specifying the number of bytes the compiler should add
before the function entry point.

Default

OFF The compiler does not prepare routines for hotpatching.

Description

This option tells the compiler to prepare a routine for hotpatching. The compiler inserts nop padding around
function entry points so that the resulting image is hot patchable.

Specifically, the compiler adds nop bytes after each function entry point and enough nop bytes before the
function entry point to fit a direct jump instruction on the target architecture.

If n is specified, it overrides the default number of bytes that the compiler adds before the function entry
point.
IDE Equivalent

None

Alternate Options

None

m

Tells the compiler which features it may target,
including which instruction set architecture (ISA) it
may generate.

Syntax
Linux OS:
-mcode

macOS:

-mcode
Windows OS:
None
Arguments

code Indicates to the compiler a feature set that it may target, including which instruction sets it
may generate. Many of the following descriptions refer to Intel® Streaming SIMD Extensions
(Intel® SSE) and Supplemental Streaming SIMD Extensions (SSSE). Possible values are:
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avx May generate Intel® Advanced Vector Extensions (Intel®
AVX), SSE4.2, SSE4.1, SSE3, SSE2, SSE, and SSSE3
instructions.

ssed.? May generate Intel® SSE4.2, SSE4.1, SSE3, SSE2, SSE,
and SSSE3 instructions.

ssed.1 May generate Intel® SSE4.1, SSE3, SSE2, SSE, and SSSE3
instructions.

ssse3 May generate SSSE3 instructions and Intel® SSE3, SSE2,
and SSE instructions.

sse3l May generate Intel® SSE3, SSE2, and SSE instructions.

sse? May generate Intel® SSE2 and SSE instructions. This value

is only available on Linux systems.

sse This setting has been deprecated; it is the same as
specifying ia32.

ia3?2 Generates x86/x87 generic code that is compatible with
IA-32 architecture. Disables any default extended
instruction settings, and any previously set extended
instruction settings. It also disables all feature-specific
optimizations and instructions.

This value is only available on Linux* systems using IA-32
architecture. IA-32 support is deprecated and will be
removed in a future release.

This compiler option also supports many of the -m option settings available with gcc. For
more information on gcc settings for -m, see the gcc documentation.

Default

Linux* systems: -msse2 For more information on the default values, see Arguments above.
macOS* systems: -mssse3

Description
This option tells the compiler which features it may target, including which instruction sets it may generate.

Code generated with these options should execute on any compatible, non-Intel processor with support for
the corresponding instruction set.

Linux* systems: For compatibility with gcc, the compiler allows the following options but they have no effect.
You will get a warning error, but the instructions associated with the name will not be generated. You should
use the suggested replacement options.

gcc Compatibility Option (Linux*) Suggested Replacement Option

-mfma -march=core-avx2

-mbmi, -mavx2, -mlzcnt -march=core-avx2

-mmovbe -march=atom -minstruction=movbe
-mcrc32, -maes, -mpclmul, -mpopcnt -march=corei?
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-mvzeroupper

-mfsgsbase, -mrdrnd, -mfléc

IDE Equivalent

None

Alternate Options

None

See Also

x, Ox compiler option

xHost, OxHost compiler option
ax, Qax compiler option

arch compiler option

march compiler option

m32, m64 compiler option

m32, m64, Qm32, Qm64

Tells the compiler to generate code for a specific
architecture. Option m32 (and /Qm32) is deprecated
and will be removed in a future release. 32-bit options
are only available for ifort.

Syntax

Linux OS:

-m32 (ifort only)
-m64

macOS:

-m64 (ifort only)
Windows OS:

/Qm32 (ifort only)

-march=corei7-avx

-march=core-avx-i

/Qm64

Arguments

None

Default

OFF The compiler's behavior depends on the host system.
Description

These options tell the compiler to generate code for a specific architecture.
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Option

Description

-m32 or /Qm32

-m64 or /Qmé64

Tells the compiler to generate code for IA-32
architecture. IA-32 support is deprecated and will
be removed in a future release. 32-bit options are
only available for i fort.

Tells the compiler to generate code for Intel® 64
architecture.

For ifort, the -m64 option is the same as macOS* option ~arch x86_64. This option is not related to the

Intel®Fortran Compiler option arch.

On Linux* systems, these options are provided for compatibility with gcc.

IDE Equivalent

None
Alternate Options

None

m80387
Specifies whether the compiler can use x87

instructions. This feature is only available for ifort.

Syntax
Linux OS:
-m80387
-mno-80387
macOS:
-m80387
-mno-80387
Windows OS:

None

Arguments

None
Default

-m80387

Description

The compiler may use x87 instructions.

This option specifies whether the compiler can use x87 instructions.

If you specify option -mno-80387, it prevents the compiler from using x87 instructions. If the compiler is
forced to generate x87 instructions, it issues an error message.

IDE Equivalent

None
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Alternate Options

-m[no-]x87

march

Tells the compiler to generate code for processors that
support certain features.

Syntax
Linux OS:

-march=processor

macOS:

-march=processor

Windows OS:

None
Arguments

processor

Tells the compiler the code it can generate. Possible values are:

alderlake
amberlake
broadwell
cannonlake
cascadelake
coffeelake
cooperlake
goldmont
goldmont-plus
haswell

icelake-client (or

icelake)
icelake-server
ivybridge
kabylake

knl

knm

rocketlake
sandybridge
sapphirerapids
silvermont
skylake
skylake-avx512
tigerlake
tremont
whiskeylake

core-avx2

May generate instructions for processors that support
the specified Intel® processor or microarchitecture code
name.

Keywords knl and silvermont are only available on
Linux* systems.

Keyword icelake is deprecated and may be removed
in a future release.

Generates code for processors that support Intel®
Advanced Vector Extensions 2 (Intel® AVX2), Intel®
AVX, SSE4.2, SSE4.1, SSE3, SSE2, SSE, and SSSE3
instructions.
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Generates code for processors that support the RDRND
instruction, Intel® Advanced Vector Extensions (Intel®
AVX), Intel® SSE4.2, SSE4.1, SSE3, SSE2, SSE, and
SSSE3 instructions.

core-avx-i

corei7-avx Generates code for processors that support Intel®
Advanced Vector Extensions (Intel® AVX), Intel®
SSE4.2, SSE4.1, SSE3, SSE2, SSE, and SSSE3
instructions.

Generates code for processors that support Intel® SSE4
Efficient Accelerated String and Text Processing
instructions. May also generate code for Intel® SSE4
Vectorizing Compiler and Media Accelerator, Intel®
SSE3, SSE2, SSE, and SSSE3 instructions.

corei’

Generates code for processors that support MOVBE
instructions, depending on the setting of option
-minstruction (Linux* and macOS*)

or /Qinstruction (Windows*). May also generate
code for SSSE3 instructions and Intel® SSE3, SSE2, and
SSE instructions.

atom

core? Generates code for the Intel® Core™2 processor family.

Generates for Intel® Pentium® 4 processors with MMX
technology.

pentiumdm

Generates code for Intel® Pentium® processors. Value
pentium3 is only available on Linux* systems.

pentium-m

pentiumé
pentium3
pentium
Default
pentium4 If no architecture option is specified, value pentium4 is used by the compiler to
generate code.
Description

This option tells the compiler to generate code for processors that support certain features.
If you specify both the -ax and -march options, the compiler will not generate Intel-specific instructions.

Options -x and -march are mutually exclusive. If both are specified, the compiler uses the last one specified
and generates a warning.

Specifying -march=pentium4 sets -mtune=pentium4.

For compatibility, a number of historical processor values are also supported, but the generated code will not
differ from the default.

Product and Performance Information

Performance varies by use, configuration and other factors. Learn more at www.Intel.com/
Performancelndex.

Notice revision #20201201
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IDE Equivalent

None
Alternate Options

-march=pentium3 Linux: -xSSE

macOS*: None

Windows: None

-march=pentiumd Linux: -xSSE2
-march=pentium-m macOS*: None

Windows: None

-march=core? Linux: —xSSSE3
macOS*: None

Windows: None

See Also

xHost, OxHost compiler option

%, Ox compiler option

ax, Qax compiler option

arch compiler option

minstruction, Qinstruction compiler option
m compiler option

masm

Tells the compiler to generate the assembler output
file using a selected dialect.

Syntax
Linux OS:

-masm=dialect

macOS:

None

Windows OS:

None

Arguments

dialect Is the dialect to use for the assembler output file. Possible values are:

att Tells the compiler to generate the assembler
output file using AT&T* syntax.

intel Tells the compiler to generate the assembler
output file using Intel syntax.
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Default

—masm=att The compiler generates the assembler output file using AT&T* syntax.

Description

This option tells the compiler to generate the assembler output file using a selected dialect.

IDE Equivalent

None

Alternate Options

None

mauto-arch, Qauto-arch

Tells the compiler to generate multiple, feature-
specific auto-dispatch code paths for x86 architecture
processors if there is a performance benefit. This
feature is only available for ifort.

Syntax
Linux OS:

-mauto-arch=value

macOS:

-mauto-arch=value
Windows OS:
/Qauto-arch:value
Arguments

value Is any setting you can specify for option [Q]ax.

Default

OFF No additional execution path is generated.

Description

This option tells the compiler to generate multiple, feature-specific auto-dispatch code paths for x86
architecture processors if there is a performance benefit. It also generates a baseline code path.

This option cannot be used together with any options that may require Intel-specific optimizations (such as
[Qlx or [Q]ax).

IDE Equivalent

None

Alternate Options

None

See Also
ax, Qax compiler option
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mbranches-within-32B-boundaries, Qbranches-within-32B-boundaries

Tells the compiler to align branches and fused
branches on 32-byte boundaries for better
performance.

Syntax

Linux OS:
-mbranches-within-32B-boundaries
-mno-branches-within-32B-boundaries
macOS:
-mbranches-within-32B-boundaries
-mno-branches-within-32B-boundaries
Windows OS:
/Qbranches-within-32B-boundaries

/Qbranches-within-32B-boundaries-

Arguments

None
Default

—mno-branches-within-32B-boundaries Branches and fused branches are not aligned on 32-

or /Qbranches-within-32B-boundaries- byte boundaries.

Description

This option tells the compiler to align branches and fused branches on 32-byte boundaries for better
performance.

NOTE
When you use this option, it may affect binary utilities usage experience, such as
debugability.

IDE Equivalent

None

Alternate Options

None

mconditional-branch, Qconditional-branch

Lets you identify and fix code that may be vulnerable
to speculative execution side-channel attacks, which
can leak your secure data as a result of bad
speculation of a conditional branch direction. This
feature is only available for ifort.
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Syntax
Linux OS:
-mconditional-branch=keyword

macOS:

-mconditional-branch=keyword

Windows OS:

/Qconditional-branch:keyword

Arguments

keyword Tells the compiler the action to take. Possible values are:

keep

pattern-report

pattern-fix

all-fix

all-fix-1lfence

all-fix-cmov

178

Tells the compiler to not attempt any vulnerable code detection
or fixing. This is equivalent to not specifying the
-mconditional-branch option.

Tells the compiler to perform a search of vulnerable code
patterns in the compilation and report all occurrences to
stderr.

Tells the compiler to perform a search of vulnerable code
patterns in the compilation and generate code to ensure that
the identified data accesses are not executed speculatively. It
will also report any fixed patterns to stderr.

This setting does not guarantee total mitigation, it only fixes
cases where all components of the vulnerability can be seen or
determined by the compiler. The pattern detection will be more
complete if advanced optimization options are specified or are
in effect, such as option 03 and option -ipo (or /Qipo).

Tells the compiler to fix all of the vulnerable code so that it is
either not executed speculatively, or there is no observable
side-channel created from their speculative execution. Since it
is a complete mitigation against Spectre variant 1 attacks, this
setting will have the most run-time performance cost.

In contrast to the pattern-fix setting, the compiler will not
attempt to identify the exact conditional branches that may
have led to the mis-speculated execution.

This is the same as specifying setting all1-fix.

Tells the compiler to treat any path where speculative
execution of a memory load creates vulnerability (if
mispredicted). The compiler automatically adds mitigation
code along any vulnerable paths found, but it uses a different
method then the one used for all-fix (or all-fix-1fence).

This method uses CMOVcc instruction execution, which
constrains speculative execution. Thus, it is used for keeping
track of the predicate value, which is updated on each
conditional branch.
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To prevent Spectre v.1 attack, each memory load that is
potentially vulnerable is bitwise ORed with the predicate to
mask out the loaded value if the code is on a mispredicted
path.

This is analogous to the Clang compiler's option to do
Speculative Load Hardening.

This setting is only supported on Intel® 64 architecture-based
systems.

Default

-mconditional-branch=keep The compiler does not attempt any vulnerable code

and /Qconditional-branch:keep detection or fixing.

Description

This option lets you identify code that may be vulnerable to speculative execution side-channel attacks,
which can leak your secure data as a result of bad speculation of a conditional branch direction. Depending
on the setting you choose, vulnerabilities may be detected and code may be generated to attempt to mitigate
the security risk.

IDE Equivalent

Visual Studio

Visual Studio: Code Generation > Spectre Variant 1 Mitigation

Alternate Options

None

minstruction, Qinstruction

Determines whether MOVBE instructions are
generated for certain Intel® processors. This feature is
only available for ifort.

Syntax
Linux OS:
-minstruction=[no]movbe

macOS:

-minstruction=[no]movbe

Windows OS:

/Qinstruction: [no]movbe
Arguments

None

Default

—minstruction=nomovbe The compiler does not generate MOVBE instructions

or/Qinstruction:nomovbe for Intel Atom® processors.
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Description

This option determines whether MOVBE instructions are generated for Intel Atom® processors. To use this
option, you must also specify [Q]xATOM SSSE3 or [Q]xATOM SSE4.2.

If -minstruction=movbe or /Qinstruction:movbe is specified, the following occurs:

e MOVBE instructions are generated that are specific to the Intel Atom® processor.

e Generated executables can only be run on Intel Atom® processors or processors that support
Supplemental Streaming SIMD Extensions 3 (Intel® SSSE3) or Intel® Streaming SIMD Extensions 4.2
(Intel® SSE4.2) and MOVBE.

If -minstruction=nomovbe Or /Qinstruction:nomovbe is specified, the following occurs:

e The compiler optimizes code for the Intel Atom® processor, but it does not generate MOVBE instructions.

e Generated executables can be run on non-Intel Atom® processors that support Intel® SSE3 or Intel®
SSE4.2.

IDE Equivalent

None

Alternate Options

None

See Also
x, Ox compiler option

momit-leaf-frame-pointer

Determines whether the frame pointer is omitted or
kept in leaf functions. This feature is only available for
ifort.

Syntax

Linux OS:
-momit-leaf-frame-pointer
-mno-omit-leaf-frame-pointer
macOS:
-momit-leaf-frame-pointer

-mno-omit-leaf-frame-pointer

Windows OS:

None

Arguments

None

Default

Varies If you specify option -fomit-frame-pointer (or it is set by default), the default is

-momit-leaf-frame-pointer. If you specify option -fno-omit-frame-pointer, the default is

-mno-omit-leaf-frame-pointer
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Description

This option determines whether the frame pointer is omitted or kept in leaf functions. It is related to option
-f[no-Jomit-frame-pointer and the setting for that option has an effect on this option.

Consider the following option combinations:

Option Combination

Result

-fomit-frame-pointer -momit-leaf-frame-pointer
or

-fomit-frame-pointer -mno-omit-leaf-frame-pointer

-fno-omit-frame-pointer -momit-leaf-frame-pointer

-fno-omit-frame-pointer -mno-omit-leaf-frame-pointer

Both combinations are the same as
specifying -fomit-frame-pointer.
Frame pointers are omitted for all
routines.

In this case, the frame pointer is
omitted for leaf routines, but other
routines will keep the frame pointer.

This is the intended effect of option
-momit-leaf-frame-pointer.

In this case,
-mno-omit-leaf-frame-pointer is
ignored since
-fno-omit-frame-pointer retains
frame pointers in all routines .

This combination is the same as
specifying
-fno-omit-frame-pointer.

This option is provided for compatibility with gcc.

IDE Equivalent

None

Alternate Options

None

See Also
fomit-frame-pointer, Oy compiler option

mstringop-inline-threshold, Qstringop-inline-threshold

Tells the compiler to not inline calls to buffer
manipulation functions such as memcpy and memset
when the number of bytes the functions handle are
known at compile time and greater than the specified
value. This feature is only available for ifort.

Syntax
Linux OS:
-mstringop-inline-threshold=val

macOS:

-mstringop-inline-threshold=val
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Windows OS:

/Qstringop-inline-threshold:val

Arguments

val Is a positive 32-bit integer. If the size is greater than val, the compiler
will never inline it.

Default

OFF The compiler uses its own heuristics to determine the default.

Description

This option tells the compiler to not inline calls to buffer manipulation functions such as memcpy and memset
when the number of bytes the functions handle are known at compile time and greater than the specified val.

IDE Equivalent

None

Alternate Options

None

See Also
mstringop-strategy, Qstringop-strategy compiler option

mstringop-strategy, Qstringop-strategy

Lets you override the internal decision heuristic for the
particular algorithm used when implementing buffer
manipulation functions such as memcpy and memset.
This feature is only available for ifort.

Syntax

Linux OS:
-mstringop-strategy=alg
macOS:
-mstringop-strategy=alg
Windows OS:
/Qstringop-strategy:alg

Arguments
alg Specifies the algorithm to use. Possible values are:
const size loop Tells the compiler to expand the string operations into an inline
- - loop when the size is known at compile time and it is not
greater than threshold value. Otherwise, the compiler uses its
own heuristics to decide how to implement the string
operation.
libcall Tells the compiler to use a library call when implementing

string operations.

182



Compiler Reference

rep Tells the compiler to use its own heuristics to decide what form
of rep movs | stos to use when inlining string operations.

Default

varies If optimization option Os is specified, the default is rep. Otherwise, the default is
const size loop.

Description

This option lets you override the internal decision heuristic for the particular algorithm used when
implementing buffer manipulation functions such as memcpy and memset.

This option may have no effect on compiler-generated string functions, for example, a call to memcpy
generated by the compiler to implement an array copy or structure copy.

IDE Equivalent

None

Alternate Options

None

See Also
mstringop-inline-threshold, Qstringop-inline-threshold compiler option
Os compiler option

mtune, tune

Performs optimizations for specific processors but
does not cause extended instruction sets to be used
(unlike -march).

Syntax

Linux OS:
-mtune=processor
macOS:

-mtune=processor

Windows OS:

/tune:processor

Arguments

processor Is the processor for which the compiler should perform optimizations. Possible values
are:
generic Optimizes code for the compiler's default behavior.
alderlake Optimizes code for processors that support the
amberlake specified Intel® processor or microarchitecture code
broadwell name.
cannonlake Keywords knl and silvermont are only available on
cascadelake Windows* and Linux* systems.
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coffeelake
cooperlake
goldmont
goldmont-plus
haswell

icelake-client (or

icelake)
icelake-server
ivybridge
kabylake

knl

knm

rocketlake
sandybridge
sapphirerapids
silvermont
skylake
skylake-avx512
tigerlake
tremont
whiskeylake

core-avx2

core-avx-i

corei7-avx

corei’

atom

core?2

Keyword icelake is deprecated and may be removed
in a future release.

Optimizes code for processors that support Intel®
Advanced Vector Extensions 2 (Intel® AVX2), Intel®
AVX, SSE4.2, SSE4.1, SSE3, SSE2, SSE, and SSSE3
instructions.

Optimizes code for processors that support the RDRND
instruction, Intel® Advanced Vector Extensions (Intel®
AVX), Intel® SSE4.2, SSE4.1, SSE3, SSE2, SSE, and
SSSE3 instructions.

Optimizes code for processors that support Intel®
Advanced Vector Extensions (Intel® AVX), Intel®
SSE4.2, SSE4.1, SSE3, SSE2, SSE, and SSSE3
instructions.

Optimizes code for processors that support Intel® SSE4
Efficient Accelerated String and Text Processing
instructions. May also generate code for Intel® SSE4
Vectorizing Compiler and Media Accelerator, Intel®
SSE3, SSE2, SSE, and SSSE3 instructions.

Optimizes code for processors that support MOVBE
instructions, depending on the setting of option
-minstruction (Linux* and macOS*)

or /Qinstruction (Windows*). May also generate
code for SSSE3 instructions and Intel® SSE3, SSE2, and
SSE instructions.

Optimizes for the Intel® Core™2 processor family,
including support for MMX™, Intel® SSE, SSE2, SSE3
and SSSE3 instruction sets.
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pentium-mmx Optimizes for Intel® Pentium® with MMX technology.

Optimizes for Intel® Pentium® Pro, Intel Pentium II, and
Intel Pentium III processors.

pentiumpro

Optimizes for Intel® Pentium® 4 processors with MMX
technology.

pentiumédm

Optimizes code for Intel® Pentium® processors. Value
pentium3 is only available on Linux* systems.

pentium-m

pentiumé

pentium3

pentium
Default
generic Code is generated for the compiler's default behavior.
Description

This option performs optimizations for specific processors but does not cause extended instruction sets to be
used (unlike -march).

The resulting executable is backwards compatible and generated code is optimized for specific processors.
For example, code generated with —-mtune=core2 or /tune:core2 will run correctly on 4th Generation Intel®
Core™ processors, but it might not run as fast as if it had been generated using -mtune=haswell

or /tune:haswell. Code generated with -mtune=haswell (/tune:haswell) Or -mtune=core-avx2
(/tune:core-avx2) will also run correctly on Intel® Core™2 processors, but it might not run as fast as if it
had been generated using -mtune=core2 or /tune:core2. This is in contrast to code generated with
-march=core-avx2 Or /arch:core-avx2, which will not run correctly on older processors such as Intel®
Core™2 processors.

Product and Performance Information

Performance varies by use, configuration and other factors. Learn more at www.Intel.com/
Performancelndex.

Notice revision #20201201

IDE Equivalent

Windows

Visual Studio: Code Generation >Intel Processor Microarchitecture-Specific Optimization
Alternate Options
—mtune Linux: -mcpu (this is a deprecated option)

macOS*: None

Windows: None

See Also
march compiler option
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Qpatchable-addresses

Tells the compiler to generate code such that
references to statically assigned addresses can be
patched. This feature is only available for ifort.

Architecture Restrictions

Only available on Intel® 64 architecture

Syntax
Linux OS:

None
macOS:

None
Windows OS:

/Qpatchable-addresses

Arguments

None
Default

OFF The compiler does not generate patchable addresses.

Description

This option tells the compiler to generate code such that references to statically assigned addresses can be
patched with arbitrary 64-bit addresses.

Normally, the Windows* system compiler that runs on Intel® 64 architecture uses 32-bit relative addressing
to reference statically allocated code and data. That assumes the code or data is within 2GB of the access
point, an assumption that is enforced by the Windows object format.

However, in some patching systems, it is useful to have the ability to replace a global address with some
other arbitrary 64-bit address, one that might not be within 2GB of the access point.

This option causes the compiler to avoid 32-bit relative addressing in favor of 64-bit direct addressing so that
the addresses can be patched in place without additional code modifications. This option causes code size to
increase, and since 32-bit relative addressing is usually more efficient than 64-bit direct addressing, you may
see a performance impact.

IDE Equivalent

None

Alternate Options

None

X, Qx

Tells the compiler which processor features it may
target, including which instruction sets and
optimizations it may generate.
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Syntax
Linux OS:

-xcode

macOS:

-xcode

Windows OS:

/Qxcode
Arguments

code

Specifies a feature set that the compiler can target, including which instruction sets and
optimizations it may generate. Many of the following descriptions refer to Intel® Streaming
SIMD Extensions (Intel® SSE) and Supplemental Streaming SIMD Extensions (Intel® SSSE).

Possible values are:

ALDERLAKE
AMBERLAKE
BROADWELL
CANNONLAKE
CASCADELAKE
COFFEELAKE
COOPERLAKE
GOLDMONT
GOLDMONT-PLUS
HASWELL

ICELAKE-CLIENT (or ICELAKE)

ICELAKE-SERVER
IVYBRIDGE
KABYLAKE

KNL

KNM

ROCKETLAKE
SANDYBRIDGE
SAPPHIRERAPIDS
SILVERMONT
SKYLAKE
SKYLAKE-AVX512
TIGERLAKE
TREMONT
WHISKEYLAKE

COMMON-AVX512

CORE-AVX512

May generate instructions for processors that support the
specified Intel® processor or microarchitecture code name.
Optimizes for the specified Intel® processor or
microarchitecture code name.

Keywords KNL and SILVERMONT are only available on
Windows* and Linux* systems.

Keyword ICELAKE is deprecated and may be removed in a
future release.

May generate Intel® Advanced Vector Extensions 512
(Intel® AVX-512) Foundation instructions, Intel® AVX-512
Conflict Detection Instructions (CDI), as well as the
instructions enabled with CORE-AVX2. Optimizes for Intel®
processors that support Intel® AVX-512 instructions.

May generate Intel® Advanced Vector Extensions 512
(Intel® AVX-512) Foundation instructions, Intel® AVX-512
Conflict Detection Instructions (CDI), Intel® AVX-512
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CORE-AVX2

CORE-AVX-I

AVX

SSE4.2

SSE4.1

ATOM SSE4.2

ATOM SSSE3

Doubleword and Quadword Instructions (DQI), Intel®
AVX-512 Byte and Word Instructions (BWI) and Intel®
AVX-512 Vector Length Extensions, as well as the
instructions enabled with CORE-AVX2. Optimizes for Intel®
processors that support Intel® AVX-512 instructions.

May generate Intel® Advanced Vector Extensions 2 (Intel®
AVX2), Intel® AVX, SSE4.2, SSE4.1, SSE3, SSE2, SSE, and
SSSE3 instructions for Intel® processors. Optimizes for
Intel® processors that support Intel® AVX2 instructions.

May generate the RDRND instruction, Intel® Advanced
Vector Extensions (Intel® AVX), Intel® SSE4.2, SSE4.1,
SSE3, SSE2, SSE, and SSSE3 instructions for Intel®
processors. Optimizes for Intel® processors that support
the RDRND instruction.

May generate Intel® Advanced Vector Extensions (Intel®
AVX), Intel® SSE4.2, SSE4.1, SSE3, SSE2, SSE, and SSSE3
instructions for Intel® processors. Optimizes for Intel
processors that support Intel® AVX instructions.

May generate Intel® SSE4 Efficient Accelerated String and
Text Processing instructions, Intel® SSE4 Vectorizing
Compiler and Media Accelerator, and Intel® SSE3, SSE2,
SSE, and SSSE3 instructions for Intel® processors.
Optimizes for Intel processors that support Intel® SSE4.2
instructions.

May generate Intel® SSE4 Vectorizing Compiler and Media
Accelerator instructions for Intel® processors. May generate
Intel® SSE4.1, SSE3, SSE2, SSE, and SSSE3 instructions
for Intel processors that support Intel® SSE4.1 instructions.

May generate MOVBE instructions for Intel® processors,
depending on the setting of option -minstruction (Linux*
and macOS*) or /Qinstruction (Windows*). May also
generate Intel® SSE4.2, SSE3, SSE2, and SSE instructions
for Intel processors. Optimizes for Intel Atom® processors
that support Intel® SSE4.2 and MOVBE instructions.

This keyword is only available on Windows* and Linux*
systems.

May generate MOVBE instructions for Intel® processors,
depending on the setting of option -minstruction (Linux*
and macOS*) or /Qinstruction (Windows*). May also
generate SSSE3, Intel® SSE3, SSE2, and SSE instructions
for Intel processors. Optimizes for Intel Atom® processors
that support Intel® SSE3 and MOVBE instructions.

This keyword is only available on Windows* and Linux*
systems.
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SSSE3 May generate SSSE3 and Intel® SSE3, SSE2, and SSE
instructions for Intel® processors. Optimizes for Intel
processors that support SSSE3 instructions. For macOS*
systems, this value is only supported on Intel® 64
architecture. This replaces value T, which is deprecated.

SSE3 May generate Intel® SSE3, SSE2, and SSE instructions for
Intel® processors. Optimizes for Intel processors that
support Intel® SSE3 instructions. This value is not available
on macOS* systems.

SSE2 May generate Intel® SSE2 and SSE instructions for Intel®
processors. Optimizes for Intel processors that support
Intel® SSE2 instructions. This value is not available on
macOS* systems.

You can also specify a Host. For more information, see option [Q]xHost.

Default
Windows* systems: None On Windows systems, if neither /0x nor /arch is specified, the default
Linux* systems: None is /arch:SSE2.

3 .
macOS™ systems: SSSE3 On Linux systems, if neither -x nor -m is specified, the default is

-msse2.

Description

This option tells the compiler which processor features it may target, including which instruction sets and
optimizations it may generate. It also enables optimizations in addition to Intel feature-specific optimizations.

The specialized code generated by this option may only run on a subset of Intel® processors.

The resulting executables created from these option code values can only be run on Intel® processors that
support the indicated instruction set.

The binaries produced by these code values will run on Intel® processors that support the specified features.

Do not use code values to create binaries that will execute on a processor that is not compatible with the
targeted processor. The resulting program may fail with an illegal instruction exception or display other
unexpected behavior.

Compiling the main program with any of the code values produces binaries that display a fatal run-time error
if they are executed on unsupported processors, including all non-Intel processors.

Compiler options m and arch produce binaries that should run on processors not made by Intel that
implement the same capabilities as the corresponding Intel® processors.

The -x and /Qx options enable additional optimizations not enabled with options -m or /arch (nor with
options -ax and /Qax).

On Windows systems, options /Qx and /arch are mutually exclusive. If both are specified, the compiler uses
the last one specified and generates a warning. Similarly, on Linux and macOS* systems, options -x and -m
are mutually exclusive. If both are specified, the compiler uses the last one specified and generates a
warning.
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NOTE
All settings except SSE2 do a CPU check. However, if you specify option -O0 (Linux* and
macOS*) or option /Od (Windows*), no CPU check is performed.

Product and Performance Information

Performance varies by use, configuration and other factors. Learn more at www.Intel.com/
Performancelndex.

Notice revision #20201201

IDE Equivalent

Visual Studio

Visual Studio: Code Generation > Intel Processor-Specific Optimization

Alternate Options

None

See Also

xHost, QxHost compiler option

ax, Qax compiler option

arch compiler option

march compiler option

minstruction, Qinstruction compiler option
m compiler option

xHost, QxHost

Tells the compiler to generate instructions for the
highest instruction set available on the compilation
host processor.

Syntax
Linux OS:
-xHost

macOS:

-xHost

Windows OS:

/OxHost

Arguments

None
Default

Windows* systems: None On Windows systems, if neither /0x nor /arch is specified, the default
Linux* systems: None is /arch:SSE2.
macOS* systems: -xSSSE3
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On Linux systems, if neither -x nor -m is specified, the default is
-msse2.

Description

This option tells the compiler to generate instructions for the highest instruction set available on the
compilation host processor.

The instructions generated by this compiler option differ depending on the compilation host processor.

The following table describes the effects of specifying the [Q] xHost option and it tells whether the resulting
executable will run on processors different from the host processor.

Descriptions in the table refer to Intel® Advanced Vector Extensions 2 (Intel® AVX2), Intel® Advanced Vector
Extensions (Intel® AVX), Intel® Streaming SIMD Extensions (Intel® SSE), and Supplemental Streaming SIMD
Extensions (SSSE).

Instruction Set Effects When the -xHost or /QxHost Compiler Option is Specified
of Host

Processor

Intel® AVX2 When compiling on Intel® processors:
Corresponds to option [Q] xCORE-AVX2. The generated executable will not run on
non-Intel processors and it will not run on Intel® processors that do not support
Intel® AVX2 instructions.
When compiling on non-Intel processors:
Corresponds to option -march=core-avx2 (Linux* and macOS*)
or /arch:CORE-AVX2 (Windows*). The generated executable will run on Intel®
processors and non-Intel processors that support at least Intel® AVX2 instructions..
You may see a run-time error if the run-time processor does not support Intel® AVX2
instructions.

Intel® AVX When compiling on Intel® processors:
Corresponds to option [Q]xAVX. The generated executable will not run on non-Intel
processors and it will not run on Intel® processors that do not support Intel® AVX
instructions.
When compiling on non-Intel processors:
Corresponds to option -mavx (Linux and macOS*) or /arch:AvX (Windows). The
generated executable will run on Intel® processors and non-Intel processors that
support at least Intel® AVX instructions. You may see a run-time error if the run-time
processor does not support Intel® AVX instructions.

Intel® SSE4.2 When compiling on Intel® processors:

Corresponds to option [Q]1xSSE4.2. The generated executable will not run on non-
Intel processors and it will not run on Intel® processors that do not support Intel®
SSE4.2 instructions.

When compiling on non-Intel processors:

Corresponds to option -msse4 .2 (Linux and macOS*) or /arch:SSE4.2 (Windows).
The generated executable will run on Intel® processors and non-Intel processors that
support at least Intel® SSE4.2 instructions. You may see a run-time error if the run-

time processor does not support Intel® SSE4.2 instructions.
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Instruction Set
of Host
Processor

Effects When the -xHost or /QxHost Compiler Option is Specified

Intel® SSE4.1

SSSE3

Intel® SSE3

Intel® SSE2

When compiling on Intel® processors:

Corresponds to option [Q]xSSE4.1. The generated executable will not run on non-
Intel processors and it will not run on Intel® processors that do not support Intel®
SSE4.1 instructions.

When compiling on non-Intel processors:

Corresponds to option -msse4 .1 (Linux and macOS*) or /arch:SSE4.1 (Windows).
The generated executable will run on Intel® processors and non-Intel processors that
support at least Intel® SSE4.1 instructions. You may see a run-time error if the run-

time processor does not support Intel® SSE4.1 instructions.

When compiling on Intel® processors:

Corresponds to option [Q]xSSSE3. The generated executable will not run on non-
Intel processors and it will not run on Intel® processors that do not support SSSE3
instructions.

When compiling on non-Intel processors:

Corresponds to option -mssse3 (Linux and macOS*) or /arch:SSSE3 (Windows).
The generated executable will run on Intel® processors and non-Intel processors that
support at least SSSE3 instructions. You may see a run-time error if the run-time
processor does not support SSSE3 instructions.

When compiling on Intel® processors:

Corresponds to option [Q]xSSE3. The generated executable will not run on non-Intel
processors and it will not run on Intel® processors that do not support Intel® SSE3
instructions.

When compiling on non-Intel processors:

Corresponds to option -msse3 (Linux and macOS*) or /arch:SSE3 (Windows). The
generated executable will run on Intel® processors and non-Intel processors that
support at least Intel® SSE3 instructions. You may see a warning run-time error if
the run-time processor does not support Intel® SSE3 instructions.

When compiling on Intel® processors or non-Intel processors:

Corresponds to option -msse2 (Linux and macOS*) or /arch:SSE2 (Windows). The
generated executable will run on Intel® processors and non-Intel processors that
support at least Intel® SSE2 instructions. You may see a run-time error if the run-
time processor does not support Intel® SSE2 instructions.

For more information on other settings for option [Q]x, see that option description.

Product and Performance Information

Performance varies by use, configuration and other factors. Learn more at www.Intel.com/

Performancelndex.

Notice revision #20201201
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IDE Equivalent

Visual Studio

Visual Studio: Code Generation > Intel Processor-Specific Optimization

Alternate Options

None

See Also

%, Ox compiler option
ax, Qax compiler option
m compiler option

arch compiler option

Interprocedural Optimization (IPO) Options

This section contains descriptions for compiler options that pertain to interprocedural optimization.

NOTE
For the ifort compiler, support for Interprocedural Optimization (IPO) is disabled for macOS* SDK 11
or higher.

ffat-lto-objects

Determines whether a fat link-time optimization (LTO)
object, containing both intermediate language and
object code, is generated during an interprocedural
optimization compilation (-c —ipo). This feature is only
available for ifort.

Syntax

Linux OS:
-ffat-lto-objects
-fno-fat-lto-objects
macOS:

None

Windows OS:

None

Arguments
None

Default

—-ffat-lto-objects When -c -ipo is specified, the compiler generates a fat link-time
optimization (LTO) object that has both a true object and a discardable
intermediate language section.

193



Intel® Fortran Compiler Classic and Intel® Fortran Compiler Developer Guide and Reference

Description

This option determines whether a fat link time optimization (LTO) object, containing both intermediate
language and object code, is generated during an interprocedural optimization compilation (-c -ipo).

During an interprocedural optimization compilation (-c -ipo), the following occurs:

e If you specify -ffat-1to-objects, the compiler generates a fat link-time optimization (LTO) object that
has both a true object and a discardable intermediate language section. This enables both link-time
optimization (LTO) linking and normal linking.

e If you specify -fno-fat-lto-objects, the compiler generates a fat link-time optimization (LTO) object
that only has a discardable intermediate language section; no true object is generated. This option may
improve compilation time.

Note that these files will be inserted into archives in the form in which they were created.

This option is provided for compatibility with gcc. For more information about this option, see the gcc
documentation.

NOTE
Intel's intermediate language representation is not compatible with gcc's intermediate
language representation.

IDE Equivalent

None

Alternate Options

None

See Also
ipo, Qipo compiler option

ip, Qip

Determines whether additional interprocedural
optimizations for single-file compilation are enabled.
This feature is only available for ifort.

Syntax
Linux OS:

—ip
-no-ip
macOS:

—ip

-no-ip
Windows OS:
/Qip

/Qip-
Arguments

None
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Default

OFF Some limited interprocedural optimizations occur, including inline function expansion for calls to
functions defined within the current source file. These optimizations are a subset of full intra-file
interprocedural optimizations. Note that this setting is not the same as -no-ip (Linux* and
macOS*) or /Qip- (Windows*).

Description

This option determines whether additional interprocedural optimizations for single-file compilation are
enabled.

The [Q]ip option enables additional interprocedural optimizations for single-file compilation.

Options -no-ip (Linux and macOS*) and /Qip- (Windows) may not disable inlining. To ensure that inlining
of user-defined functions is disabled, specify -inline-level=00r -fno-inline (Linux and macOS¥*), or
specify /0b0 (Windows).

IDE Equivalent

Windows

Visual Studio: Optimization > Interprocedural Optimization

Alternate Options

None

See Also
finline-functions compiler option

ip-no-inlining, Qip-no-inlining

Disables full and partial inlining enabled by
interprocedural optimization options. This feature is
only available for ifort.

Syntax

Linux OS:
-ip-no-inlining
macOS:
-ip-no-inlining
Windows OS:
/Qip-no-inlining
Arguments

None

Default

OFF Inlining enabled by interprocedural optimization options is performed.

Description

This option disables full and partial inlining enabled by the following interprocedural optimization options:
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e On Linux* and macOS* systems: -ip or -ipo
e On Windows* systems: /Qip, /Qipo, or /0b2

It has no effect on other interprocedural optimizations.

On Windows systems, this option also has no effect on user-directed inlining specified by option /0b1.

IDE Equivalent

None

Alternate Options

None

ip-no-pinlining, Qip-no-pinlining

Disables partial inlining enabled by interprocedural
optimization options. This feature is only available for
ifort.

Syntax

Linux OS:
-ip-no-pinlining
macOS:
-ip-no-pinlining
Windows OS:
/Qip-no-pinlining
Arguments

None

Default

OFF Inlining enabled by interprocedural optimization options is performed.

Description
This option disables partial inlining enabled by the following interprocedural optimization options:

e On Linux* and macOS* systems: -ip or -ipo
e On Windows* systems: /Qip or /Qipo

It has no effect on other interprocedural optimizations.

IDE Equivalent

None

Alternate Options

None

ipo, Qipo
Enables interprocedural optimization between files.
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Syntax
Linux OS:

-ipo[n]
-no-ipo
macOS:
-ipol[n]
-no-ipo
Windows OS:
/Qipo[n]
/Qipo-

Arguments

n Is an optional integer that specifies the number of object files the
compiler should create. The integer must be greater than or equal to
0.

Default

-no-1ipo or /Qipo- Multifile interprocedural optimization is not enabled.

Description

This option enables interprocedural optimization between files. This is also called multifile interprocedural
optimization (multifile IPO) or Whole Program Optimization (WPO).

When you specify this option, the compiler performs inline function expansion for calls to functions defined in
separate files.

You cannot specify the names for the files that are created.

If n is 0, the compiler decides whether to create one or more object files based on an estimate of the size of
the application. It generates one object file for small applications, and two or more object files for large
applications.

If n is greater than 0, the compiler generates n object files, unless n exceeds the number of source files (m),
in which case the compiler generates only m object files.

If you do not specify n, the default is 0.

NOTE

When you specify option [Q]ipo with option [gq or Q]opt-report, IPO information is
generated in the compiler optimization report at link time. After linking, you will see a report
named ipo_out.optrpt in the folder where you linked all of the object files.

IDE Equivalent

Windows
Visual Studio: Optimization > Interprocedural Optimization

General > Whole Program Optimization
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Alternate Options
None
ipo-c, Qipo-c

Tells the compiler to optimize across multiple files and
generate a single object file.

Syntax
Linux OS:
-ipo-c
macOS:
-ipo-c
Windows OS:
/Qipo-c
Arguments

None

Default

OFF The compiler does not generate a multifile object file.

Description

This option tells the compiler to optimize across multiple files and generate a single object file (named
ipo_out.o on Linux* and macOS* systems; ipo_out.obj on Windows* systems).

It performs the same optimizations as the [Q] ipo option, but compilation stops before the final link stage,
leaving an optimized object file that can be used in further link steps.
IDE Equivalent

None

Alternate Options

None

See Also
ipo, QOipo compiler option

ipo-jobs, Qipo-jobs

Specifies the number of commands (jobs) to be
executed simultaneously during the link phase of
Interprocedural Optimization (IPO). This feature is
only available for ifort.

Syntax
Linux OS:
-ipo-jobsn
macOS:

-ipo-jobsn
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Windows OS:
/Qipo-jobs:n

Arguments

n Is the number of commands (jobs) to run simultaneously. The number
must be greater than or equal to 1.

Default

-ipo-jobsl One command (job) is executed in an interprocedural optimization parallel

or /Qipo-jobs:1 build.

Description

This option specifies the number of commands (jobs) to be executed simultaneously during the link phase of
Interprocedural Optimization (IPO). It should only be used if the link-time compilation is generating more
than one object. In this case, each object is generated by a separate compilation, which can be done in
parallel.

This option can be affected by the following compiler options:

e [Q]ipo when applications are large enough that the compiler decides to generate multiple object files.
e [Q]ipon when n is greater than 1.
® [Q]ipo-separate

Caution

Be careful when using this option. On a multi-processor system with lots of memory, it can
speed application build time. However, if n is greater than the number of processors, or if
there is not enough memory to avoid thrashing, this option can increase application build
time.

IDE Equivalent

None

Alternate Options

None

See Also

ipo, Qipo compiler option

ipo-separate, Qipo-separate compiler option

ipo-S, Qipo-S

Tells the compiler to optimize across multiple files and
generate a single assembly file. This feature is only
available for ifort.

Syntax
Linux OS:
-ipo-S
macOS:

-ipo-S
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Windows OS:

/Qipo-S

Arguments

None

Default

OFF The compiler does not generate a multifile assembly file.
Description

This option tells the compiler to optimize across multiple files and generate a single assembly file (named
ipo_out.s on Linux* and macOS* systems; ipo_out.asm on Windows* systems).

It performs the same optimizations as the [Q] ipo option, but compilation stops before the final link stage,
leaving an optimized assembly file that can be used in further link steps.
IDE Equivalent

None

Alternate Options

None

See Also
ipo, QOipo compiler option

ipo-separate, Qipo-separate
Tells the compiler to generate one object file for every
source file. This feature is only available for ifort.

Syntax
Linux OS:

-ipo-separate
macOS:

None

Windows OS:

/Qipo-separate

Arguments

None

Default

OFF The compiler decides whether to create one or more object files.

Description

This option tells the compiler to generate one object file for every source file. It overrides any [Q] ipo option
specification.
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IDE Equivalent

None

Alternate Options

None

See Also
ipo, Qipo compiler option

Advanced Optimization Options
This section contains descriptions for compiler options that pertain to advanced optimization.

ansi-alias, Qansi-alias

Tells the compiler to assume certain rules of the
Fortran standard regarding aliasing and array bounds.

Syntax

Linux OS:
-ansi-alias
-no-ansi-alias
macOS:
-ansi-alias
-no-ansi-alias
Windows OS:
/Qansi-alias

/Qansi-alias-

Arguments

None
Default

—ansi-alias Programs adhere to the Fortran standard's rules regarding aliasing and

or /Qansi-alias array bounds.

Description

This option tells the compiler to assume certain rules of the Fortran standard regarding aliasing and array
bounds.

It tells the compiler to assume that the program adheres to the following rules of the Fortran standard:

e Arrays cannot be accessed outside of declared bounds.
e A dummy argument may have its definition status changed only through that dummy argument, unless it
has the TARGET attribute.

This option is similar to option assume nodummy aliases with the additional restriction on array bounds.

If -no-ansi-alias (Linux* and macOS*) or /Qansi-alias- (Windows¥*) is specified, the compiler assumes
that the program might not follow the Fortran standard's rules regarding dummy argument aliasing and array
bounds; this can possibly affect performance.
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IDE Equivalent

None

Alternate Options

None

See Also
assume compiler option, setting [no]dummy_aliases

coarray, Qcoarray
Enables the coarray feature.

Syntax
Linux OS:
—-coarray[=keyword]

macOS:

None
Windows OS:

/Qcoarray|: keyword]

Arguments
keyword Specifies the memory system where the coarrays will be implemented. Possible values are:
shared Indicates a shared memory system. This is the default.
distributed Indicates a distributed memory system.
single Indicates a configuration where the image does not contain self-
replication code. This results in an executable with a single running
image. This configuration can be useful for debugging purposes, even
though there are no inter-image interactions.
Default
OFF Coarrays are not enabled unless you specify this option.
Description

This option enables the coarray feature of the Fortran 2008 Standard. It enables any coarray syntax in your
program. If this option is not specified, coarray syntax is rejected.

It also tells the driver to link against appropriate libraries, and to create the appropriate executables.

Only one keyword can be in effect. If you specify more than one keyword, the last one specified takes
precedence. However, if keyword single is specified anywhere on the command line, it takes precedence.

You can specify option [Q] coarray-num-images to specify the default number of images that can be used
to run a coarray executable. If you do not specify that option, you get the number of execution units on the
current system.

You can specify the [Q]coarray-config-file option to specify the name of a Message Passing Interface
(MPI) configuration file.

Options [Q]coarray-num-images and [Q]coarray-config-file are valid for all keyword values.
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NOTE
Coarrays are only supported on 64-bit architectures.

IDE Equivalent

Windows

Visual Studio: Language > Enable Coarrays

Alternate Options

None

Example

The following command runs a coarray program on shared memory using n images:
/Qcoarray /Qcoarray-num-images:n ! Windows systems
-coarray -coarray-num-images=n ! Linux systems

The following command runs a coarray program on distributed memory using n images:
/Qcoarray:distributed /Qcoarray-num-images:n ! Windows systems
-coarray=distributed -coarray-num-images=n ! Linux systems

The following command runs a coarray program on shared memory using the MPI configuration file specified
by filename:

/Qcoarray:shared /Qcoarray-config-file:filename ! Windows systems
-coarray=shared -coarray-config-file=filename ! Linux systems
The following commands illustrate precedence:
Linux* systems:

-coarray=single -coarray=shared ! single takes precedence (single always takes
precedence)

Windows* systems:

/Qcoarray:distributed /Qcoarray:shared ! shared takes precedence (last one specified)
/Qcoarray:single /Qcoarray:shared ! single takes precedence (single always takes
precedence)

See Also

coarray-num-images, Qcoarray-num-images con1pHeropﬁon
coarray-config-file, Qcoarray-config-file compiler option
Coarrays

Using Coarrays

coarray-config-file, Qcoarray-config-file

Specifies the name of a Message Passing Interface
(MPI) configuration file.

Syntax
Linux OS:

-coarray-config-file=filename
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macOS:

None

Windows OS:

/Qcoarray-config-file: filename

Arguments

filename Is the name of the MPI configuration file. You can specify a path.
Default

OFF When coarrays are enabled, the compiler uses default settings for MPI.

Description

This option specifies the name of a Message Passing Interface (MPI) configuration file. This file is used by the
compiler when coarrays are processed; it configures the MPI for multi-node operations.

This option has no affect unless you also specify the [Q]coarray option, which is required to create the
coarray executable.

Note that when a setting is specified in environment variable FOR_COARRAY_CONFIG_FILE, it overrides the
compiler option setting.

IDE Equivalent

Windows
Visual Studio: Language > MPI Configuration File

Alternate Options

None

See Also
coarray, Qcoarray compiler option

coarray-num-images, Qcoarray-num-images

Specifies the default number of images that can be
used to run a coarray executable.

Syntax

Linux OS:
-coarray-num-images=n
macOS:

None

Windows OS:
/Qcoarray-num-images:n
Arguments

n Is the default number of images. The limit is determined from the system
configuration.
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Default
OFF The number of images is determined at run-time.
Description

This option specifies the default number of images that can be used to run a coarray executable.

This option has no affect unless you also specify the [Q] coarray option. This option is required to create the
coarray executable.

You can specify option [Q] coarray-num-images to specify the default number of images that can be used
to run a coarray executable. If you do not specify that option, you get the number of execution units on the
current system.

Note that when a setting is specified in environment variable FOR_COARRAY_NUM_IMAGES, it overrides the
compiler option setting.

IDE Equivalent

Windows

Visual Studio: Language > Coarray Images

Alternate Options

None

See Also
coarray, Qcoarray compiler option

complex-limited-range, Qcomplex-limited-range
Determines whether the use of basic algebraic
expansions of some arithmetic operations involving
data of type COMPLEX is enabled. This feature is only
available for ifort.

Syntax

Linux OS:
-complex-limited-range
-no-complex-limited-range
macOS:
-complex-limited-range
-no-complex-limited-range
Windows OS:
/Qcomplex-limited-range

/Qcomplex-1limited-range-

Arguments

None
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Default

-no-complex-limited-range Basic algebraic expansions of some arithmetic operations

or /Qcomplex-1imited-range- involving data of type COMPLEX are disabled.

Description

This option determines whether the use of basic algebraic expansions of some arithmetic operations involving
data of type COMPLEX is enabled.

When the option is enabled, this can cause performance improvements in programs that use a lot of
COMPLEX arithmetic. However, values at the extremes of the exponent range may not compute correctly.

IDE Equivalent

Windows
Visual Studio: Floating point > Limit COMPLEX Range

Alternate Options

None

guide, Qguide

Lets you set a level of guidance for auto-vectorization,
auto parallelism, and data transformation. This feature
is only available for ifort.

Syntax

Linux OS:

-guide[=n]

macOS:

-guide[=n]

Windows OS:

/Qguide|:n]

Arguments

n Is an optional value specifying the level of guidance to be provided.
The values available are 1 through 4. Value 1 indicates a standard
level of guidance. Value 4 indicates the most advanced level of
guidance. If n is omitted, the default is 4.

Default

OFF You do not receive guidance about how to improve optimizations for

parallelism, vectorization, and data transformation.
Description

This option lets you set a level of guidance (advice) for auto-vectorization, auto parallelism, and data
transformation. It causes the compiler to generate messages suggesting ways to improve these
optimizations.

When this option is specified, the compiler does not produce any objects or executables.
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You must also specify the [Q]lparallel option to receive auto parallelism guidance.

You can set levels of guidance for the individual guide optimizations by specifying one of the following
options:

[0]guide-data-trans Provides guidance for data transformation.
[0] guide-par Provides guidance for auto parallelism.
[0] guide-vec Provides guidance for auto-vectorization.

If you specify the [Q]guide option and also specify one of the options setting a level of guidance for an
individual guide optimization, the value set for the individual guide optimization will override the setting
specified in [Q]guide.

If you do not specify [Q]guide, but specify one of the options setting a level of guidance for an individual
guide optimization, option [Q]guide is enabled with the greatest value passed among any of the three
individual guide optimizations specified.

In debug mode, this option has no effect unless option 02 (or higher) is explicitly specified in the same
command line.

NOTE

The compiler speculatively performs optimizations as part of guide analysis. As a result,
when you use guided auto-parallelism options with options that produce vectorization or
auto-parallelizer reports (such as option [q or Q]opt-report), the compiler generates

"LOOP WAS VECTORIZED" or similar messages as if the compilation was performed with the

recommended changes.

When compilation is performed with the [Q] guide option, you should use extra caution when
interpreting vectorizer diagnostics and auto-parallelizer diagnostics.

NOTE
You can specify [Q]diag-disable to prevent the compiler from issuing one or more
diagnostic messages.

IDE Equivalent

Visual Studio

Visual Studio: Diagnostics > Guided Auto Parallelism > Guided Auto Parallelism Analysis

Alternate Options

None

See Also

guide-data-trans, Qguide-data-trans compiler option
guide-par, Qguide-par compiler option

guide-vec, Qguide-vec compiler option

guide-file, Qguide-file compiler option
guide-file-append, Qguide-file-append compiler option
guide-opts, Qguide-opts compiler option

diag, odiag compiler option

gopt-report, Qopt-report compiler option
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guide-data-trans, Qguide-data-trans

Lets you set a level of guidance for data
transformation. This feature is only available for ifort.

Syntax

Linux OS:
-guide-data-trans[=n]
macOS:
-guide-data-trans[=n]
Windows OS:

/Qguide-data-trans]|:n]

Arguments

n Is an optional value specifying the level of guidance to be provided.
The values available are 1 through 4. Value 1 indicates a standard
level of guidance. Value 4 indicates the most advanced level of
guidance. If n is omitted, the default is 4.

Default

OFF You do not receive guidance about how to improve optimizations for data

transformation.
Description

This option lets you set a level of guidance for data transformation. It causes the compiler to generate
messages suggesting ways to improve that optimization.

IDE Equivalent

None

Alternate Options

None

See Also

guide, Qguide compiler option
guide-par, Qguide-par compiler option
guide-vec, Qguide-vec compiler option
guide-file, Qguide-file compiler option

guide-file, Qguide-file
Causes the results of guided auto parallelism to be
output to a file. This feature is only available for ifort.

Syntax
Linux OS:

-guide-file[=filename]
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macOS:
-guide-file[=filename]
Windows OS:
/Qguide-file[: filename]

Arguments

filename Is the name of the file for output. It can include a path.
Default

OFF Messages that are generated by guided auto parallelism are output to stderr.
Description

This option causes the results of guided auto parallelism to be output to a file.
This option is ignored unless you also specify one or more of the following options:

[Qlguide
® [Q]lguide-vec
® [Q]guide-data-trans
e [Qlguide-par

If you do not specify a path, the file is placed in the current working directory.
If there is already a file named filename, it will be overwritten.

You can include a file extension in filename. For example, if file.txt is specified, the name of the output file is
file.txt. If you do not provide a file extension, the name of the file is filename.guide.

If you do not specify filename, the name of the file is name-of-the-first-source-file.guide. This is also the
name of the file if the name specified for filename conflicts with a source file name provided in the command
line.

NOTE
If you specify the [0]guide-file option and you also specify option [Q]guide-file-append,
the last option specified on the command line takes precedence.

IDE Equivalent

Windows

Visual Studio: Diagnostics > Guided Auto Parallelism > Emit Guided Auto Parallelism Diagnostics to
File

Diagnostics > Guided Auto Parallelism Diagnostics File

Alternate Options

None
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Example

The following example shows how to cause guided auto parallelism messages to be output to a file named
my_guided_autopar.guide:

-guide-file=my guided autopar ! Linux and macOS* systems
/Qguide-file:my guided autopar ! Windows systems
See Also

guide, Qguide compiler option
guide-file-append, Qguide-file-append compiler option

guide-file-append, Qguide-file-append
Causes the results of guided auto parallelism to be

appended to a file. This feature is only available for
ifort.

Syntax

Linux OS:
-guide-file-append[=filename]
macOS:
-guide-file-append[=filename]
Windows OS:
/Qguide-file-append[: filename]

Arguments

filename Is the name of the file to be appended to. It can include a path.
Default

OFF Messages that are generated by guided auto parallelism are output to stderr.

Description

This option causes the results of guided auto parallelism to be appended to a file.
This option is ignored unless you also specify one or more of the following options:

guide

[Q]

e [Q]guide-vec
[Qlguide-data-trans
[Q]

° guide-par

If you do not specify a path, the compiler looks for filename in the current working directory.

If filename is not found, then a new file with that name is created in the current working directory.
If you do not specify a file extension, the name of the file is filename.guide.

If the name specified for filename conflicts with a source file name provided in the command line, the name
of the file is name-of-the-first-source-file.guide.
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NOTE
If you specify the [Q]guide-file-append option and you also specify option [Q]lguide-file,
the last option specified on the command line takes precedence.

IDE Equivalent

None

Alternate Options

None

Example

The following example shows how to cause guided auto parallelism messages to be appended to a file named
my_messages.txt:

-guide-file-append=my messages.txt ! Linux and macOS* systems
/Qguide-file-append:my messages.txt ! Windows systems
See Also

guide, Qguide compiler option
guide-file, Qguide-file compiler option

guide-opts, Qguide-opts

Tells the compiler to analyze certain code and
generate recommendations that may improve
optimizations. This feature is only available for ifort.

Syntax

Linux OS:
-guide-opts=string
macOS:
-guide-opts=string
Windows OS:
/Qguide-opts:string
Arguments

string Is the text denoting the code to analyze. The string must appear within quotes. It can take
one or more of the following forms:

filename

filename, routine

filename, range [, range]...

filename, routine, range [, range]...

If you specify more than one of the above forms in a string, a semicolon must appear
between each form. If you specify more than one range in a string, a comma must appear
between each range. Optional blanks can follow each parameter in the forms above and
they can also follow each form in a string.

211




Intel® Fortran Compiler Classic and Intel® Fortran Compiler Developer Guide and Reference

filename Specifies the name of a file to be analyzed. It can include a
path.

If you do not specify a path, the compiler looks for
filename in the current working directory.

routine Specifies the name of a routine to be analyzed. You can
include an identifying argument.

The name, including any argument, must be enclosed in
single quotes.

The compiler tries to uniquely identify the routine that
corresponds to the specified routine name. It may select
multiple routines to analyze, especially if the following is
true:

e More than one routine has the specified routine name,
so the routine cannot be uniquely identified.

e No argument information has been specified to narrow
the number of routines selected as matches.

range Specifies a range of line numbers to analyze in the file or
routine specified. The range must be specified in integers
in the form:

first_line_number-last_line_number

The hyphen between the line numbers is required.

Default

OFF You do not receive guidance on how to improve optimizations. However, if you specify the
[Q]guide option, the compiler analyzes and generates recommendations for all the code in an
application

Description

This option tells the compiler to analyze certain code and generate recommendations that may improve
optimizations.

This option is ignored unless you also specify one or more of the following options:

guide
. guide-vec

° guide-data-trans

[0]
[Q]
[Q]
® [Q]guide-par

When the [Q]guide-opts option is specified, a message is output that includes which parts of the input files
are being analyzed. If a routine is selected to be analyzed, the complete routine name will appear in the
generated message.

When inlining is involved, you should specify callee line numbers. Generated messages also use callee line
numbers.

IDE Equivalent

Visual Studio

Visual Studio: Diagnostics > Guided Auto Parallelism > Guided Auto Parallelism Code Selection
Options
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Alternate Options

None

Example

Consider the following:

Linux*: -qguide-opts="m.f, 1-10; m2.£90, 1-40, 50-90, 100-200; m5.f, 300-400; x.f, 'funca(j)',
22-44, 55-77, 88-99; y.f, 'subrb'"

Windows*: /Quide-opts="m.f, 1-10; m2.£90, 1-40, 50-90, 100-200; m5.f, 300-400; x.f, 'funca(j)'
22-44, 55-77, 88-99; y.f, 'subrb'"

r

The above command causes the following to be analyzed:

file m.f, line numbers 1 to 10

file m2.f90, line numbers 1 to 40, 50 to 90, and 100 to 200

file m5.f, line numbers 300 to 400

file x.f, function funca with argument (j), line numbers 22 to 44, 55 to 77, and 88 to 99

file y.f, subroutine subrb

See Also

guide, Qguide compiler option

guide-data-trans, Qguide-data-trans compiler option
guide-par, Qguide-par compiler option

guide-vec, Qguide-vec compiler option

guide-file, Qguide-file compiler option

guide-par, Qguide-par
Lets you set a level of guidance for auto parallelism.
This feature is only available for ifort.

Syntax

Linux OS:
-guide-par[=n]
macOS:
-guide-par[=n]

Windows OS:
/Qguide-par|[:n]

Arguments

n Is an optional value specifying the level of guidance to be provided.
The values available are 1 through 4. Value 1 indicates a standard
level of guidance. Value 4 indicates the most advanced level of
guidance. If n is omitted, the default is 4.

Default

OFF You do not receive guidance about how to improve optimizations for

parallelism.
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Description

This option lets you set a level of guidance for auto parallelism. It causes the compiler to generate messages
suggesting ways to improve that optimization.

You must also specify the [Q]lparallel option to receive auto parallelism guidance.

IDE Equivalent

None

Alternate Options

None

See Also

guide, Qguide compiler option

guide-data-trans, Qguide-data-trans compiler option
guide-vec, Qguide-vec compiler option

guide-file, Qguide-file compiler option

guide-vec, Qguide-vec
Lets you set a level of guidance for auto-vectorization.
This feature is only available for ifort.

Syntax

Linux OS:
-guide-vec[=n]
macOS:
-guide-vec|[=n]
Windows OS:
/Qguide-vec|:n]

Arguments

n Is an optional value specifying the level of guidance to be provided.
The values available are 1 through 4. Value 1 indicates a standard
level of guidance. Value 4 indicates the most advanced level of
guidance. If n is omitted, the default is 4.

Default

OFF You do not receive guidance about how to improve optimizations for

vectorization.
Description

This option lets you set a level of guidance for auto-vectorization. It causes the compiler to generate
messages suggesting ways to improve that optimization.

IDE Equivalent

None
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Alternate Options

None

See Also

guide, Qguide compiler option

guide-data-trans, Qguide-data-trans compiler option
guide-par, Qguide-par compiler option

guide-file, Qguide-file compiler option

heap-arrays

Puts automatic arrays and arrays created for
temporary computations on the heap instead of the
stack.

Syntax
Linux OS:

~heap-arrays [size]
-no-heap-arrays
macOS:

-heap-arrays [size]
-no-heap-arrays
Windows OS:
/heap-arrays|[:size]

/heap-arrays—
Arguments

size Is an integer value representing the size of the arrays in kilobytes. Arrays smaller than size are
put on the stack.

Default

-no-heap-arrays The compiler puts automatic arrays and temporary arrays in the stack storage

or /heap-arrays- area.

Description

This option puts automatic arrays and arrays created for temporary computations on the heap instead of the
stack.

When this option is specified, automatic (temporary) arrays that have a compile-time size greater than the
value specified for size are put on the heap, rather than on the stack. If the compiler cannot determine the
size at compile time, it always puts the automatic array on the heap.

If size is specified, the value is only used when the total size of the temporary array or automatic array can
be determined at compile time, using compile-time constants. Any arrays known at compile-time to be larger
than size are allocated on the heap instead of the stack. For example, if 10 is specified for size:

e All automatic and temporary arrays equal to or larger than 10 KB are put on the heap.
e All automatic and temporary arrays smaller than 10 KB are put on the stack.
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If size is omitted, and the size of the temporary array or automatic array cannot be determined at compile
time, it is assumed that the total size is greater than size and the array is allocated on the heap.

On Windows, you can use compiler option /F to tell the linker to increase the size of the run-time stack to
allow for large objects on the stack.

On Linux and macOS*, you can use the shell command unlimit to increase the size of the run-time stack
before execution.

IDE Equivalent

Windows

Visual Studio: Optimization > Heap Arrays

Alternate Options

None

Example

In Fortran, an automatic array gets its size from a run-time expression. For example:

RECURSIVE SUBROUTINE F( N )

INTEGER :: N

REAL :: X ( N ) ! an automatic array

REAL :: Y ( 1000 ) ! an explicit-shape local array on the stack

Array X in the example above is affected by the heap-array option; array Y is not.

Temporary arrays are often created before making a routine call, or when an array operation detects overlap.
For example:

integer a(10000)
a(2:) = a(l:ubound(a,dim=1)-1)

In this case, the array assignment uses a temporary intermediate array because there is clearly an overlap
between the right hand side and the left hand side of the assignment.

If you specify the heap-arrays option, the compiler creates the temporary array on the heap.

If you specify the heap-arrays option with size 50, the compiler creates the temporary array on the stack.
This is because the size of the temporary intermediate array can be determined at compile time (40Kb), and
it's size is less than the size value.

In the following example, a contiguous array is created from the array slice declaration and passed on:

call somesub(a(1:10000:2))
If you specify the heap-arrays option, the compiler creates the temporary array on the heap.

If you specify the heap-arrays option with size 25, the compiler creates the temporary array on the stack.
This is because the size of the temporary intermediate array at compile time is only 20Kb.

See Also
F compiler option

pad, Qpad
Enables the changing of the variable and array
memory layout.
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Syntax
Linux OS:

-pad
-nopad
macOS:

-pad
-nopad
Windows OS:
/Qpad
/Qpad-

Arguments

None

Default

-nopad oOr /Qpad- Variable and array memory layout is performed by default methods.

Description
This option enables the changing of the variable and array memory layout.

This option is effectively not different from the align option when applied to structures and derived types.
However, the scope of pad is greater because it applies also to common blocks, derived types, sequence
types, and structures.

IDE Equivalent

None

Alternate Options
None

See Also
align compiler option

qmkl, Qmkl

Tells the compiler to link to certain libraries in the
Intel® oneAPI Math Kernel Library (oneMKL). On
Windows systems, you must specify this option at
compile time.

Syntax
Linux OS:
—gmkl[=1ib]
macOS:
—-gmkl [=11ib]
Windows OS:
/Omk1[:11ib]
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Arguments
lib Indicates which oneMKL library files should be linked. Possible values are:
parallel Tells the compiler to link using the threaded libraries in
oneMKL. This is the default if the option is specified with no
lib.
sequential Tells the compiler to link using the sequential libraries in
oneMKL.
cluster Tells the compiler to link using the cluster-specific libraries
and the sequential libraries in oneMKL. Cluster-specific
libraries are not available for macOS*.
Default
OFF The compiler does not link to the oneMKL library.

Description
This option tells the compiler to link to certain libraries in the Intel® oneAPI Math Kernel Library (oneMKL).
On Linux* and macOS* systems, dynamic linking is the default when you specify -gmk1.
On C++ systems, to link with oneMKL statically, you must specify:

-gmkl -static-intel
On Windows* systems, static linking is the default when you specify /omk1. To link with oneMKL dynamically,
you must specify:

/Qmkl /libs:d1l or /Qmkl /MD

For more information about using oneMKL libraries, see the article in Intel® Developer Zone titled: Intel®
oneAPI Math Kernel Library Link Line Advisor, which is located in https://software.intel.com/
content/www/us/en/develop/tools/oneapi/components/onemkl/link-line-advisor.html.

NOTE

On Windows* systems, this option adds directives to the compiled code, which the linker
then reads without further input from the driver. You do not need to specify a separate link
command.

On Linux* and macOS* systems, the driver must add the library names explicitly to the link command.
You must use option -gmk1 to perform the link to pull in the dependent libraries.

IDE Equivalent

Visual Studio
Visual Studio: Libraries > Intel® oneAPI Math Kernel Library

Alternate Options

Linux and macOS* on ifort: -mk1 (this is a deprecated option)

See Also
static-intel compiler option
MD compiler option
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libs compiler option

qopt-args-in-regs, Qopt-args-in-regs

Determines whether calls to routines are optimized by
passing arguments in registers instead of on the
stack. This option is deprecated and will be removed
in a future release. This feature is only available for
ifort.

Architecture Restrictions

Only available on IA-32 architecture. IA-32 support has been deprecated, and will be removed in a future
release.

Syntax

Linux OS:
-gopt-args-in-regs[=keyword]
macOS:

None
Windows OS:

/Qopt-args—-in-regs|[:keyword]

Arguments
keyword Specifies whether the optimization should be performed and under what conditions. Possible
values are:
none The optimization is not performed. No arguments are passed in registers. They are
put on the stack.
seen Causes arguments to be passed in registers when they are passed to routines
whose definition can be seen in the same compilation unit.
all Causes arguments to be passed in registers, whether they are passed to routines
whose definition can be seen in the same compilation unit, or not. This value is
only available on Linux* systems.
Default
-gopt-args—in-regs=seen Arguments are passed in registers when they are passed to routines

or /Qopt-args-in-regs:seen  Whose definition is seen in the same compilation unit.

Description

This option determines whether calls to routines are optimized by passing arguments in registers instead of
on the stack. It also indicates the conditions when the optimization will be performed.

This option can improve performance for Application Binary Interfaces (ABIs) that require arguments to be
passed in memory and compiled without interprocedural optimization (IPO).

Note that on Linux* systems, if all is specified, a small overhead may be paid when calling "unseen"
routines that have not been compiled with the same option. This is because the call will need to go through a
"thunk" to ensure that arguments are placed back on the stack where the callee expects them.

219



Intel® Fortran Compiler Classic and Intel® Fortran Compiler Developer Guide and Reference

IDE Equivalent

None

Alternate Options

None

gopt-assume-safe-padding, Qopt-assume-safe-padding

Determines whether the compiler assumes that
variables and dynamically allocated memory are
padded past the end of the object. This feature is only

available for ifort.

Architecture Restrictions

Only available on all architectures that support Intel® Advanced Vector Extensions 512 (Intel® AVX-512)

Foundation instructions
Syntax
Linux OS:

-gopt-assume-safe-padding
-gno-opt-assume-safe-padding
macOS:
-gopt-assume-safe-padding
-gno-opt-assume-safe-padding
Windows OS:
/Qopt-assume-safe-padding
/Qopt-assume-safe-padding-
Arguments

None
Default
-gqno-opt-assume-safe-padding

or /Qopt-assume-safe-padding-

Description

The compiler will not assume that variables and dynamically allocated
memory are padded past the end of the object. It will adhere to the
sizes specified in your program.

This option determines whether the compiler assumes that variables and dynamically allocated memory are

padded past the end of the object.

When you specify option [g or Q]opt-assume-safe-padding, the compiler assumes that variables and
dynamically allocated memory are padded. This means that code can access up to 64 bytes beyond what is

specified in your program.

The compiler does not add any padding for static and automatic objects when this option is used, but it
assumes that code can access up to 64 bytes beyond the end of the object, wherever the object appears in
the program. To satisfy this assumption, you must increase the size of static and automatic objects in your

program when you use this option.

This option may improve performance of memory operations.
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IDE Equivalent

None

Alternate Options
None

qopt-block-factor, Qopt-block-factor

Lets you specify a loop blocking factor. This feature is
only available for ifort.

Syntax

Linux OS:
-gopt-block-factor=n
macOS:
—-gopt-block-factor=n

Windows OS:
/Qopt-block-factor:n

Arguments

n Is the blocking factor. It must be an integer. The compiler may ignore
the blocking factor if the value is 0 or 1.

Default

OFF The compiler uses default heuristics for loop blocking.

Description

This option lets you specify a loop blocking factor.

IDE Equivalent

None

Alternate Options
None
qopt-dynamic-align, Qopt-dynamic-align

Enables or disables dynamic data alignment
optimizations. This feature is only available for ifort.

Syntax

Linux OS:
-gopt-dynamic-align
-gqno-opt-dynamic-align
macOS:
-gopt-dynamic-align

-gno-opt-dynamic-align
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Windows OS:
/Qopt-dynamic-align

/Qopt-dynamic-align-

Arguments

None

Default

The compiler may generate code dynamically
dependent on alignment. It may do optimizations
based on data location for the best performance. The
result of execution on some algorithms may depend
on data layout.

-gopt-dynamic-align
or /Qopt-dynamic-align

Description
This option enables or disables dynamic data alignment optimizations.

If you specify -gno-opt-dynamic-align or /Qopt-dynamic-align-, the compiler generates no code
dynamically dependent on alignment. It will not do any optimizations based on data location and results will
depend on the data values themselves.

When you specify [g or Q]gopt-dynamic-align, the compiler may implement conditional optimizations
based on dynamic alignment of the input data. These dynamic alignment optimizations may result in
different bitwise results for aligned and unaligned data with the same values.

Dynamic alignment optimizations can improve the performance of vectorized code, especially for long trip
count loops. Disabling such optimizations can decrease performance, but it may improve bitwise
reproducibility of results, factoring out data location from possible sources of discrepancy.

IDE Equivalent

None

Alternate Options

None

qopt-for-throughput, Qopt-for-throughput
Determines how the compiler optimizes for throughput
depending on whether the program is to run in single-
job or multi-job mode. This feature is only available
for ifx.

Syntax

Linux OS:
—-gopt-for-throughput [=value]
macOS:

None

Windows OS:
/Qopt-for-throughput[:value]
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Arguments

value Is one of the values "multi-job" or "single-job". If no value is specified,
the default is "multi-job".

Default

OFF If this option is not specified, the compiler will not optimize for throughput performance.

Description

This option determines whether throughput performance optimization occurs for a program that is run as a
single job or one that is run in a multiple job environment.

The memory optimizations for a single job versus multiple jobs can be tuned in different ways by the
compiler. For example, the cost model for loop tiling and prefetching are different for a single job versus
multiple jobs. When a single job is running, more memory is available and the tunings will be different.

NOTE
When offloading is enabled, this option only applies to host compilation. Offloading can only
be enabled when using ifx.

IDE Equivalent

None

Alternate Options

None

qopt-jump-tables, Qopt-jump-tables
Enables or disables generation of jump tables for

switch statements. This feature is only available for
ifort.

Syntax

Linux OS:
—-gopt-jump-tables=keyword
-gqno-opt-jump-tables
macOS:
-gopt-jump-tables=keyword
-gqno-opt-jump-tables
Windows OS:
/Qopt-jump-tables: keyword

/Qopt-jump-tables-
Arguments

keyword Is the instruction for generating jump tables. Possible values are:
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never

default

large

Default

-gopt-jump-tables=default
or /Qopt-jump-tables:default

Description

Tells the compiler to never generate jump tables. All switch
statements are implemented as chains of if-then-elses.
This is the same as specifying —gqno-opt-jump-tables
(Linux* and macOS*) or /Qopt-jump-tables-
(Windows*).

The compiler uses default heuristics to determine when to
generate jump tables.

Tells the compiler to generate jump tables up to a certain
pre-defined size (64K entries).

Must be an integer. Tells the compiler to generate jump
tables up to n entries in size.

The compiler uses default heuristics to determine
when to generate jump tables for switch statements.

This option enables or disables generation of jump tables for switch statements. When the option is enabled,
it may improve performance for programs with large switch statements.

IDE Equivalent

None

Alternate Options

None

qopt-malloc-options

Lets you specify an alternate algorithm for malloc().

This feature is only available for ifort.

Syntax

Linux OS:
-gopt-malloc-options=n
macOS:
-gopt-malloc-options=n
Windows OS:

None

Arguments

n Specifies the algorithm to use for malloc(). Possible values are:

0
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Default

-gopt-malloc-options=0

Causes the following adjustments to the
malloc() algorithm: M_MMAP_MAX=2 and
M_TRIM_THRESHOLD=0x10000000.

Causes the following adjustments to the
malloc() algorithm: M_MMAP_MAX=2 and
M_TRIM_THRESHOLD=0x40000000.

Causes the following adjustments to the
malloc() algorithm: M_MMAP_MAX=0 and
M_TRIM_THRESHOLD=-1.

Causes the following adjustments to the
malloc() algorithm: M_MMAP_MAX=0,
M_TRIM_THRESHOLD=-1,
M_TOP_PAD=4096.

The compiler uses the default algorithm when malloc() is called.

No call is made to mallopt().

Description

This option lets you specify an alternate algorithm for malloc().

If you specify a non-zero value for n, it causes alternate configuration parameters to be set for how malloc()
allocates and frees memory. It tells the compiler to insert calls to mallopt() to adjust these parameters to
malloc() for dynamic memory allocation. This may improve speed.

IDE Equivalent

None

Alternate Options

None

See Also
malloc(3) man page

mallopt function (defined in malloc.h)

qopt-matmul, Qopt-matmul

Enables or disables a compiler-generated Matrix
Multiply (matmul) library call.

Syntax

Linux OS:
-gopt-matmul
-gno-opt-matmul
macOS:

None

Windows OS:

/Qopt-matmul
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/Qopt-matmul-

Arguments

None
Default

-gno-opt-matmul The matmul library call optimization does not occur unless this option is
or /Qopt-matmul- enabled or certain other compiler options are specified (see below).

Description
This option enables or disables a compiler-generated Matrix Multiply (MATMUL) library call.

The [g or Qlopt-matmul option tells the compiler to identify matrix multiplication loop nests (if any) and
replace them with a matmul library call for improved performance. The resulting executable may improve
performance on Intel® microprocessors.

NOTE
This option is dependent upon the OpenMP* library. If your product does not support
OpenMP, this option will have no effect.

This option has no effect unless option 02 or higher is set.

NOTE
Many routines in the MATMUL library are more highly optimized for Intel® microprocessors
than for non-Intel microprocessors.

IDE Equivalent

Visual Studio
Visual Studio: Optimization > Enable Matrix Multiply Library Call

Alternate Options

None

See Also
0 compiler option

qopt-mem-layout-trans, Qopt-mem-layout-trans
Controls the level of memory layout transformations
performed by the compiler.

Syntax

Linux OS:
—gopt-mem-layout-trans[=n]
-gno-opt-mem-layout-trans
macOS:
-gopt-mem-layout-trans[=n]

-gno-opt-mem-layout-trans
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Windows OS:
/Qopt-mem-layout-trans[:n]

/Qopt-mem-layout-trans-—

Arguments
n Is the level of memory layout transformations. Possible values are:

0 Disables memory layout transformations. This is the same
as specifying -qno-opt-mem-layout-trans (Linux* or
macOS*) or /Qopt-mem-layout-trans—- (Windows*).

1 Enables basic memory layout transformations.

2 Enables more memory layout transformations. This is the
same as specifying [qg or Q]opt-mem-layout-trans with
no argument.

3 Enables more memory layout transformations like copy-in/
copy-out of structures for a region of code. You should only
use this setting if your system has more than 4GB of
physical memory per core.

4 Enables more aggressive memory layout transformations.
You should only use this setting if your system has more
than 4GB of physical memory per core.

Default

-gopt-mem-layout-trans=2 The compiler performs moderate memory layout transformations.

or /Qopt-mem-layout-trans:2

Description

This option controls the level of memory layout transformations performed by the compiler. This option can
improve cache reuse and cache locality.

Product and Performance Information

Performance varies by use, configuration and other factors. Learn more at www.Intel.com/
Performancelndex.

Notice revision #20201201

IDE Equivalent

None

Alternate Options

None

qopt-multi-version-aggressive, Qopt-multi-version-aggressive

Tells the compiler to use aggressive multi-versioning
to check for pointer aliasing and scalar replacement.
This feature is only available for ifort.
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Syntax

Linux OS:
-gopt-multi-version-aggressive
-gno-opt-multi-version-aggressive
macOS:
—-gopt-multi-version-aggressive
-gqno-opt-multi-version-aggressive
Windows OS:
/Qopt-multi-version-aggressive

/Qopt-multi-version-aggressive-

Arguments

None

Default

—-gno-opt-multi-version-aggressive The compiler uses default heuristics when checking

or /Qopt-multi-version-aggressive- for pointer aliasing and scalar replacement.

Description

This option tells the compiler to use aggressive multi-versioning to check for pointer aliasing and scalar
replacement. This option may improve performance.

The performance can be affected by certain options, such as /arch or /0x (Windows*) or -m or -x (Linux*
and macOS*).
IDE Equivalent

None

Alternate Options

None

qopt-multiple-gather-scatter-by-shuffles, Qopt-multiple-gather-scatter-by-shuffles

Enables or disables the optimization for multiple
adjacent gather/scatter type vector memory
references.

Syntax

Linux OS:
—gqopt-multiple-gather-scatter-by-shuffles
-gno-opt-multiple-gather-scatter-by-shuffles
macOS:
—gopt-multiple-gather-scatter-by-shuffles

-gno-opt-multiple-gather-scatter-by-shuffles
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Windows OS:
/Qopt-multiple-gather-scatter-by-shuffles

/Qopt-multiple-gather-scatter-by-shuffles-

Arguments

None

Default

varies When this option is not specified, the compiler uses default heuristics for
optimization.

Description

This option controls the optimization for multiple adjacent gather/scatter type vector memory references.
This optimization hint is useful for performance tuning. It tries to generate more optimal software sequences
using shuffles.

If you specify this option, the compiler will apply the optimization heuristics. If you specify
-gqno-opt-multiple-gather-scatter-by-shuffles
or /Qopt-multiple-gather-scatter-by-shuffles-, the compiler will not apply the optimization.

NOTE
Optimization is affected by optimization compiler options, such as [Q]x, -march (Linux* or
macOS*), and /arch (Windows*).

To override the effect of this option (or the default) per loop basis, you can use directive VECTOR
[NO]MULTIPLE_GATHER_SCATTER_BY_SHUFFLE.

Product and Performance Information

Performance varies by use, configuration and other factors. Learn more at www.Intel.com/
Performancelndex.

Notice revision #20201201

IDE Equivalent

None

Alternate Options

None

See Also

VECTOR directive

%, Ox compiler option
march compiler option
arch compiler option

qopt-prefetch, Qopt-prefetch

Enables or disables prefetch insertion optimization.
This feature is only available for ifort.
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Syntax

Linux OS:
-gopt-prefetch[=n]
-gqno-opt-prefetch
macOS:
-gopt-prefetch([=n]
-gqno-opt-prefetch
Windows OS:
/Qopt-prefetchl:n]

/Qopt-prefetch-
Arguments

n

Default

-gno-opt-prefetch
or /Qopt-prefetch-

Description

Is the level of software prefetching optimization desired. Possible

values are:

0

1to>s

Disables software prefetching. This is the
same as specifying —qno-opt-prefetch
(Linux* and macOS*) or /Qopt-prefetch-
(Windows*).

Enables different levels of software
prefetching. If you do not specify a value for
n, the default is 2. Use lower values to
reduce the amount of prefetching.

Prefetch insertion optimization is disabled.

This option enables or disables prefetch insertion optimization. The goal of prefetching is to reduce cache
misses by providing hints to the processor about when data should be loaded into the cache.

This option enables prefetching when higher optimization levels are specified.

IDE Equivalent

Visual Studio

Visual Studio: Optimization > Prefetch Insertion

Alternate Options

None

See Also

gopt-prefetch-distance, Qopt-prefetch-distance compiler option
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qopt-prefetch-distance, Qopt-prefetch-distance

Specifies the prefetch distance to be used for
compiler-generated prefetches inside loops. This
feature is only available for ifort.

Syntax

Linux OS:
-gopt-prefetch-distance=nl[, nZ2]
macOS:

None

Windows OS:
/Qopt-prefetch-distance:nl[, n2]

Arguments

ni, n2 Is the prefetch distance in terms of the nhumber of (possibly-
vectorized) iterations. Possible values are non-negative numbers >=0.
n2 is optional.
nl = 0 turns off all compiler issued prefetches from memory to L2. n2
= 0 turns off all compiler issued prefetches from L2 to L1. If n2 is
specified and n1 > 0, n1 should be >= n2.

Default

OFF The compiler uses default heuristics to determine the prefetch distance.

Description

This option specifies the prefetch distance to be used for compiler-generated prefetches inside loops. The unit
(n1 and optionally n2) is the number of iterations. If the loop is vectorized by the compiler, the unit is the
number of vectorized iterations.

The value of n1 will be used as the distance for prefetches from memory to L2 (for example, the vprefetchl
instruction). If n2 is specified, it will be used as the distance for prefetches from L2 to L1 (for example, the
vprefetchO instruction).

This option is ignored if option —~gopt-prefetch=0 (Linux*) or /Qopt-prefetch:0 (Windows*) is specified.

IDE Equivalent

None

Alternate Options

None

Example

Consider the following Linux* examples:

-qopt-prefetch-distance=64, 32
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The above causes the compiler to use a distance of 64 iterations for memory to L2 prefetches, and a distance
of 32 iterations for L2 to L1 prefetches.

-qopt-prefetch-distance=24

The above causes the compiler to use a distance of 24 iterations for memory to L2 prefetches. The distance
for L2 to L1 prefetches will be determined by the compiler.

-gqopt-prefetch-distance=0, 4

The above turns off all memory to L2 prefetches inserted by the compiler inside loops. The compiler will use
a distance of 4 iterations for L2 to L1 prefetches.

-gopt-prefetch-distance=16,0

The above causes the compiler to use a distance of 16 iterations for memory to L2 prefetches. No L2 to L1
loop prefetches are issued by the compiler.

See Also
gopt-prefetch, Qopt-prefetch compiler option
PREFETCH directive

qopt-prefetch-issue-excl-hint, Qopt-prefetch-issue-excl-hint
Supports the prefetchW instruction in Intel®

microarchitecture code name Broadwell and later. This
feature is only available for ifort.

Syntax

Linux OS:
-qopt-prefetch-issue-excl-hint
macOS:

None

Windows OS:

/Qopt-prefetch-issue-excl-hint

Arguments

None

Default

OFF The compiler does not support the PREFETCHW
instruction for this microarchitecture.

Description

This option supports the PREFETCHW instruction in Intel® microarchitecture code name Broadwell and later.
When you specify this option, you must also specify option [q or Qlopt-prefetch.

The prefetch instruction is merely a hint and does not affect program behavior. If executed, this instruction
moves data closer to the processor and invalidates any other cached copy in anticipation of the line being
written to in the future.

IDE Equivalent

None
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Alternate Options

None

See Also
gopt-prefetch/Qopt-prefetch Compiler option

qopt-ra-region-strategy, Qopt-ra-region-strategy
Selects the method that the register allocator uses to

partition each routine into regions. This feature is only
available for ifort.

Syntax

Linux OS:
-gopt-ra-region-strategy[=keyword]
macOS:
-gopt-ra-region-strategy[=keyword]
Windows OS:

/Qopt-ra-region-strategyl[:keyword]

Arguments
keyword Is the method used for partitioning. Possible values are:
routine Creates a single region for each routine.
block Partitions each routine into one region per
basic block.
trace Partitions each routine into one region per
trace.
loop Partitions each routine into one region per
loop.
default The compiler determines which method is
used for partitioning.
Default
-gopt-ra-region-strategy=default The compiler determines which method is used for
or /Qopt-ra-region-strategy:default partitioning. This is also the default if keyword is not
specified.
Description

This option selects the method that the register allocator uses to partition each routine into regions.

When setting default is in effect, the compiler attempts to optimize the tradeoff between compile-time
performance and generated code performance.

This option is only relevant when optimizations are enabled (option 01 or higher).

IDE Equivalent

None
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Alternate Options

None

See Also
0 compiler option

qopt-streaming-stores, Qopt-streaming-stores

Enables generation of streaming stores for
optimization. This feature is only available for ifort.

Syntax

Linux OS:
-gopt-streaming-stores=keyword
-gno-opt-streaming-stores
macOS:
-gopt-streaming-stores=keyword
-gno-opt-streaming-stores
Windows OS:
/Qopt-streaming-stores:keyword

/Qopt-streaming-stores-

Arguments

keyword Specifies whether streaming stores are generated. Possible values are:

always

never

auto

Default

-gopt-streaming-stores=auto
Oor /Qopt-streaming-stores:auto
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Enables generation of streaming stores for
optimization. The compiler optimizes under
the assumption that the application is
memory bound.

When this option setting is specified, it is
your responsibility to also insert any memory
barriers (fences) as required to ensure
correct memory ordering within a thread or
across threads. See the Examples section for
one way to do this.

Disables generation of streaming stores for
optimization. Normal stores are performed.
This setting has the same effect as
specifying —qno-opt-streaming-stores
or /Qopt-streaming-stores-.

Lets the compiler decide which instructions
to use.

The compiler decides whether to use streaming stores
or normal stores.
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Description

This option enables generation of streaming stores for optimization. This method stores data with
instructions that use a non-temporal buffer, which minimizes memory hierarchy pollution.

This option may be useful for applications that can benefit from streaming stores.

IDE Equivalent

None

Alternate Options

None

Example

The following example shows one way to insert memory barriers (fences) when specifying
-gopt-streaming-stores=always Or /Qopt-streaming-stores:always. It uses the procedure interface
for_sfence from the module IFCORE, which maps to the C/C++ function _mm_sfence:

subroutine subl(a, b, ¢, len, nl, n2)
use IFCORE, only : for sfence

integer len, nl, n2, i, j

real (8) a(len), b(len), c(len), d(len)

!Somp parallel do
do j =1, nl

a(j) = 1.0

b(j) = 2.0

c(j) = 3.0
enddo

!Somp end parallel do
call ftn sfence()

!Somp parallel do

doi=1, n2
a(l) = a(i) + b(i) * c(i)
enddo

!Somp end parallel do

end

See Also
ax, Qax compiler option
x, Ox compiler option

qopt-subscript-in-range, Qopt-subscript-in-range
Determines whether the compiler assumes that there

are no "large" integers being used or being computed
inside loops. This feature is only available for ifort.

Syntax
Linux OS:

-gopt-subscript-in-range

-gqno-opt-subscript-in-range
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macOS:
-gopt-subscript-in-range
—-gqno-opt-subscript-in-range
Windows OS:
/Qopt-subscript-in-range

/Qopt-subscript-in-range-

Arguments

None

Default

-gno-opt-subscript-in-range The compiler assumes there are "large" integers being used or being

or /Qopt-subscript-in-range- computed within loops.

Description

This option determines whether the compiler assumes that there are no "large" integers being used or being
computed inside loops.

If you specify [g or Qlopt-subscript-in-range, the compiler assumes that there are no "large" integers
being used or being computed inside loops. A "large" integer is typically > 231,

This feature can enable more loop transformations.

IDE Equivalent

None

Alternate Options

None

Example

The following example shows how these options can be useful. Variable m is declared as type
integer(kind=8) (64-bits) and all other variables inside the subscript are declared as type integer(kind=4)
(32-bits):

Ali +3 +(n +%k *mn]

qopt-zmm-usage, Qopt-zmm-usage
Defines a level of zmm registers usage.

Syntax

Linux OS:
—-gopt-zmm-usage=keyword
macOS:
—-gqopt-zmm-usage=keyword
Windows OS:

/Qopt-zmm-usage: keyword
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Arguments
keyword Specifies the level of zmm registers usage. Possible values are:
low Tells the compiler that the compiled program is unlikely to
benefit from zmm registers usage. It specifies that the
compiler should avoid using zmm registers unless it can
prove the gain from their usage.
high Tells the compiler to generate zmm code without
restrictions.
Default

varies The default is low when you specify [Q]xCORE-AVX512.
The default is high when you specify [Q]xCOMMON-AVX512.

Description

This option may provide better code optimization for Intel® processors that are on the Intel®
microarchitecture formerly code-named Skylake.

This option defines a level of zmm registers usage. The low setting causes the compiler to generate code
with zmm registers very carefully, only when the gain from their usage is proven. The high setting causes
the compiler to use much less restrictive heuristics for zmm code generation.

It is not always easy to predict whether the high or the low setting will yield better performance. Programs
that enjoy high performance gains from the use of xmm or ymm registers may expect performance
improvement by moving to use zmm registers. However, some programs that use zmm registers may not
gain as much or may even lose performance. We recommend that you try both option values to measure the
performance of your programs.

This option is ignored if you do not specify an option that enables Intel® AVX-512, such as [Q] xCORE-AVX512
or option [Q] xCOMMON-AVX512.

This option has no effect on loops that use directive SIMD SIMDLEN(n) or on functions that are generated by
vector specifications specific to CORE-AVX512.

IDE Equivalent

None

Alternate Options

None

See Also
x, Ox compiler option
SIMD Directive (OpenMP* API) clause SIMDLEN

qoverride-limits, Qoverride-limits

Lets you override certain internal compiler limits that
are intended to prevent excessive memory usage or
compile times for very large, complex compilation
units. This feature is only available for ifort.
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Syntax

Linux OS:
-goverride-limits
macOS:
-goverride-limits
Windows OS:

/Qoverride-limits

Arguments

None

Default

OFF Certain internal compiler limits are not overridden. These limits are determined by default
heuristics.

Description

This option provides a way to override certain internal compiler limits that are intended to prevent excessive
memory usage or compile times for very large, complex compilation units.

If this option is not used and your program exceeds one of these internal compiler limits, some optimizations
will be skipped to reduce the memory footprint and compile time. If you chose to create an optimization
report by specifying [g or Qlopt-report, you may see a related diagnostic remark as part of the report.

Specifying this option may substantially increase compile time and/or memory usage.

NOTE
If you use this option, it is your responsibility to ensure that sufficient memory is available.
If there is not sufficient available memory, the compilation may fail.

This option should only be used where there is a specific need; it is not recommended for
inexperienced users.

IDE Equivalent

None

Alternate Options
None

reentrancy

Tells the compiler to generate reentrant code to
support a multithreaded application.

Syntax
Linux OS:

-reentrancy keyword

-noreentrancy
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macOS:

-reentrancy keyword
-noreentrancy
Windows OS:
/reentrancy: keyword

/noreentrancy

Arguments
keyword Specifies details about the program. Possible values are:

none Tells the run-time library (RTL) that the program does not rely on
threaded or asynchronous reentrancy. The RTL will not guard against
such interrupts inside its own critical regions. This is the same as
specifying noreentrancy.

async Tells the run-time library (RTL) that the program may contain
asynchronous (AST) handlers that could call the RTL. This causes the
RTL to guard against AST interrupts inside its own critical regions.

threaded Tells the run-time library (RTL) that the program is multithreaded, such
as programs using the POSIX threads library. This causes the RTL to use
thread locking to guard its own critical regions.

Default

threaded The compiler tells the run-time library (RTL) that the program is multithreaded.

Description
This option tells the compiler to generate reentrant code to support a multithreaded application.
If you do not specify a keyword for reentrancy, it is the same as specifying reentrancy threaded.

To ensure that a threadsafe and/or reentrant run-time library is linked and correctly initialized, option
reentrancy threaded should also be used for the link step and for the compilation of the main routine.

Note that if option threads is specified, it sets option reentrancy threaded, since multithreaded code must
be reentrant.

IDE Equivalent

Windows

Visual Studio: Code Generation > Generate Reentrant Code

Alternate Options

None

See Also
threads compiler option

safe-cray-ptr, Qsafe-cray-ptr

Tells the compiler that Cray* pointers do not alias
other variables.
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Syntax
Linux OS:

-safe-cray-ptr
macOS:
-safe-cray-ptr
Windows OS:

/Qsafe-cray-ptr

Arguments

None

Default

OFF The compiler assumes that Cray pointers alias other variables.

Description

This option tells the compiler that Cray pointers do not alias (that is, do not specify sharing memory with)
other variables.

IDE Equivalent

Windows

Visual Studio: Data > Assume CRAY Pointers Do Not Share Memory Locations (/Qsafe-cray-ptr)

Alternate Options

None

Example

Consider the following:

pointer (pb, b)
pb = getstorage()
doi=1, n

b(i) = a(i) + 1
enddo

By default, the compiler assumes that b and a are aliased. To prevent such an assumption, specify the
-safe-cray-ptr (Linux* and macOS*) or /Qsafe-cray-ptr (Windows*) option, and the compiler will treat
b(i) and a(i) as independent of each other.

However, if the variables are intended to be aliased with Cray pointers, using the option produces incorrect
results. In the following example, you should not use the option:

pointer (pb, b)
pb = loc(a(2))
do i=1, n

b(i) = a(i) +1
enddo
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scalar-rep, Qscalar-rep

Enables or disables the scalar replacement
optimization done by the compiler as part of loop
transformations. This feature is only available for ifort.

Syntax

Linux OS:
-scalar-rep
-no-scalar-rep
macOS:
-scalar-rep
-no-scalar-rep
Windows OS:
/Qscalar-rep

/Qscalar-rep-

Arguments

None
Default

-scalar-rep Scalar replacement is performed during loop transformation at optimization levels of

or /Qscalar-rep 02 and above.

Description

This option enables or disables the scalar replacement optimization done by the compiler as part of loop
transformations. This option takes effect only if you specify an optimization level of 02 or higher.

IDE Equivalent

None

Alternate Options

None

See Also
O compiler option

simd, Qsimd

Enables or disables compiler interpretation of SIMD
directives.This feature is only available for ifort.

Syntax
Linux OS:

-simd

-no-simd
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macOS:
-simd
-no-simd
Windows OS:
/Qsimd
/Qsimd-

Arguments

None

Default

—simd SIMD directives are enabled.
or /QOsimd

Description
This option enables or disables compiler interpretation of SIMD directives.

To disable interpretation of SIMD directives, specify —-no-simd (Linux* and macOS*) or /Qsimd-
(Windows*). Note that the compiler may still vectorize loops based on its own heuristics (leading to
generation of SIMD instructions) even when -no-simd (or /Qsimd-) is specified.

To disable all compiler vectorization, use the "-no-vec -no-simd" (Linux* and macOS*) or

"/Qvec- /Qsimd-" (Windows*) compiler options. The option -no-vec (and /Qvec-) disables all auto-
vectorization, including vectorization of array notation statements. The option -no-simd (and /Qsimd-)
disables vectorization of loops that have SIMD directives.

NOTE

If you specify option -mia32 (Linux*) or option /arch:Ia32 (Windows*), SIMD directives are
disabled by default and vector instructions cannot be used. Therefore, you cannot explicitly
enable SIMD directives by specifying option [Q]simd.

IDE Equivalent

None

Alternate Options

None

See Also
vec, Ovec compiler option
SIMD Directive

unroll, Qunroll

Tells the compiler the maximum number of times to
unroll loops.

Syntax
Linux OS:

-unroll [=n]
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macOS:
-unroll [=n]
Windows OS:

/Ounroll[:n]

Arguments

n Is the maximum number of times a loop can be unrolled. To disable loop enrolling, specify 0.
Default

—unroll The compiler uses default heuristics when unrolling loops.

or /Qunroll

Description
This option tells the compiler the maximum number of times to unroll loops.

If you do not specify n, the optimizer determines how many times loops can be unrolled.
IDE Equivalent

Windows

Visual Studio: Optimization > Loop Unroll Count

Alternate Options
Linux and macOS*: -funroll-loops
Windows: /unroll (this is a deprecated option)

unroll-aggressive, Qunroll-aggressive

Determines whether the compiler uses more
aggressive unrolling for certain loops. This feature is
only available for ifort.

Syntax

Linux OS:
-unroll-aggressive
-no-unroll-aggressive
macOS:
-unroll-aggressive
-no-unroll-aggressive
Windows OS:
/Qunroll-aggressive

/Qunroll-aggressive-

Arguments

None
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Default

-no-unroll-aggressive The compiler uses default heuristics when unrolling loops.

or /Qunroll-aggressive-

Description

This option determines whether the compiler uses more aggressive unrolling for certain loops. The positive
form of the option may improve performance.

This option enables aggressive, complete unrolling for loops with small constant trip counts.

IDE Equivalent

None

Alternate Options

None

vec, Qvec
Enables or disables vectorization.

Syntax
Linux OS:
-vec
—no—-vec
macOS:

—-vec
—no—-vec
Windows OS:
/Qvec

/Qvec-—

Arguments

None
Default
—vec Vectorization is enabled if option 02 or higher is in effect.

or /Qvec

Description
This option enables or disables vectorization.
To disable vectorization, specify -no-vec (Linux* and macOS*) or /Qvec- (Windows¥*).

To disable interpretation of SIMD directives, specify -no-simd (Linux* and macOS*) or /Qsimd-
(Windows*).
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To disable all compiler vectorization, use the "-no-vec -no-simd" (Linux* and macOS*) or

"/Quec- /Qsimd-" (Windows*) compiler options. The option -no-vec (and /Qvec-) disables all auto-
vectorization, including vectorization of array notation statements. The option -no-simd (and /Qsimd-)
disables vectorization of loops that have SIMD directives.

NOTE

Using this option enables vectorization at default optimization levels for both Intel®
microprocessors and non-Intel microprocessors. Vectorization may call library routines that
can result in additional performance gain on Intel microprocessors than on non-Intel
microprocessors. The vectorization can also be affected by certain options, such as /arch
(Windows), -m (Linux and macOS*), or [Q]x.

IDE Equivalent

None

Alternate Options

None

See Also

simd, QOsimd compiler option

ax, Qax compiler option

x, Ox compiler option

vec-guard-write, Qvec-guard-write compiler option
vec-threshold, Qvec-threshold compiler option

vec-guard-write, Qvec-guard-write

Tells the compiler to perform a conditional check in a
vectorized loop. This feature is only available for ifort.

Syntax

Linux OS:
-vec-guard-write
-no-vec-guard-write
macOS:
-vec-guard-write
-no-vec-guard-write
Windows OS:
/Qvec-guard-write

/Qvec—-guard-write-

Arguments

None
Default

-vec-guard-write The compiler performs a conditional check in a vectorized loop.
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or /Qvec—-guard-write

Description

This option tells the compiler to perform a conditional check in a vectorized loop. This checking avoids
unnecessary stores and may improve performance.

IDE Equivalent

None

Alternate Options

None

vec-threshold, Qvec-threshold

Sets a threshold for the vectorization of loops.

Syntax
Linux OS:

-vec-threshold[n]

macOS:

-vec—-threshold[n]

Windows OS:
/Qvec—-threshold[[:]n]

Arguments

n

Default

-vec-thresholdl100
or /Qvec-thresholdl100

Description

Is an integer whose value is the threshold for the vectorization of
loops. Possible values are 0 through 100.

If n is 0, loops get vectorized always, regardless of computation work
volume.

If nis 100, loops get vectorized when performance gains are predicted
based on the compiler analysis data. Loops get vectorized only if
profitable vector-level parallel execution is almost certain.

The intermediate 1 to 99 values represent the percentage probability
for profitable speed-up. For example, n=50 directs the compiler to
vectorize only if there is a 50% probability of the code speeding up if
executed in vector form.

Loops get vectorized only if profitable vector-level parallel execution is
almost certain. This is also the default if you do not specify n.

This option sets a threshold for the vectorization of loops based on the probability of profitable execution of

the vectorized loop in parallel.

This option is useful for loops whose computation work volume cannot be determined at compile-time. The
threshold is usually relevant when the loop trip count is unknown at compile-time.
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The compiler applies a heuristic that tries to balance the overhead of creating multiple threads versus the
amount of work available to be shared amongst the threads.

IDE Equivalent

Windows

Visual Studio: Optimization > Threshold For Vectorization

Alternate Options
None

vecabi, Qvecabi

Determines which vector function application binary
interface (ABI) the compiler uses to create or call

vector functions. This feature is only available for ifort.

Syntax
Linux OS:
-vecabi=keyword

macOS:

-vecabi=keyword

Windows OS:
/Qvecabi : keyword

Arguments

keyword Specifies which vector function ABI to use. Possible values are:

compat

cmdtarget

gcc

legacy

Tells the compiler to use the compatibility vector
function ABI. This ABI includes Intel®-specific features.

Tells the compiler to generate an extended set of vector
functions. The option is very similar to setting compat.
However, for compat, only one vector function is
created, while for cmdtarget, several vector functions
are created for each vector specification. Vector
variants are created for targets specified by compiler
options [Q]x and/or [Q]ax. No change is made to the
source code.

Tells the compiler to use the gcc vector function ABI.
Use this setting only in cases when you want to link
with modules compiled by gcc. This setting is not
available on Windows* systems.

Tells the compiler to use the legacy vector function ABI.
Use this setting if you need to keep the generated
vector function binary backward compatible with the
vectorized binary generated by older versions of the
Intel® compilers (V13.1 or older).
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Default

compat The compiler uses the compatibility vector function ABI.

Description

This option determines which vector function application binary interface (ABI) the compiler uses to create or
call vector functions.

NOTE

To avoid possible link-time and runtime errors, use identical [Q]vecabi settings when
compiling all files in an application that define or use vector functions, including libraries. If
setting cmdtarget is specified, options [0]x and/or [0]ax must have identical values.

Be careful using setting cmdtarget with libraries or program modules/routines with vector function
definitions that cannot be recompiled. In such cases, setting cmdtarget may cause link errors.

On Linux* systems, since the default is compat, you must specify legacy if you need to keep the generated
vector function binary backward compatible with the vectorized binary generated by the previous version of
Intel® compilers.

When cmdtarget is specified, the additional vector function versions are created by copying each vector
specification and changing target processor in the copy. The number of vector functions is determined by the
settings specified in options [Q]x and/or [Q]ax.

For example, suppose we have the following function declaration:

interface

integer function foo(a)

'dir$ attributes vector: (processor (core 2 duo ssed4 1)) :: foo
integer a

end function

end interface

and the following options are specified: —axAVX, CORE-AVX2

The following table shows the different results for the above declaration and option specifications when
setting compat or setting cmdtarget is used:

compat cmdtarget

One vector version is created for Intel® SSE4.1 (by Four vector versions are created for the following
vector function specification). targets:

¢ Intel® SSE2 (default because no -x option is
used)

¢ Intel® SSE4.1 (by vector function specification)

+ Intel® AVX (by the first —ax option value)

¢ Intel® AVX2 (by the second -ax option value)

For more information about the Intel®-compatible vector functions ABI, see the downloadable PDF titled:
Vector Function Application Binary Interface, at https://software.intel.com/content/www/us/en/develop/
download/vector-simd-function-abi.html

For more information about the GCC vector functions ABI, see the item Libmvec - vector math library
document in the GLIBC wiki at sourceware.org.
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Product and Performance Information

Performance varies by use, configuration and other factors. Learn more at www.Intel.com/
Performancelndex.

Notice revision #20201201

IDE Equivalent

None

Alternate Options

None

Profile Guided Optimization (PGO) Options
This section contains descriptions for compiler options that pertain to profile-guided optimization.

finstrument-functions, Qinstrument-functions

Determines whether routine entry and exit points are
instrumented.

Syntax

Linux OS:
-finstrument-functions
-fno-instrument-functions
macOS:
-finstrument-functions
-fno-instrument-functions
Windows OS:
/Qinstrument-functions

/Qinstrument-functions-

Arguments

None
Default

—fno-instrument-functions Routine entry and exit points are not instrumented.

or /Qinstrument-functions-

Description

This option determines whether routine entry and exit points are instrumented. It may increase execution
time.

The following profiling functions are called with the address of the current routine and the address of where
the routine was called (its "call site"):

e This function is called upon routine entry:
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void cyg profile func enter (void *this fn,

void *call site);
e This function is called upon routine exit:

void cyg profile func exit (void *this fn,
void *call site);

These functions can be used to gather more information, such as profiling information or timing information.
Note that it is the user's responsibility to provide these profiling functions.

If you specify -finstrument-functions (Linux* and macOS*) or /Qinstrument-functions (Windows*),
routine inlining is disabled. If you specify -fno-instrument-functions or /Qinstrument-functions-,
inlining is not disabled.

This option is provided for compatibility with gcc.
IDE Equivalent

None

Alternate Options
None
fnsplit, Qfnsplit

Enables function splitting. This feature is only
available for ifort.

Syntax

Linux OS:
-fnsplit[=n]
-no-fnsplit
macOS:

None
Windows OS:
/Qfnsplit[:n]

/Qfnsplit-

Arguments

n Is an optional positive integer indicating the threshold number.
The blocks can be placed into a different code segment if they are only
reachable via a conditional branch whose taken probability is less than
the specified n. Branch taken probability is heuristically calculated by
the compiler and can be observed in assembly listings.
The range for nis 0 <= n <= 100.

Default

OFF Function splitting is not enabled. However, function grouping is still

enabled.
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Description

This option enables function splitting. If you specify [Q] fnsplit with no n, you must also specify option
[Qlprof-use, or the option will have no effect and no function splitting will occur.

If you specify n, function splitting is enabled and you do not need to specify option [Q]prof-use.

To disable function splitting when you use option [Q]prof-use, specify /Qfnsplit- (Windows*) or
-no-fnsplit (Linux*).

NOTE
Function splitting is generally not supported when exception handling is turned on for C/C+
+ routines in the stack of called routines. See also -fexceptions (Linux*).

IDE Equivalent

None

Alternate Options
Linux: -freorder-blocks-and-partition (a gcc option)
Windows: None

p
Compiles and links for function profiling with gprof(1).

Syntax
Linux OS:

-p

macOS:

-p

Windows OS:
None
Arguments
None
Default

OFF Files are compiled and linked without profiling.

Description
This option compiles and links for function profiling with gprof(1).

When you specify this option, inlining is disabled. However, you can override this by specifying directive
FORCEINLINE, or a compiler option such as [Q]inline-forceinline.

IDE Equivalent

None
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Alternate Options
Linux and macOS*: -pg,-gp (this is a deprecated option)
Windows: None

prof-data-order, Qprof-data-order

Enables or disables data ordering if profiling
information is enabled. This feature is only available
for ifort.

Syntax

Linux OS:
-prof-data-order
-no-prof-data-order
macOS:

None

Windows OS:
/Qprof-data-order

/Qprof-data-order-

Arguments

None
Default

-no-prof-data-order Data ordering is disabled.
or /Qprof-data-order-

Description

This option enables or disables data ordering if profiling information is enabled. It controls the use of profiling
information to order static program data items.

For this option to be effective, you must do the following:

e For instrumentation compilation, you must specify option [Q]lprof-gen setting globdata.

e For feedback compilation, you must specify the [Q]prof-use option. You must not use multi-file
optimization by specifying options such as [Q] ipo or [Q]ipo-c.

IDE Equivalent

None

Alternate Options

None

See Also

prof-gen, Qprof-gen compiler option

prof-use, Qprof-use compiler option
prof-func-order, Qprof-func-order compiler option
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prof-dir, Qprof-dir
Specifies a directory for profiling information output
files. This feature is only available for ifort.

Syntax

Linux OS:
-prof-dir dir
macOS:
-prof-dir dir
Windows OS:
/Qprof-dir:dir

Arguments

dir Is the name of the directory. You can specify a relative pathname or
an absolute pathname.

Default

OFF Profiling output files are placed in the directory where the program is compiled.

Description

This option specifies a directory for profiling information output files (*.dyn and *.dpi). The specified
directory must already exist.

You should specify this option using the same directory name for both instrumentation and feedback
compilations. If you move the .dyn files, you need to specify the new path.

Option /Qprof-dir is equivalent to option /Qcov-dir. If you specify both options, the last option specified
on the command line takes precedence.

IDE Equivalent

Windows

Visual Studio: Output Files > Profile Directory

Alternate Options
None
prof-file, Qprof-file

Specifies an alternate file name for the profiling
summary files. This feature is only available for ifort.

Syntax
Linux OS:

-prof-file filename

macOS:

-prof-file filename
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Windows OS:
/Qprof-file: filename

Arguments

filename Is the name of the profiling summary file.
Default

OFF The profiling summary files have the file name pgopti.*

Description

This option specifies an alternate file name for the profiling summary files. The filename is used as the base
name for files created by different profiling passes.

If you add this option to profmerge, the .dpi file will be named filename.dpi instead of pgopti.dpi.

If you specify this option with option [Q]prof-use, the .dpi file will be named filename.dpi instead of
pgopti.dpi.

Option /Qprof-file is equivalent to option /Qcov-file. If you specify both options, the last option
specified on the command line takes precedence.

NOTE
When you use option [Q]prof-file, you can only specify a file name. If you want to specify
a path (relative or absolute) for filename, you must also use option [Q]prof-dir.

IDE Equivalent

None

Alternate Options

None

See Also

prof-gen, Qprof-gen compiler option
prof-use, Qprof-use compiler option
prof-dir, Qprof-dir compiler option

prof-func-groups

Enables or disables function grouping if profiling
information is enabled. This feature is only available
for ifort.

Syntax

Linux OS:
-prof-func-groups
-no-prof-func-groups
macOS:

None
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Windows OS:

None

Arguments

None

Default

-no-prof-func-groups Function grouping is disabled.
Description

This option enables or disables function grouping if profiling information is enabled.

A "function grouping" is a profiling optimization in which entire routines are placed either in the cold code
section or the hot code section.

If profiling information is enabled by option -prof-use, option -prof-func-groups is set and function
grouping is enabled. However, if you explicitly enable -prof-func-order, function ordering is performed
instead of function grouping.

If you want to disable function grouping when profiling information is enabled, specify
-no-prof-func-groups.

To set the hotness threshold for function grouping, use option -prof-hotness-threshold.

IDE Equivalent

None

See Also

prof-use, Qprof-use compiler option

prof-func-order, Qprof-func-order
compiler option

prof-hotness-threshold, Qprof-hotness-threshold
compiler option

prof-func-order, Qprof-func-order

Enables or disables function ordering if profiling
information is enabled. This feature is only available
for ifort.

Syntax

Linux OS:
-prof-func-order
-no-prof-func-order
macOS:

None

Windows OS:
/Qprof-func-order

/Qprof-func-order-
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Arguments

None

Default

-no-prof-func-order Function ordering is disabled.

or /Qprof-func-order-

Description
This option enables or disables function ordering if profiling information is enabled.
For this option to be effective, you must do the following:

e For instrumentation compilation, you must specify option [Q]lprof-gen setting srcpos.
e For feedback compilation, you must specify [Q]prof-use. You must not use multi-file optimization by
specifying options such as [Q]ipo or [Q]ipo-c.

If you enable profiling information by specifying option [Q]prof-use, option [Q]prof-func-groups is set
and function grouping is enabled. However, if you explicitly enable the [Q]prof-func-order option, function
ordering is performed instead of function grouping.

On Linux* systems, this option is only available for Linux linker 2.15.94.0.1, or later.

To set the hotness threshold for function grouping and function ordering, use option
[Qlprof-hotness-threshold.

IDE Equivalent

None

Alternate Options

None

Example

The following example shows how to use this option on a Windows system:

ifort /Qprof-gen:globdata filel.f90 file2.f90 /exe:instrumented.exe
./instrumented.exe
ifort /Qprof-use /Qprof-func-order filel.f90 file2.f90 /exe:feedback.exe

The following example shows how to use this option on a Linux system:

ifort -prof-gen:globdata filel.f90 file2.£f90 -o instrumented
./instrumented.exe
ifort -prof-use -prof-func-order filel.f90 file2.£f90 -o feedback

See Also

prof-hotness-threshold, Qprof-hotness-threshold compiler option
prof-gen, Qprof-gen compiler option

prof-use, Qprof-use compiler option

prof-data-order, Qprof-data-order compiler option
prof-func-groups compiler option

prof-gen, Qprof-gen
Produces an instrumented object file that can be used

in profile guided optimization. This feature is only
available for ifort.
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Syntax

Linux OS:

-prof-gen[=keyword[, keyword],...]
-no-prof-gen

macOS:

-prof-gen[=keyword[, keyword],...]
-no-prof-gen

Windows OS:
/Qprof-gen|:keyword[, keyword], ...]

/Qprof-gen-
Arguments
keyword Specifies details for the instrumented file. Possible values are:

default Produces an instrumented object file. This is
the same as specifying the [Q]prof-gen
option with no keyword.

srcpos Produces an instrumented object file that
includes extra source position information.

globdata Produces an instrumented object file that
includes information for global data layout.

[no]threadsafe Produces an instrumented object file that
includes the collection of PGO data on
applications that use a high level of
parallelism. If [Q]prof-gen is specified with
no keyword, the default is nothreadsafe.

Default

-no-prof-gen Or /Qprof-gen—- Profile generation is disabled.

Description

This option produces an instrumented object file that can be used in profile guided optimization. It gets the
execution count of each basic block.

You can specify more than one setting for [Q]prof-gen. For example, you can specify the following:

-prof-gen=srcpos -prof-gen=threadsafe (Linux* and macOS*)
-prof-gen=srcpos, threadsafe (this is equivalent to the above)

/Qprof-gen:srcpos /Qprof-gen:threadsafe (Windows*)
/Qprof-gen:srcpos, threadsafe (this is equivalent to the above)

If you specify keyword srcpos or globdata, a static profile information file (.spi) is created. These settings
may increase the time needed to do a parallel build using -prof-gen, because of contention writing the .spi
file.

These options are used in phase 1 of the Profile Guided Optimizer (PGO) to instruct the compiler to produce
instrumented code in your object files in preparation for instrumented execution.
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When the [Q]prof-gen option is used to produce an instrumented binary file for profile generation, some
optimizations are disabled. Those optimizations are not disabled for any subsequent profile-guided
compilation with option [Q]prof-use that makes use of the generated profiles.

IDE Equivalent

None

Alternate Options

None

See Also
prof-use, Qprof-use compiler option
Profile an Application with Instrumentation

prof-gen-sampling

Tells the compiler to generate debug discriminators in
debug output. This aids in developing more precise
sampled profiling output. This option is deprecated
and will be removed in a future release. This feature is
only available for ifort.

Syntax

Linux OS:
-prof-gen-sampling
macOS:

None

Windows OS:

None

Arguments

None
Default

OFF The compiler does not generate debug discriminators in the debug
output.

Description

This option tells the compiler to generate debug discriminators in debug output. Debug discriminators are
used to distinguish code from different basic blocks that have the same source position information. This aids
in developing more precise sampled hardware profiling output.

To build an executable suitable for generating hardware profiled sampled output, compile with the following
options:

-prof-gen-sampling -g

To use the data files produced by hardware profiling, compile with option -prof-use-sampling.

IDE Equivalent

None
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Alternate Options

None

See Also

prof-use-sampling compiler option

g compiler option

Profile an Application with Instrumentation

prof-hotness-threshold, Qprof-hotness-threshold
Lets you set the hotness threshold for function

grouping and function ordering. This feature is only
available for ifort.

Syntax

Linux OS:
-prof-hotness-threshold=n
macOS:

None

Windows OS:

/Qprof-hotness-threshold:n

Arguments

n Is the hotness threshold. n is a percentage having a value between 0
and 100 inclusive. If you specify 0, there will be no hotness threshold
setting in effect for function grouping and function ordering.

Default

OFF The compiler's default hotness threshold setting of 10 percent is in effect for function

grouping and function ordering.
Description

This option lets you set the hotness threshold for function grouping and function ordering.

The "hotness threshold" is the percentage of functions in the application that should be placed in the
application's hot region. The hot region is the most frequently executed part of the application. By grouping
these functions together into one hot region, they have a greater probability of remaining resident in the
instruction cache. This can enhance the application's performance.

For this option to take effect, you must specify option [Q]prof-use and one of the following:

e On Linux systems: -prof-func-groups or -prof-func-order
e On Windows systems: /Qprof-func-order

IDE Equivalent

None

Alternate Options

None
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See Also

prof-use, Qprof-use compiler option
prof-func-groups compiler option
prof-func-order, Qprof-func-order compiler option

prof-src-dir, Qprof-src-dir

Determines whether directory information of the
source file under compilation is considered when
looking up profile data records. This feature is only
available for ifort.

Syntax

Linux OS:
-prof-src-dir
-no-prof-src-dir
macOS:
-prof-src-dir
-no-prof-src-dir
Windows OS:
/Qprof-src-dir

/Qprof-src-dir-

Arguments

None

Default

[Q]prof-src-dir Directory information is used when looking up profile data records in
the .dpi file.

Description

This option determines whether directory information of the source file under compilation is considered when
looking up profile data records in the .dpi file. To use this option, you must also specify the [Q]prof-use
option.

If the option is enabled, directory information is considered when looking up the profile data records within
the .dpi file. You can specify directory information by using one of the following options:

e Linux and macOS*: -prof-src-root Or -prof-src-root-cwd
e Windows: /Qprof-src-root Or /Qprof-src-root-cwd

If the option is disabled, directory information is ignored and only the name of the file is used to find the
profile data record.

Note that option [Q]prof-src-dir controls how the names of the user's source files get represented within
the .dyn or .dpi files. Option [Q]prof-dir specifies the location of the .dyn or the .dpi files.

IDE Equivalent

None
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Alternate Options

None

See Also

prof-use, Qprof-use compiler option

prof-src-root, Qprof-src-root compiler option
prof-src-root-cwd, Qprof-src-root-cwd compiler option

prof-src-root, Qprof-src-root

Lets you use relative directory paths when looking up
profile data and specifies a directory as the base. This
feature is only available for ifort.

Syntax

Linux OS:
-prof-src-root=dir
macOS:
-prof-src-root=dir
Windows OS:

/Qprof-src-root:dir

Arguments

dir Is the base for the relative paths.

Default

OFF The setting of relevant options determines the path used when looking up profile data records.
Description

This option lets you use relative directory paths when looking up profile data in .dpi files. It lets you specify a
directory as the base. The paths are relative to a base directory specified during the [Q]prof-gen
compilation phase.

This option is available during the following phases of compilation:

e Linux* and macOS* systems: -prof-gen and -prof-use phases
e Windows* systems: /Qprof-gen and /Qprof-use phases

When this option is specified during the [Q]prof-gen phase, it stores information into the .dyn or .dpi file.
Then, when .dyn files are merged together or the .dpi file is loaded, only the directory information below the
root directory is used for forming the lookup key.

When this option is specified during the [Q]prof-use phase, it specifies a root directory that replaces the
root directory specified at the [Q]prof-gen phase for forming the lookup keys.

To be effective, this option or option [Q]prof-src-root-cwd must be specified during the [Q]prof-gen
phase. In addition, if one of these options is not specified, absolute paths are used in the .dpi file.

IDE Equivalent

None
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Alternate Options

None

Example

Consider the initial [Q] prof-gen compilation of the source file c:\userl\feature_foo\myproject\common
\glob.f90 shown below:

Linux* and macOS*: icc -prof-gen -prof-src-root=c:\userl\feature foo\myproject -c common\glob.c
Windows*: ifort /Qprof-gen /Qprof-src-root=c:\userl\feature foo\myproject -c common\glob.f90

Linux* and macOS*: ifort -prof-gen -prof-src-root=c:\userl\feature foo\myproject -c common
\glob.£90

For the [Q]lprof-use phase, the file glob.f90 could be moved into the directory c:\user2\feature_bar
\myproject\common\glob.f90 and profile information would be found from the .dpi when using the following:

Windows*: ifort /Qprof-use /Qprof-src-root=c:\user2\feature bar\myproject -c common\glob.£90

Linux* and macOS*: ifort -prof-use -prof-src-root=c:\user2\feature bar\myproject -c common
\glob.£90

If you do not use option [Q]prof-src-root during the [Q]lprof-gen phase, by default, the [Q]prof-use
compilation can only find the profile data if the file is compiled in the c:\userl\feature_foo\my_project
\common directory.

See Also

prof-gen, Qprof-gen compiler option

prof-use, Qprof-use compiler option

prof-src-dir, Qprof-src-dir compiler option
prof-src-root-cwd, Qprof-src-root-cwd compiler option

prof-src-root-cwd, Qprof-src-root-cwd

Lets you use relative directory paths when looking up
profile data and specifies the current working directory
as the base. This feature is only available for ifort.

Syntax
Linux OS:
-prof-src-root-cwd

macOS:

-prof-src-root-cwd

Windows OS:

/Qprof-src-root-cwd

Arguments

None

Default

OFF The setting of relevant options determines the path used when looking up profile data records.
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Description

This option lets you use relative directory paths when looking up profile data in .dpi files. It specifies the
current working directory as the base. To use this option, you must also specify option [Q]prof-use.

This option is available during the following phases of compilation:

e Linux* and macOS* systems: -prof-gen and -prof-use phases
e Windows* systems: /Qprof-gen and /Qprof-use phases

When this option is specified during the [Q]prof-gen phase, it stores information into the .dyn or .dpi file.
Then, when .dyn files are merged together or the .dpi file is loaded, only the directory information below the
root directory is used for forming the lookup key.

When this option is specified during the [Q]prof-use phase, it specifies a root directory that replaces the
root directory specified at the [Q]prof-gen phase for forming the lookup keys.

To be effective, this option or option [Q]prof-src-root must be specified during the [Q]prof-gen phase.
In addition, if one of these options is not specified, absolute paths are used in the .dpi file.
IDE Equivalent

None

Alternate Options

None

See Also

prof-gen, Qprof-gen compiler option

prof-use, Qprof-use compiler option
prof-src-dir, Qprof-src-dir compiler option
prof-src-root, Qprof-src-root compiler option

prof-use, Qprof-use

Enables the use of profiling information during
optimization. This feature is only available for ifort.

Syntax

Linux OS:
-prof-use[=keyword]
-no-prof-use

macOS:
-prof-use[=keyword]
-no-prof-use
Windows OS:
/Qprof-usel: keyword]

/Qprof-use-

Arguments

keyword Specifies additional instructions. Possible values are:
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weighted Tells the profmerge utility to apply a weighting to
the .dyn file values when creating the .dpi file to
normalize the data counts when the training runs have
differentexecution durations. This argument only has an
effect when the compiler invokes the profmerge utility
to create the .dpi file. This argument does not have an
effect if the .dpi file was previously created without
weighting.

[nolmerge Enables or disables automatic invocation of the
profmerge utility. The default is merge. Note that you
cannot specify both weighted and nomerge. If you try
to specify both values, a warning will be displayed and
nomerge takes precedence.

default Enables the use of profiling information during
optimization. The profmerge utility is invoked by
default. This value is the same as specifying
[Q]lprof-use with no argument.

Default

-no-prof-use Of /Qprof-use- Profiling information is not used during optimization.

Description

This option enables the use of profiling information (including function splitting and function grouping) during
optimization. It enables option /Qfnsplit (Windows*) and -fnsplit (Linux* and macOS¥*) .

This option instructs the compiler to produce a profile-optimized executable and it merges available profiling
output files into a pgopti.dpi file.

Note that there is no way to turn off function grouping if you enable it using this option.
To set the hotness threshold for function grouping and function ordering, use option
[Q]lprof-hotness-threshold.

IDE Equivalent

None

Alternate Options

None

See Also

prof-hotness-threshold, Qprof-hotness-threshold compiler option
prof-gen, Qprof-gen compiler option

Profile an Application with Instrumentation

prof-use-sampling

Lets you use data files produced by hardware profiling
to produce an optimized executable. This option is
deprecated and will be removed in a future release.
This feature is only available for ifort.
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Syntax

Linux OS:
-prof-use-sampling=1list
macOS:

None

Windows OS:

None

Arguments

list Is a list of one or more data files. If you specify more than one data

file, they must be separated by colons.

Default

OFF Data files produced by hardware profiling will not be used to produce

an optimized executable.

Description

This option lets you use data files produced by hardware profiling to produce an optimized executable.

These data files are named and produced by using Intel® VTune™.

The executable should have been produced using the following options:

-prof-gen-sampling -g

IDE Equivalent

None

Alternate Options

None

See Also
prof-gen-sampling compiler option
Profile an Application with Instrumentation

prof-value-profiling, Qprof-value-profiling

Controls which values are value profiled. This feature
is only available for ifort.

Syntax

Linux OS:
-prof-value-profiling[=keyword]
macOS:
-prof-value-profiling[=keyword]

Windows OS:
/Qprof-value-profiling[: keyword]
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Arguments
keyword Controls which type of value profiling is performed. Possible values are:
none Prevents all types of value profiling.
nodivide Prevents value profiling of non-compile time constants used in division or

remainder operations.
noindcall Prevents value profiling of function addresses at indirect call sites.

all Enables all types of value profiling.

You can specify more than one keyword, but they must be separated by commas.

Default
all All value profile types are enabled and value profiling is performed.
Description

This option controls which features are value profiled.

If this option is specified with option [Q]prof-gen, it turns off instrumentation of operations of the specified
type. This also prevents feedback of values for the operations.

If this option is specified with option [Q]prof-use, it turns off feedback of values collected of the specified
type.

If you specify level 2 or higher for option[gq or Q]opt-report, the value profiling specialization information
will be reported within the PGO optimization report.

IDE Equivalent

None

Alternate Options
None

See Also

prof-gen, Qprof-gen compiler option
prof-use, Qprof-use compiler option
gopt-report, Qopt-report conpreropHon

Qcov-dir

Specifies a directory for profiling information output
files that can be used with the codecov or tselect tool.
This feature is only available for ifort.

Syntax
Linux OS:
None

macOS:

None

Windows OS:

/Qcov-dir:dir
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Arguments

dir Is the name of the directory.

Default

OFF Profiling output files are placed in the directory where the program is compiled.
Description

This option specifies a directory for profiling information output files (*.dyn and *.dpi) that can be used with
the code-coverage tool (codecov) or the test prioritization tool (tselect). The specified directory must already
exist.

You should specify this option using the same directory name for both instrumentation and feedback
compilations. If you move the .dyn files, you need to specify the new path.

Option /Qcov-dir is equivalent to option /Qprof-dir. If you specify both options, the last option specified
on the command line takes precedence.
IDE Equivalent

None

Alternate Options

None

See Also
Qcov-gen compiler option
Qcov-file compiler option

Qcov-file

Specifies an alternate file name for the profiling
summary files that can be used with the codecov or
tselect tool. This feature is only available for ifort.

Syntax
Linux OS:
None

macOS:

None

Windows OS:

/Qcov-file: filename

Arguments

filename Is the name of the profiling summary file.
Default

OFF The profiling summary files have the file name pgopti.*.
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Description

This option specifies an alternate file name for the profiling summary files. The file name can be used with
the code-coverage tool (codecov) or the test prioritization tool (tselect).

The filename is used as the base name for the set of files created by different profiling passes.

If you specify this option with option /Qcov-gen, the .spi and .spl files will be named filename.spi and
filename.spl instead of pgopti.spi and pgopti.spl.

Option /Qcov-file is equivalent to option /Qprof-file. If you specify both options, the last option
specified on the command line takes precedence.
IDE Equivalent

None

Alternate Options

None

See Also
Qcov-gen compiler option
Qcov-dir compiler option

Qcov-gen

Produces an instrumented object file that can be used
with the codecov or tselect tool. This feature is only
available for ifort.

Syntax
Linux OS:
None
macOS:

None
Windows OS:
/Qcov-gen

/Qcov-gen-
Arguments
None
Default

/Qcov-gen- The instrumented object file is not produced.

Description

This option produces an instrumented object file that can be used with the code-coverage tool (codecov) or
the test prioritization tool (tselect). The instrumented code is included in the object file in preparation for
instrumented execution.

This option also creates a static profile information file (.spi) that can be used with the codecov or tselect
tool.
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Option /Qcov-gen should be used to minimize the instrumentation overhead if you are interested in using
the instrumentation only for code coverage. You should use /Qprof-gen:srcpos if you intend to use the
collected data for code coverage and profile feedback.

IDE Equivalent

None

Alternate Options
None
See Also

Qcov-dir compiler option
Qcov-file compiler option

Optimization Report Options
This section contains descriptions for compiler options that pertain to optimization reports.
qopt-report, Qopt-report

Tells the compiler to generate an optimization report.
This feature is only available for ifort.

Syntax

Linux OS:
-gopt-report [=n]
macOS:
-gopt-report [=n]
Windows OS:

/Qopt-report[:n]

Arguments

n (Optional) Indicates the level of detail in the report. You can specify
values 0 through 5.
If you specify zero, no report is generated.
For levels n=1 through n=5, each level includes all the information of
the previous level, as well as potentially some additional information.
Level 5 produces the greatest level of detail. If you do not specify n,
the default is level 2, which produces a medium level of detail.

Default

OFF No optimization report is generated.

Description

This option tells the compiler to generate a collection of optimization report files, one per object; this is the
same output produced by option [g or Q]opt-report-per-object.

If you prefer another form of output, you can specify option [g or Qlopt-report-file.

If you specify a level (n) higher than 5, a warning will be displayed and you will get a level 5 report.
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When optimization reporting is enabled, the default is ~-qopt-report-phase=all (Linux* or macOS*)
or /Qopt-report-phase:all (Windows¥*).

For a description of the information that each n level provides, see the Example section in option
[g or Q]opt-report-phase.

IDE Equivalent

Visual Studio

Visual Studio: Diagnostics > Optimization Diagnostic Level

Alternate Options

None

Example

If you only want reports about certain diagnostics, you can use this option with option
[g or Q]lopt-report-phase. The phase you specify determines which diagnostics you will receive.

For example, the following examples show how to get reports about certain specific diagnostics.

To get this specific report Specify

Auto-parallelizer diagnostics Linux* or macOS*:
-gqopt-report -gopt-report-phase=par
Windows*:
/Qopt-report /Qopt-report-phase:par

OpenMP parallelizer diagnostics Linux* or macOS*:
-gopt-report -gopt-report-phase=openmp
Windows*:
/Qopt-report /Qopt-report-phase:openmp

Vectorizer diagnostics Linux* or macOS*:
—gopt-report —-gopt-report-phase=vec
Windows*:
/Qopt-report /Qopt-report-phase:vec

See Also

gopt-report-file, Qopt-report-file compiler option
gopt-report-per-object, Qopt-report-per-object con1pHeropﬂon
gopt-report-phase, Qopt-report-phase compiler option

qopt-report-annotate, Qopt-report-annotate
Enables the annotated source listing feature and
specifies its format. This feature is only available for
ifort.

Syntax

Linux OS:
-gopt-report-annotate[=keyword]
macOS:

-gopt-report—-annotate[=keyword]
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Windows OS:

/Qopt-report-annotate[: keyword]

Arguments

keyword Specifies the format for the annotated source listing. You can specify one of the following:

text Indicates that the listing should be in text format. This is the default if you do not
specify keyword.

html Indicates that the listing should be in html format.
Default
OFF No annotated source listing is generated
Description

This option enables the annotated source listing feature and specifies its format. The feature annotates
source files with compiler optimization reports.

By default, one annotated source file is output per object. The annotated file is written to the same directory
where the object files are generated. If the object file is a temporary file and an executable is generated,
annotated files are placed in the directory where the executable is placed. You cannot generate annotated
files to a directory of your choosing.

However, you can output annotated listings to stdout, stderr, or to a file if you also specify option
[g or Qlopt-report-file.

By default, this option sets option [q or Q]opt-report with default level 2.

The following shows the file extension and listing details for the two possible keywords.

Format Listing Details

text The annotated source listing has an .annot extension. It includes line numbers and
compiler diagnostics placed after correspondent lines. IPO footnotes are inserted at
the end of annotated file.

html The annotated source listing has an .annot.html extension. It includes line numbers
and compiler diagnostics placed after correspondent lines (as the text format does).
It also provides hyperlinks in compiler messages and quick navigation with the
routine list. IPO footnotes are displayed as tooltips.
IDE Equivalent

None

Alternate Options

None

See Also

gopt-report, Qopt-report compiler option

gopt-report-file, Qopt-report-file compiler option
gopt-report-annotate-position, Qopt-report-annotate-position compiler option
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qopt-report-annotate-position, Qopt-report-annotate-position
Enables the annotated source listing feature and

specifies the site where optimization messages appear

in the annotated source in inlined cases of loop

optimizations. This feature is only available for ifort.

Syntax
Linux OS:

-gopt-report-annotate-position=keyword
macOS:
-gopt-report-annotate-position=keyword
Windows OS:
/Qopt-report-annotate-position:keyword

Arguments

keyword Specifies the site where optimization messages appear in the annotated source. You can specify
one of the following:

caller Indicates that the messages should appear in the caller site.

callee Indicates that the messages should appear in the callee site.

both Indicates that the messages should appear in both the caller and the callee sites.
Default
OFF No annotated source listing is generated
Description

This option enables the annotated source listing feature and specifies the site where optimization messages
appear in the annotated source in inlined cases of loop optimizations.

This option enables option [q or Q]opt-report-annotate if it is not explicitly specified.

If annotated source listing is enabled and this option is not passed to compiler, loop optimizations are placed
in caller position by default.

IDE Equivalent

None
Alternate Options

None

See Also
gopt-report, Qopt-report compiler option
gopt-report-annotate, Qopt-report-annotate compiler option
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qopt-report-embed, Qopt-report-embed
Determines whether special loop information
annotations will be embedded in the object file and/or
the assembly file when it is generated. This feature is
only available for ifort.

Syntax

Linux OS:
-gqopt-report-embed
-gno-opt-report-embed
macOS:
-gopt-report-embed
-gno-opt-report-embed
Windows OS:
/Qopt-report-embed

/Qopt-report-embed-

Arguments

None

Default

OFF When an assembly file is being generated, special loop information annotations will not be

embedded in the assembly file.

However, if option -g (Linux* and macOS*) or /zi (Windows*) is specified, special loop
information annotations will be embedded in the assembly file unless option
-gno-opt-report-embed (Linux and macOS*) or /Qopt-report-embed- (Windows) is
specified.

Description

This option determines whether special loop information annotations will be embedded in the object file
and/or the assembly file when it is generated. Specify the positive form of the option to include the
annotations in the assembly file.

If an object file (or executable) is being generated, the annotations will be embedded in the object file (or
executable).

If you use this option, you do not have to specify option [g or Q]opt-report.

Alternate Options

None

See Also
gopt-report, Qopt-report conpreropﬂon

qopt-report-file, Qopt-report-file

Specifies that the output for the optimization report
goes to a file, stderr, or stdout. This feature is only
available for ifort.
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Syntax

Linux OS:
-qopt-report-file=keyword
macOS:
—-gqopt-report-file=keyword
Windows OS:

/Qopt-report-file:keyword

Arguments

keyword Specifies the output for the report. You can specify one of the following:
filename Specifies the name of the file where the output should go.
stderr Indicates that the output should go to stderr.
stdout Indicates that the output should go to stdout.

Default

OFF No optimization report is generated.

Description

This option specifies that the output for the optimization report goes to a file, stderr, or stdout.

If you use this option, you do not have to specify option [g or Q]opt-report.

When optimization reporting is enabled, the default is ~-qopt-report-phase=all (Linux* and macOS*)
or /Qopt-report-phase:all (Windows¥*).

IDE Equivalent

Visual Studio
Visual Studio: Diagnostics > Emit Optimization Diagnostics to File

Diagnostics > Optimization Diagnostic File

Alternate Options

None

See Also
gopt-report, Qopt-report compiler option

qopt-report-filter, Qopt-report-filter

Tells the compiler to find the indicated parts of your
application, and generate optimization reports for
those parts of your application. This feature is only
available for ifort.

Syntax
Linux OS:

-gopt-report-filter=string
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macOS:
-gopt-report-filter=string
Windows OS:

/Qopt-report-filter:string

Arguments
string Is the information to search for. The string must appear within quotes. It can take one or
more of the following forms:
filename
filename, routine
filename, range [, range]...
filename, routine, range [, range]...
If you specify more than one of the above forms in a string, a semicolon must appear
between each form. If you specify more than one range in a string, a comma must appear
between each range. Optional blanks can follow each parameter in the forms above and
they can also follow each form in a string.
filename Specifies the name of a file to be found. It can include a
path.
If you do not specify a path, the compiler looks for the
filename in the current working directory.
routine Specifies the name of a routine to be found. You can
include an identifying argument.
The name, including any argument, must be enclosed in
single quotes.
The compiler tries to uniquely identify the routine that
corresponds to the specified routine name.
It may select multiple routines to analyze, especially if
more than one routine has the specified routine name, so
the routine cannot be uniquely identified.
range Specifies a range of line numbers to be found in the file or
routine specified. The range must be specified in integers
in the form:
first_line_number-last_line_number
The hyphen between the line numbers is required.
Default
OFF No optimization report is generated.
Description

This option tells the compiler to find the indicated parts of your application, and generate optimization
reports for those parts of your application. Optimization reports will only be generated for the routines that

contain the specified string.
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On Linux* and macOS*, if you specify both -gqopt-report-routine=stringl and
-gqopt-report-filter=string2, it is treated as -qopt-report-filter=stringl;string2. On
Windows*, if you specify both /Qopt-report-routine:stringl and /Qopt-report-filter:string2, itis
treated as/Qopt-report-filter:stringl;string2.

If you use this option, you do not have to specify option [g or Q]opt-report.

When optimization reporting is enabled, the default is ~-qopt-report-phase=all (Linux* and macOS*)
or /Qopt-report-phase:all (Windows*).

IDE Equivalent

None

Alternate Options

None

See Also
gopt-report, Qopt-report compiler option

qopt-report-format, Qopt-report-format
Specifies the format for an optimization report. This
feature is only available for ifort.

Syntax

Linux OS:

—gopt-report-format=keyword

macOS:

-gopt-report-format=keyword

Windows OS:

/Qopt-report-format: keyword

Arguments

keyword Specifies the format for the report. You can specify one of the following:
text Indicates that the report should be in text format.

vs Indicates that the report should be in Visual Studio* (IDE) format. The Visual Studio
IDE uses the information to visualize the optimization report in the context of your
program source code.

Default
OFF No optimization report is generated.
Description

This option specifies the format for an optimization report. If you use this option, you must specify either
text Or vs.

If you do not specify this option and another option causes an optimization report to be generated, the
default format is text.

If the [g or Q]lopt-report-file option is also specified, it will affect where the output goes:
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e If filename is specified, output goes to the specified file.
e If stdout is specified, output goes to stdout.
e If stderr is specified, output goes to stderr.

If you use this option, you do not have to specify option [g or Q]opt-report.

When optimization reporting is enabled, the default is ~-qopt-report-phase=all (Linux* and macOS¥*)
or /Qopt-report-phase:all (Windows¥*).

IDE Equivalent

None

Alternate Options

None

See Also
gopt-report, Qopt-report con1pHeropﬂon
gopt-report-file, Qopt-report-file compiler option

qopt-report-help, Qopt-report-help
Displays the optimizer phases available for report

generation and a short description of what is reported
at each level. This feature is only available for ifort.

Syntax

Linux OS:
-gopt-report-help
Linux OS and macOS:
-gopt-report-help
Windows OS:

/Qopt-report-help

Arguments

None

Default

OFF No optimization report is generated.

Description

This option displays the optimizer phases available for report generation using [g or Q]opt-report-phase,
and a short description of what is reported at each level. No compilation is performed.

To indicate where output should go, you can specify one of the following options:

e [g or Qlopt-report-file
® [g or Qlopt-report-per-object

If you use this option, you do not have to specify option [g or Q]opt-report.

IDE Equivalent

None
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Alternate Options

None

See Also

gopt-report, Qopt-report con1pHeropHon

gopt-report-phase, Qopt-report-phase compiler option
gopt-report-file, Qopt-report-file compiler option
gopt-report-per-object, Qopt-report-per-object compiler option

qopt-report-per-object, Qopt-report-per-object
Tells the compiler that optimization report information

should be generated in a separate file for each object.
This feature is only available for ifort.

Syntax
Linux OS:

-gqopt-report-per-object
macOS:
-gopt-report-per-object
Windows OS:
/Qopt-report-per-object

Arguments

None
Default

OFF No optimization report is generated.

Description

This option tells the compiler that optimization report information should be generated in a separate file for
each object.

If you specify this option for a single-file compilation, a file with a .optrpt extension is produced for every
object file or assembly file that is generated by the compiler. For a multifile Interprocedural Optimization
(IPO) compilation, one file is produced for each of the N true objects generated in the compilation. If only
one true object file is generated, the optimization report file generated is called ipo_out.optrpt. If multiple
true object files are generated (N>1), the names used are ipo_outl.optprt, ipo_out2.optrpt, ...
ipo_outN.optrpt.

The .optrpt files are written to the target directory of the compilation process. If an object or assembly file is
explicitly generated, the corresponding .optrpt file is written to the same directory where the object file is
generated. If the object file is just a temporary file and an executable is generated, the corresponding .optrpt
files are placed in the directory in which the executable is placed.

If you use this option, you do not have to specify option [g or Q]opt-report.

When optimization reporting is enabled, the default is ~-qopt-report-phase=all (Linux* or macOS*)
or /Qopt-report-phase:all (Windows*).

IDE Equivalent

None
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Alternate Options

None

See Also
gopt-report, Qopt-report compiler option

qopt-report-phase, Qopt-report-phase
Specifies one or more optimizer phases for which

optimization reports are generated. This feature is
only available for ifort.

Syntax

Linux OS:
-gopt-report-phase[=1ist]
macOS:
—-gqopt-report-phase[=1ist]

Windows OS:

/Qopt-report-phase[:1ist]

Arguments

list (Optional) Specifies one or more phases to generate reports for. If you
specify more than one phase, they must be separated with commas.
The values you can specify are:
cg The phase for code generation
ipo The phase for Interprocedural Optimization
loop The phase for loop nest optimization
openmp The phase for OpenMP*
par The phase for auto-parallelization
pgo The phase for Profile Guided optimization
tcollect The phase for trace collection
vec The phase for vectorization
all All optimizer phases. This is the default if

you do not specify list.

Default

OFF No optimization report is generated.

Description

This option specifies one or more optimizer phases for which optimization reports are generated.
For certain phases, you also need to specify other options:

e If you specify phase cg, you must also specify option 01, 02 (default), or 03.
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e If you specify phase ipo, you must also specify option [Q]ipo.

e If you specify phase loop, you must also specify option 02 (default) or 03.

e If you specify phase openmp, you must also specify option [g or Q] openmp.

e If you specify phase par, you must also specify option [Q]parallel.

e If you specify phase pgo, you must also specify option [Q]prof-use.

e If you specify phase tcollect, you must also specify option [Q]tcollect.

e If you specify phase vec, you must also specify option 02 (default) or 03. If you are interested in explicit
vectorization by OpenMP* SIMD, you must also specify option [g or Q]openmp.

To find all phase possibilities, specify option [g or Q]opt-report-help.
If you use this option, you do not have to specify option [g or Q]opt-report.

However, if you want to get more details for each phase, specify option [g or Q]opt-report=n along with
this option and indicate the level of detail you want by specifying an appropriate value for n. (See also the
Example section below.)

When optimization reporting is enabled, the default is ~-qopt-report-phase=all (Linux* or macOS*)
or /Qopt-report-phase:all (Windows¥*).

IDE Equivalent

Visual Studio

Visual Studio: Diagnostics > Optimization Diagnostic Phase

Alternate Options

None

Example

The following shows examples of the details you may receive when you specify one of the optimizer phases
and a particular level (n) for option [g or Q]opt-report. Note that details may change in future releases.

Optimizer phase The level specified in Description
option[g or Qlopt-report

cg 1 Generates a list of which
intrinsics were lowered and which
memcall optimizations were
performed.

ipo 1 For each compiled routine,
generates a list of the routines
that were inlined into the routine,
called directly by the routine, and
whose calls were deleted.

2 Generates level 1 details, values
for important inlining command
line options, and a list of the
routines that were discovered to
be dead and eliminated.

3 Generates level 2 details, whole
program information, the sizes of
inlined routines, and the reasons
routines were not inlined.
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Optimizer phase

The level specified in
option[g or Q]opt-report

Description

loop

openmp

par

4

Generates level 3 details, detailed
footnotes on the reasons why
routines are not inlined, and what
action the user can take to get
them inlined.

Reports high-level details about
which optimizations have been
performed on the loop nests
(along with the line number).
Most of the loop optimizations
(like fusion, unroll, unroll & jam,
collapsing, rerolling etc) only
support this level of detail.

Generates level 1 details, and
provides more detail on the
metrics and types of references
(like prefetch distance, indirect
prefetches etc) used in
optimizations. Only a few
optimizations (like prefetching,
loop classification framework etc)
support these extra details.

Reports loops, regions, sections,
and tasks successfully
parallelized.

Generates level 1 details, and
messages indicating successful
handling of MASKED constructs,
SINGLE constructs, CRITICAL
constructs, ORDERED constructs,
ATOMIC directives, and so forth.

Reports which loops were
parallelized.

Generates level 1 details, and
reports which loops were not

parallelized along with a short
reason.

Generates level 2 details, and
prints the memory locations that
are categorized as private,
shared, reduction, etc..

For this phase, this is the same
as specifying level 3.

281



Intel® Fortran Compiler Classic and Intel® Fortran Compiler Developer Guide and Reference

Optimizer phase The level specified in
option[g or Q]opt-report

Description

5

pgo 1

tcollect 1

vec 1

See Also

gopt-report, Qopt-report compiler option
gopt-report-help, Qopt-report-help compiler option
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Generates level 4 details, and
dependency edges that inhibit
parallelization.

During profile feedback,
generates report status of
feedback (such as, profile used,
no profile available, or unable to
use profile) for each routine
compiled.

Generates level 1 details, and
reports which value profile
specializations took place for
indirect calls and arithmetic
operations.

Generates level 2 details, and
reports which indirect calls had
profile data, but did not meet the
internal threshold limits for the
percentage or execution count.

Generates a list of routines and
whether each was selected for
trace collection.

Reports which loops were
vectorized.

Generates level 1 details and
reports which loops were not
vectorized along with short
reason.

Generates level 2 details, and
vectorizer loop summary
information.

Generates level 3 details, and
greater detail about vectorized
and non-vectorized loops.

Generates level 4 details, and
details about any proven or
assumed data dependences.
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qopt-report-routine, Qopt-report-routine

Tells the compiler to generate an optimization report
for each of the routines whose names contain the
specified substring. This feature is only available for
ifort.

Syntax

Linux OS:
-gopt-report-routine=substring
macOS:
-gopt-report-routine=substring
Windows OS:

/Qopt-report-routine: substring

Arguments

substring Is the text (string) to look for.
Default

OFF No optimization report is generated.

Description

This option tells the compiler to generate an optimization report for each of the routines whose names
contain the specified substring.

You can also specify a sequence of substrings separated by commas. If you do this, the compiler will
generate an optimization report for each of the routines whose name contains one or more of these
substrings.

If you use this option, you do not have to specify option [g or Q]opt-report.
When optimization reporting is enabled, the default is ~-qopt-report-phase=all (Linux* and macOS*)
or /Qopt-report-phase:all (Windows¥*).

IDE Equivalent

Visual Studio

Visual Studio: Diagnostics > Optimization Diagnostic Routine

Alternate Options

None

See Also
gopt-report, Qopt-report compiler option

qopt-report-names, Qopt-report-names
Specifies whether mangled or unmangled names

should appear in the optimization report. This feature
is only available for ifort.
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Syntax

Linux OS:
-gopt-report-names=keyword
macOS:
-gopt-report-names=keyword
Windows OS:

/Qopt-report-names: keyword

Arguments
keyword Specifies the form for the names. You can specify one of the following:
mangled Indicates that the optimization report should contain mangled
names.
unmangled Indicates that the optimization report should contain unmangled
names.
Default
OFF No optimization report is generated.
Description

This option specifies whether mangled or unmangled names should appear in the optimization report. If you
use this option, you must specify either mangled or unmangled.

If this option is not specified, unmangled names are used by default.

If you specify mangled, encoding (also known as decoration) is added to names in the optimization report.
This is appropriate when you want to match annotations with the assembly listing.

If you specify unmangled, no encoding (or decoration) is added to names in the optimization report. This is
appropriate when you want to match annotations with the source listing.

If you use this option, you do not have to specify option [g or Q]opt-report.

When optimization reporting is enabled, the default is ~-qopt-report-phase=all (Linux* and macOS*)
or /Qopt-report-phase:all (Windows*).

IDE Equivalent

None

Alternate Options

None

See Also
gopt-report, Qopt-report compiler option

tcollect, Qtcollect

Inserts instrumentation probes calling the Intel® Trace
Collector API. This feature is only available for ifort.
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Syntax

Linux OS:
-tcollect[1ib]
macOS:

None

Windows OS:
/Qtcollect[:11ib]

Arguments

lib Is one of the Intel® Trace Collector libraries; for example, VT, VTcs,
VTmc, or VTfs. If you do not specify /ib, the default library is VT.

Default

OFF Instrumentation probes are not inserted into compiled applications.

Description

This option inserts instrumentation probes calling the Intel® Trace Collector API.

This trace analyzing/collecting feature requires installation of another product. For more information, see
Feature Requirements.

This option provides a flexible and convenient way of instrumenting functions of a compiled application. For
every function, the entry and exit points are instrumented at compile time to let the Intel® Trace Collector
record functions beyond the default MPI calls. For non-MPI applications (for example, threaded or serial), you
must ensure that the Intel® Trace Collector is properly initialized (VT_initialize/VT_init).

Caution
Be careful with full instrumentation because this feature can produce very large trace files.

IDE Equivalent

None

Alternate Options

None

See Also
tcollect-filter, Qtcollect-filter compiler option

tcollect-filter, Qtcollect-filter

Lets you enable or disable the instrumentation of
specified functions. You must also specify option
[Q]Jtcollect. This feature is only available for ifort.

Syntax
Linux OS:

-tcollect-filter filename
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macOS:

None

Windows OS:
/Qtcollect-filter: filename

Arguments

filename Is a configuration file that lists filters, one per line. Each filter consists
of a regular expression string and a switch. Strings with leading or
trailing white spaces must be quoted. Other strings do not have to be
quoted. The switch value can be ON, on, OFF, or off.

Default

OFF Functions are not instrumented. However, if option -tcollect (Linux) or /Qtcollect (Windows)

is specified, the filter setting is ".* ON" and all functions get instrumented.

Description

This option lets you enable or disable the instrumentation of specified functions.

To get instrumentation with a specified filter (or filters), you must specify both option [Q]tcollect and

option [Q]tcollect-filter.

During instrumentation, the regular expressions in the file are matched against the function names. The
switch specifies whether matching functions are to be instrumented or not. Multiple filters are evaluated from
top to bottom with increasing precedence.

The names of the functions to match against are formatted as follows:

e The source file name is followed by a colon-separated function name. Source file names should contain
the full path, if available. For example:

/home/joe/src/file.f:FOO bar

e C(lasses and function names are separated by double colons. For example:

/home/joe/src/file.fpp:app::foo: :bar

You can use option [g or Q]opt-report to get a full list of file and function names that the compiler
recognizes from the compilation unit. This list can be used as the basis for filtering in the configuration file.

This trace analyzing/collecting feature requires installation of another product. For more information, see

Feature Requirements.

IDE Equivalent

None

Alternate Options

None

Consider the following filters in a configuration file:

'.*" OFF '.*vector.*' ON

The above will cause instrumentation of only those functions having the string 'vector' in their names. No
other function will be instrumented. Note that reversing the order of the two lines will prevent

instrumentation of all functions.
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To get a list of the file or routine strings that can be matched by the regular expression filters, generate an
optimization report with tcollect information. For example:

Windows: ifort /Qtcollect /Qopt-report /Qopt-report-phase:tcollect
Linux: ifort -tcollect -gopt-report -gopt-report-phase=tcollect
See Also

tcollect, Qtcollect compiler option
gopt-report, Qopt-report compiler option

Offload Compilation Options, OpenMP* Options, and Parallel Processing Options

This section contains descriptions for compiler options that pertain to offload compilation, OpenMP*, or
parallel processing.

device-math-lib

Enables or disables certain device libraries. This is a
deprecated option that may be removed in a future
release.

Syntax
Linux OS:

-device-math-lib=I1ibrary
-no-device-math-lib=1ibrary
macOS:

None

Windows OS:
/device-math-1lib:1ibrary

/no-device-math-1lib:library

Arguments
library Possible values are:
fp32 Links the fp32 device math library.
fp64 Links the fp64 device math library.
To link more than one library, include a comma between the library names.
For example, if you want to link both the fp32 and fp64 device libraries, specify: fp32,
fp64
Default
fp32, fp64 Both the fp32 and fp64 device libraries are linked.
Description

This option enables or disables certain device libraries.

IDE Equivalent

None
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Alternate Options

None

See Also
fopenmp-device-lib compiler option

fmpc-privatize

Enables or disables privatization of all static data for
the MultiProcessor Computing environment (MPC)
unified parallel runtime. This feature is only available
for ifort.

Architecture Restrictions

Only available on Intel® 64 architecture

Syntax

Linux OS:
-fmpc-privatize
-fno-mpc-privatize
macOS:

None

Windows OS:

None

Arguments

None
Default

-fno-mpc-privatize The privatization of all static data for the MPC unified parallel runtime
is disabled.

Description

This option enables or disables privatization of all static data for the MultiProcessor Computing environment
(MPCQC) unified parallel runtime.

Option -fmpc-privatize causes calls to extended thread-local-storage (TLS) resolution, run-time routines
that are not supported on standard Linux* distributions.

This option requires installation of another product. For more information, see Feature Requirements.

IDE Equivalent

None

Alternate Options
None

fopenmp

Option -fopenmp is a deprecated option that will be
removed in a future release.
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Syntax
Linux OS:
-fopenmp
macOS:
None

Windows OS:

None

Arguments

None
Default

OFF No OpenMP* multi-threaded code is generated by the compiler.

Description

Enables recognition of OpenMP* features and tells the parallelizer to generate multi-threaded code based on
OpenMP* directives.

Option -fopenmp is a deprecated option that will be removed in a future release. For most users, we
recommend that you instead use option gopenmp, Qopenmp.

IDE Equivalent

None

Alternate Options
None
fopenmp-device-lib

Enables or disables certain device libraries for an
OpenMP* target.

Syntax

Linux OS:

-fopenmp-device-lib=1ibraryl, library,...]
-fno-openmp-device-lib=Ilibraryl[, library, ...]
macOS:

None

Windows OS:

-fopenmp-device-lib=I1ibraryl, library,...]
-fopenmp-device-lib=1ibraryl, library,...]
Arguments

library Possible values are:
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libm-£fp32 Enables linking to the fp32 device math
library.

libm-fp64 Enables linking to the fp64 device math
library.

libc Enables linking to the C library.

all Enables linking to libraries libm-fp32, libm-
fp-64, and libc.

To link more than one library, include a comma between the library
names. For example, if you want to link both the libm-fp32 device
library and the C library, specify: libm-fp32,libc.

Do not add spaces between library names.

Note that if you specify "all", it supersedes any additional value you

may specify.
Default
OFF Disables linking to device libraries for this target.
Description

This option enables or disables certain device libraries for an OpenMP* target.

If you specify fno-openmp-device-lib=1ibrary, linking to the specified library is disabled for the
OpenMP* target.

IDE Equivalent

Windows
Visual Studio: Linker > General > Enable linking of the device libraries for OpenMP offload

Linker > General > Disable linking of the device libraries for OpenMP offload

Alternate Options

None

fopenmp-target-buffers, Qopenmp-target-buffers

Enables a way to overcome the problem where some
OpenMP* offload SPIR-V* devices produce incorrect
code when a target object is larger than 4GB. This
feature is only available for ifx.

Syntax
Linux OS:
—-fopenmp-target-buffers=keyword

macOS:

None

Windows OS:
/Qopenmp-target-buffers: keyword
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Arguments
keyword Possible values are:

default Tells the compiler to use default heuristics. This may produce incorrect
code on some OpenMP* offload SPIR-V* devices when a target object is
larger than 4GB.

4GB Tells the compiler to generate code to prevent the issue described by
default. OpenMP* offload programs that access target objects of size
larger than 4GB in target code require this option.

This setting applies to the following:

e Target objects declared in OpenMP* target regions or inside OpenMP*
declare target functions
Target objects that exist in the OpenMP* device data environment

e Objects that are mapped and/or allocated by means of OpenMP* APIs
(such as omp_target_alloc)

Default

default If you do not specify this option, the compiler may produce incorrect code on some OpenMP*
offload SPIR-V* devices when a target object is larger than 4GB.

Description

This option enables a way to overcome the problem where some OpenMP* offload SPIR-V* devices produce
incorrect code when a target object is larger than 4GB (4294959104 bytes).

However, note that when -fopenmp-target-buffers=4GB (Or /Qopenmp-target-buffers:4GB) is
specified on Intel® GPUs, there may be a decrease in performance.

To use this option, you must also specify option —-fopenmp-targets (Linux*) or /Qopenmp-targets
(Windows*).

NOTE
This option may have no effect for some OpenMP* offload SPIR-V* devices, and for
OpenMP* offload targets different from SPIR*.

IDE Equivalent

Windows

Visual Studio: Code Generation > Specify buffer size for OpenMP offload kernel access limitations
(ifx only)

Alternate Options

None

See Also
fopenmp-targets, Qopenmp-targets compiler option
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fopenmp-targets, Qopenmp-targets

Enables offloading to a specified GPU target if
OpenMP* features have been enabled. This feature is
only available for ifx.

Syntax

Linux OS:
-fopenmp-targets=keyword
macOS:

None

Windows OS:

/Qopenmp-targets: keyword

Arguments

keyword The only supported value for this argument is spir64.
When you specify spir64, the compiler generates an x86 + SPIR64
(64-bit Standard Portable Intermediate Representation) fat binary for
Intel® GPU devices.

Default

OFF If this option is not specified, no x86 + SPIR64 fat binary is created.

Description

This option enables offloading to a specified GPU target if OpenMP* features have been enabled.

To use this option, you must enable recognition of OpenMP* features by specifying one of the following
options:

® [g or Q]openmp
e -—fiopenmp (Linux*) or /Qiopenmp (Windows*) (ifx only)

These options are equivalent in ifx to —gopenmp on Linux* and /Qopenmp on Windows*
e -—fopenmp (ifx; deprecated)

This option is equivalent to —gopenmp on Linux*
The following shows an example:
ifx -gopenmp -fopenmp-targets=spir64 matmul offload.cpp -o matmul

When you specify -fopenmp-targets (Linux*) or /Qopenmp-targets (Windows*), C++ exception handling
is disabled for target compilations.

For host compilations on Linux* systems, if you want to disable C++ exception handling, you must specify
option -fno-exceptions.

IDE Equivalent

Windows

Visual Studio: Code Generation > Enable OpenMP Offloading

292



Compiler Reference

Alternate Options

None

See Also

gopenmp, Qopenmp compiler option

par-affinity, Qpar-affinity

Specifies thread affinity. This feature is only available

for ifort.

Syntax

Linux OS:
-par-affinity=[modifier,
macOS:

None

Windows OS:
/Qpar-affinity: [modifier,

...l typel, permute] [,offset]

...ltypel, permute] [,offset]

Arguments

modifier Is one of the following values: granularity={fine|thread|core]|
tile}, [no]lrespect, [no]verbose, [no]lwarnings,
proclist=proc list. The default is granularity=core, respect,
and noverbose. For information on value proclist, see Thread
Affinity Interface.

type Indicates the thread affinity. This argument is required and must be
one of the following values: compact, disabled, explicit, none,
scatter, logical, physical. The default is none. Values logical
and physical are deprecated. Use compact and scatter,
respectively, with no permute value.

permute Is a positive integer. You cannot use this argument with type setting
explicit, none, or disabled. The default is 0.

offset Is a positive integer. You cannot use this argument with type setting
explicit, none, or disabled. The default is 0.

Default

OFF The thread affinity is determined by the run-time environment.

Description

This option specifies thread affinity, which binds threads to physical processing units. It has the same effect
as environment variable KMP_AFFINITY.

This option overrides the environment variable when both are specified.

This option only has an effect if the following is true:

e You have specified option [Q]parallel or option [g or Q]openmp (or both).
e You are compiling the main program.

293



Intel® Fortran Compiler Classic and Intel® Fortran Compiler Developer Guide and Reference

NOTE
This option may behave differently on Intel® microprocessors than on non-Intel
microprocessors.

IDE Equivalent

None

Alternate Options

None

See Also
parallel, Qparallel compiler option
gopt-report, Qopt-report conpreropHon

par-num-threads, Qpar-num-threads

Specifies the number of threads to use in a parallel
region. This feature is only available for ifort.

Syntax
Linux OS:
-par—-num-threads=n

macOS:

-par-num-threads=n

Windows OS:

/Qpar-num-threads:n

Arguments

n Is the number of threads to use. It must be a positive integer.
Default

OFF The number of threads to use is determined by the run-time environment.

Description

This option specifies the number of threads to use in a parallel region. It has the same effect as environment
variable OMP_NUM_THREADS.

This option overrides the environment variable when both are specified.
This option only has an effect if the following is true:

e You have specified option [Q]parallel or option [g or Q]openmp (or both).
e You are compiling the main program.

IDE Equivalent

None

Alternate Options

None
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See Also

parallel, Qparallel compiler option
gopt-report, Qopt-report compiler option

par-runtime-control, Qpar-runtime-control

Generates code to perform run-time checks for loops
that have symbolic loop bounds. This feature is only

available for ifort.

Syntax

Linux OS:
-par-runtime-control [n]
-no-par-runtime-control
macOS:
-par-runtime-control[n]
-no-par-runtime-control
Windows OS:
/Qpar-runtime-control [n]

/Qpar-runtime-control-
Arguments

n

Default

-no-par-runtime-control

or /Qpar-runtime-control-

Description

Is a value denoting what kind of runtime checking to perform. Possible
values are:

0 Performs no runtime check based on auto-
parallelization. This is the same as specifying
-no-par-runtime-control (Linux* and
macOS*) or /Qpar-runtime-control-
(Windows*).

1 Generates runtime check code under
conservative mode. This is the default if you
do not specify n.

2 Generates runtime check code under
heuristic mode.

3 Generates runtime check code under
aggressive mode.

The compiler uses default heuristics when checking loops.

This option generates code to perform run-time checks for loops that have symbolic loop bounds.

If the granularity of a loop is greater than the parallelization threshold, the loop will be executed in parallel.
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If you do not specify this option, the compiler may not parallelize loops with symbolic loop bounds if the
compile-time granularity estimation of a loop can not ensure it is beneficial to parallelize the loop.

NOTE
This option may behave differently on Intel® microprocessors than on non-Intel
Mmicroprocessors.

IDE Equivalent

None

Alternate Options
None

par-schedule, Qpar-schedule

Lets you specify a scheduling algorithm for loop
iterations. This feature is only available for ifort.

Syntax

Linux OS:
-par-schedule-keyword|[=n]
macOS:
-par-schedule-keyword|[=n]
Windows OS:
/Qpar-schedule-keyword[ [:]n]

Arguments
keyword Specifies the scheduling algorithm or tuning method. Possible values are:
auto Lets the compiler or run-time system determine the
scheduling algorithm.
static Divides iterations into contiguous pieces.
static-balanced Divides iterations into even-sized chunks.
static-steal Divides iterations into even-sized chunks, but allows
threads to steal parts of chunks from neighboring threads.
dynamic Gets a set of iterations dynamically.
guided Specifies a minimum number of iterations.
guided-analytical Divides iterations by using exponential distribution or
dynamic distribution.
runtime Defers the scheduling decision until run time.
n Is the size of the chunk or the number of iterations for each chunk.

This setting can only be specified for static, dynamic, and guided. For
more information, see the descriptions of each keyword below.
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Default

static-balanced Iterations are divided into even-sized chunks and the chunks are assigned
to the threads in the team in a round-robin fashion in the order of the
thread number.

Description

This option lets you specify a scheduling algorithm for loop iterations. It specifies how iterations are to be
divided among the threads of the team.

This option is only useful when specified with option [Q]parallel.

This option affects performance tuning and can provide better performance during auto-parallelization. It
does nothing if it is used with option [g or Q]openmp.

Option Description

[Q]lpar-schedule-auto Lets the compiler or run-time system determine the
scheduling algorithm. Any possible mapping may
occur for iterations to threads in the team.

[Q]par-schedule-static Divides iterations into contiguous pieces (chunks) of
size n. The chunks are assigned to threads in the
team in a round-robin fashion in the order of the
thread number. Note that the last chunk to be
assigned may have a smaller number of iterations.

If no n is specified, the iteration space is divided
into chunks that are approximately equal in size,
and each thread is assigned at most one chunk.

[Q]lpar-schedule-static-balanced Divides iterations into even-sized chunks. The
chunks are assigned to the threads in the team in a
round-robin fashion in the order of the thread
number.

[Q]par-schedule-static-steal Divides iterations into even-sized chunks, but when
a thread completes its chunk, it can steal parts of
chunks assigned to neighboring threads.

Each thread keeps track of L and U, which
represent the lower and upper bounds of its chunks
respectively. Iterations are executed starting from
the lower bound, and simultaneously, L is updated
to represent the new lower bound.

[Q]lpar-schedule-dynamic Can be used to get a set of iterations dynamically.
Assigns iterations to threads in chunks as the
threads request them. The thread executes the
chunk of iterations, then requests another chunk,
until no chunks remain to be assigned.

As each thread finishes a piece of the iteration
space, it dynamically gets the next set of iterations.
Each chunk contains n iterations, except for the last
chunk to be assigned, which may have fewer
iterations. If no n is specified, the default is 1.
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Option

Description

[Qlpar-schedule-guided

[Qlpar-schedule-guided-analytical

[Qlpar-schedule-runtime

Can be used to specify a minimum number of
iterations. Assigns iterations to threads in chunks as
the threads request them. The thread executes the
chunk of iterations, then requests another chunk,
until no chunks remain to be assigned.

For a chunk of size 1, the size of each chunk is
proportional to the number of unassigned iterations
divided by the number of threads, decreasing to 1.

For an n with value k (greater than 1), the size of
each chunk is determined in the same way with the
restriction that the chunks do not contain fewer
than k iterations (except for the last chunk to be
assigned, which may have fewer than k iterations).
If no n is specified, the default is 1.

Divides iterations by using exponential distribution
or dynamic distribution. The method depends on
run-time implementation. Loop bounds are
calculated with faster synchronization and chunks
are dynamically dispatched at run time by threads
in the team.

Defers the scheduling decision until run time. The
scheduling algorithm and chunk size are then taken
from the setting of environment variable
OMP_SCHEDULE.

NOTE

This option may behave differently on Intel® microprocessors than on non-Intel

microprocessors.

IDE Equivalent

None

Alternate Options
None

par-threshold, Qpar-threshold

Sets a threshold for the auto-parallelization of loops.
This feature is only available for ifort.

Syntax

Linux OS:
-par-threshold[n]

macOS:

-par-threshold[n]

298



Compiler Reference

Windows OS:
/Qpar-threshold[[:]n]

Arguments

n Is an integer whose value is the threshold for the auto-parallelization
of loops. Possible values are 0 through 100.

If nis 0, loops get auto-parallelized always, regardless of computation
work volume.

If n is 100, loops get auto-parallelized when performance gains are
predicted based on the compiler analysis data. Loops get auto-
parallelized only if profitable parallel execution is almost certain.

The intermediate 1 to 99 values represent the percentage probability
for profitable speed-up. For example, n=50 directs the compiler to
parallelize only if there is a 50% probability of the code speeding up if
executed in parallel.

Default

-par-threshold100 Loops get auto-parallelized only if profitable parallel execution is almost
or /Qpar-threshold100 certain. This is also the default if you do not specify n.

Description

This option sets a threshold for the auto-parallelization of loops based on the probability of profitable
execution of the loop in parallel. To use this option, you must also specify option [Q]parallel.

This option is useful for loops whose computation work volume cannot be determined at compile-time. The
threshold is usually relevant when the loop trip count is unknown at compile-time.

The compiler applies a heuristic that tries to balance the overhead of creating multiple threads versus the
amount of work available to be shared amongst the threads.

NOTE
This option may behave differently on Intel® microprocessors than on non-Intel
microprocessors.

IDE Equivalent

Windows

Visual Studio: Optimization > Threshold For Auto-Parallelization

Alternate Options

None

parallel, Qparallel

Tells the auto-parallelizer to generate multithreaded
code for loops that can be safely executed in parallel.
This feature is only available for ifort.
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Syntax
Linux OS:
-parallel
macOS:
-parallel

Windows OS:
/Qparallel (or /Qpar)

Arguments

None

Default

OFF Multithreaded code is not generated for loops that can be safely executed in parallel.

Description

This option tells the auto-parallelizer to generate multithreaded code for loops that can be safely executed in
parallel.

To use this option, you must also specify option 02 or 03.

This option sets option [g or Q]opt-matmul if option 03 is also specified.

NOTE

Using this option enables parallelization for both Intel® microprocessors and non-Intel
microprocessors. The resulting executable may get additional performance gain on Intel
microprocessors than on non-Intel microprocessors. The parallelization can also be affected
by certain options, such as /arch or /0x (Windows*) or -m or -x (Linux* and macOS*).

Product and Performance Information

Performance varies by use, configuration and other factors. Learn more at www.Intel.com/
Performancelndex.

Notice revision #20201201

IDE Equivalent

Visual Studio

Visual Studio: Optimization > Parallelization

Alternate Options

None

See Also

gopt-report, Qopt-report conpreropﬂon

par-affinity, Qpar-affinity compiler option
par-num-threads, QOpar-num-threads compiler option
par-runtime-control, Qpar-runtime-control compiler option
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par-schedule, Qpar-schedule compiler option
gopt-matmul, Qopt-matmul compiler option
0 compiler option

parallel-source-info, Qparallel-source-info

Enables or disables source location emission when
OpenMP* or auto-parallelism code is generated. This
feature is only available for ifort.

Syntax

Linux OS:
-parallel-source-info[=n]
-no-parallel-source-info
macOS:
-parallel-source-info[=n]
-no-parallel-source-info
Windows OS:
/Qparallel-source-info

/Qparallel-source-info-[:n]

Arguments

n Is the level of source location emission. Possible values are:

Default

Disables the emission of source location
information when OpenMP* code or auto-
parallelism code is generated. This is the
same as specifying
-no-parallel-source-info (Linux* and
macOS*) or /Qparallel-source-info-
(Windows*).

Tells the compiler to emit routine name and
line information. This is the same as
specifying [Q]parallel-source-info with
no n.

Tells the compiler to emit path, file, routine
name, and line information.

-parallel-source-info=1 When OpenMP* code or auto-parallelism code is generated, the routine
or name and line information is emitted.

/Qparallel-source-info:1

Description

This option enables or disables source location emission when OpenMP code or auto-parallelism code is

generated. It also lets you set the level of emission.
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IDE Equivalent

None

Alternate Options

None

qopenmp, Qopenmp

Enables recognition of OpenMP* features and tells the
parallelizer to generate multi-threaded code based on
OpenMP* directives.

Syntax
Linux OS:

-gopenmp
—gno-openmp
macOS:
-gopenmp
-gno-openmp
Windows OS:
/Qopenmp

/Qopenmp-

Arguments

None

Default

-gno-openmp OF /Qopenmp- No OpenMP* multi-threaded code is generated by the compiler.

Description

This option enables recognition of OpenMP* features and tells the parallelizer to generate multi-threaded
code based on OpenMP* directives. The code can be executed in parallel on both uniprocessor and
multiprocessor systems.

If you use this option, multithreaded libraries are used, but option fpp is not automatically invoked.
This option sets option automatic.

This option works with any optimization level. Specifying no optimization (-00 on Linux* or /0d on
Windows*) helps to debug OpenMP applications.

To ensure that a threadsafe and/or reentrant run-time library is linked and correctly initialized, option
[g or Q]openmp should also be used for the link step and for the compilation of the main routine.

NOTE
If you want to do offloading, specify option -fiopenmp. This option is only available for ifx.
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NOTE

To enable offloading to a specified GPU target, you must also specify option
fopenmp-targets (Linux*) or /Qopenmp-targets (Windows). This option is only available for
ifx.

NOTE

Options that use OpenMP* API are available for both Intel® microprocessors and non-Intel
microprocessors, but these options may perform additional optimizations on Intel®
microprocessors than they perform on non-Intel microprocessors. The list of major, user-
visible OpenMP constructs and features that may perform differently on Intel®
microprocessors versus non-Intel microprocessors include: locks (internal and user visible),
the SINGLE construct, barriers (explicit and implicit), parallel loop scheduling, reductions,
memory allocation, thread affinity, and binding.

Product and Performance Information

Performance varies by use, configuration and other factors. Learn more at www.Intel.com/
Performancelndex.

Notice revision #20201201

IDE Equivalent

Visual Studio
Visual Studio: Language > Process OpenMP Directives

Language > OpenMP Support (for ifx /Qiopenmp)

Alternate Options
Linux and macOS*: -fopenmp (deprecated), -fiopenmp (ifx only)

Windows: /openmp (deprecated), /Qiopenmp (ifx only)

See Also
fopenmp-targets, Qopenmp-targets compiler option

qopenmp-lib, Qopenmp-lib
Lets you specify an OpenMP* run-time library to use
for linking. This feature is only available for ifort.

Syntax

Linux OS:
—-gopenmp-lib=type
macOS:
—-gopenmp-lib=type
Windows OS:
/Qopenmp-1ib: type
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Arguments
type Specifies the type of library to use; it implies compatibility levels. Currently, the only
possible value is:
compat Tells the compiler to use the compatibility OpenMP* run-
time library (libiomp). This setting provides compatibility
with object files created using Microsoft* and GNU*
compilers.
Default
-gopenmp-1ib=compat The compiler uses the compatibility OpenMP* run-time library
or /Qopenmp-1ib:compat (libiomp).
Description

This option lets you specify an OpenMP* run-time library to use for linking.

The compatibility OpenMP run-time libraries are compatible with object files created using the Microsoft*
OpenMP run-time library (vcomp) or the GNU OpenMP run-time library (libgomp).

To use the compatibility OpenMP run-time library, compile and link your application using the compat setting
for option [g or Q]openmp-1lib. To use this option, you must also specify one of the following compiler
options:

e Linux* systems: -gqopenmp Or —gopenmp-stubs
e Windows* systems: /Qopenmp Or /Qopenmp-stubs

On Windows* systems, the compatibility OpenMP* run-time library lets you combine OpenMP* object files
compiled with the Microsoft* C/C++ compiler with OpenMP* object files compiled with the Intel® C, Intel® C+
+, or Intel® Fortran compilers. The linking phase results in a single, coherent copy of the run-time library.

On Linux* systems, the compatibility Intel OpenMP* run-time library lets you combine OpenMP* object files

compiled with the GNU* gcc or gfortran compilers with similar OpenMP* object files compiled with the Intel®

C, Intel® C++, or Intel® Fortran Compiler. The linking phase results in a single, coherent copy of the run-time
library.

You cannot link object files generated by the Intel® Fortran compiler to object files compiled by the GNU
Fortran compiler, regardless of the presence or absence of the [Q] openmp compiler option. This is because
the Fortran run-time libraries are incompatible.

NOTE The compatibility OpenMP run-time library is not compatible with object files created
using versions of the Intel compilers earlier than 10.0.

NOTE On Windows* systems, this option is processed by the compiler, which adds directives
to the compiled object file that are processed by the linker. On Linux* and macOS* systems,
this option is processed by the ifort command that initiates linking, adding library names
explicitly to the link command.

IDE Equivalent

None
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Alternate Options

None

See Also
gopenmp, Qopenmp compiler option
gopenmp-stubs, Qopenmp-stubs compiler option

qopenmp-link
Controls whether the compiler links to static or
dynamic OpenMP* run-time libraries.

Syntax

Linux OS:
—-qopenmp-link=Ilibrary
macOS:

—-gqopenmp-link=1library

Windows OS:
None
Arguments
library Specifies the OpenMP library to use. Possible values are:
static Tells the compiler to link to static OpenMP
run-time libraries. Note that static OpenMP
libraries are deprecated.
dynamic Tells the compiler to link to dynamic OpenMP
run-time libraries.
Default
-gopenmp-1ink=dynamic The compiler links to dynamic OpenMP* run-time libraries.
However, if Linux* option -static is specified, the compiler
links to static OpenMP run-time libraries.
Description

This option controls whether the compiler links to static or dynamic OpenMP* run-time libraries.

To link to the static OpenMP run-time library (RTL) and create a purely static executable, you must specify
-gopenmp-link=static. However, we strongly recommend you use the default setting,

—-gopenmp-link=dynamic.

NOTE

Compiler options -static-intel and -shared-intel (Linux* and macOS*) have no effect on

which OpenMP run-time library is linked.
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NOTE
On Linux* systems, -qopenmp-1link=dynamic cannot be used in conjunction with option
-static. If you try to specify both options together, an error will be displayed.

NOTE

On Linux systems, the OpenMP runtime library depends on using libpthread and libc (libgcc

when compiled with gcc). Libpthread and libc (libgcc) must both be static or both be

dynamic. If both libpthread and libc (libgcc) are static, then the static version of the OpenMP

runtime should be used. If both libpthread and libc (libgcc) are dynamic, then either the
static or dynamic version of the OpenMP runtime may be used.

IDE Equivalent

None

Alternate Options

None

qopenmp-offload

Enables or disables OpenMP* offloading compilation
for the TARGET directives. This feature is only
available for ifort.

Syntax

Linux OS:
—-qopenmp-offload[=device]
—-gno-openmp-offload

macOS:

None

Windows OS:

None

Arguments

device Specifies the default device for TARGET directives. Possible values are:

host OpenMP* offloading constructs are ignored. For Openmp*
combined offload constructs, only the offloading part is
ignored.
None
Default
-gno-openmp-offload OpenMP* offloading compilation is disabled. However, if option

gopenmp is specified, the default is ON and OpenMP offloading
compilation is enabled.
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Description

This option enables or disables OpenMP* offloading compilation for the TARGET directives. When enabling
offloading, it lets you specify what the default target device should be for the TARGET directives.

NOTE
The TARGET directives are only available on Linux* systems.

You can also use this option if you want to enable or disable the offloading feature with no impact on other
OpenMP* features. In this case, no OpenMP runtime library is needed to link and the compiler does not need
to generate OpenMP runtime initialization code.

If you specify this option with the gopenmp option, it can impact other OpenMP* features.

IDE Equivalent

None

Alternate Options

None

Example

Consider the following:

-qno-openmp -gopenmp-offload
The above is equivalent to specifying only gopenmp-offload. In this case, only the offload library is linked,
not the OpenMP* library, and only the !$OMP directives for TARGET are processed but no other '$OMP
directives.
Consider the following:

-gopenmp -qgopenmp-offload

In this case, the offload library is linked, the OpenMP library is linked, and OpenMP runtime initialization code
is generated.

See Also

gopenmp, Qopenmp compiler option
TARGET directive

TARGET DATA directive

TARGET UPDATE directive

qopenmp-simd, Qopenmp-simd
Enables or disables OpenMP* SIMD compilation.

Syntax
Linux OS:

-gopenmp-simd
-gno-openmp-simd
macOS:
-gopenmp-simd

-gno-openmp-simd
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Windows OS:
/Qopenmp-simd

/Qopenmp-simd-

Arguments

None
Default

—-gopenmp-simd Or /Qopenmp-simd

Description

OpenMP* SIMD compilation is enabled if the following option is
in effect:

e ifort: 02 or higher
e ifx: 01 or higher

OpenMP* SIMD compilation is always disabled at this
optimization level:

e fort: levels 01 or lower
e ifx: 00

When OpenMP* SIMD compilation is in effect because of the
setting of option 0, the OpenMP SIMD compilation can only be
disabled by specifying option -gno-openmp-simd

or /Qopenmp-simd-.

OpenMP SIMD compilation is not disabled by specifying option
-gqno-openmp OF /Qopenmp-.

This option enables or disables OpenMP* SIMD compilation.

You can use this option if you want to enable or disable the SIMD support with no impact on other OpenMP
features. In this case, no OpenMP runtime library is needed to link and the compiler does not need to
generate OpenMP runtime initialization code.

If you specify this option with the [g or Q]openmp option, it can impact other OpenMP features.

IDE Equivalent

None

Alternate Options

ifort: None

ifx:
Linux: -fopenmp-simd and -fiopenmp-simd

Windows: /Qiopenmp-simd

Example

Consider the following:

-gno-openmp -gopenmp-simd ! Linux or macOS*

/Qopenmp- /Qopenmp-simd ! Windows
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The above is equivalent to specifying only [g or Q]openmp-simd. In this case, only SIMD support is
provided, the OpenMP* library is not linked, and only the !$OMP directives related to SIMD are processed.

Consider the following:

—-gopenmp -gopenmp-simd ! Linux or macOS*
/Qopenmp /Qopenmp-simd ! Windows

In this case, SIMD support is provided, the OpenMP library is linked, and OpenMP runtime initialization code
is generated. Note that when you specify [g or Q]openmp, it implies [q or Q] openmp-simd.

See Also

gopenmp, Qopenmp compiler option

0 compiler option

SIMD Directive (OpenMP* API) directive

qopenmp-stubs, Qopenmp-stubs

Enables compilation of OpenMP* programs in
sequential mode.

Syntax

Linux OS:
—gopenmp-stubs
macOS:
—-gopenmp-stubs
Windows OS:

/Qopenmp-stubs

Arguments

None

Default

OFF The library of OpenMP* function stubs is not linked.

Description

This option enables compilation of OpenMP* programs in sequential mode. The OpenMP directives are
ignored and a stub OpenMP library is linked.

IDE Equivalent

Windows

Visual Studio: Language > Process OpenMP Directives

Alternate Options

None

See Also
gopenmp, Qopenmp compiler option
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qopenmp-threadprivate, Qopenmp-threadprivate

Lets you specify an OpenMP* threadprivate
implementation.

Syntax
Linux OS:

-gopenmp-threadprivate=type
macOS:

None

Windows OS:

/Qopenmp-threadprivate: type

Arguments

type Specifies the type of threadprivate implementation. Possible values
are:

legacy Tells the compiler to use the legacy OpenMP*
threadprivate implementation used in the
previous releases of the Intel® compiler. This
setting does not provide compatibility with
the implementation used by other compilers.

compat Tells the compiler to use the compatibility
OpenMP* threadprivate implementation
based on applying the thread-local attribute
to each threadprivate variable. This setting
provides compatibility with the
implementation provided by the Microsoft*
and GNU* compilers.

Default

ifort: —~gopenmp-threadprivate=legacy 1he compiler uses the legacy OpenMP* threadprivate
implementation used in the previous releases of the Intel
compiler.

or /Qopenmp-threadprivate:legacy

ifx: —~gopenmp-threadprivate=compat The compiler uses the compatibility OpenMP* threadprivate

or /Qopenmp-threadprivate:compat implementation.

Description
This option lets you specify an OpenMP* threadprivate implementation.

The threadprivate implementation of the legacy OpenMP run-time library may not be compatible with object
files created using OpenMP run-time libraries supported in other compilers.

To use this option, you must also specify one of the following compiler options:

e Linux* systems: -gopenmp Or —gopenmp-stubs
e Windows* systems: /Qopenmp Or /Qopenmp-stubs

The value specified for this option is independent of the value used for the [g or Q]openmp-1ib option.
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NOTE

On Windows* systems, if you specify option /Qopenmp-threadprivate:compat, the compiler
does not generate threadsafe code for common blocks in an '$OMP THREADPRIVATE
directive unless at least one element in the common block is explicitly initialized. For more
information, see the article titled: /Qopenmp-threadprivate:compat doesn't work with
uninitialized threadprivate common blocks, which is located in http://intel.ly/1aHhsjc

NOTE
On macOS* systems, legacy is the only type of threadprivate supported. Option
-gopenmp-threadprivate is not recognized by the compiler.

IDE Equivalent

None

Alternate Options

None

See Also
gopenmp, Qopenmp conpreropﬂon
gopenmp-stubs, Qopenmp-stubs con1pHeropﬂon

Qpar-adjust-stack

Tells the compiler to generate code to adjust the stack
size for a fiber-based main thread. This feature is only
available for ifort.

Syntax

Linux OS and macOS:

None

Windows OS:

/Qpar-adjust-stack:n

Arguments

n Is the stack size (in bytes) for the fiber-based main thread. It must be
a number equal to or greater than zero.

Default

/Opar-adjust-stack:0 No adjustment is made to the main thread stack size.

Description

This option tells the compiler to generate code to adjust the stack size for a fiber-based main thread. This
can reduce the stack size of threads.

For this option to be effective, you must also specify option /Qparallel.

IDE Equivalent

None
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Alternate Options

None

See Also
parallel, Qparallel compiler option

Xopenmp-target

Enables options to be passed to the specified tool in
the device compilation tool chain for the target. This
compiler option supports OpenMP* offloading. This
feature is only available for ifx.

Syntax

Linux OS:

-Xopenmp-target-tool=T "options"
macOS:

None

Windows OS:

-Xopenmp-target-tool=T "options"

Arguments
ool Can be one of the following:
frontend Indicates the frontend + middle end of the Standard
Portable Intermediate Representation (SPIR-V*)-based
device compiler for target triple T.
The middle end is the part of a SPIR-V*-based device
compiler that generates SPIR-V*. This SPIR-V* is then
passed by the ifx driver to the backend of target T.
backend Indicates Ahead of Time (AOT) compilation for target triple
T and Just in Time (JIT) compilation for target T at
runtime.
linker Indicates the device code linker for target triple T.
Some targets may have frontend and backend in one component; in that case, options are
merged.
T Is the target triple device.
options Are the options you want to pass to tool.
Default
OFF No options are passed to a tool.
Description

This option enables options to be passed to the specified tool in the device compilation tool chain for the
target. It supports OpenMP* offloading.
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IDE Equivalent

None

Alternate Options

None

Floating-Point Options

This section contains descriptions for compiler options that pertain to floating-point calculations.

fast-transcendentals, Qfast-transcendentals

Enables the compiler to replace calls to transcendental
functions with faster but less precise implementations.
This feature is only available for ifort.

Syntax

Linux OS:
-fast-transcendentals
-no-fast-transcendentals
macOS:
-fast-transcendentals
-no-fast-transcendentals
Windows OS:
/Qfast-transcendentals

/Qfast-transcendentals-

Arguments

None

Default

depends on the setting of

-fp-model (Linux* and
macOS*) or /fp (Windows*)

Description

If you do not specify option - [no-] fast-transcendentals or option /
Qfast-transcendentals[-]:

e The default is ON if option -fp-model fast or /fp:fast is specified or
is in effect.
e The default is OFF if a value-safe setting is specified for -fp-model

or /fp (such as "precise", "source", etc.).

This option enables the compiler to replace calls to transcendental functions with implementations that may

be faster but less precise.

It allows the compiler to perform certain optimizations on transcendental functions, such as replacing
individual calls to sine in a loop with a single call to a less precise vectorized sine library routine. These
optimizations can cause numerical differences that would not otherwise exist if you are also compiling with a
value-safe option such as -fp-model precise (Linux* and macOS*) or /fp:precise (Windows).
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For example, you may get different results if you specify option 00 versus option 02, or you may get different
results from calling the same function with the same input at different points in your program. If these kinds
of numerical differences are problematic, consider using option -fimf-use-svml (Linux* and macOS*)

or /Qimf-use-svml (Windows) as an alternative. When used with a value-safe option such as

-fp-model precise or /fp:precise, option -fimf-use-svml or /Qimf-use-svml provides many of the
positive performance benefits of [Q] fast-transcendentals without negatively affecting numeric
consistency. For more details, see the description of option -fimf-use-svml and /Qimf-use-svml.

This option does not affect explicit Short Vector Math Library (SVML) intrinsics. It only affects scalar calls to
the standard math library routines.

You cannot use option -fast-transcendentals with option -fp-model strict and you cannot use
option /Qfast-transcendentals with option /fp:strict.

This option determines the setting for the maximum allowable relative error for math library function results
(max-error) if none of the following options are specified:

e -fimf-accuracy-bits (Linux* and macOS*) or /Qimf-accuracy-bits (Windows¥*)
e -fimf-max-error (Linux and macOS*) or /Qimf-max-error (Windows)
e -—fimf-precision (Linux and macOS*) or /Qimf-precision (Windows)

This option enables extra optimization that only applies to Intel® processors.

Product and Performance Information

Performance varies by use, configuration and other factors. Learn more at www.Intel.com/
Performancelndex.

Notice revision #20201201

IDE Equivalent

None

Alternate Options

None

See Also

fp-model, fp compiler option

fimf-use-svml, Qimf-use-svml compiler option
fimf-accuracy-bits, Qimf-accuracy-bits compiler option
fimf-max-error, Qimf-max-error compiler option
fimf-precision, Qimf-precision compiler option

fimf-absolute-error, Qimf-absolute-error

Defines the maximum allowable absolute error for
math library function results. This feature is only
available for ifort.

Syntax
Linux OS:

-fimf-absolute-error=value|: funclist]

macOS:

-fimf-absolute-error=value|: funclist]
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Windows OS:

/Qimf-absolute-error:valuel: funclist]

Arguments

value Is a positive, floating-point number. Errors in math library function results may exceed
the maximum relative error (max-error) setting if the absolute-error is less than or
equal to value.
The format for the number is [digits] [.digits] [ { e | E }[sign]digits]

funclist Is an optional list of one or more math library functions to which the attribute should
be applied. Do not specify the standard Fortran name of the math function; you must
specify the actual math library name. If you specify more than one function, they must
be separated with commas.
Precision-specific variants like sin and sinf are considered different functions, so you
would need to use -fimf-absolute-error=0.00001:sin, sinf
(or /Qimf-absolute-error:0.00001:sin, sinf) to specify the maximum allowable
absolute error for both the single-precision and double-precision sine functions.
You also can specify the symbol /f to denote single-precision divides, symbol / to
denote double-precision divides, symbol /I to denote extended-precision divides, and
symbol /q to denote quad-precision divides. For example you can specify
-fimf-absolute-error=0.00001:/ or /Qimf-absolute-error: 0.00001:/.

Default

Zero ("0") An absolute-error setting of 0 means that the function is bound by the relative error
setting. This is the default behavior.

Description

This option defines the maximum allowable absolute error for math library function results.
This option can improve run-time performance, but it may decrease the accuracy of results.
This option only affects functions that have zero as a possible return value, such as log, sin, asin, etc.

The relative error requirements for a particular function are determined by options that set the maximum
relative error (max-error) and precision. The return value from a function must have a relative error less
than the max-error value, or an absolute error less than the absolute-error value.

If you need to define the accuracy for a math function of a certain precision, specify the function name of the
precision that you need. For example, if you want double precision, you can specify :sin; if you want single
precision, you can specify :sinf, as in -fimf-absolute-error=0.00001:sin

or /Qimf-absolute-error:0.00001:sin, or —-fimf-absolute-error=0.00001:sqgrtf

or /Qimf-absolute-error:0.00001:sqgrtf.

If you do not specify any function names, then the setting applies to all functions (and to all precisions).
However, as soon as you specify an individual function name, the setting applies only to the function of
corresponding precision. So, for example, sinf applies only to the single-precision sine function, sin applies
only to the double-precision sine function, sinl applies only to the extended-precision sine function, etc.

NOTE
Many routines in libraries LIBM (Math Library) and SVML (Short Vector Math Library) are
more highly optimized for Intel® microprocessors than for non-Intel microprocessors.
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NOTE

The standard Fortran names for the various math intrinsic functions do not match the math
library names of the math intrinsic functions. You must find the actual math library name
that is generated for the relevant Fortran math intrinsic.

One way to do this is to generate assembly code by using options /Fa or /S on Windows, or option -3
on Linux. The assembly code will show the actual math library name.

For example, if you create a program that contains a call to SIN(x) where x is declared as
REAL(KIND=4) and then use option /s on Windows to produce assembly code for the program, the
assembly code will show a call to sinf.

Therefore, to define the maximum allowable absolute error for the single-precision sine function, you
would specify -fimf-absolute-error=sinf (or /Qimf-absolute-error:sinf).

Product and Performance Information

Performance varies by use, configuration and other factors. Learn more at www.Intel.com/
Performancelndex.

Notice revision #20201201

IDE Equivalent

None

Alternate Options

None

See Also

fimf-accuracy-bits, Qimf-accuracy-bits compiler option
fimf-arch-consistency, Qimf-arch-consistency compiler option
fimf-domain-exclusion, Qimf-domain-exclusion compiler option
fimf-max-error, Qimf-max-error compiler option
fimf-precision, Qimf-precision compiler option

fimf-use-svml Qimf-use-svml compiler option

fimf-accuracy-bits, Qimf-accuracy-bits

Defines the relative error for math library function
results, including division and square root. This
feature is only available for ifort.

Syntax

Linux OS:
-fimf-accuracy-bits=bits[:funclist]
macOS:
-fimf-accuracy-bits=bits[:funclist]
Windows OS:

/Qimf-accuracy-bits:bits[: funclist]
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Arguments

bits Is a positive, floating-point number indicating the number of correct bits the compiler
should use.
The format for the number is [digits] [.digits] [ { e | E }[sign]digits].

funclist Is an optional list of one or more math library functions to which the attribute should
be applied. Do not specify the standard Fortran name of the math function; you must
specify the actual math library name. If you specify more than one function, they must
be separated with commas.
Precision-specific variants like sin and sinf are considered different functions, so you
would need to use -fimf-accuracy-bits=23:sin,sinf
(or /Qimf-accuracy-bits:23:sin, sinf) to specify the relative error for both the
single-precision and double-precision sine functions.
You also can specify the symbol /f to denote single-precision divides, symbol / to
denote double-precision divides, symbol /I to denote extended-precision divides, and
symbol /g to denote quad-precision divides. For example you can specify
-fimf-accuracy-bits=10.0:/f or /Qimf-accuracy-bits:10.0:/f.

Default

-fimf-precision=medium or /Qimf- The compiler uses medium precision when calling math library

precision:medium functions. Note that other options can affect precision; see below

for details.
Description

This option defines the relative error, measured by the number of correct bits, for math library function
results.

The following formula is used to convert bits into ulps: ulps = 2P-1-bits \where p is the number of the target
format mantissa bits (24, 53, and 113 for single, double, and quad precision, respectively).

This option can affect run-time performance and the accuracy of results.

If you need to define the accuracy for a math function of a certain precision, specify the function name of the
precision that you need. For example, if you want double precision, you can specify :sin; if you want single
precision, you can specify :sinf, as in the following:

e -fimf-accuracy-bits=23:sinf,cosf, logf or /Qimf-accuracy-bits:23:sinf,cosf, logf
e -fimf-accuracy-bits=52:sqrt,/,trunc or /Qimf-accuracy-bits:52:sqgrt,/, trunc
e -—fimf-accuracy-bits=10:powf Or /Qimf-accuracy-bits:10:powf

If you do not specify any function names, then the setting applies to all functions (and to all precisions).
However, as soon as you specify an individual function name, the setting applies only to the function of
corresponding precision. So, for example, sinf applies only to the single-precision sine function, sin applies
only to the double-precision sine function, sinl applies only to the extended-precision sine function, etc.

There are three options you can use to express the maximum relative error. They are as follows:

e -fimf-precision (Linux* and macOS*) or /Qimf-precision (Windows*)
e -—fimf-max-error (Linux* and macOS*) or /Qimf-max-error (Windows*)
e -fimf-accuracy-bits (Linux and macOS*) or /Qimf-accuracy-bits (Windows)

If more than one of these options are specified, the default value for the maximum relative error is
determined by the last one specified on the command line.
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If none of the above options are specified, the default values for the maximum relative error are determined
by the setting of the following options:

® [Q]fast-transcendentals

® [Q]prec-div

® [Q]prec-sqgrt

e -—fp-model (Linux and macOS*) or /fp (Windows)

NOTE
Many routines in libraries LIBM (Math Library) and SVML (Short Vector Math Library) are
more highly optimized for Intel® microprocessors than for non-Intel microprocessors.

NOTE

The standard Fortran names for the various math intrinsic functions do not match the math
library names of the math intrinsic functions. You must find the actual math library name
that is generated for the relevant Fortran math intrinsic.

One way to do this is to generate assembly code by using options /Fa or /S on Windows, or option -S
on Linux. The assembly code will show the actual math library name.

For example, if you create a program that contains a call to SIN(x) where x is declared as
REAL(KIND=4) and then use option /s on Windows to produce assembly code for the program, the
assembly code will show a call to sinf.

Therefore, to request the relative error for the single-precision sine function, you would specify
-fimf-accuracy-bits=sinf (or /Qimf-accuracy-bits:sinf).

Product and Performance Information

Performance varies by use, configuration and other factors. Learn more at www.Intel.com/
Performancelndex.

Notice revision #20201201

IDE Equivalent

None

Alternate Options

None

See Also

fimf-absolute-error, Qimf-absolute-error compiler option
fimf-arch-consistency, Qimf-arch-consistency compiler option
fimf-domain-exclusion, Qimf-domain-exclusion compiler option
fimf-max-error, Qimf-max-error compiler option
fimf-precision, Qimf-precision compiler option
fimf-use-svml Qimf-use-svml compiler option
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fimf-arch-consistency, Qimf-arch-consistency

Ensures that the math library functions produce
consistent results across different microarchitectural
implementations of the same architecture. This

feature is only available for ifort.

Syntax
Linux OS:

-fimf-arch-consistency=valuel: funclist]

macOS:

-fimf-arch-consistency=valuel:funclist]

Windows OS:

/Qimf-arch-consistency:valuel: funclist]

Arguments

value Is one of the logical values "true" or "false".

funclist Is an optional list of one or more math library functions to which the
attribute should be applied. Do not specify the standard Fortran name
of the math function; you must specify the actual math library name.
If you specify more than one function, they must be separated with
commas.
Precision-specific variants like sin and sinf are considered different
functions, so you would need to use
-fimf-arch-consistency=true:sin, sinf
(or /Qimf-arch-consistency:true:sin, sinf) to specify consistent
results for both the single-precision and double-precision sine
functions.
You also can specify the symbol /f to denote single-precision divides,
symbol / to denote double-precision divides, symbol /I to denote
extended-precision divides, and symbol /q to denote quad-precision
divides. For example you can specify
-fimf-arch-consistency=true:/
or /Qimf-arch-consistency:true:/.

Default

false Implementations of some math library functions may produce slightly different results on

implementations of the same architecture.

Description

This option ensures that the math library functions produce consistent results across different
microarchitectural implementations of the same architecture (for example, across different microarchitectural
implementations of IA-32 architecture). Consistency is only guaranteed for a single binary. Consistency is not
guaranteed across different architectures. For example, consistency is not guaranteed across IA-32
architecture and Intel® 64 architecture.
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If you need to define the accuracy for a math function of a certain precision, specify the function name of the
precision that you need. For example, if you want double precision, you can specify :sin; if you want single
precision, you can specify :sinf, as in -fimf-arch-consistency=true:sin

or /Qimf-arch-consistency:true:sin, or -fimf-arch-consistency=false:sqrtf

or /Qimf-arch-consistency:false:sqgrtf.

If you do not specify any function names, then the setting applies to all functions (and to all precisions).
However, as soon as you specify an individual function name, the setting applies only to the function of
corresponding precision. So, for example, sinf applies only to the single-precision sine function, sin applies
only to the double-precision sine function, sinl applies only to the extended-precision sine function, etc.

The -fimf-arch-consistency (Linux* and macOS*) and /Qimf-arch-consistency (Windows*) option
may decrease run-time performance, but the option will provide bit-wise consistent results on all Intel®
processors and compatible, non-Intel processors, regardless of micro-architecture. This option may not
provide bit-wise consistent results between different architectures.

NOTE
Many routines in libraries LIBM (Math Library) and SVML (Short Vector Math Library) are
more highly optimized for Intel® microprocessors than for non-Intel microprocessors.

NOTE

The standard Fortran names for the various math intrinsic functions do not match the math
library names of the math intrinsic functions. You must find the actual math library name
that is generated for the relevant Fortran math intrinsic.

One way to do this is to generate assembly code by using options /Fa or /S on Windows, or option -S
on Linux. The assembly code will show the actual math library name.

For example, if you create a program that contains a call to SIN(x) where x is declared as
REAL(KIND=4) and then use option /S on Windows to produce assembly code for the program, the
assembly code will show a call to sinf.

Therefore, to ensure consistent results for the single-precision sine function, you would specify
-fimf-arch-consistency=sinf (or /Qimf-arch-consistency:sinf).

Product and Performance Information

Performance varies by use, configuration and other factors. Learn more at www.Intel.com/
Performancelndex.

Notice revision #20201201

IDE Equivalent

None

Alternate Options

None

See Also

fimf-absolute-error, Qimf-absolute-error compiler option
fimf-accuracy-bits, Qimf-accuracy-bits compiler option
fimf-domain-exclusion, Qimf-domain-exclusion compiler option

fimf-max-error, Qimf-max-error compiler option
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fimf-precision, Qimf-precision compiler option
fimf-use-svml Qimf-use-svml compiler option

fimf-domain-exclusion, Qimf-domain-exclusion

Indicates the input arguments domain on which math
functions must provide correct results. This feature is
only available for ifort.

Syntax

Linux OS:
-fimf-domain-exclusion=classlist[:funclist]
macOS:
—fimf-domain-exclusion=classlist[:funclist]

Windows OS:

/Qimf-domain-exclusion:classlist[:funclist]

Arguments

classlist Is one of the following:

e One or more of the following floating-point value classes you can exclude from the
function domain without affecting the correctness of your program. The supported
class names are:

extremes This class is for values which do not lie within the
usual domain of arguments for a given function.

nans This means "x=Nan".
infinities This means "x=infinities".
denormals This means "x=denormal".
zeros This means "x=0".

Each classlist element corresponds to a power of two. The exclusion attribute is the
logical or of the associated powers of two (that is, a bitmask).

The following shows the current mapping from classl/ist mnemonics to numerical

values:
extremes 1
nans 2
infinities 4
denormals 8
zeros 16
none 0
all 31
common 15
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other combinations bitwise OR of the used values

You must specify the integer value that corresponds to the class that you want to
exclude.

Note that on excluded values, unexpected results may occur.
e One of the following short-hand tokens:

none This means that none of the supported classes are
excluded from the domain. To indicate this token,
specify 0, as in -fimf-domain-exclusion=0
(or /Qimf-domain-exclusion:0).

all This means that all of the supported classes are
excluded from the domain. To indicate this token,
specify 31, as in -fimf-domain-exclusion=31
(or /Qimf-domain-exclusion:31).

common This is the same as specifying
extremes,nans,infinities,subnormals. To indicate this
token, specify 15 (1 + 2+ 4 + 8), as in
-fimf-domain-exclusion=15
(or /Qimf-domain-exclusion:15)

funclist Is an optional list of one or more math library functions to which the attribute should
be applied. Do not specify the standard Fortran name of the math function; you must
specify the actual math library name. If you specify more than one function, they must
be separated with commas.

Precision-specific variants like sin and sinf are considered different functions, so you
would need to use -fimf-domain-exclusion=4:sin, sinf

(or /Qimf-domain-exclusion:4:sin, sinf) to specify infinities for both the single-
precision and double-precision sine functions.

You also can specify the symbol /f to denote single-precision divides, symbol / to
denote double-precision divides, symbol /I to denote extended-precision divides, and
symbol /g to denote quad-precision divides. For example, you can specify:

-fimf-domain-exclusion=4 or /Qimf-domain-exclusion:4
-fimf-domain-exclusion=5:/,powf or /Qimf-domain-exclusion:5:/,powf

-fimf-domain-exclusion=23:10g, logf,/,sin, cosf
or /Qimf-domain-exclusion:23:1og, logf,/,sin, cosft

If you don't specify argument funclist, the domain restrictions apply to all math library

functions.
Default
Zero ("0") The compiler uses default heuristics when calling math library functions.
Description

This option indicates the input arguments domain on which math functions must provide correct results. It
specifies that your program will function correctly if the functions specified in funclist do not produce
standard conforming results on the number classes.
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This option can affect run-time performance and the accuracy of results. As more classes are excluded, faster
code sequences can be used.

If you need to define the accuracy for a math function of a certain precision, specify the function name of the
precision that you need. For example, if you want double precision, you can specify :sin; if you want single
precision, you can specify :sinf, as in -fimf-domain-exclusion=subnormals:sin

or /Qimf-domain-exclusion:subnormals:sin, or —-fimf-domain-exclusion=extremes:sqrtf

or /Qimf-domain-exclusion:extremes:sqrtf.

If you do not specify any function names, then the setting applies to all functions (and to all precisions).
However, as soon as you specify an individual function name, the setting applies only to the function of
corresponding precision. So, for example, sinf applies only to the single-precision sine function, sin applies
only to the double-precision sine function, sinl applies only to the extended-precision sine function, etc.

NOTE
Many routines in libraries LIBM (Math Library) and SVML (Short Vector Math Library) are
more highly optimized for Intel® microprocessors than for non-Intel microprocessors.

NOTE

The standard Fortran names for the various math intrinsic functions do not match the math
library names of the math intrinsic functions. You must find the actual math library name
that is generated for the relevant Fortran math intrinsic.

One way to do this is to generate assembly code by using options /Fa or /S on Windows, or option -S
on Linux. The assembly code will show the actual math library name.

For example, if you create a program that contains a call to SIN(x) where x is declared as
REAL(KIND=4) and then use option /s on Windows to produce assembly code for the program, the
assembly code will show a call to sinf.

Therefore, to indicate the input arguments domain for the single-precision sine function, you would
specify —-fimf-domain-exclusion=sinf (or /Qimf-domain-exclusion:sinf).

Product and Performance Information

Performance varies by use, configuration and other factors. Learn more at www.Intel.com/
Performancelndex.

Notice revision #20201201

IDE Equivalent

None

Alternate Options

None

Example

Consider the following single-precision sequence for function exp2f:
Operation: y = exp2f(x)
Accuracy: 1.014 ulp
Instructions: 4 (2 without fix-up)
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The following shows the 2-instruction sequence without the fix-up:
vevtfxpntps2dg  zmml {k1}, zmm0O, 0x50 // zmml <-- rndToInt (2724 * x)
vexp223ps zmml {k1}, zmml // zmml <-- exp2 (x)
However, the above 2-instruction sequence will not correctly process NaNs. To process Nans correctly, the

following fix-up must be included following the above instruction sequence:

vpxord zmm2, zmm2, zmm2 // zmm2 <-- 0
vfixupnanps zmml {k1}, zmmO, zmm2 {aaaa} // zmml <-- QNaN(x) if x is NaN <F>

If the vfixupnanps instruction is not included, the sequence correctly processes any arguments except NaN
values. For example, the following options generate the 2-instruction sequence:

-fimf-domain-exclusion=2:exp2f <- NaN’s are excluded (2 corresponds to NaNs)
-fimf-domain-exclusion=6:exp2f <- NaN’s and infinities are excluded (4 corresponds to
infinities; 2 + 4 = 6)

-fimf-domain-exclusion=7:exp2f <- NaN’s, infinities, and extremes are excluded (1
corresponds to extremes; 2 + 4 + 1 = 7)

-fimf-domain-exclusion=15:exp2f <- NaN’s, infinities, extremes, and subnormals are excluded

(8 corresponds to subnormals; 2 + 4 + 1 + 8=15)

If the vfixupnanps instruction is included, the sequence correctly processes any arguments including NaN
values. For example, the following options generate the 4-instruction sequence:

-fimf-domain-exclusion=1:exp2f <- only extremes are excluded (1 corresponds to extremes)
-fimf-domain-exclusion=4:exp2f <- only infinities are excluded (4 corresponds to infinities)
-fimf-domain-exclusion=8:exp2f <- only subnormals are excluded (8 corresponds to subnormals)
-fimf-domain-exclusion=13:exp2f <- only extremes, infinities and subnormals are excluded (1
+ 4 + 8 = 13)

See Also

fimf-absolute-error, Qimf-absolute-error compiler option
fimf-accuracy-bits, Qimf-accuracy-bits compiler option
fimf-arch-consistency, Qimf-arch-consistency compiler option
fimf-max-error, Qimf-max-error compiler option
fimf-precision, Qimf-precision compiler option
fimf-use-svml Qimf-use-svml compiler option

fimf-force-dynamic-target, Qimf-force-dynamic-target
Instructs the compiler to use run-time dispatch in calls
to math functions.

Syntax

Linux OS:
-fimf-force-dynamic-target[=funclist]
macOS:
-fimf-force-dynamic-target[=funclist]
Windows OS:

/Qimf-force-dynamic-target[: funclist]
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Arguments

Is an optional list of one or more math library functions to which the
attribute should be applied. Do not specify the standard Fortran name
of the math function; you must specify the actual math library name.
If you specify more than one function, they must be separated with
commas.

funclist

Precision-specific variants like sin and sinf are considered different
functions, so you would need to use
-fimf-dynamic-target=sin, sinf

(or /Qimf-dynamic-target:sin, sinf) to specify run-time dispatch
for both the single-precision and double-precision sine functions.

You also can specify the symbol /f to denote single-precision divides,
symbol / to denote double-precision divides, symbol /I to denote
extended-precision divides, and symbol /q to denote quad-precision
divides. For example, you can specify -fimf-dynamic-target=/

or /Qimf-dynamic-target:/.

Default

OFF Run-time dispatch is not forced in math libraries calls. The compiler can choose to call a CPU-
specific version of a math function if one is available.

Description

This option instructs the compiler to use run-time dispatch in calls to math functions. When this option set to
ON, it lets you force run-time dispatch in math libraries calls.

By default, when this option is set to OFF, the compiler often optimizes math library calls using the target
CPU architecture-specific information available at compile time through the [Q]x and arch compiler options.

If you want to target multiple CPU families with a single application or you prefer to choose a target CPU at
run time, you can force run-time dispatch in math libraries by using this option.

NOTE

The standard Fortran names for the various math intrinsic functions do not match the math
library names of the math intrinsic functions. You must find the actual math library name
that is generated for the relevant Fortran math intrinsic.

One way to do this is to generate assembly code by using options /Fa or /S on Windows, or option -S
on Linux. The assembly code will show the actual math library name.

For example, if you create a program that contains a call to SIN(x) where x is declared as
REAL(KIND=4) and then use option /s on Windows to produce assembly code for the program, the

assembly code will show a call to sinf.

Therefore, to use run-time dispatch in calls to the single-precision sine function, you would specify
-fimf-force-dynamic-target=sinf (or /Qimf-force-dynamic-target:sinf).

Product and Performance Information

Performance varies by use, configuration and other factors. Learn more at www.Intel.com/
Performancelndex.

Notice revision #20201201
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IDE Equivalent

None

Alternate Options

None

See Also

%, Ox compiler option

arch compiler option
mtune, tune compiler option

fimf-max-error, Qimf-max-error

Defines the maximum allowable relative error for
math library function results, including division and
square root. This feature is only available for ifort.

Syntax
Linux OS:

-fimf-max-error=ulps|: funclist]
macOS:

-fimf-max-error=ulps|[: funclist]
Windows OS:

/Qimf-max-error:ulps[: funclist]
Arguments

ulps

funclist
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Is a positive, floating-point number indicating the maximum allowable
relative error the compiler should use.

The format for the number is [digits] [.digits] [ { e | E }[sign]digits].

Is an optional list of one or more math library functions to which the
attribute should be applied. Do not specify the standard Fortran name
of the math function; you must specify the actual math library name.
If you specify more than one function, they must be separated with
commas.

Precision-specific variants like sin and sinf are considered different
functions, so you would need to use
—fimf-max-error=4.0:sin,sinf

(or /Qimf-max-error=4.0:sin, sinf) to specify the maximum
allowable relative error for both the single-precision and double-
precision sine functions.

You also can specify the symbol /f to denote single-precision divides,
symbol / to denote double-precision divides, symbol /I to denote
extended-precision divides, and symbol /q to denote quad-precision
divides. For example you can specify -fimf-max-error=4.0:/

or /Qimf-max-error:4.0:/.
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Default

-fimf-precision=medium or /Qimf- The compiler uses medium precision when calling math library

precision:medium functions. Note that other options can affect precision; see below
for details.

Description

This option defines the maximum allowable relative error, measured in ulps, for math library function results.
This option can affect run-time performance and the accuracy of results.

If you need to define the accuracy for a math function of a certain precision, specify the function name of the
precision that you need. For example, if you want double precision, you can specify :sin; if you want single
precision, you can specify :sinf, as in -fimf-max-error=4.0:sin or /Qimf-max-error:4.0:sin, or
-fimf-max-error=4.0:sqrtf or /Qimf-max-error:4.0:sqrtf.

If you do not specify any function names, then the setting applies to all functions (and to all precisions).
However, as soon as you specify an individual function name, the setting applies only to the function of
corresponding precision. So, for example, sinf applies only to the single-precision sine function, sin applies
only to the double-precision sine function, sinl applies only to the extended-precision sine function, etc.

There are three options you can use to express the maximum relative error. They are as follows:

e -—fimf-precision (Linux* and macOS*) or /Qimf-precision (Windows*)
e -fimf-max-error (Linux* and macOS*) or /Qimf-max-error (Windows*)
e -—fimf-accuracy-bits (Linux and macOS*) or /Qimf-accuracy-bits (Windows)

If more than one of these options are specified, the default value for the maximum relative error is
determined by the last one specified on the command line.

If none of the above options are specified, the default values for the maximum relative error are determined
by the setting of the following options:

® [Q]fast-transcendentals

® [Q]prec-div

® [Q]prec-sqgrt

e -—fp-model (Linux and macOS*) or /fp (Windows)

NOTE
Many routines in libraries LIBM (Math Library) and SVML (Short Vector Math Library) are
more highly optimized for Intel® microprocessors than for non-Intel microprocessors.
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NOTE

The standard Fortran names for the various math intrinsic functions do not match the math
library names of the math intrinsic functions. You must find the actual math library name
that is generated for the relevant Fortran math intrinsic.

One way to do this is to generate assembly code by using options /Fa or /S on Windows, or option -3
on Linux. The assembly code will show the actual math library name.

For example, if you create a program that contains a call to SIN(x) where x is declared as
REAL(KIND=4) and then use option /s on Windows to produce assembly code for the program, the
assembly code will show a call to sinf.

Therefore, to define the maximum allowable relative error for the single-precision sine function, you
would specify -fimf-max-error=sinf (Or /Qimf-max-error:sinf).

Product and Performance Information

Performance varies by use, configuration and other factors. Learn more at www.Intel.com/
Performancelndex.

Notice revision #20201201

IDE Equivalent

None

Alternate Options

None

See Also

fimf-absolute-error, Qimf-absolute-error compiler option
fimf-accuracy-bits, Qimf-accuracy-bits compiler option
fimf-arch-consistency, Qimf-arch-consistency compiler option
fimf-domain-exclusion, Qimf-domain-exclusion compiler option
fimf-precision, Qimf-precision compiler option
fimf-use-svml Qimf-use-svml compiler option

fimf-precision, Qimf-precision

Lets you specify a level of accuracy (precision) that
the compiler should use when determining which math
library functions to use. This feature is only available
for ifort.

Syntax

Linux OS:
-fimf-precision[=valuel:funclist]]
macOS:

-fimf-precision[=valuel:funclist]]

Windows OS:

/Qimf-precision[:valuel[: funclist]]
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Arguments
value Is one of the following values denoting the desired accuracy:

1.0.

high This is equivalent to max-error

medium This is equivalent to max-error = 4; this is
the default setting if the option is specified
and value is omitted.

low This is equivalent to accuracy-bits = 11 for
single-precision functions; accuracy-bits =
26 for double-precision functions.

In the above explanations, max-error means option
-fimf-max-error (Linux* and macOS*) or /Qimf-max-error
(Windows*); accuracy-bits means option -fimf-accuracy-bits
(Linux* and macOS*) or /Qimf-accuracy-bits (Windows*).

funclist Is an optional list of one or more math library functions to which the
attribute should be applied. Do not specify the standard Fortran name
of the math function; you must specify the actual math library name.
If you specify more than one function, they must be separated with
commas.

Precision-specific variants like sin and sinf are considered different
functions, so you would need to use

-fimf-precision=high:sin, sinf

(or /Qimf-precision:high:sin, sinf) to specify high precision for
both the single-precision and double-precision sine functions.

You also can specify the symbol /f to denote single-precision divides,
symbol / to denote double-precision divides, symbol /I to denote
extended-precision divides, and symbol /q to denote quad-precision
divides. For example you can specify -fimf-precision=low:/

or /Qimf-precision:low:/ and -fimf-precision=low:/f

or /Qimf-precision:low:/f.

Default

medium The compiler uses medium precision when calling math library functions. Note that
other options can affect precision; see below for details.

Description

This option lets you specify a level of accuracy (precision) that the compiler should use when determining
which math library functions to use.

This option can be used to improve run-time performance if reduced accuracy is sufficient for the application,
or it can be used to increase the accuracy of math library functions selected by the compiler.

In general, using a lower precision can improve run-time performance and using a higher precision may
reduce run-time performance.

If you need to define the accuracy for a math function of a certain precision, specify the function name of the
precision that you need. For example, if you want double precision, you can specify :sin; if you want single
precision, you can specify :sinf, as in —-fimf-precision=low:sin or /Qimf-precision:low:sin, or
-fimf-precision=high:sqrtf or /Qimf-precision:high:sqrtf.
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If you do not specify any function names, then the setting applies to all functions (and to all precisions).
However, as soon as you specify an individual function name, the setting applies only to the function of
corresponding precision. So, for example, sinf applies only to the single-precision sine function, sin applies
only to the double-precision sine function, sinl applies only to the extended-precision sine function, etc.

There are three options you can use to express the maximum relative error. They are as follows:

e -fimf-precision (Linux* and macOS*) or /Qimf-precision (Windows*)
e -—fimf-max-error (Linux* and macOS*) or /Qimf-max-error (Windows*)
e -fimf-accuracy-bits (Linux and macOS*) or /Qimf-accuracy-bits (Windows)

If more than one of these options are specified, the default value for the maximum relative error is
determined by the last one specified on the command line.

If none of the above options are specified, the default values for the maximum relative error are determined
by the setting of the following options:

® [Q]fast-transcendentals

® [Q]prec-div

® [Q]prec-sqgrt

e -fp-model (Linux and macOS*) or /fp (Windows)

NOTE
Many routines in libraries LIBM (Math Library) and SVML (Short Vector Math Library) are
more highly optimized for Intel® microprocessors than for non-Intel microprocessors.

NOTE

The standard Fortran names for the various math intrinsic functions do not match the math
library names of the math intrinsic functions. You must find the actual math library name
that is generated for the relevant Fortran math intrinsic.

One way to do this is to generate assembly code by using options /Fa or /S on Windows, or option -3
on Linux. The assembly code will show the actual math library name.

For example, if you create a program that contains a call to SIN(x) where x is declared as
REAL(KIND=4) and then use option /s on Windows to produce assembly code for the program, the
assembly code will show a call to sinf.

Therefore, to specify a level of accuracy for the single-precision sine function, you would specify
-fimf-precision=sinf (or /Qimf-precision:sinf).

Product and Performance Information

Performance varies by use, configuration and other factors. Learn more at www.Intel.com/
Performancelndex.

Notice revision #20201201

IDE Equivalent

None

Alternate Options

None
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See Also

fimf-absolute-error, Qimf-absolute-error compiler option
fimf-accuracy-bits, Qimf-accuracy-bits compiler option
fimf-arch-consistency, Qimf-arch-consistency compiler option
fimf-domain-exclusion, Qimf-domain-exclusion compiler option
fimf-max-error, Qimf-max-error compiler option
fast-transcendentals, Qfast-transcendentals compiler option
prec-div, Qprec-div compiler option

prec-sqrt, Qprec-sqgrt con1pHeropﬂon

fp-model, fp compiler option

fimf-use-svml Qimf-use-svml compiler option

fimf-use-svml, Qimf-use-svml

Instructs the compiler to use the Short Vector Math
Library (SVML) rather than the Intel® Math Library
(LIBM) to implement math library functions.

Syntax
Linux OS:

-fimf-use-svml=value|: funclist]

macOS:

-fimf-use-svml=valuel[: funclist]

Windows OS:

/Qimf-use-svml:valuel: funclist]

Arguments

funclist Is an optional list of one or more math library functions to which the
attribute should be applied. Do not specify the standard Fortran name
of the math function; you must specify the actual math library name.
If you specify more than one function, they must be separated with
commas.

Precision-specific variants like sin and sinf are considered different
functions, so you would need to use
-fimf-use-svmlt=true:sin, sinf

(or /Qimf-use-svml:true:sin, sinf) to specify that both the
single-precision and double-precision sine functions should use SVML.

Default

false Math library functions are implemented using the Intel® Math Library, though other compiler
options such as -fast-transcendentals or /Qfast-transcendentals may give the compiler
the flexibility to implement math library functions with either LIBM or SVML.
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Description

This option instructs the compiler to implement math library functions using the Short Vector Math Library
(SVML). When you specify -fimf-use-svml=true or /Qimf-use-svml:true, the specific SVML variant
chosen is influenced by other compiler options such as -fimf-precision (Linux* and macOS*)

or /Qimf-precision (Windows*) and -fp-model (Linux and macOS¥*) or /£fp (Windows). This option has
no effect on math library functions that are implemented in LIBM but not in SVML.

In value-safe settings of option -fp-model (Linux and macOS*) or option /fp (Windows) such as precise,
this option causes a slight decrease in the accuracy of math library functions, because even the high
accuracy SVML functions are slightly less accurate than the corresponding functions in LIBM. Additionally, the
SVML functions might not accurately raise floating-point exceptions, do not maintain errno, and are designed
to work correctly only in round-to-nearest-even rounding mode.

The benefit of using -fimf-use-svml=true or /Qimf-use-svml:true with value-safe settings of
-fp-model (Linux and macOS*) or /fp (Windows) is that it can significantly improve performance by
enabling the compiler to efficiently vectorize loops containing calls to math library functions.

If you need to use SVML for a specific math function of a certain precision, specify the function name of the
precision that you need. For example, if you want double precision, you can specify :sin; if you want single
precision, you can specify :sqrtf, as in -fimf-use-svml=true:sin or /Qimf-use-svml:true:sin, or
-fimf-use-svml =false:sqrtf or /Qimf-use-svml:false:sqrtf.

If you do not specify any function names, then the setting applies to all functions (and to all precisions).
However, as soon as you specify an individual function name, the setting applies only to the function of
corresponding precision. So, for example, sinf applies only to the single-precision sine function, sin applies
only to the double-precision sine function, sinl applies only to the extended-precision sine function, etc.

NOTE

If you specify option -mia32 (Linux*) or option /arch:1a32 (Windows*), vector instructions
cannot be used. Therefore, you cannot use Linux* option -mia32 with option
-fimf-use-svml=true, and you cannot use Windows* option /arch:12a32 with

option /Qimf-use-svml:true.

NOTE

Since SVML functions may raise unexpected floating-point exceptions, be cautious about
using features that enable trapping on floating-point exceptions. For example, be cautious
about specifying option -fimf-use-svml=true with option -fp-trap, or

option /Qimf-use-svml:true with option /ofp-trap. For some inputs to some math library
functions, such option combinations may cause your program to trap unexpectedly.
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NOTE

The standard Fortran names for the various math intrinsic functions do not match the math
library names of the math intrinsic functions. You must find the actual math library name

that is generated for the relevant Fortran math intrinsic.

One way to do this is to generate assembly code by using options /Fa or /S on Windows, or option -3

on Linux. The assembly code will show the actual math library name.

For example, if you create a program that contains a call to SIN(x) where x is declared as

REAL(KIND=4) and then use option /s on Windows to produce assembly code for the program, the

assembly code will show a call to sinf.

Therefore, to request the use of SVML for the single-precision sine function, you would specify
-fimf-use-svml=true: sinf (Or /Qimf-use-svml:true: sinf).

Product and Performance Information

Performance varies by use, configuration and other factors. Learn more at www.Intel.com/
Performancelndex.

Notice revision #20201201

IDE Equivalent

None

Alternate Options

None

See Also

fp-model, fp compiler option
m compiler option

arch compiler option

fltconsistency
Enables improved floating-point consistency.

Syntax

Linux OS:
-fltconsistency
-nofltconsistency
macOS:
-fltconsistency
-nofltconsistency
Windows OS:
/fltconsistency

/nofltconsistency

Arguments

None
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Default

nofltconsistency Improved floating-point consistency is not enabled. This setting provides
better accuracy and run-time performance at the expense of less consistent
floating-point results.

Description

This option enables improved floating-point consistency and may slightly reduce execution speed. It limits
floating-point optimizations and maintains declared precision. It also disables inlining of math library
functions.

Floating-point operations are not reordered and the result of each floating-point operation is stored in the
target variable rather than being kept in the floating-point processor for use in a subsequent calculation.

For example, the compiler can change floating-point division computations into multiplication by the
reciprocal of the denominator. This change can alter the results of floating-point division computations
slightly.

Floating-point intermediate results are kept in full 80 bits internal precision. Additionally, all spills/reloads of
the X87 floating point registers are done using the internal formats; this prevents accidental loss of precision
due to spill/reload behavior over which you have no control.

Specifying this option has the following effects on program compilation:

Floating-point user variables are not assigned to registers.
Floating-point arithmetic comparisons conform to IEEE 754.

e The exact operations specified in the code are performed. For example, division is never changed to
multiplication by the reciprocal.

e The compiler performs floating-point operations in the order specified without reassociation.

e The compiler does not perform constant folding on floating-point values. Constant folding also eliminates
any multiplication by 1, division by 1, and addition or subtraction of 0. For example, code that adds 0.0 to
a number is executed exactly as written. Compile-time floating-point arithmetic is not performed to
ensure that floating-point exceptions are also maintained.

e Whenever an expression is spilled, it is spilled as 80 bits (extended precision), not 64 bits (DOUBLE
PRECISION). When assignments to type REAL and DOUBLE PRECISION are made, the precision is
rounded from 80 bits down to 32 bits (REAL) or 64 bits (DOUBLE PRECISION). When you do not
specify /fltconsistency, the extra bits of precision are not always rounded away before the variable is
reused.

e Even if vectorization is enabled by the [0]x option, the compiler does not vectorize reduction loops (loops
computing the dot product) and loops with mixed precision types. Similarly, the compiler does not enable
certain loop transformations. For example, the compiler does not transform reduction loops to perform
partial summation or loop interchange.

This option causes performance degradation relative to using default floating-point optimization flags.

On Windows systems, an alternative is to use the /Qprec option, which should provide better than default
floating-point precision while still delivering good floating-point performance.

The recommended method to control the semantics of floating-point calculations is to use option -fp-model
(Linux* and macOS*) or /fp (Windows*).

IDE Equivalent

None

Alternate Options

fltconsistency Linux and macOS*: -mieee-fp
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nofltconsistency

See Also

Windows: None

Linux and macOS*: -mno-ieee-fp

Windows: None

mpl, Qprec compiler option
fp-model, fp compiler option

fma, Qfma

Determines whether the compiler generates fused
multiply-add (FMA) instructions if such instructions
exist on the target processor.

Syntax
Linux OS:
-fma
-no-fma
macOS:
-fma

-no-fma

Windows OS:

/Qfma

/Qfma-

Arguments

None
Default

-fma
or /Qfma

Description

If the instructions exist on the target processor, the compiler generates fused multiply-
add (FMA) instructions.

However, if you specify —-fp-model strict (Linux* and macOS*) or /fp:strict
(Windows*), but do not explicitly specify -fma or /Qfma, the default is -no-fma
or /Qfma-.

This option determines whether the compiler generates fused multiply-add (FMA) instructions if such
instructions exist on the target processor. When the [Q] fma option is specified, the compiler may generate
FMA instructions for combining multiply and add operations. When the negative form of the [Q] fma option is
specified, the compiler must generate separate multiply and add instructions with intermediate rounding.

This option has no effect unless setting CORE-AVX2 or higher is specified for option [Q]x,-march (Linux and
macOS*), or /arch (Windows).

IDE Equivalent

None
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See Also

fp-model, fp compiler option
%, Ox compiler option

ax, Qax compiler option
march compiler option

arch compiler option

fp-model, fp

Controls the semantics of floating-point calculations.

Syntax
Linux OS:

-fp-model=keyword

macOS:

-fp-model=keyword

Windows OS:
/fp:keyword

Arguments
keyword Specifies the semantics to be used. Possible values are:
precise Disables optimizations that are not value-safe on floating-point
data and rounds intermediate results to source-defined precision.
fast[=1]2] Enables more aggressive optimizations on floating-point data.
consistent (ifort only)  The compiler uses default heuristics to determine results for
different optimization levels or between different processors of
the same architecture.
strict Enables precise and except, disables contractions, and enables
the property that allows modification of the floating-point
environment.
source (ifort only) Rounds intermediate results to source-defined precision.
[no-]except (Linux* and Determines whether strict floating-point exception semantics are
macOS*) or except [-] honored.
(Windows*) (ifort only)
Default
-fp-model=fast The compiler uses more aggressive optimizations on floating-point
or /fp: fast calculations.
Description

This option controls the semantics of floating-point calculations.
The keywords can be considered in groups:

e Group A: precise, fast, strict
e Group B: source
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Group C: except (or negative forms -no-except or /except-)
Group D: consistent

You can specify more than one keyword. However, the following rules apply:

You cannot specify fast and except together in the same compilation. You can specify any other
combination of group A, group B, and group C.

Since fast is the default, you must not specify except without a group A or group B keyword.

You should specify only one keyword from group A and only one keyword from group B. If you try to
specify more than one keyword from either group A or group B, the last (rightmost) one takes effect.
If you specify except more than once, the last (rightmost) one takes effect.

If you specify consistent and any other keyword from another group, the last (rightmost) one may not
fully override the heuristics set by consistent.

NOTE
The fp-model=fast (Or /fp:fast) options and the fp-model=fast=2 (Or /fp:fast=2) options
behave differently with ifx and ifort.

With ifort, floating-point compares happen as specified by the IEEE floating-point standard, in that
the code sequence generated for them assumes a compare can involve a NaN.

ifx does not generate the check for NaN operands. If you want to use option fp-model=fast

(or /fp:fast) or option fp-model=fast=2 (or /fp:fast=2) with ifx and you want NaN compares to

match ifort’s behavior, specify option assume nan compares on the command line.

The floating-point (FP) environment is a collection of registers that control the behavior of FP machine
instructions and indicate the current FP status. The floating-point environment may include rounding-mode
controls, exception masks, flush-to-zero controls, exception status flags, and other floating-point related

features.
Option Description
-fp-model=precise or /fp:precise Tells the compiler to strictly adhere to value-safe

optimizations when implementing floating-point
calculations. It disables optimizations that can
change the result of floating-point calculations.

These semantics ensure the reproducibility of
floating-point computations for serial code,

including code vectorized or auto-parallelized by the
compiler, but they may slow performance. They do
not ensure value safety or run-to-run reproducibility
of other parallel code.

Run-to-run reproducibility for floating-point
reductions in OpenMP* code may be obtained for a
fixed number of threads through the
KMP_DETERMINISTIC_REDUCTION environment
variable. For more information about this
environment variable, see topic "Supported
Environment Variables".

The compiler assumes the default floating-point
environment; you are not allowed to modify it.

337



Intel® Fortran Compiler Classic and Intel® Fortran Compiler Developer Guide and Reference

Option

Description

-fp-model=fast[=1]2] or /fp:fast[=1]2]

-fp-model=consistent or /fp:consistent
(ifort only)

-fp-model=strict or /fp:strict

-fp-model=source or /fp:source (ifort only)
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Note that option fp-model=precise implies
fp-model=source and option fp:precise implies
fp:source.

Floating-point exception semantics are disabled by
default. To enable these semantics, you must also
specify —fp-model=except or /fp:except.

Tells the compiler to use more aggressive
optimizations when implementing floating-point
calculations. These optimizations increase speed,
but may affect the accuracy or reproducibility of
floating-point computations.

Specifying fast is the same as specifying fast=1.
fast=2 may produce faster and less accurate
results.

fast=2 sets assume nonan_compares for ifx,
while it does not for i fort. To get i fort's behavior
when compiling with ifx and fast=2, explicitly set
the assume nan_ compares option.

Floating-point exception semantics are disabled by
default. To enable these semantics, you must also
specify —fp-model=except Or /fp:except.

The compiler uses default heuristics to generate
code that will determine results for different
optimization levels or between different processors
of the same architecture.

For more information, see the article titled:
Consistency of Floating-Point Results using the
Intel® Compiler, which is located in https://
software.intel.com/content/www/us/en/develop/
articles/consistency-of-floating-point-results-using-
the-intel-compiler.html

Tells the compiler to strictly adhere to value-safe
optimizations when implementing floating-point
calculations and enables floating-point exception
semantics. This is the strictest floating-point model.

The compiler does not assume the default floating-
point environment; you are allowed to modify it.

Floating-point exception semantics can be disabled
by explicitly specifying -fp-model=no-except
or /fp:except-.

This option causes intermediate results to be
rounded to the precision defined in the source code.
It also implies keyword precise unless it is
overridden by a keyword from Group A.
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Option Description

The compiler assumes the default floating-point
environment; you are not allowed to modify it.

-fp-model=except or /fp:except (ifort only) Tells the compiler to follow strict floating-point
exception semantics.

The -fp-model and /fp options determine the setting for the maximum allowable relative error for math
library function results (max-error) if none of the following options are specified (the following options are
only available for ifort):

e -fimf-accuracy-bits (Linux* and macOS*) or /Qimf-accuracy-bits (Windows¥*)
e -fimf-max-error (Linux and macOS*) or /Qimf-max-error (Windows)
e -—fimf-precision (Linux and macOS*) or /Qimf-precision (Windows)

® [Q]fast-transcendentals

Option -fp-model=fast (and /fp:fast) sets option -fimf-precision=medium
(/Qimf-precision:medium) and option -fp-model=precise (and /fp:precise) implies
-fimf-precision=high (and /Qimf-precision:high). Option -fp-model=fast=2 (and /fp:fast2) sets
option -fimf-precision=medium (and /Qimf-precision:medium) and option
-fimf-domain-exclusion=15 (and /Qimf-domain-exclusion=15).

NOTE
This option cannot be used to change the default (source) precision for the calculation of

intermediate results.

NOTE

In Microsoft* Visual Studio, when you create a Visual Studio* Fortran project,

option /fp:fast is set by default. It sets the floating-point model to use more aggressive
optimizations when implementing floating-point calculations, which increase speed, but may
affect the accuracy or reproducibility of floating-point computations. /fp:fast is the general
default for the IDE project property for Floating Point Model.

Product and Performance Information

Performance varies by use, configuration and other factors. Learn more at www.Intel.com/
Performancelndex.

Notice revision #20201201

IDE Equivalent
Visual Studio

Visual Studio: Floating Point > Floating Point Model

Floating Point > Reliable Floating Point Exceptions Model

Alternate Options
None

See Also
o compiler option (specifically 00)
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od compiler option

mpl, Qprec compiler option

fimf-absolute-error, Qimf-absolute-error compiler option

fimf-accuracy-bits, Qimf-accuracy-bits compiler option

fimf-max-error, Qimf-max-error compiler option

fimf-precision, Qimf-precision compiler option

fimf-domain-exclusion, Qimf-domain-exclusion compiler option

fast-transcendentals, Qfast-transcendentals compiler option

Supported Environment Variables

The article titled: Consistency of Floating-Point Results using the Intel® Compiler, which is located in https://

software.intel.com/content/www/us/en/develop/articles/consistency-of-floating-point-results-using-the-intel-
compiler.html

fp-port, Qfp-port
Rounds floating-point results after floating-point
operations. This feature is only available for ifort.

Syntax
Linux OS:

-fp-port
-no-fp-port
macOS:
-fp-port
-no-fp-port
Windows OS:
/Qfp-port

/Qfp-port-

Arguments

None
Default

-no-fp-port The default rounding behavior depends on the compiler's code generation decisions
or /Qfp-port- and the precision parameters of the operating system.

Description
This option rounds floating-point results after floating-point operations.

This option is designed to be used with the -mia32 (Linux*) or /arch:1A32 (Windows*) option on a 32-bit
compiler. Under those conditions, the compiler implements floating-point calculations using the x87
instruction set, which uses an internal precision that may be higher than the precision specified in the
program.

By default, the compiler may keep results of floating-point operations in this higher internal precision.
Rounding to program precision occurs at unspecified points. This provides better performance, but the
floating-point results are less deterministic. The [Q] fp-port option rounds floating-point results to user-
specified precision at assignments and type conversions. This has some impact on speed.
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When compiling for newer architectures, the compiler implements floating-point calculations with different
instructions, such as Intel® SSE and SSE2. These Intel® Streaming SIMD Extensions round directly to single
precision or double precision at every instruction. In these cases, option [Q] fp-port has no effect.

IDE Equivalent

Windows

Visual Studio: Floating-Point > Round Floating-Point Results

Alternate Options

None

See Also
Understanding Floating-point Operations

fp-speculation, Qfp-speculation

Tells the compiler the mode in which to speculate on
floating-point operations.

Syntax

Linux OS:
-fp-speculation=mode
macOS:
-fp-speculation=mode
Windows OS:

/Qfp-speculation:mode

Arguments
mode Is the mode for floating-point operations. Possible values are:
fast Tells the compiler to speculate on floating-
point operations.
safe Tells the compiler to disable speculation if
there is a possibility that the speculation
may cause a floating-point exception.
strict Tells the compiler to disable speculation on
floating-point operations.
off This is the same as specifying strict. This
feature is only available for ifort.
Default
-fp-speculation=fast The compiler speculates on floating-point operations. This is also the
or/Qfp-speculation: fast behavior when optimizations are enabled. However, if you specify no

optimizations (-00 on Linux*; /0d on Windows*), the default is
-fp-speculation=safe (Linux*) or /Qfp-speculation:safe
(Windows*).
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Description
This option tells the compiler the mode in which to speculate on floating-point operations.

Disabling speculation may prevent the vectorization of some loops containing conditionals. For an example,
see the article titled: Diagnostic 15326: loop was not vectorized: implied FP exception model prevents
vectorization, which is located in https://software.intel.com/content/www/us/en/develop/articles/
fdiag15326.html .

IDE Equivalent

Visual Studio

Visual Studio: Floating Point > Floating-Point Speculation

Alternate Options

None

fp-stack-check, Qfp-stack-check

Tells the compiler to generate extra code after every
function call to ensure that the floating-point stack is
in the expected state. This feature is only available for
ifort.

Syntax

Linux OS:
-fp-stack-check
macOS:
-fp-stack-check

Windows OS:
/Qfp-stack-check

Arguments

None

Default

OFF There is no checking to ensure that the floating-point (FP) stack is in the expected state.

Description

This option tells the compiler to generate extra code after every function call to ensure that the floating-point
(FP) stack is in the expected state.

By default, there is no checking. So when the FP stack overflows, a NaN value is put into FP calculations and
the program's results differ. Unfortunately, the overflow point can be far away from the point of the actual
bug. This option places code that causes an access violation exception immediately after an incorrect call
occurs, thus making it easier to locate these issues.

IDE Equivalent

Windows

Visual Studio: Floating-Point > Check Floating-Point Stack
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Alternate Options

None

fpe

Allows some control over floating-point exception
handling for the main program at run-time.

Syntax
Linux OS:
-fpen

macOS:

-fpen

Windows OS:

/fpe:n

Arguments

n Specifies the floating-point exception handling level. Possible values are:

0

Floating-point invalid, divide-by-zero, and overflow exceptions are enabled throughout
the application when the main program is compiled with this value. If any such
exceptions occur, execution is aborted. This option causes subnormal floating-point
results to be set to zero. Underflow results will also be set to zero, unless you override
this by explicitly specifying option -no-ftz or -fp-model precise (Linux* and
macOS*) or option /Qftz- or /fp:precise (Windows¥*).

Underflow results from SSE instructions, as well as x87 instructions, will be set to zero.
By contrast, option [Q] ftz only sets SSE underflow results to zero.

Sets option -fp-speculation=strict (Linux* and macOS*)

or /Qfp-speculation:strict (Windows*) for any program unit compiled with -fpe0
(Linux* and macOS*) or /fpe:0 (Windows*). This disables certain optimizations in
cases where speculative execution of floating-point operations could lead to floating-
point exceptions that would not occur in the absence of speculation. For example, this
may prevent the vectorization of some loops containing conditionals.

Disables certain optimizations that generate calls to the Short Vector Math Library that
could lead to floating-point exceptions for extreme input arguments that would not
occur if libm was called instead. For example, this may prevent the vectorization of
some loops containing calls to transcendental math functions.

To get more detailed location information about where the error occurred, use option
traceback.

NOTE

If you have more than one module, you must build each module,
including the main module, with value fpeO (Linux) or fpe:0 (Windows) to
avoid floating-point exceptions that may occur within the modules.

All floating-point exceptions are disabled.

Underflow results from SSE instructions, as well as x87 instructions, will be set to zero.
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3 All floating-point exceptions are disabled. Floating-point underflow is gradual, unless
you explicitly specify a compiler option that enables flush-to-zero, such as [Q] ftz, 03,
or 02. This setting provides full IEEE support.

Default

—fpe3 or /fpe:3 All floating-point exceptions are disabled. Floating-point underflow is
gradual, unless you explicitly specify a compiler option that enables flush-
to-zero.

Description

This option allows some control over floating-point exception handling at run-time. This includes whether
exceptional floating-point values are allowed and how precisely run-time exceptions are reported.

The fpe option affects how the following conditions are handled:
When floating-point calculations result in a divide by zero, overflow, or invalid operation.
When floating-point calculations result in an underflow.

e When a subnormal number or other exceptional number (positive infinity, negative infinity, or a NaN) is
present in an arithmetic expression.

When enabled exceptions occur, execution is aborted and the cause of the abort reported to the user. If
compiler option traceback is specified at compile time, detailed information about the location of the abort
is also reported.

This option does not enable underflow exceptions, input subnormal exceptions, or inexact exceptions.
IDE Equivalent

Visual Studio
Visual Studio: Floating-Point > Floating-Point Exception Handling

Alternate Options

None

See Also

fpe-all compiler option

ftz, Qftz compiler option

fp-model, fp compiler option

fp-speculation, Qfp-speculation compiler option
traceback compiler option

fpe-all
Allows some control over floating-point exception
handling for each routine in a program at run-time.

Syntax
Linux OS:
-fpe-all=n
macOS:

-fpe-all=n
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Windows OS:

/fpe-all:n

Arguments

n Specifies the floating-point exception handling level. Possible values are:

0 Floating-point invalid, divide-by-zero, and overflow exceptions are enabled. If any such
exceptions occur, execution is aborted. This option sets the [Q] ftz option; therefore
underflow results will be set to zero unless you explicitly specify -no-ftz (Linux and
macO0S*) or /Qftz- (Windows).

To get more detailed location information about where the error occurred, use option
traceback.

1 All floating-point exceptions are disabled.

Underflow results from SSE instructions, as well as x87 instructions, will be set to zero.

3 All floating-point exceptions are disabled. Floating-point underflow is gradual, unless
you explicitly specify a compiler option that enables flush-to-zero, such as [Q]ftz, 03,
or 02. This setting provides full IEEE support.

Default

-fpe-all=3 or /fpe-all:3 or the All floating-point exceptions are disabled. Floating-point underflow is
setting of fpe that the main gradual, unless you explicitly specify a compiler option that enables

program was compiled with flush-to-zero.

Description

This option allows some control over floating-point exception handling for each routine in a program at run-
time. This includes whether exceptional floating-point values are allowed and how precisely run-time
exceptions are reported.

The fpe-all option affects how the following conditions are handled:

e When floating-point calculations result in a divide by zero, overflow, or invalid operation.

e When floating-point calculations result in an underflow.

e When a subnormal number or other exceptional number (positive infinity, negative infinity, or a NaN) is
present in an arithmetic expression.

The current settings of the floating-point exception and status flags are saved on each routine entry and
restored on each routine exit. This may incur some performance overhead.

When option fpe-all is applied to a main program, it has the same effect as when option fpe is applied to
the main program.

When enabled exceptions occur, execution is aborted and the cause of the abort reported to the user. If
compiler option traceback is specified at compile time, detailed information about the location of the abort
is also reported.

This option does not enable underflow exceptions, input subnormal exceptions, or inexact exceptions.

Option fpe-all sets option assume ieee fpe flags.

IDE Equivalent

None
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Alternate Options

None

See Also

assume compiler option
fpe compiler option

ftz, Qftz compiler option
traceback compiler option

ftz, Qftz
Flushes subnormal results to zero.

Syntax
Linux OS:

-ftz
-no-ftz
macOS:

-ftz
-no-ftz
Windows OS:
/Qftz
/Qftz-

Arguments

None
Default

—-ftz or /Qftz Subnormal results are flushed to zero.

Every optimization option 0O level, except 00, sets
[Q]lftz.

Value 0O for the [Q] fpe option sets [Q] ftz.

Description

This option flushes subnormal results to zero when the application is in the gradual underflow mode. It may
improve performance if the subnormal values are not critical to your application's behavior.

The [Q] £tz option has no effect during compile-time optimization.

The [Q] ftz option sets or resets the FTZ and the DAZ hardware flags. If FTZ is ON, subnormal results from
floating-point calculations will be set to the value zero. If FTZ is OFF, subnormal results remain as is. If DAZ
is ON, subnormal values used as input to floating-point instructions will be treated as zero. If DAZ is OFF,
subnormal instruction inputs remain as is. Systems using Intel® 64 architecture have both FTZ and DAZ. FTZ
and DAZ are not supported on all IA-32 architectures.

When the [Q] ftz option is used in combination with an SSE-enabling option on systems using IA-32
architecture (for example, the [Q]xSSE2 option), the compiler will insert code in the main routine to set FTZ
and DAZ. When [Q] ftz is used without such an option, the compiler will insert code to conditionally set
FTZ/DAZ based on a run-time processor check.
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If you specify option —-no-ftz (Linux and macOS*) or option /Qftz- (Windows), it prevents the compiler
from inserting any code that might set FTZ or DAZ.

Option [Q] ftz only has an effect when the main program is being compiled. It sets the FTZ/DAZ mode for
the process. The initial thread and any threads subsequently created by that process will operate in FTZ/DAZ
mode.

If this option produces undesirable results of the numerical behavior of your program, you can turn the
FTZ/DAZ mode off by specifying -no-ftz or /Qftz- in the command line while still benefiting from the 03
optimizations.

NOTE

Option [Q]ftz is a performance option. Setting this option does not guarantee that all
subnormals in a program are flushed to zero. The option only causes subnormals generated
at run time to be flushed to zero.

IDE Equivalent

Windows
Visual Studio: IA-32 architecture: Floating Point > Flush Subnormal Results to Zero

Intel® 64 architecture: None

Alternate Options
None

See Also
x, Ox compiler option
Setting the FTZ and DAZ Flags

Ge

Enables stack-checking for all functions. This is a
deprecated option. The replacement option is /GsO.

Syntax
Linux OS:

None

macOS:

None

Windows OS:
/Ge

Arguments

None

Default

OFF Stack-checking for all functions is disabled.

Description

This option enables stack-checking for all functions.
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IDE Equivalent

None

Alternate Options
Linux and macOS*: None
Windows: /Gs0

mp1, Qprec

Improves floating-point precision and consistency.
This feature is only available for ifort.

Syntax
Linux OS:
~mp1
macOS:

~mp1
Windows OS:
/Qprec

Arguments

None

Default

OFF The compiler provides good accuracy and run-time performance at the expense of less consistent
floating-point results.

Description

This option improves floating-point consistency. It ensures the out-of-range check of operands of
transcendental functions and improves the accuracy of floating-point compares.

This option prevents the compiler from performing optimizations that change NaN comparison semantics and
causes all values to be truncated to declared precision before they are used in comparisons. It also causes
the compiler to use library routines that give better precision results compared to the X87 transcendental
instructions.

This option disables fewer optimizations and has less impact on performance than option fltconsistency.

This option disables fewer optimizations and has less impact on performance than option
fltconsistency,-fp-model precise (Linux* and macOS*), or option /fp:precise (Windows¥*).

IDE Equivalent

None

Alternate Options

None

See Also
fltconsistency compiler option
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pc, Qpc
Enables control of floating-point significand precision.
Syntax
Linux OS:
-pcn
macOS:
-pcn
Windows OS:
/Qpcn
Arguments
n Is the floating-point significand precision. Possible values are:
32 Rounds the significand to 24 bits (single
precision).
64 Rounds the significand to 53 bits (double
precision).
80 Rounds the significand to 64 bits (extended
precision).
Default
-pc8o On Linux* and macOS* systems, the floating-point significand is rounded to
or /Qpc64 64 bits. On Windows* systems, the floating-point significand is rounded to
53 bits.
Description

This option enables control of floating-point significand precision.

Some floating-point algorithms are sensitive to the accuracy of the significand, or fractional part of the
floating-point value. For example, iterative operations like division and finding the square root can run faster
if you lower the precision with the this option.

Note that a change of the default precision control or rounding mode, for example, by using the [Q]pc32
option or by user intervention, may affect the results returned by some of the mathematical functions.
IDE Equivalent

None

Alternate Options
None
prec-div, Qprec-div

Improves precision of floating-point divides. This
feature is only available for ifort.
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Syntax
Linux OS:

-prec-div
-no-prec-div
macOS:
-prec-div
-no-prec-div
Windows OS:
/Qprec-div
/Qprec—-div-
Arguments

None
Default

OFF

Description

Default heuristics are used. The default is not as accurate as full IEEE division, but it is
slightly more accurate than would be obtained when /Qprec-div- or -no-prec-div
is specified.

If you need full IEEE precision for division, you should specify [Q]prec-div.

This option improves precision of floating-point divides. It has a slight impact on speed.

At default optimization levels, the compiler may change floating-point division computations into
multiplication by the reciprocal of the denominator. For example, A/B is computed as A * (1/B) to improve
the speed of the computation.

However, sometimes the value produced by this transformation is not as accurate as full IEEE division. When
it is important to have fully precise IEEE division, use this option to disable the floating-point division-to-
multiplication optimization. The result is more accurate, with some loss of performance.

If you specify -no-prec-div (Linux* and macOS*) or /Qprec-div- (Windows¥*), it enables optimizations
that give slightly less precise results than full IEEE division.

Option [Q]lprec-div is implied by option -fp-model precise (Linux* and macOS*) and
option /fp:precise (Windows*).

IDE Equivalent

None

Alternate Options

None

See Also

fp-model, fp compiler option

prec-sqrt, Qprec-sqrt
Improves precision of square root implementations.
This feature is only available for ifort.
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Syntax

Linux OS:
-prec-sqgrt
-no-prec-sqgrt
macOS:
-prec-sqgrt
—-no-prec-sqgrt
Windows OS:
/Qprec-sqrt

/Qprec-sqrt-

Arguments

None

Default

-no-prec-sqrt The compiler uses a faster but less precise implementation of square root.

or /Qprec-sqrt- However, the default is -prec-sqrt or /Qprec-sqgrt if any of the following options
are specified: /0d, /fltconsistency, or /Qprec on Windows* systems; -00,
-fltconsistency, or -mpl on Linux* and macOS* systems.

Description

This option improves precision of square root implementations. It has a slight impact on speed.

This option inhibits any optimizations that can adversely affect the precision of a square root computation.

The result is fully precise square root implementations, with some loss of performance.

IDE Equivalent

None

Alternate Options

None

gsimd-honor-fp-model, Qsimd-honor-fp-model

Tells the compiler to obey the selected floating-point
model when vectorizing SIMD loops. This feature is
only available for ifort.

Syntax

Linux OS:
-gsimd-honor-fp-model
-gno-simd-honor-fp-model
macOS:
-gsimd-honor-fp-model

-gno-simd-honor-fp-model
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Windows OS:
/Qsimd-honor-fp-model

/Qsimd-honor-fp-model-

Arguments

None

Default

-gno-simd-honor-fp-model The compiler performs vectorization of SIMD loops even if it breaks
or /Qsimd-honor-fp-model- the floating-point model setting.

Description

The OpenMP* SIMD specification and the setting of compiler option -fp-model (Linux* and macOS*) or /fp
(Windows*) can contradict in requirements. When contradiction occurs, the default behavior of the compiler
is to follow the OpenMP* specification and therefore vectorize the loop.

This option lets you override this default behavior - it causes the compiler to follow the —-fp-model (or /fp)
specification. This means that the compiler will serialize the loop.

NOTE
This option does not affect automatic vectorization of loops. By default, the compiler uses
-fp-model (Linux* and macOS*) or /fp (Windows*) settings for this.

IDE Equivalent

None

Alternate Options

None

See Also

gsimd-serialize-fp-reduction, Qsimd-serialize-fp-reduction compiler option
fp-model, fp compiler option

SIMD Loop Directive directive

SIMD Directive (OpenMP* API) directive

qsimd-serialize-fp-reduction, Qsimd-serialize-fp-reduction

Tells the compiler to serialize floating-point reduction
when vectorizing SIMD loops. This feature is only
available for ifort.

Syntax

Linux OS:
-gsimd-serialize-fp-reduction
-gqno-simd-serialize-fp-reduction
macOS:
-gsimd-serialize-fp-reduction

-gno-simd-serialize-fp-reduction
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Windows OS:
/Qsimd-serialize-fp-reduction
/Qsimd-serialize-fp-reduction-
Arguments

None

Default

The compiler does not attempt to serialize floating-point
reduction in SIMD loops.

-gno-simd-serialize-fp-reduction
or /Qsimd-serialize-fp-reduction-

Description

The OpenMP* SIMD reduction specification and the setting of compiler option —-fp-model (Linux* and
macOS*) or /fp (Windows*) can contradict in requirements. When contradiction occurs, the default behavior
of the compiler is to follow OpenMP* specification and therefore vectorize the loop, including floating-point
reduction.

This option lets you override this default behavior - it causes the compiler to follow the —-fp-model (or /£fp)
specification. This means that the compiler will serialize the floating-point reduction while vectorizing the rest
of the loop.

NOTE

When [g or Q]simd-honor-fp-model is specified and OpenMP* SIMD reduction specification
is the only thing causing serialization of the entire loop, addition of option

[g or Q]simd-serialize-fp-reduction Will result in vectorization of the entire loop except
for reduction calculation, which will be serialized.

NOTE
This option does not affect automatic vectorization of loops. By default, the compiler uses
-fp-model (Linux* and macOS*) or /fp (Windows*) settings for this.

IDE Equivalent

None

Alternate Options

None

See Also

gsimd-honor-fp-model, Qsimd-honor-fp-model compiler option
fp-model, fp compiler option

SIMD Loop Directive directive

SIMD Directive (OpenMP* API) directive

rcd, Qrcd

Enables fast float-to-integer conversions. This is a
deprecated option. There is no replacement option.
This feature is only available for ifort.
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Syntax
Linux OS:

-rcd
macOS:

-rcd
Windows OS:
/Qrcd

Arguments

None

Default

OFF Floating-point values are truncated when a conversion to an integer is involved.

Description

This option enables fast float-to-integer conversions. It can improve the performance of code that requires
floating-point-to-integer conversions.

The system default floating-point rounding mode is round-to-nearest. However, the Fortran language
requires floating-point values to be truncated when a conversion to an integer is involved. To do this, the
compiler must change the rounding mode to truncation before each floating-point-to-integer conversion and
change it back afterwards.

This option disables the change to truncation of the rounding mode for all floating-point calculations,
including floating point-to-integer conversions. This option can improve performance, but floating-point
conversions to integer will not conform to Fortran semantics.

IDE Equivalent

None

Alternate Options
Linux and macOS*: None

Windows: /QIfist (this is a deprecated option)

recursive

Tells the compiler that all routines should be compiled
for possible recursive execution.

Syntax

Linux OS:
-recursive
-norecursive

macOS:
-recursive

-norecursive
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Windows OS:
/recursive

/norecursive

Arguments

None
Default

norecursive Routines are not compiled for possible recursive execution.

Description

This option tells the compiler that all routines should be compiled for possible recursive execution. It sets the
automatic option.

NOTE
This option will be deprecated in a future release. We recommend you use its replacement
opﬂon: assume [no]recursion.

IDE Equivalent

Windows

Visual Studio: Code Generation > Enable Recursive Routines

Alternate Options
Linux and macOS*: -assume [no]recursion

Windows: /assume: [no]recursion

See Also
auto compiler option
assume compiler option, setting [no]recursion

Inlining Options
This section contains descriptions for compiler options that pertain to inlining.
finline

Tells the compiler to inline functions declared with !
DIR$ ATTRIBUTES FORCEINLINE.

Syntax
Linux OS:
-finline
-fno-inline
macOS:
-finline

-fno-inline
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Windows OS:

None

Arguments

None

Default

—fno-inline The compiler does not inline functions declared with !DIR$ ATTRIBUTES FORCEINLINE.

Description

This option tells the compiler to inline functions declared with |DIR$ ATTRIBUTES FORCEINLINE.

IDE Equivalent

None

Alternate Options

Linux and macOS*: -inline-level

Windows: /0b

finline-functions

Enables function inlining for single file compilation.

Syntax

Linux OS:
-finline-functions
-fno-inline-functions
macOS:
-finline-functions
-fno-inline-functions

Windows OS:

None

Arguments

None

Default

-finline-functions

Description

Interprocedural optimizations occur. However, if you specify -00, the default
is OFF.

This option enables function inlining for single file compilation.

It enables the compiler to perform inline function expansion for calls to functions defined within the current

source file.
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The compiler applies a heuristic to perform the function expansion. To specify the size of the function to be
expanded, use the -finline-1imit option.
IDE Equivalent

None

Alternate Options
Linux and macOS*: -inline-level=2

Windows: /0b2

See Also
ip, 0ip compiler option
finline-limit compiler option

finline-limit

Lets you specify the maximum size of a function to be
inlined.

Syntax

Linux OS:
-finline-limit=n
macOS:

-finline-limit=n

Windows OS:

None

Arguments

n Must be an integer greater than or equal to zero. It is the maximum
number of lines the function can have to be considered for inlining.

Default

OFF The compiler uses default heuristics when inlining functions.

Description

This option lets you specify the maximum size of a function to be inlined. The compiler inlines smaller
functions, but this option lets you inline large functions. For example, to indicate a large function, you could
specify 100 or 1000 for n.

Note that parts of functions cannot be inlined, only whole functions.

This option is a modification of the -finline-functions option, whose behavior occurs by default.

IDE Equivalent

None

Alternate Options

None
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See Also

finline-functions compiler option
inline

Specifies the level of inline function expansion.

Syntax
Linux OS:
None

macOS:

None

Windows OS:

/inline|[: keyword]

Arguments
keyword Is the level of inline function expansion. Possible values are:
none Disables inlining of user-defined functions. This is the same as specifying manual.
manual PDisables inlining of user-defined functions. Fortran statement functions are always
inlined.
size Enables inlining of any function. However, the compiler decides which functions
are inlined.
This option enables interprocedural optimizations and most speed optimizations.
speed Enables inlining of any function. This is the same as specifying all.
all Enables inlining of any function. However, the compiler decides which functions
are inlined.
This option enables interprocedural optimizations and all speed optimizations. This
is the same as specifying inline with no keyword.
Default
OFF The compiler inlines certain functions by default.
Description

This option specifies the level of inline function expansion.

IDE Equivalent

None
Alternate Options

inline all or inline speed Linux and macOS*: None
Windows: /0b2/0t

inline size Linux and macOS*: None
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Windows: /0b2/0s

inline manual Linux and macOS*: None

Windows: /0b0

inline none Linux and macOS*: None

Windows: /0b0

See Also
finline-functions compiler option

inline-factor, Qinline-factor

Specifies the percentage multiplier that should be
applied to all inlining options that define upper limits.
This feature is only available for ifort.

Syntax

Linux OS:
-inline-factor=n
-no-inline-factor
macOS:
-inline-factor=n
-no-inline-factor
Windows OS:
/Qinline-factor:n

/Qinline-factor-

Arguments

n Is a positive integer specifying the percentage value. The default value
is 100 (a factor of 1).

Default

—inline-factor=100 The compiler uses a percentage multiplier of 100.

or /Qinline-factor:100

Description

This option specifies the percentage multiplier that should be applied to all inlining options that define upper
limits:

[ )

[
e |
[
(

inline-max-size

0]
Qlinline-max-total-size
Qlinline-max-per-routine
Q]

U inline-max-per-compile

The [Q]inline-factor option takes the default value for each of the above options and multiplies it by n
divided by 100. For example, if 200 is specified, all inlining options that define upper limits are multiplied by
a factor of 2. This option is useful if you do not want to individually increase each option limit.
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If you specify -no-inline-factor (Linux* and macOS*) or /Qinline-factor- (Windows*), the following
occurs:

Every function is considered to be a small or medium function; there are no large functions.
There is no limit to the size a routine may grow when inline expansion is performed.

There is no limit to the number of times some routine may be inlined into a particular routine.
There is no limit to the number of times inlining can be applied to a compilation unit.

To see compiler values for important inlining limits, specify option [g or Q]opt-report.

Caution
When you use this option to increase default limits, the compiler may do so much additional
inlining that it runs out of memory and terminates with an "out of memory" message.

IDE Equivalent

None

Alternate Options

None

See Also

inline-max-size, Qinline-max-size compiler option
inline-max-total-size, Qinline-max-total-size compiler option
inline-max-per-routine, Qinline-max-per-routine compiler option
inline-max-per-compile, Qinline-max-per-compile con1pHeropﬂon
gopt-report, Qopt-report conpreropﬂon

inline-forceinline, Qinline-forceinline

Instructs the compiler to force inlining of functions
suggested for inlining whenever the compiler is
capable doing so. This feature is only available for
ifort.

Syntax

Linux OS:
-inline-forceinline
macOS:
-inline-forceinline
Windows OS:

/Qinline-forceinline

Default
OFF The compiler uses default heuristics for inline routine expansion.
Description

This option instructs the compiler to force inlining of functions suggested for inlining whenever the compiler
is capable doing so.
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Without this option, the compiler treats functions declared with an INLINE attribute as merely being
recommended for inlining. When this option is used, it is as if they were declared with the directive 'DIR$
ATTRIBUTES FORCEINLINE.

To see compiler values for important inlining limits, specify option [g or Q]opt-report.

Caution

When you use this option to change the meaning of inline to "forceinline", the compiler may
do so much additional inlining that it runs out of memory and terminates with an "out of
memory" message.

IDE Equivalent

None
Alternate Options

None

See Also
gopt-report, Qopt-report compiler option

inline-level, Ob
Specifies the level of inline function expansion.

Syntax

Linux OS:
-inline-level=n
macOS:

-inline-level=n

Windows OS:

/0bn

Arguments

n Is the inline function expansion level. Possible values are 0, 1, and 2.

Default

—inline-level=2 Or /Ob2 This is the default if option 02 is specified or is in effect by
default. On Windows* systems, this is also the default if option
03 is specified.

—inline-level=0 or /Ob0 This is the default if option -00 (Linux* and macOS*) or /0d
(Windows*) is specified.

Description

This option specifies the level of inline function expansion. Inlining procedures can greatly improve the run-
time performance of certain programs.
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Option Description

-inline-level=0 or /Ob0 Disables inlining of user-defined functions. Note that statement functions
are always inlined.

-inline-level=1 or /Obl Enables inlining when an inline keyword or an inline directive is specified.

-inline-level=2 or /Ob2 Enables inlining of any function at the compiler's discretion.

IDE Equivalent

Windows

Visual Studio: Optimization > Inline Function Expansion

Alternate Options

None

See Also
inline compiler option

inline-max-per-compile, Qinline-max-per-compile
Specifies the maximum number of times inlining may

be applied to an entire compilation unit. This feature is
only available for ifort.

Syntax

Linux OS:
-inline-max-per-compile=n
-no-inline-max-per-compile
macOS:
-inline-max-per-compile=n
-no-inline-max-per-compile
Windows OS:
/Qinline-max-per-compile=n

/Qinline-max-per—-compile-

Arguments

n Is a positive integer that specifies the number of times inlining may be
applied.

Default

-no-inline-max-per-compile The compiler uses default heuristics for inline routine expansion.

or /Qinline-max-per-compile-

Description

This option the maximum number of times inlining may be applied to an entire compilation unit. It limits the
number of times that inlining can be applied.
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For compilations using Interprocedural Optimizations (IPO), the entire compilation is a compilation unit. For
other compilations, a compilation unit is a file.

If you specify -no-inline-max-per-compile (Linux* and macOS*) or /Qinline-max-per-compile-
(Windows*), there is no limit to the number of times inlining may be applied to a compilation unit.

To see compiler values for important inlining limits, specify option [g or Q]opt-report.

Caution

When you use this option to increase the default limit, the compiler may do so much
additional inlining that it runs out of memory and terminates with an "out of memory"
message.

IDE Equivalent

None

Alternate Options

None

See Also
inline-factor, Qinline-factor compiler option
gopt-report, Qopt-report compiler option

inline-max-per-routine, Qinline-max-per-routine
Specifies the maximum number of times the inliner

may inline into a particular routine. This feature is
only available for ifort.

Syntax

Linux OS:
-inline-max-per-routine=n
-no-inline-max-per-routine
macOS:
-inline-max-per-routine=n
-no-inline-max-per-routine
Windows OS:
/Qinline-max-per-routine=n

/Qinline-max-per-routine-

Arguments

n Is a positive integer that specifies the maximum number of times the
inliner may inline into a particular routine.

Default

-no-inline-max-per-routine The compiler uses default heuristics for inline routine expansion.

or /Qinline-max-per-routine-
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Description

This option specifies the maximum number of times the inliner may inline into a particular routine. It limits
the number of times that inlining can be applied to any routine.

If you specify -no-inline-max-per-routine (Linux* and macOS*) or /Qinline-max-per-routine-
(Windows*), there is no limit to the number of times some routine may be inlined into a particular routine.

To see compiler values for important inlining limits, specify option [g or Q]opt-report.

Caution

When you use this option to increase the default limit, the compiler may do so much
additional inlining that it runs out of memory and terminates with an "out of memory"
message.

IDE Equivalent

None

Alternate Options

None

See Also
inline-factor, Qinline-factor compiler option
gopt-report, Qopt-report conpreropﬂon

inline-max-size, Qinline-max-size

Specifies the lower limit for the size of what the inliner
considers to be a large routine. This feature is only
available for ifort.

Syntax

Linux OS:
-inline-max-size=n
-no-inline-max-size
macOS:
-inline-max-size=n
-no-inline-max-size
Windows OS:
/Qinline-max-size=n
/Qinline-max-size-
Arguments

n Is a positive integer that specifies the minimum size of what the
inliner considers to be a large routine.
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Default

—inline-max-size The compiler sets the maximum size (n) dynamically, based on

or /Qinline-max-size the platform.

Description

This option specifies the lower limit for the size of what the inliner considers to be a large routine (a function
or subroutine). The inliner classifies routines as small, medium, or large. This option specifies the boundary
between what the inliner considers to be medium and large-size routines.

The inliner prefers to inline small routines. It has a preference against inlining large routines. So, any large
routine is highly unlikely to be inlined.

If you specify -no-inline-max-size (Linux* and macOS*) or /Qinline-max-size- (Windows*), there are
no large routines. Every routine is either a small or medium routine.

To see compiler values for important inlining limits, specify option [g or Q]opt-report.

Caution

When you use this option to increase the default limit, the compiler may do so much
additional inlining that it runs out of memory and terminates with an "out of memory"
message.

IDE Equivalent

None

Alternate Options

None

See Also

inline-min-size, Qinline-min-size compiler option
inline-factor, Qinline-factor compiler option
gopt-report, Qopt-report conpreropﬂon

inline-max-total-size, Qinline-max-total-size

Specifies how much larger a routine can normally
grow when inline expansion is performed. This feature
is only available for ifort.

Syntax

Linux OS:
-inline-max-total-size=n
-no-inline-max-total-size
macOS:
-inline-max-total-size=n
-no-inline-max-total-size
Windows OS:
/Qinline-max-total-size=n

/Qinline-max-total-size-
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Arguments

n Is a positive integer that specifies the permitted increase in the
routine's size when inline expansion is performed.

Default

—no-inline-max-total-size The compiler uses default heuristics for inline routine expansion.

or /Qinline-max-total-size-

Description

This option specifies how much larger a routine can normally grow when inline expansion is performed. It
limits the potential size of the routine. For example, if 2000 is specified for n, the size of any routine will
normally not increase by more than 2000.

If you specify -no-inline-max-total-size (Linux* and macOS*) or /Qinline-max-total-size-
(Windows*), there is no limit to the size a routine may grow when inline expansion is performed.

To see compiler values for important inlining limits, specify option [g or Q]opt-report.

Caution

When you use this option to increase the default limit, the compiler may do so much
additional inlining that it runs out of memory and terminates with an "out of memory"
message.

IDE Equivalent

None

Alternate Options

None

See Also
inline-factor, Qinline-factor compiler option
gopt-report, Qopt-report con1pHeropﬂon

inline-min-caller-growth, Qinline-min-caller-growth
Lets you specify a procedure size n for which

procedures of size <= n do not contribute to the
estimated growth of the caller when inlined. This

feature is only available for ifort.

Syntax

Linux OS:
—-inline-min-caller-growth=n
macOS:
-inline-min-caller-growth=n
Windows OS:

/Qinline-min-caller-growth=n
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Arguments

n Is a non-negative integer. When n > 0, procedures with a size of n are
treated as if they are size 0.

Default

-inline-min-caller-growth=0 The compiler treats procedures as if they have size zero.

or /Qinline-min-caller-growth=0

Description

This option lets you specify a procedure size n for which procedures of size <= n do not contribute to the
estimated growth of the caller when inlined. It allows you to inline procedures that the compiler would
otherwise consider too large to inline.

NOTE
We recommend that you choose a value of n <= 10; otherwise, compile time and code size
may greatly increase.

IDE Equivalent

None

Alternate Options

None

inline-min-size, Qinline-min-size
Specifies the upper limit for the size of what the

inliner considers to be a small routine. This feature is
only available for ifort.

Syntax

Linux OS:
-inline-min-size=n
-no-inline-min-size
macOS:
-inline-min-size=n
-no-inline-min-size
Windows OS:
/Qinline-min-size=n

/Qinline-min-size-
Arguments

n Is a positive integer that specifies the maximum size of what the
inliner considers to be a small routine.
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Default

—no-inline-min-size The compiler uses default heuristics for inline routine expansion.

or /Qinline-min-size-
Description

This option specifies the upper limit for the size of what the inliner considers to be a small routine (a function
or subroutine). The inliner classifies routines as small, medium, or large. This option specifies the boundary
between what the inliner considers to be small and medium-size routines.

The inliner has a preference to inline small routines. So, when a routine is smaller than or equal to the
specified size, it is very likely to be inlined.

If you specify -no-inline-min-size (Linux* and macOS*) or /Qinline-min-size- (Windows*), there is
no limit to the size of small routines. Every routine is a small routine; there are no medium or large routines.

To see compiler values for important inlining limits, specify option [g or Q]opt-report.

Caution

When you use this option to increase the default limit, the compiler may do so much
additional inlining that it runs out of memory and terminates with an "out of memory"
message.

IDE Equivalent

None

Alternate Options

None

See Also
inline-max-size, Qinline-max-size compiler option

gopt-report, Qopt-report compiler option

Qinline-dllimport
Determines whether dllimport functions are inlined.
This feature is only available for ifort.

Syntax
Linux OS:
None

macOS:

None

Windows OS:
/Qinline-dllimport

/Qinline-dllimport-

Arguments

None
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Default

/Oinline-dllimport The dllimport functions are inlined.

Description

This option determines whether dllimport functions are inlined. To disable dllimport functions from being
inlined, specify /Qinline-dllimport-.

IDE Equivalent

None

Alternate Options

None

Output, Debug, and Precompiled Header (PCH) Options

This section contains descriptions for compiler options that pertain to output, debugging, or precompiled
headers (PCH).

bintext

Places a text string into the object file (.obj) being
generated by the compiler. This feature is only
available for ifort.

Syntax

Linux OS:

None

macOS:

None

Windows OS:
/bintext:string

/nobintext

Arguments

string Is the text string to go into the object file.

Default

/nobintext No text string is placed in the object file.

Description

This option places a text string into the object file (.obj) being generated by the compiler. The string also
gets propagated into the executable file.

For example, this option is useful if you want to place a version number or copyright information into the
object and executable.

If the string contains a space or tab, the string must be enclosed by double quotation marks ("). A backslash

(\) must precede any double quotation marks contained within the string.
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If the command line contains multiple /bintext options, the last (rightmost) one is used.
IDE Equivalent

Windows
Visual Studio: Code Generation > Object Text String

Alternate Options
Linux and macOS*: None
Windows: /vstring

C
Prevents linking.

Syntax
Linux OS:

-C

macOS:

-C

Windows OS:
/c

Arguments

None

Default

OFF Linking is performed.

Description
This option prevents linking. Compilation stops after the object file is generated.

The compiler generates an object file for each Fortran source file.

IDE Equivalent

None

Alternate Options
Linux and macOS*: None

Windows: /compile-only, /nolink

debug (Linux* and macOS*)

Enables or disables generation of debugging
information.

Syntax

Linux OS:
-debug [keyword]
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macOS:
-debug [keyword]
Windows OS:
None
Arguments
keyword Is the type of debugging information to be generated. Possible values are:
none Disables generation of debugging information.
full or all Generates complete debugging information.
minimal Generates line number information for debugging.
[nojemit column Determines whether the compiler generates column

number information for debugging.
[nolinline-debug-info Determines whether the compiler generates enhanced
debug information for inlined code.

[no]pubnames Determines whether the compiler generates a DWARF
debug_pubnames section.

[no] semantic-stepping Determines whether the compiler generates enhanced
debug information useful for breakpoints and stepping.

[no]variable-locations Determines whether the compiler generates enhanced
debug information useful in finding scalar local variables.

extended Generates complete debugging information and also sets
keyword values semantic-stepping and variable-
locations.

[no]parallel Determines whether the compiler generates parallel debug

(Linux only) code instrumentations useful for thread data sharing and

reentrant call detection.

For information on the non-default settings for these keywords, see the Description section.

Default

varies Normally, the default is ~debug none and no debugging information is
generated. However, on Linux*, the -debug inline-debug-info
option will be enabled by default if you compile with optimizations
(option -02 or higher) and debugging is enabled (option -g).

Description

This option enables or disables generation of debugging information.

By default, enabling debugging, will disable optimization. To enable both debugging and optimization use the
-debug option together with one of the optimization level options (-03, -02 or -03).

Keywords semantic-stepping, inline-debug-info, variable-locations, and extended can be used in
combination with each other. If conflicting keywords are used in combination, the last one specified on the
command line has precedence.
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Option Description

-debug none Disables generation of debugging information.

-debug full or -debug all Generates complete debugging information. It is the same as specifying
-debug with no keyword.

-debug minimal Generates line number information for debugging.
-debug emit column Generates column number information for debugging.

-debug inline-debug-info Generates enhanced debug information for inlined code.

On inlined functions, symbols are (by default) associated with the caller.
This option causes symbols for inlined functions to be associated with the
source of the called function.

-debug pubnames The compiler generates a DWARF debug_pubnames section. This provides
a means to list the names of global objects and functions in a compilation
unit.

-debug semantic-stepping Generates enhanced debug information useful for breakpoints and
stepping. It tells the debugger to stop only at machine instructions that
achieve the final effect of a source statement.

For example, in the case of an assignment statement, this might be a
store instruction that assigns a value to a program variable; for a function
call, it might be the machine instruction that executes the call. Other
instructions generated for those source statements are not displayed
during stepping.

This option has no impact unless optimizations have also been enabled.

-debug variable-locations Generates enhanced debug information useful in finding scalar local
variables. It uses a feature of the Dwarf object module known as
"location lists".

This feature allows the run-time locations of local scalar variables to be
specified more accurately; that is, whether, at a given position in the
code, a variable value is found in memory or a machine register.

-debug extended Sets keyword values semantic-stepping and variable-locations. It
also tells the compiler to include column numbers in the line information.

Generates complete debugging information and also sets keyword values
semantic-stepping and variable-locations. This is a more powerful
setting than -debug full or -debug all.

-debug parallel Generates parallel debug code instrumentations needed for the thread
data sharing and reentrant call detection.

For this setting to be effective, option ~gopenmp must be set.

On Linux* systems, debuggers read debug information from executable images. As a result, information is
written to object files and then added to the executable by the linker.

On macOS* systems, debuggers read debug information from object files. As a result, the executables don't
contain any debug information. Therefore, if you want to be able to debug on these systems, you must retain
the object files.
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IDE Equivalent

None
Alternate Options

For -debug full, -debug all, or Linux and macOS*: -g
-debug Windows: /debug:full, /debug:all, or /debug
For -debug variable-locations Linuxand macOS*: -fvar-tracking

Windows: None

For -debug semantic-stepping Linux and macOS*: -fvar-tracking-assignments

Windows: None

See Also
debug (Windows*) compiler option
gopenmp, Qopenmp conpreropﬂon

debug (Windows*)
Enables or disables generation of debugging

information.

Syntax

Linux OS:

None

macOS:

None

Windows OS:

/debug|: keyword]

/nodebug

Arguments

keyword Is the type of debugging information to be generated. Possible values are:
none Disables generation of debugging information.
full or all Generates complete debugging information.
minimal Generates line nhumber information for debugging.
[no]inline- Determines whether the compiler generates enhanced debug information

debug-info for inlined code.

For information on the non-default settings for these keywords, see the Description section.

Default
/debug:none This is the default on the command line and for a release configuration in the IDE.
/debug:all This is the default for a debug configuration in the IDE.
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Description

This option enables or disables generation of debugging information. It is passed to the linker.

By default, enabling debugging, will disable optimization. To enable both debugging and optimization use
the /debug option together with one of the optimization level options (/03, /02 or /03).

If conflicting keywords are used in combination, the last one specified on the command line has precedence.

Option

Description

/debug:none

/debug: full or /debug:all

/debug:minimal

/debug:partial

/debug:inline-debug-info

IDE Equivalent

Windows

Disables generation of debugging information. It is the same
as specifying /nodebug.

Generates complete debugging information. It produces
symbol table information needed for full symbolic debugging of
unoptimized code and global symbol information needed for
linking. It is the same as specifying /debug with no keyword.
If you specify /debug: full for an application that makes calls
to C library routines and you need to debug calls into the C
library, you should also specify /dbglibs to request that the
appropriate C debug library be linked against.

Generates line number information for debugging.

Generates global symbol table information needed for linking,
but not local symbol table information needed for debugging.
This option is deprecated and is not available in the IDE.

Generates enhanced debug information for inlined code.

On inlined functions, symbols are (by default) associated with
the caller. This option causes symbols for inlined functions to
be associated with the source of the called function.

Visual Studio: General > Debug Information Format (/debug:minimal, /debug:full)

Alternate Options

For /debug:all or
/debug

See Also
dbglibs compiler option

Linux and macOS*: None
Windows: /zi

debug (Linux* and macOS*) compiler option

debug-parameters

Tells the compiler to generate debug information for

PARAMETERs used in a program.

Syntax
Linux OS:

-debug-parameters [keyword]
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-nodebug-parameters

macOS:

—-debug-parameters [keyword]
-nodebug-parameters
Windows OS:
/debug-parameters|: keyword]

/nodebug-parameters

Arguments
keyword Specifies the PARAMETERs to generate debug information for. Possible values are:
none Generates no debug information for any PARAMETERSs used in the program.
This is the same as specifying nodebug-parameters.
used Generates debug information for only PARAMETERSs that have actually been
referenced in the program. This is the default if you do not specify a
keyword.
all Generates debug information for all PARAMETERSs defined in the program.
Default
nodebug-parameters The compiler generates no debug information for any PARAMETERS used in
the program. This is the same as specifying keyword none.
Description

This option tells the compiler to generate debug information for PARAMETERSs used in a program.
Note that if a .mod file contains PARAMETERSs, debug information is only generated for the PARAMETERs that
have actually been referenced in the program, even if you specify keyword all.

IDE Equivalent

Windows
Visual Studio: Debugging > Information for PARAMETER Constants

Alternate Options
None

exe

Specifies the name for a built program or dynamic-link
library.

Syntax
Linux OS:

None

macOS:

None

375



Intel® Fortran Compiler Classic and Intel® Fortran Compiler Developer Guide and Reference

Windows OS:

/exe:{filename | dir}

Arguments

£ilename Is the name for the built program or dynamic-link library.

dir Is the directory where the built program or dynamic-link library should be placed. It can
include filename.

Default

OFF The name of the file is the name of the first source file on the command line with file

extension .exe, so file.f becomes file.exe.

Description
This option specifies the name for a built program (.EXE) or a dynamic-link library (.DLL).

You can use this option to specify an alternate name for an executable file. This is especially useful when
compiling and linking a set of input files. You can use the option to give the resulting file a name other than
that of the first input file (source or object) on the command line.

You can use this option to specify an alternate name for an executable file. This is especially useful when
compiling and linking a set of input files. You can use the option to give the resulting file a name other than
that of the first input file (source or object) on the command line.

IDE Equivalent

None

Alternate Options
Linux and macOS*: -o

Windows: /Fe

Example

The following example creates a dynamic-link library file named file.dll (note that you can use /LD in place
of /d11):

ifort /dll /exe:file.dll a.f

In the following example (which uses the alternate option /Fe), the command produces an executable file
named outfile.exe as a result of compiling and linking three files: one object file and two Fortran source files.

prompt>ifort /Feoutfile.exe filel.obj file2.for file3.for

By default, this command produces an executable file named filel.exe.

See Also
o compiler option

Fa

Specifies that an assembly listing file should be
generated.
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Syntax
Linux OS:
-Fa[filename|dir]

macOS:

-Fa[filename|dir]

Windows OS:

/Fa[filename|dir]

Arguments

filename Is the name of the assembly listing file.

dir Is the directory where the file should be placed. It can include
filename.

Default

OFF No assembly listing file is produced.

Description

This option specifies that an assembly listing file should be generated (optionally named filename).

If filename is not specified, the file name will be the name of the source file with an extension of .asm; the

file is placed in the current directory.

IDE Equivalent

Windows

Visual Studio: Output > ASM Listing Name

Alternate Options

Linux and macOS*: -s

Windows: /s, /asmfile (this is a deprecated option)

FA

Specifies the contents of an assembly listing file.

Syntax
Linux OS:
None

macOS:

None

Windows OS:

/FA[specifier]

Arguments

specifier Denotes the contents of the assembly listing file. Possible values are ¢, s, or cs.
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Default
OFF No source or machine code annotations appear in the assembly listing file, if one is produced.
Description

These options specify what information, in addition to the assembly code, should be generated in the
assembly listing file.

To use this option, you must also specify option /Fa, which causes an assembly listing to be generated.

Option Description

/FA Produces an assembly listing without source or machine code
annotations.

/FAc Produces an assembly listing with machine code annotations.

The assembly listing file shows the hex machine instructions at the
beginning of each line of assembly code. The file cannot be assembled;
the file name is the name of the source file with an extension of .cod.

/FAs Produces an assembly listing with source code annotations.

The assembly listing file shows the source code as interspersed
comments.

Note that if you use alternate option -fsource-asm, you must also
specify the -s option.
/FAcs Produces an assembly listing with source and machine code annotations.

The assembly listing file shows the source code as interspersed
comments and shows the hex machine instructions at the beginning of
each line of assembly code. This file cannot be assembled.

IDE Equivalent

Windows
Visual Studio: Output Files > Assembler Output

Alternate Options
/FAC Linux and macOS*: -fcode-asm
Windows: None

/FAs Linux and macOS*: -fsource-asm

Windows: None

fcode-asm

Produces an assembly listing with machine code
annotations. This feature is only available for ifort.

Syntax
Linux OS:

-fcode-asm
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macOS:

-fcode-asm

Windows OS:

None

Arguments

None

Default

OFF No machine code annotations appear in the assembly listing file, if one is produced.
Description

This option produces an assembly listing file with machine code annotations.

The assembly listing file shows the hex machine instructions at the beginning of each line of assembly code.
The file cannot be assembled; the file name is the name of the source file with an extension of .cod.

To use this option, you must also specify option -3, which causes an assembly listing to be generated.

IDE Equivalent

None

Alternate Options
Linux and macOS*: None

Windows: /FAc

See Also
S compiler option

Fd

Lets you specify a name for a program database
(PDB) file created by the compiler. This feature is only
available for ifort.

Syntax
Linux OS:
None

macOS:

None

Windows OS:
/Fd[:filename]

Arguments

filename Is the name for the PDB file. It can include a path. If you do not
specify a file extension, the extension .pdb is used.
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Default

OFF No PDB file is created unless you specify option /zi. If you specify option /zi and /Fd, the
default filename is vcx0.pdb, where x represents the version of Visual C++, for example
vc100.pdb.

Description

This option lets you specify a name for a program database (PDB) file that is created by the compiler.

A program database (PDB) file holds debugging and project state information that allows incremental linking
of a Debug configuration of your program. A PDB file is created when you build with option /zi. Option /Fd
has no effect unless you specify option /zi.

IDE Equivalent

Windows

Visual Studio: Output Files > Program Database File Name

Alternate Options

None

See Also
Zi, Z7 compiler option
pdbfile compiler option

feliminate-unused-debug-types, Qeliminate-unused-debug-types

Controls the debug information emitted for types
declared in a compilation unit. This feature is only
available for ifort.

Syntax

Linux OS:
-feliminate-unused-debug-types
-fno-eliminate-unused-debug-types
macOS:
-feliminate-unused-debug-types
-fno-eliminate-unused-debug-types
Windows OS:
/Qeliminate-unused-debug-types

/Qeliminate-unused-debug-types-

Arguments

None
Default

-feliminate-unused-debug-types Ihe compiler emits debug information only for types that are actually
or used by a variable/parameter/etc..

/Qeliminate-unused-debug-types
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Description
This option controls the debug information emitted for types declared in a compilation unit.

If you specify -fno-eliminate-unused-debug-types (Linux and macOS*)
or /Qeliminate-unused-debug-types-, it will cause the compiler to emit debug information for all types
present in the sources. This option may cause a large increase in the size of the debug information.

IDE Equivalent

None

Alternate Options

None

fmerge-constants

Determines whether the compiler and linker attempt
to merge identical constants (string constants and
floating-point constants) across compilation units. This
feature is only available for ifort.

Syntax

Linux OS:
-fmerge-constants
-fno-merge-constants
macOS:

None

Windows OS:

None

Arguments

None

Default
-fmerge-constants The compiler and linker attempt to merge identical constants across

compilation units if the compiler and linker supports it.

Description

This option determines whether the compiler and linker attempt to merge identical constants (string
constants and floating-point constants) across compilation units.

If you do not want the compiler and linker to attempt to merge identical constants across compilation units.
specify —-fno-merge-constants.

IDE Equivalent

None

Alternate Options

None
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fmerge-debug-strings
Causes the compiler to pool strings used in debugging
information.

Syntax

Linux OS:
-fmerge-debug-strings
-fno-merge-debug-strings
macOS:

None

Windows OS:

None

Arguments

None
Default

-fmerge-debug-strings The compiler will pool strings used in debugging information.

Description

This option causes the compiler to pool strings used in debugging information. The linker will automatically
retain this pooling.

This option can reduce the size of debug information, but it may produce slightly slower compile and link
times.

This option is only turned on by default if you are using gcc 4.3 or later, where this setting is also the default,
since the generated debug tables require binutils version 2.17 or later to work reliably.

If you do not want the compiler to pool strings used in debugging information, specify option
-fno-merge-debug-strings
IDE Equivalent

None

Alternate Options
None

fsource-asm

Produces an assembly listing with source code
annotations. This feature is only available for ifort.

Syntax
Linux OS:

-fsource-asm

macOS:

-fsource-asm
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Windows OS:

None

Arguments

None

Default

OFF No source code annotations appear in the assembly listing file, if one is produced.
Description

This option produces an assembly listing file with source code annotations. The assembly listing file shows
the source code as interspersed comments.

To use this option, you must also specify option -S, which causes an assembly listing to be generated.

IDE Equivalent

None

Alternate Options
Linux and macOS*: None

Windows: /FAs

See Also
s compiler option

ftrapuv, Qtrapuv

Initializes stack local variables to an unusual value to
aid error detection. This feature is only available for
ifort.

Syntax
Linux OS:

-ftrapuv

macOS:

-ftrapuv

Windows OS:
/Qtrapuv

Arguments

None
Default

OFF The compiler does not initialize local variables.

Description

This option initializes stack local variables to an unusual value to aid error detection. Normally, these local
variables should be initialized in the application. It also unmasks the floating-point invalid exception.
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The option sets any uninitialized local variables that are allocated on the stack to a value that is typically
interpreted as a very large integer or an invalid address. References to these variables are then likely to
cause run-time errors that can help you detect coding errors.

This option sets option -g (Linux* and macOS*) and /zi or /z7 (Windows*), which changes the default
optimization level from 02 to -00 (Linux and macOS*) or /0d (Windows). You can override this effect by
explicitly specifying an O option setting.

This option sets option [Q]init snan.

If option 02 and option -ftrapuv (Linux and macOS*) or /Qtrapuv (Windows) are used together, you
should specify option -fp-speculation safe (Linux and macOS*) or /Qfp-speculation:safe (Windows)
to prevent exceptions resulting from speculated floating-point operations from being trapped.

For more details on using options -ftrapuv and /Qtrapuv with compiler option 0, see the article in Intel®
Developer Zone titled Don't optimize when using -ftrapuv for uninitialized variable detection, which is located
in https://software.intel.com/content/www/us/en/develop/articles/dont-optimize-when-using-ftrapuv-for-
uninitialized-variable-detection.html.

Another way to detect uninitialized local scalar variables is by specifying keyword uninit for option check.
IDE Equivalent

Windows

Visual Studio: Data > Initialize stack variables to an unusual value

Alternate Options

None

See Also

g compiler option

Zi, Z7 compiler option

o0 compiler option

check compiler option (see setting uninit)
init, 0init compiler option (see setting snan)
Locating Run-Time Errors

fverbose-asm

Produces an assembly listing with compiler comments,
including options and version information. This feature
is only available for ifort.

Syntax
Linux OS:
-fverbose-asm

-fno-verbose-asm
macOS:
-fverbose-asm
-fno-verbose-asm

Windows OS:

None
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Arguments

None

Default

—fno-verbose-asm No source code annotations appear in the assembly listing file, if one
is produced.

Description

This option produces an assembly listing file with compiler comments, including options and version
information.

To use this option, you must also specify -s, which sets -fverbose-asm.

If you do not want this default when you specify -3, specify -fno-verbose-asm.

IDE Equivalent

None

Alternate Options

None

See Also
s compiler option

g

Tells the compiler to generate a level of debugging
information in the object file.

Syntax
Linux OS:

—-gl[n]
macOS:
—-gln]
Windows OS:

See option ZzZi, Z7.

Arguments
n Is the level of debugging information to be generated. Possible values
are:
0 Disables generation of symbolic debug
information.
1 Produces minimal debug information for
performing stack traces.
2 Produces complete debug information. This

is the same as specifying -g with no n.
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3 Produces extra information that may be
useful for some tools.

Default

-g or -g2 The compiler produces complete debug information.

Description

Option -g tells the compiler to generate symbolic debugging information in the object file, which increases
the size of the object file.

The compiler does not support the generation of debugging information in assemblable files. If you specify
this option, the resulting object file will contain debugging information, but the assemblable file will not.

This option turns off option -02 and makes option -00 the default unless option -02 (or higher) is explicitly
specified in the same command line.

Specifying the -g or —-00 option sets the -fno-omit-frame-pointer option. On Linux*, the -debug inline-
debug-info option will be enabled by default if you compile with optimizations (option -02 or higher) and
debugging is enabled (option -g).

Specifying the -g or -00 option sets the -fno-omit-frame-pointer option.

NOTE

When option -g is specified, debugging information is generated in the DWARF Version 3
format. Older versions of some analysis tools may require applications to be built with the
-gdwarf-2 option to ensure correct operation.

IDE Equivalent

None

Alternate Options
Linux: None
Windows: /Zi, /Z7

See Also

gdwarf compiler option

Zi, Z7 compiler option

debug (Linux* and macOS*) compiler option

gdwarf

Lets you specify a DWARF Version format when
generating debug information.

Syntax
Linux OS:

-gdwarf-n
macOS:

-gdwarf-n
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Windows OS:
None
Arguments
n Is a value denoting the DWARF Version format to use. Possible values
are:
2 Generates debug information using the
DWARF Version 2 format.
3 Generates debug information using the
DWARF Version 3 format.
4 Generates debug information using the
DWARF Version 4 format. This setting is only
available on Linux*.
Default
OFF No debug information is generated. However, if compiler option -g is specified, debugging

information is generated in the DWARF Version 3 format.

Description

This option lets you specify a DWARF Version format when generating debug information.

Note that older versions of some analysis tools may require applications to be built with the -gdwarf-2 option
to ensure correct operation.

IDE Equivalent

None

Alternate Options

None

See Also
g compiler option

grecord-gcc-switches

Causes the command line options that were used to
invoke the compiler to be appended to the
DW_AT_producer attribute in DWARF debugging
information.

Syntax
Linux OS:

-grecord-gcc-switches

macOS:

None

Windows OS:

None
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Arguments

None

Default

OFF The command line options that were used to invoke the compiler are
not appended to the DW_AT_producer attribute in DWARF debugging
information.

Description

This option causes the command line options that were used to invoke the compiler to be appended to the
DW_AT_producer attribute in DWARF debugging information.

The options are concatenated with whitespace separating them from each other and from the compiler
version.

IDE Equivalent

None

Alternate Options
None
gsplit-dwarf

Creates a separate object file containing DWARF
debug information.

Syntax

Linux OS:
-gsplit-dwarf
macOS:

None

Windows OS:

None

Arguments

None

Default

OFF No separate object file containing DWARF debug information is
created.

Description

This option creates a separate object file containing DWARF debug information. It causes debug information
to be split between the generated object (.0) file and the new DWARF object (.dwo) file.

The DWAREF object file is not used by the linker, so this reduces the amount of debug information the linker
must process and it results in a smaller executable file.

For this option to perform correctly, you must use binutils-2.24 or later. To debug the resulting executable,
you must use gdb-7.6.1 or later.
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NOTE
If you use the split executable with a tool that does not support the split DWARF format, it
will behave as though the DWARF debug information is absent.

IDE Equivalent

None

Alternate Options

None

list
Tells the compiler to create a listing of the source file.

Syntax

Linux OS:
-list[=filename]
-no-list

macOS:
-list[=filename]
-no-list
Windows OS:
/list[:filename]

/list-
Arguments

filename Is the name of the file for output. It can include a path.

Default

-no-list or /list- No listing is created for the source file.

Description
This option tells the compiler to create a listing of the source file. The listing contains the following:

e The contents of files included with INCLUDE statements
e A symbol list with a line number cross-reference for each routine
e A list of compiler options used for the current compilation

The contents of the listing can be controlled by specifying option show.
The line length of the listing can be specified by using option 1ist-1line-1len.
The page length of the listing can be specified by using option 1ist-page-len.

If you do not specify filename, the output is written to a file in the same directory as the source. The file
name is the name of the source file with an extension of .Ist.
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IDE Equivalent

Windows
Visual Studio: Output Files > Source Listing (/list)
Output Files > Source Listing File (/list:[filename])

Alternate Options

None

See Also

show compiler option
list-line-len compiler option
list-page-len compiler option

list-line-len
Specifies the line length for the listing generated when
option list is specified.

Syntax

Linux OS:
-list-line-len=n
macOS:
-list-line-len=n
Windows OS:
/list-line-len:n
Arguments

n Is a positive integer indicating the number of columns to show in the listing.

Default

80 When a listing is generated, the default line length is 80 columns.

Description
This option specifies the line length for the listing generated when option 1ist is specified.

If you specify option 1ist-1ine-len and do not specify option 1ist, the option is ignored.

IDE Equivalent

None
Alternate Options

None

See Also
list compiler option
list-page-len compiler option
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list-page-len
Specifies the page length for the listing generated
when option list is specified.

Syntax

Linux OS:
-list-page-len=n
macOS:
-list-page-len=n

Windows OS:

/list-page-len:n

Arguments

n Is a positive integer indicating the number of lines on a page to show in the listing.
Default

60 When a listing is generated, the default page length is 60 lines.

Description

This option specifies the page length for the listing generated when option 1ist is specified.

If you specify option 1ist-page-1len and do not specify option 1ist, the option is ignored.

IDE Equivalent

None
Alternate Options

None

See Also
list compiler option
list-line-len compiler option

map-opts, Qmap-opts

Maps one or more compiler options to their equivalent

on a different operating system.

Syntax
Linux OS:
-map-opts

macOS:

None

Windows OS:
/Qmap-opts
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Arguments

None
Default

OFF No platform mappings are performed.

Description

This option maps one or more compiler options to their equivalent on a different operating system. The result
is output to stdout.

On Windows systems, the options you provide are presumed to be Windows options, so the options that are
output to stdout will be Linux equivalents.

On Linux systems, the options you provide are presumed to be Linux options, so the options that are output
to stdout will be Windows equivalents.

The tool can be invoked from the compiler command line or it can be used directly.
No compilation is performed when the option mapping tool is used.

This option is useful if you have both compilers and want to convert scripts or makefiles.

NOTE

Compiler options are mapped to their equivalent on the architecture you are using. For
example, if you are using a processor with Intel® 64 architecture, you will only see
equivalent options that are available on processors with Intel® 64 architecture.

IDE Equivalent

None

Alternate Options

None

Example

The following command line invokes the option mapping tool, which maps the Linux options to Windows-
based options, and then outputs the results to stdout:

ifort -map-opts -xP -02

The following command line invokes the option mapping tool, which maps the Windows options to Linux-
based options, and then outputs the results to stdout:

ifort /Qmap-opts /QxP /02

See Also
Compiler Option Mapping Tool

o
Specifies the name for an output file.

Syntax

Linux OS:

-0 filename
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macOS:

-o filename

Windows OS:

None

Arguments

filename Is the name for the output file. The space before filename is optional.
Default

OFF The compiler uses the default file name for an output file.

Description

This option specifies the name for an output file as follows:

o If —c is specified, it specifies the name of the generated object file.
e If -5 is specified, it specifies the name of the generated assembly listing file.
e If -preprocess-only or -P is specified, it specifies the name of the generated preprocessor file.

Otherwise, it specifies the name of the executable file.

IDE Equivalent

None

Alternate Options
Linux and macOS*: None

Windows: /exe

See Also
object compiler option
exe compiler option

object
Specifies the name for an object file.

Syntax
Linux OS:
None

macOS:

None

Windows OS:

/object: filename
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Arguments

filename IS the name for the object file. It can be a file name or a directory name. A directory name must
be followed by a backslash (\). If a special character appears within the file name or directory
name, the file name or directory name must appear within quotes. To be safe, you should
consider any non-ASCII numeric character to be a special character.

Default
OFF An object file has the same name as the name of the first source file and a file extension of .obj.
Description

This option specifies the name for an object file.

If you specify this option and you omit /c or /compile-only, the /object option gives the object file its
name.

On Linux and macOS* systems, this option is equivalent to specifying option -ofilename-c.
IDE Equivalent

Windows
Visual Studio: Output Files > Object File Name

Alternate Options
Linux and macOS*: None

Windows: /Fo

Example

The following command shows how to specify a directory:
ifort /object:directorya\ end.f

If you do not add the backslash following a directory name, an executable is created. For example, the
following command causes the compiler to create directorya.exe:

ifort /object:directorya end.f
The following commands show how to specify a subdirectory that contains a special character:
ifort /object:"blank subdirectory"\ end.f

ifort /object:"c:\my directory"\ end.f

See Also
o compiler option

pdbfile

Lets you specify the name for a program database
(PDB) file created by the linker. This feature is only
available for ifort.

Syntax
Linux OS:

None
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macOS:

None

Windows OS:
/pdbfilel: filename]

Arguments

filename Is the name for the PDB file. It can include a path. If you do not
specify a file extension, the extension .pdb is used.

Default

OFF No PDB file is created unless you specify option /zi. If you specify option /71 the default

filename is executablename.pdb.

Description

This option lets you specify the name for a program database (PDB) file created by the linker. This option
does not affect where the compiler outputs debug information.

To use this option, you must also specify option /debug:full or /Zi.

If filename is not specified, the default file name used is the name of your file with an extension of .pdb.

IDE Equivalent

None

Alternate Options

None

See Also

Zi, Z7 compiler option
debug compiler option
Fd compiler option

print-multi-lib
Prints information about where system libraries should
be found.

Syntax

Linux OS:
-print-multi-1lib
macOS:
-print-multi-1ib
Windows OS:

None

Arguments

None
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Default
OFF No information is printed unless the option is specified.
Description

This option prints information about where system libraries should be found, but no compilation occurs. On
Linux* systems, it is provided for compatibility with gcc.
IDE Equivalent

None

Alternate Options

None

Quse-msasm-symbols

Tells the compiler to use a dollar sign ("$") when
producing symbol names. This feature is only available
for ifort.

Syntax
Linux OS:
None
macOS:
None

Windows OS:

/Quse-msasm-symbols

Arguments

None

Default

OFF The compiler uses a period (".") when producing symbol names

Description
This option tells the compiler to use a dollar sign ("$") when producing symbol names.

Use this option if you require symbols in your .asm files to contain characters that are accepted by the MS
assembler.

IDE Equivalent

None

Alternate Options
None

S

Causes the compiler to compile to an assembly file
only and not link.
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Syntax
Linux OS:

Windows OS:
/S

Arguments

None

Default

OFF Normal compilation and linking occur.

Description
This option causes the compiler to compile to an assembly file only and not link.

On Linux* and macOS* systems, the assembly file name has a .s suffix. On Windows* systems, the
assembly file name has an .asm suffix.

IDE Equivalent

None

Alternate Options
Linux and macOS*: None

Windows: /Fa

See Also
Fa compiler option

show

Controls the contents of the listing generated when
option list is specified.

Syntax

Linux OS:
-show keyword[, keyword...]

macOS:

-show keyword[, keyword...]

Windows OS:
/show: keyword[, keyword...]

Arguments

keyword Specifies the contents for the listing. Possible values are:
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[no] include Controls whether contents of files added with INCLUDE statements
are included when a listing is generated.

[nolmap Controls whether a symbol listing with a line number cross-
reference for each routine is included when a listing is generated.

[no]options Controls whether a list of compiler options used for the compilation
is included when a listing is generated.

Default

include, map, and When a listing is generated, it contains the contents of INCLUDE files, a symbol list

options with a line number cross reference, and a list of compiler options used.

Description
This option controls the contents of the listing generated when option 1ist is specified.

If you specify option show and do not specify option 1ist, the option is ignored.

IDE Equivalent

None

Alternate Options

None

See Also
list compiler option

use-asm, Quse-asm

Tells the compiler to produce objects through the
assembler. This is a deprecated option. There is no
replacement option. This feature is only available for
ifort.

Syntax

Linux OS:
—use—asm
—no—-use-—asm
macOS:
—use—asm
—no—-use-—asm
Windows OS:
/Quse-asm

/Quse-asm-

Arguments

None
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Default

OFF The compiler produces objects directly.

Description

This option tells the compiler to produce objects through the assembler.

IDE Equivalent

None

Alternate Options

None

Zi, Z7

Tells the compiler to generate full debugging

information in either an object (.obj) file or a project
database (PDB) file.

Syntax
Linux OS:
See option g.

macOS:

See option g.

Windows OS:

/Z1i

/27

Arguments

None

Default

OFF No debugging information is produced.
Description

Option /z7 tells the compiler to generate symbolic debugging information in the object (.obj) file for use with
the debugger. No .pdb file is produced by the compiler.

The /zi option tells the compiler to generate symbolic debugging information in a program database (PDB)
file for use with the debugger. Type information is placed in the .pdb file, and not in the .obj file, resulting in
smaller object files in comparison to option /z7.

When option /z1i is specified, two PDB files are created:

e The compiler creates the program database project.pdb. If you compile a file without a project, the
compiler creates a database named vcx0.pdb, where x represents the major version of Visual C++, for
example vc140.pdb.

This file stores all debugging information for the individual object files and resides in the same directory
as the project makefile. If you want to change this name, use option /Fd.
e The linker creates the program database executablename.pdb.
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This file stores all debug information for the .exe file and resides in the debug subdirectory. It contains full
debug information, including function prototypes, not just the type information found in vcx0.pdb.

Both PDB files allow incremental updates. The linker also embeds the path to the .pdb file in the .exe or .dll
file that it creates.

The compiler does not support the generation of debugging information in assemblable files. If you specify
these options, the resulting object file will contain debugging information, but the assemblable file will not.

These options turn off option /02 and make option /0d the default unless option /02 (or higher) is explicitly
specified in the same command line.

For more information about the /z7 and /Z1i options, see the Microsoft documentation.
IDE Equivalent

Visual Studio

Visual Studio: General > Generate Debug Information

Alternate Options
Linux: -g

Windows: None

See Also

Fd compiler option

g compiler option

debug (Windows*) compiler option

Zo

Enables or disables generation of enhanced debugging
information for optimized code. This feature is only
available for ifort.

Syntax
Linux OS:
None

macOS:

None

Windows OS:
/70

/Zo-

Arguments

None
Default

OFF The compiler does not generate enhanced debugging information for optimized code.
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Description

This option enables or disables the generation of additional debugging information for local variables and
inlined routines when code optimizations are enabled. It should be used with option /zi or /z7 to allow
improved debugging of optimized code.

Option /zo enables generation of this enhanced debugging information. Option /Zo- disables this
functionality.

For mor